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Chapter 1.  Introduction

This redbook deals with installing and administering Lotus Domino R5 on an 
IBM RS/6000 AIX platform. We documented our experience while working 
with Lotus Domino R5. 

Lotus Domino R5 brings messaging, Internet integration, and scalability to a 
whole new level. The new Domino Server includes the latest innovations in 
Internet messaging with native support for all the major Internet standards, 
such as industry-leading support for Web applications, including Common 
Object Request Broker Architecture (CORBA) support and integration with 
Microsoft Internet Information Server (IIS). The Domino Server has increased 
reliability and scalability including improvements in performance, capacity, 
availability, and maximum database size. In addition, the server has a new 
administration interface with a task-oriented approach that makes Domino 
easier to deploy, use, and manage. 

Lotus Domino R5 continues to support a wide variety of clients in addition to 
the traditional Notes clients. Messaging features are available to Web 
browsers and Internet mail clients, such as Post Office Protocol, Version 3 
(POP3) and Internet Message Access Protocol, Version 4 (IMAP4) clients. 
Directory features are available to browsers and Lightweight Directory 
Access Protocol (LDAP) clients. Discussion features are available to 
browsers and Network News Transfer Protocol (NNTP) newsreader clients, 
and administration features are available to browsers as well as the Notes 
clients. Domino continues to be the best platform for designing dynamic Web 
applications. With the new Domino Designer R5, you can easily build a single 
application that looks and runs the same for both the Web and Notes clients. 

The Lotus Notes R5 client gives you easy access to all the information that is 
important to you -- whether that information is personal (like your e-mail and 
calendar) or public (like your favorite Web sites and Internet newsgroups). 
The client includes a new browser-like user interface with a customizable 
welcome page for tracking your important daily information. It also includes 
improvements to the applications you use in your daily work, such as mail, 
calendar and scheduling, Web browsing, and discussions. 

The Notes R5 client is server independent -- that is, you can use it with 
Domino R5 as well as other Internet-standard servers, such as the ones your 
Internet Service Provider (ISP) may use. For example, you can read and 
send messages to any Internet mail server, read and post topics to any 
Internet newsgroup, search any Internet directory, view HTML from any Web 
server, and use X.509 certificates for security. The best part is that you can 
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do all these things from within one, consistent interface without needing to 
know about the Internet standards involved. You simply do your work within 
the Notes interface, and Notes handles the rest for you. 

The rest of this chapter briefly outlines the new features and enhanced 
functionality of Lotus Domino Server 5 and the various clients. It also 
describes the new concepts in R5 and the available platforms. The hardware 
and software we used while writing this book is also described.

1.1  What Is Lotus Domino R5?

Lotus Domino R5 is Lotus’ next generation of Internet products that include 
Notes integrated Internet client and Domino server platform for messaging, 
collaboration, and Internet and Intranet applications. The Domino Designer is 
a Web and Intranet application development tool. Domino’s integrated 
platform delivers messaging and collaborative solutions for the Internet. 
Several key services enable IT professionals to manage and run their 
messaging and Web application infrastructures easily and efficiently. The new 
R5 Domino Administrator makes it faster and easier for administrators to 
manage users, configure systems, optimize performance, all from an intuitive 
user interface.

The Lotus Domino R5 server builds on its already strong foundation for 
messaging and Web applications. The R5 enhancements are the next step in 
making Domino easy to use and a better fit for any sized organization.

Specific Lotus Domino R5 features include:

Internet Messaging and Directories
  • Provide full-fidelity messaging for your users with native MIME and SMTP 

support 
  • Use the new Directory Catalog to save space and provide quick name 

lookups 
  • Use new LDAP features to authenticate users in external directories, 

customize the directory, and more 

Expanded Web Application Services
  • Design applications with CORBA-standard distributed objects, Java, or 

JavaScript
  • Use Web clusters for high availability of Web services, expanded security 

options, and more 
  • Run Domino using the IIS HTTP services
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Database Improvements
  • Use transactional logging for faster restarts and data recovery
  • Convert to the new on-disk structure (ODS) for better performance, data 

integrity, and more

Easier Administration
  • Manage users, databases, and servers with the new Domino 

Administrator. It includes the Administration Process, a tool for analyzing 
what you need to do to decommission a server, topology maps, and 
integration hooks for third-party tools to appear on the registration 
interface.

  • Migrate users from cc:Mail, Microsoft (MS) Mail, Exchange, or Windows 
NT with the redesigned user registration. 

  • New tools for server monitoring and message management.

1.2  What Is Lotus Notes R5?

The new Lotus Notes R5 interface is more intuitive and easier to use than 
ever. It provides a single integrated environment to manage e-mail, 
appointments, tasks, key contacts, and Web information. It gives you a 
headlines page that helps you stay on top of your most important priorities 
throughout the day. Lotus Notes R5 offers powerful, new knowledge 
management tools. Its bookmarks help get back to information quickly. It is 
state-of-the-art e-mail, calendaring, group scheduling, Web access, and 
information management -- all integrated in an easy-to-use and customizable 
environment. Lotus Notes R5 extends the lead in integrated collaboration 
clients with even more Internet support and a Web-style interface that adapts 
to your work style plus scores of other improvements to help you work 
smarter and be more productive.

The new look and feel of Lotus Notes R5 focuses on creating an environment 
that makes it easy for both new and existing users to access all of their 
information. This involved adding features that help new users, such as 
cc:Mail and Internet mail users, feel comfortable within the Notes mail 
interface as well as making other existing features, such as calendar and 
scheduling, easier to use. Underlying both of these areas is the client’s total 
embrace of Internet standards; so, you can work with the information that 
matters to you regardless of where that data is stored or what protocol is 
used to deliver it. 

Specific Lotus Notes R5 features include:
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The New User Interface
  • Use the new Welcome page for instant access to your mail, calendar, and 

more and customize it to track your important information.
  • Create bookmarks for anything that you want to return to later, whether it 

is from Notes or the Internet.
  • Navigate through open pages of information with tabs and Web-like 

universal navigation buttons. 

Improved Applications
  • Use new mail features, such as cc:Mail-like address headers, mail rules, 

easier mail archiving, and others.
  • Get organized with enhanced Calendar and Scheduling features, such as 

tasks that follow you, improved calendar management, a Group calendar, 
and more.

Native Support of Internet Standards
  • View Internet mail messages, Web pages, and newsgroups with full fidelity 

(because of MIME and HTML support) and security (using SSL, S/MIME, 
and X.509 certificates).

  • Read and send messages from Internet mail servers (using POP3 or 
IMAP).

  • Search any Internet directory (using LDAP).
  • Read and post articles to any Internet newsgroup discussion (using 

NNTP). 

1.2.1  Benefits of R5:
Some of the benefits of R5 are given below:

  • Ease of use

Notes makes it easy to find, sort, and manage all your work in a way that 
makes sense to you.

  • Notes works your way

You can personalize the new Headlines page or customize your 
Bookmarks so that the information you need is the information you see.

  • Universal In-Box

Notes support for Internet Protocols lets you manage all your e-mail from 
one place whether it’s from your network or from an Internet account.

  • One place for all information

Notes is a truly integrated Internet client providing access to a world of 
information and helping you manage it with ease.
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  • Mobile support

Whether you are in the office or on the road, you can stay connected. 
Notes synchronizes data with PCs, pagers, faxes, and popular hand-held 
devices.

  • Easy to install and setup

Simple install of software will get you right to work.

  • A powerful tool for any infrastructure

Current Notes users can upgrade quickly and easily to take advantage of 
all the enhancements in Notes and Domino R5.

1.2.2  New Lotus Notes R5 Client Interface
Notes unveils a dramatically new user interface designed to let you take 
advantage of the new power of Notes whether you are viewing Notes 
databases, contributing to a discussion group, reading mail from your ISP, or 
just surfing the Web. While the interface has changed, you can still use the 
legacy Notes Workspace from the previous releases of Notes.

Table 1.  User Interface Features

The Welcome page looks like the example shown in Figure 1 below:

UI Features Description

Welcome page Start on the Welcome page for all your important information. The 
Welcome page contains some basic tasks, and you can customize 
it to:

Instant access to mail, calendar, and to-do lists

Customize the page to see your latest mail messages and 
appointments at a glance

Add your favorite Web sites or newsgroups

Instant search of Web sites, local documents, or databases

Notes Tour

See What’s New

Bookmarks Create bookmarks for anything you want to return to later whether 
it’s from Notes or the Internet.

Navigation Navigate through open pages of infomration with tabs and Web-like 
universal navigation buttons.
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Figure 1.  New Lotus Notes R5 Client Interface

1.3  Lotus Domino R5 Family of Servers and Clients

The Domino Server Family is an integrated messaging and Web application 
software platform for growing companies that need to improve customer 
responsiveness and streamline business processes.

The only solution built on an open, unified architecture, Domino is trusted by 
the world’s leading companies to deliver secure communication, 
collaboration, and business applications. Lotus Domino R5 Servers set a new 
standard for rich Internet messaging, ease of administration, integration with 
backend systems, and reliability.

The Domino Server family is comprised of three core servers:

1. Domino R5 Mail Server

The Domino Mail Server combines full support for the latest Internet mail 
standards with Domino’s industry-leading messaging capabilities -- all in 
one manageable and reliable infrastructure. 

2. Domino R5 Application Server
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The Domino Application Server is an open, secure platform optimized to 
deliver collaborative Web applications that integrate your Enterprise 
systems with rapidly changing business processes.

3. Domino R5 Enterprise Server

The Domino Enterprise Server delivers all the functionality of the Domino 
Mail and Application Servers reinforced with clustering for the high 
availability and reliability required by mission-critical applications. 

The Domino client family is comprised of three core clients:

1. Domino Administrator

Domino Administrator is the new administration client for Notes and 
Domino. It has a completely new interface with different navigation from 
the R4.x Administration panel.

2. Domino Designer

Domino Designer R5 is an integrated development environment. It 
enables developers to rapidly build secure Web applications that 
incorporate Enterprise data and streamline business processes. 

3. Notes Client

The Notes Client provides the interface that allows a Lotus Notes user to 
access shared databases to read and send mail. The client user interface 
is dramatically enhanced in R5.

1.4  New Terminologies Used in Lotus Notes Release 5

With the advancement in technology, Lotus has introduced some new terms 
in the latest release as given below:

Directory Catalog
The Directory Catalog is a compressed version of one or multiple Domino 
Directories, which improves the speed of name lookups and name resolution 
for all organizations.

Domino Directory
The Public Address Book is now referred to as the Domino Directory.

Directory Assistance
The Master Address Book is now referred to as the Directory Assistance.
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Domino Enterprise Connection Services
Lotus Domino R5 includes DECS for building live links between Domino 
pages and forms to data from relational databases

Byte-Range Serving
Allowing users to download files in sections rather than all at once.

Transactional Logging
Domino now allows for 24x7 online server backups and recovery support. So, 
you no longer need to shut down Domino servers in order to maintain them. A 
transactional log provides a sequential record of every operation that occurs 
(sequential writing on a disk is much faster than writing in various places on a 
disk). Logging helps to ensure complete data integrity for updates and 
enables you to perform incremental database backups.

Online, In-Place Compaction
This means that when you compact a database, the compaction occurs 
in-place meaning that your server does not require extra disk space. Also, 
users can continue to work in the database during the compaction. 

Native Support
With support for native MIME content and native SMTP routing, Domino now 
integrates the features that previously required a separate message transfer 
agent (MTA). The native support means that conversions between a Notes 
format and an Internet format are no longer required.

Redesigned User Registration
The redesigned user registration allows you to easily register users from 
other directories whether those directories are from cc:Mail, MS Mail, 
Exchange, Windows NT, or another LDAP directory. Domino R5 also includes 
the registration API calls; so, you can integrate your own migration tools. 
When registering users, you can select to migrate people and groups from a 
foreign directory source.

1.5  Available Platforms

The new release of Lotus Domino Server elevates the standard for Enterprise 
messaging, groupware, and Web application development servers. It is 
available on all Lotus Domino Server platforms.
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The following table is a summary of the various operating systems platforms 
that support Lotus Notes/Domino Release 5.0.

Table 2.  Available Platforms for Release 5.0

1.5.1  AIX
The RS/6000 is known for its performance, innovative technology, and 
scalability. The RS/6000 family offers the broadest product line spanning from 
workstations to massive parallel servers and is the only IBM brand of server 
that delivers a full range of solutions for technical applications.

IBM’s award winning UNIX implementation is AIX. Domino, coupled with the 
IBM RS/6000 hardware, is a highly scalable platform that will optimize 
network communications (TCP/IP leadership), security (SSL, LDAP, C2, 
IPSEC), and Java (leading Volcanomark) with award winning System 
Management and high availability system software (HACMP).

Lotus Domino servers are an integral part of the IBM Internet technology. The 
data managed by these servers must be highly available in a world where 
online information is the corner stone of business success. Domino is a Web 
server for highly interactive Internet and intranet applications. It is also the 
base for future Lotus Internet solutions.

IBM’s RS/6000 provides new Internet and electronic commerce solutions for 
your business. New workstations and servers include Internet-ready systems 
that include Lotus Notes and state-of-the-art electronic commerce software 

Platform Domino Server R5 Notes Client R5

UNIX (AIX V 4.3.1 or higher, 
HP-UX 11.0, Solaris/SPARC 2.6, 
Solaris/Intel 2.6)

Yes No

OS/2 Warp Server V4.0 Yes No

Windows 95/98 No Yes

Windows NT Server 4.0 and 
Windows NT Workstation 4.0

Yes Yes

Novell NetWare No No

Macintosh Power PC 7.6, 8.1 No Yes

AS/400 V4R2 Yes No

S/390 V2R6 Yes No
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providing all the elements needed to get businesses up and running on the 
World Wide Web. 

The newly announced RS/6000 servers and workstations make IBM a solid 
choice for engineers and scientists by offering outstanding graphics 
price/performance and a wide-range of power and expansion options. 

IBM’s Web-based solutions for customers seeking to establish electronic 
commerce capability include a family of POWERsolutions for AIX. It now 
includes options, such as IBM’s Net.Commerce, which allows interactive 
browsing of merchants’ catalogs and the greater security required for 
purchases made over the Internet. 

The newly announced family of cost-effective uniprocessor and SMP 
workstations also makes IBM RS/6000 a wise decision for engineers and 
scientists. They meet customers’ needs for high-performance systems at 
lower cost. Additions also include five graphics cards that provide customers 
a wide range of choices to meet their graphics needs from 2D to advanced 
3D. 

Environments, protocols, and hardware details for Lotus Domino R5 on 
RS/6000 is as given below :

Environment(s): AIX V4.3.1 or higher

Workstation: No

Server: Yes

Network protocols available for Server:

  • NetWare IPX/SPX
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Disk Space:

Installation or distribution directory: 160 MB minimum

Server data directory: 200 MB minimum

Swap Space: 256 MB minimum

Mail Database requirements: 50 MB - 100 MB per user

Memory Requirements:

Lotus Domino Server on AIX: 128 MB RAM minimum + 0.5 MB per 
concurrent user
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1.6  Our Lotus Domino Server and Notes Workstation Environment

We have installed and set up Lotus Domino Servers and Notes Workstations 
in an environment with many different operating systems and networking 
protocols. Throughout the rest of this book, we will be explaining our 
installation in great detail. The following figure shows the various Lotus 
Domino Servers, Notes Workstations, and networking protocols that we have 
used.

The naming conventions used in for the test environment is as follows:

  • Volume Group for domino data is dominovg
  • Logical Volume for domino data is dominodatalv
  • Logical Volume for domino binaries is dominobinlv
  • File System for domino data is /server1
  • File System for Domino binaries is /usr/domino
  • Server name is server1/ibm

Figure 2.  Lotus Domino Servers and Notes Workstations Environment in Our Lab
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Part 1.  Installation and Setup
© Copyright IBM Corp. 1999 13



14 Lotus Domino R5 on IBM RS/6000



Chapter 2.  Installing a Lotus Domino R5 Server

In order to install a Lotus Domino R5 Server, certain software, hardware, and 
system requirements must be met, the AIX environment must be prepared, 
and finally, the server software is installed. These topics will be discussed 
and illustrated in this chapter.

2.1  Hardware, Software, and System Requirements

Before installing a Lotus Domino R5 Server, make sure that the RS/6000 
system meets the following hardware, software, and operating system 
requirements. The list below specifies the bare minimum requirements. 
Additional resources are required when taking into consideration the number 
of users, Domino applications, and server load.

  • An IBM RS/6000 system.

  • IBM AIX version 4.3.1 or higher with the IBM AIX operating system 
patches listed in Table 3 on page 17 and Table 4 on page 18. If you’re not 
sure if you have these patches, refer to 2.2.3, “Step 3 - Check PTF Levels 
of Operating System Filesets” on page 16.

  • A minimum of 128 MB of memory required.

  • A minimum of 256 MB of paging space required. Please see 2.2.15, “Step 
15 - Paging Space” on page 36 for more information.

  • A minimum of 160 MB of disk space is required for the binaries.

  • A minimum of 200 MB of disk space is required for the data files.

  • A network adapter.

  • You must have root access to the system. 

  • You must have a Web browser to configure the server.

To size a machine beyond the minimum requirements, a couple rules of 
thumb can be used. This information is provided since every environment is 
different, and your own requirements may differ.

  • Add an additional .5 MB of memory per concurrent user anticipated on the 
system. Concurrent users is usually based on the total number of 
registered mail users for a particular server since it is possible to have all 
registered users concurrent at the same time.

  • Add an additional 50 - 100 MB of disk space for each registered mail user.

  • Add an additional processor per 1000 users.
© Copyright IBM Corp. 1999 15



  • Add an additional network adapter per 1000 users.

2.2  Preparing the AIX Environment

Once you have met the requirements mentioned in the section above, you 
must complete each of the following steps before installing the server 
software. Since Domino server doesn’t require a graphical desktop interface 
(CDE or X-windows) anymore, this chapter assumes that you are using a 
command line prompt interface (green screen) to perform the installation.

2.2.1  Step 1 - Log Into AIX as the Root User
Log in to your AIX system as the root user either from a login prompt or by 
using the command su - at the prompt if you are already logged in as another 
user.

Figure 3.  Log In as Root User

2.2.2  Step 2 - Check Your Default Path Environment Variable
Check your default path. Make sure that it includes /usr/sbin. Use the 
command echo $PATH to display your default path and make changes if 
necessary in the /etc/environment file.

Figure 4.  Environment Path Query

2.2.3  Step 3 - Check PTF Levels of Operating System Filesets
Check to make sure you have the necessary operating system patches 
installed on your system. Use the command lslpp -l <fileset> to check the 
current level for a given fileset. An example of this command is given below. If 
you find a fileset that is not at the appropriate level, you must apply the PTF 
to bring it to the correct level. Refer to http://service.software.ibm.com/support/rs6000 
for PTF download information.

$ su -
root’s Password: ******
# 

# echo $PATH

/usr/dt/bin:/usr/bin:/etc:/usr/sbin:/usr/ucb:/home/ausres/bin:/opt/lotus/bin:/
usr/contrib/bin:/usr/prod/bin:/afs/austin/local/bin/:/usr/afs/bin:/sbin:.
# 
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Figure 5.  AIX Fileset Query

This table lists the current PFT requirements in order to install Lotus Domino 
R5. Refer to the latest copy of the Lotus Domino Release Notes for the most 
current PTF requirements.

Table 3.  Patches for AIX Version 4.3.1 

Patch Number
(PTF / APAR)

Fileset Version

U453875 X11.base.rte 4.3.1.1

U457544 xlC.rte 3.6.4.0

U456080 X11.base.lib 4.3.1.1

U456000 X11.compat.lib.X11R5 4.3.1.1

U456135 bos.adt.debug 4.3.1.1

U457438 bos.adt.include 4.3.1.3

U457423
(development only)

bos.adt.syscalls 4.3.1.1

U453878 bos.adt.prof 4.3.1.1

U456056 bos.net.nfs.client 4.3.1.1

U455978 bos.net.tcp.client 4.3.1.1

U456118 bos.rte.bind_cmds 4.3.1.1

U455998 bos.rte.commands 4.3.1.1

U456156 bos.rte.control 4.3.1.1

U456119 bos.rte.cron 4.3.1.1

U455981 bos.rte.install 4.3.1.1

U456098 bos.rte.libc 4.3.1.1

U456120 bos.rte.libpthreads 4.3.1.1

# lslpp -l bos.adt.include

  Fileset                      Level  State      Description
  ----------------------------------------------------------------------------
Path: /usr/lib/objrepos
  bos.adt.include            4.3.1.1 COMMITTED  Base Application Development
                                                 Include Files
#
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Table 4.  Patches for AIX Version 4.3.2

2.2.4  Step 4 - Configure TCP/IP
Next, we must make sure that TCP/IP is configured correctly. For most 
systems, this is probably already done. If you’re sure that TCP/IP is 
configured correctly, please skip to “Step 5 - Stop Daemons” on page 20. 
Otherwise, please continue with this step.

You should be familiar with TCP/IP and know the host name, TCP/IP address, 
network mask, domain name server (DNS) address, and the default gateway 
address of the RS/6000 you’re working with. If you’re not familiar with these 
terms, or you’re missing some of the information, please contact your network 
administrator for assistance.

U456138 bos.rte.lvm 4.3.1.1

U456152 bos.rte.shell 4.3.1.1

U455983 bos.sysmgt.smit 4.3.1.1

U457293 bos.up 4.3.1.3

U456091 bos.mp 4.3.1.3

U452653 devices.graphics.com 4.3.1.1

Patch Number
(PTF / APAR)

Fileset Version

U461236 bos.up 4.3.2.1

U461454 bos.mp 4.3.2.1

U461854 bos.adt.prof 4.3.2.3

U461430 bos.rte.libc 4.3.2.3

U461941 bos.rte.libpthreads 4.3.2.1

U462006
(development only)

ibmcxx.include 3.6.4.1

U462007
(development only)

ibmcxx.cmp 3.6.4.2

Patch Number
(PTF / APAR)

Fileset Version
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To set up TCP/IP, use the command smitty tcpip and press Enter.

# smitty tcpip

You will be presented with the TCP/IP menu. Select Minimum Configuration 
& Startup and press Enter.

Figure 6.  TCP/IP Configuration Screen

A popup list will appear. Select the desired network interface adapter from the 
list and press Enter. For our environment, we will select the token ring 
network interface.

Figure 7.  TCP/IP Network Interface Selection Screen

On the configuration screen, enter the hostname, internet address (TCP/IP 
address), network mask, name server (DNS), domain name, and the default 
gateway address then press Enter.

TCP/IP

Move cursor to desired item and press Enter.

  Minimum Configuration & Startup
  Further Configuration
  Use DHCP for TCPIP Configuration & Startup
  IPV6 Configuration

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do 

Available Network Interfaces

Move cursor to desired item and press Enter.

en0     Standard Ethernet Network Interface
et0     IEEE 802.3 Ethernet Network Interface
tr0 Token Ring Network Interface 

F1=Help                 F2=Refresh              F3=Cancel
F8=Image                F10=Exit                Enter=Do
/=Find                  n=Find Next
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Figure 8.  TCP/IP Configuration Screen

If everything worked, you will see a screen similar to the one in Figure 9. 
Press F10 to exit the screen and return to the prompt.

Figure 9.  TCP/IP Configuration Status Screen

2.2.5  Step 5 - Stop Daemons
There are some AIX daemons that will interfere with the operation of the 
Lotus Domino server. Generally, you will find one or more of the following 
daemons running on your RS/6000 system:

  • sendmail

  • httpd

  • httpdlite

Minimum Configuration & Startup

 To Delete existing configuration data, please use Further Configuration menus

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* HOSTNAME                                           [ausres29.ibm.com]
* Internet ADDRESS (dotted decimal)                  [9.3.240.6]
  Network MASK (dotted decimal)                      [255.255.255.0]
* Network INTERFACE                                   tr0
  NAMESERVER
           Internet ADDRESS (dotted decimal)         [9.3.240.2]              
           DOMAIN Name                               [ibm.com]
  Default GATEWAY Address                            [9.3.240.1]              
  (dotted decimal or symbolic name)                                           
  RING Speed                                         [autosense]              +
  START Now                                           no                      +
  
  
  
F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image          
F9=Shell            F10=Exit            Enter=Do 

COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

tr0
ausres29.ibm.com
inet0 changed
tr0 changed
inet0 changed

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next                                                         
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These daemons must be stopped in order to free up certain network ports 
that the Lotus Domino server will need. In order to check to see if you have 
any of these daemons running, use the command: ps -ef | grep <daemon 
name> Here’s an example of this command:

Figure 10.  Show Active Daemons

As you can see from our example, we have both the sendmail and httpdlite 
daemons active on our RS/6000.

The easier of the two to stop is the sendmail daemon. Although the Domino 
installation will stop this for you, you must still disable the daemon from 
restarting upon boot. First let’s stop the sendmail daemon by using the 
command: stopsrc -s sendmail

Figure 11.  Stop Sendmail

Next, lets disable sendmail from restarting by using the command: chrctcp -d 
sendmail

Figure 12.  Disable Sendmail

You can verify that the sendmail daemon has indeed stopped by using the 
command: ps -ef | grep sendmail

# ps -ef | grep sendmail

root  5692  4166   0 16:02:52      -  0:00 sendmail: accepting connections on port 25 
root 21278 22720   2 16:25:16  pts/0  0:00 grep sendmail 

# ps -ef | grep httpd

imnadm 20128     1   0 16:04:23      -  0:00 /usr/IMNSearch/httpdlite/httpdlite -r 
/etc/IMNSearch/httpdlite/httpdlite.conf 

root 22078 22720   2 16:25:16  pts/0  0:00 grep sendmail 

#

# stopsrc -s sendmail

0513-044 The stop of the sendmail Subsystem was completed successfully.
# 

# chrctcp -d sendmail
# 
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Figure 13.  Show Active Daemons

As you can see, the sendmail daemon has stopped.

Next, we’re going to stop and disable the httpd daemon. First you must get 
the process ID (PID) by using the command: ps -ef | grep httpd

Figure 14.  Show HTTPD’s Process ID

In our example above, the httpdlite daemon is running under the PID of 
19870. To stop the daemon, you use the command: kill -9 <process id>

Figure 15.  Kill HTTPD

Next, you must disable the httpd daemon by commenting out the appropriate 
line in the /etc/inittab file. Using vi, edit the /etc/inittab file.

# vi /etc/inittab

After entering vi, you will see the following screen:

# ps -ef | grep sendmail

    root 22978 22720   2 16:25:16  pts/0  0:00 grep sendmail 
#

# ps -ef | grep httpd

  imnadm 19870     1   0 11:02:42      -  0:00 /usr/IMNSearch/httpdlite/httpdlite -r 
/etc/IMNSearch/httpdlite/httpdlite.conf 
    root 22974  3916   2 11:33:22  pts/0  0:00 grep httpd 
# 

# kill -9 19870
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Figure 16.  /etc/inittab in vi

Do a search for the httpd daemon line by using the vi command /httpd and 
press Enter. This command will appear at the bottom of the screen as you 
type.

Figure 17.  Search /etc/inittab Using vi Commands

After you press Enter, vi will search the /etc/inittab file for any line that 
contains httpd and then display that on the screen.

: @(#)49  1.28.2.7  src/bos/etc/inittab/inittab, cmdoper, bos430, 9737A_430 7/26
/94 16:27:45
: IBM_PROLOG_BEGIN_TAG
: This is an automatically generated prolog.
:
: bos430 src/bos/etc/inittab/inittab 1.28.2.7
:
: Licensed Materials - Property of IBM
:
: (C) COPYRIGHT International Business Machines Corp. 1989,1993
: All Rights Reserved
:
: US Government Users Restricted Rights - Use, duplication or
: disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
:
: IBM_PROLOG_END_TAG
:
:  COMPONENT_NAME: CMDOPER
:
:  ORIGINS: 3, 27
:
:  (C) COPYRIGHT International Business Machines Corp. 1989, 1993
:  All Rights Reserved
:  Licensed Materials - Property of IBM
"/etc/inittab" 53 lines, 2364 characters

: @(#)49  1.28.2.7  src/bos/etc/inittab/inittab, cmdoper, bos430, 9737A_430 7/26
/94 16:27:45
: IBM_PROLOG_BEGIN_TAG
: This is an automatically generated prolog.
:
: bos430 src/bos/etc/inittab/inittab 1.28.2.7
:
: Licensed Materials - Property of IBM
:
: (C) COPYRIGHT International Business Machines Corp. 1989,1993
: All Rights Reserved
:
: US Government Users Restricted Rights - Use, duplication or
: disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
:
: IBM_PROLOG_END_TAG
:
:  COMPONENT_NAME: CMDOPER
:
:  ORIGINS: 3, 27
:
:  (C) COPYRIGHT International Business Machines Corp. 1989, 1993
:  All Rights Reserved
:  Licensed Materials - Property of IBM
/httpd
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Figure 18.  Search Results for httpd

After the search, the cursor is located at the beginning of the line that 
contains the startup information for the httpd daemon. To comment out this 
line, you must insert a colon at the beginning of the line.

To insert the necessary colon, you use the vi command i to enter the insert 
mode. Make sure the cursor is at the beginning of the line before you enter 
the insert mode.

Once in the insert mode, type a colon and a space as shown in the example 
below.

Figure 19.  Edit /etc/inittab

When you’re finished, press the Escape twice to leave the insert mode. Once 
out of the insert mode, you will need to save your changes by using the vi 
command :wq and press Enter. This command will appear at the bottom of 
the screen as you type.

piobe:2:wait:/usr/lib/lpd/pio/etc/pioinit >/dev/null 2>&1  # pb cleanup
qdaemon:2:wait:/usr/bin/startsrc -sqdaemon
writesrv:2:wait:/usr/bin/startsrc -swritesrv
uprintfd:2:respawn:/usr/sbin/uprintfd
logsymp:2:once:/usr/lib/ras/logsymptom # for system dumps
pmd:2:wait:/usr/bin/pmd > /dev/console 2>&1 # Start PM daemon
diagd:2:once:/usr/lpp/diagnostics/bin/diagd >/dev/console 2>&1
dt:2:wait:/etc/rc.dt
cons:0123456789:respawn:/usr/sbin/getty /dev/console
imnss:2:once:/usr/IMNSearch/bin/imnss -start imnhelp >/dev/console 2>&1
httpdlite:2:once:/usr/IMNSearch/httpdlite/httpdlite -r 
/etc/IMNSearch/httpdlite/httpdlite.conf >/dev/console 2>&1
imqss:2:once:/usr/IMNSearch/bin/imq_start >/dev/console 2>&1

piobe:2:wait:/usr/lib/lpd/pio/etc/pioinit >/dev/null 2>&1  # pb cleanup
qdaemon:2:wait:/usr/bin/startsrc -sqdaemon
writesrv:2:wait:/usr/bin/startsrc -swritesrv
uprintfd:2:respawn:/usr/sbin/uprintfd
logsymp:2:once:/usr/lib/ras/logsymptom # for system dumps
pmd:2:wait:/usr/bin/pmd > /dev/console 2>&1 # Start PM daemon
diagd:2:once:/usr/lpp/diagnostics/bin/diagd >/dev/console 2>&1
dt:2:wait:/etc/rc.dt
cons:0123456789:respawn:/usr/sbin/getty /dev/console
imnss:2:once:/usr/IMNSearch/bin/imnss -start imnhelp >/dev/console 2>&1
: httpdlite:2:once:/usr/IMNSearch/httpdlite/httpdlite -r 
/etc/IMNSearch/httpdlite/httpdlite.conf >/dev/console 2>&1
imqss:2:once:/usr/IMNSearch/bin/imq_start >/dev/console 2>&1
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Figure 20.  Save /etc/inittab and Exit vi

After you press Enter, you will be back at the command prompt.

Figure 21.  vi Exit Message

You can verify that the httpd daemon has indeed stopped by using the 
command: ps -ef | grep httpd

Figure 22.  Show Active Daemons

As you can see, the httpd daemon has stopped.

2.2.6  Step 6 - Create AIX Groups
You must create an AIX group called notes for use during your Lotus Domino 
server installation. To create this group, simply use the command mkgroup -A 
notes.

Figure 23.  Create AIX Group

piobe:2:wait:/usr/lib/lpd/pio/etc/pioinit >/dev/null 2>&1  # pb cleanup
qdaemon:2:wait:/usr/bin/startsrc -sqdaemon
writesrv:2:wait:/usr/bin/startsrc -swritesrv
uprintfd:2:respawn:/usr/sbin/uprintfd
logsymp:2:once:/usr/lib/ras/logsymptom # for system dumps
pmd:2:wait:/usr/bin/pmd > /dev/console 2>&1 # Start PM daemon
diagd:2:once:/usr/lpp/diagnostics/bin/diagd >/dev/console 2>&1
dt:2:wait:/etc/rc.dt
cons:0123456789:respawn:/usr/sbin/getty /dev/console
imnss:2:once:/usr/IMNSearch/bin/imnss -start imnhelp >/dev/console 2>&1
: httpdlite:2:once:/usr/IMNSearch/httpdlite/httpdlite -r /etc/IMNSearch/httpdlit
e/httpdlite.conf >/dev/console 2>&1
imqss:2:once:/usr/IMNSearch/bin/imq_start >/dev/console 2>&1
~
~
~
~
:wq

"/etc/inittab" 53 lines, 2366 characters 
# 

# ps -ef | grep httpd

    root 22458 17030   2 12:40:11  pts/0  0:00 grep httpd 
# 

# mkgroup -A notes
# 
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2.2.7  Step 7 - Create AIX Users
You must create an AIX user called notes. This AIX user will be the one that is 
logged in when the Domino server is running. If you plan to install partitioned 
servers (multiple instances on the same machine), you will need a different 
AIX account for each partition installed. For example, if you have four 
partitioned servers, you would probably have notes1, notes2, notes3, and 
notes4 as user accounts. In our example, we are only going to install a single 
server; so, we will simply create a user called notes. For more information on 
Domino server partitioning, please refer to Chapter 7, “Domino Enterprise 
Server” on page 159.

To create this user, simply use the command: 
mkuser pgrp=notes groups=’staff,notes’ home=’/server1’ notes

Figure 24.  Create AIX User

Next, we must assign a password to the new user by using the command: 
pwdadm <user>

Figure 25.  Assign AIX User Password

You will be prompted for a new password. Enter the new password in and 
verify it. The password is now changed.

2.2.8  Step 8 - Create a Volume Group
The next step is to create a volume group for the Domino data directory. It is 
recommended that you store your data on a separate volume group by itself. 
This allows for easier backup and recovery or migration to another RS/6000 
in case of a hardware failure.

To create a new volume group, make sure you have an unused disk installed 
and use the command: smitty mkvg

# smitty mkvg

# mkuser pgrp=notes groups=’staff,notes’ home=’/server1’ notes
# 

# pwdadm notes
Changing password for "notes"
notes’s New password: *****
Enter the new password again: *****
# 
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The SMIT utility then displays the screen to create a new volume group. Enter 
a new volume group name. In our example, we will use the preferred name 
dominovg. Also select the physical volume to use in this new volume group. In 
our example, we will be using hdisk1. When the information has been 
entered, press Enter.

Figure 26.  Volume Group Configuration Screen

A pop up message will appear asking you to verify that you really want to 
create a new volume group. Press Enter again to create the volume group.

Figure 27.  Volume Group Conformation Screen

If everything worked, you will see a screen similar to the one in Figure 28. 
Press F10 to exit the screen and return to the prompt.

 Add a Volume Group

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  VOLUME GROUP name                                  [dominovg]
  Physical partition SIZE in megabytes                4 +
* PHYSICAL VOLUME names                              [hdisk1] +
  Activate volume group AUTOMATICALLY                 yes +
    at system restart?
  Volume Group MAJOR NUMBER                          [] +#
  Create VG Concurrent Capable?                       no +
  Auto-varyon in Concurrent Mode?                     no +

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do 

ARE YOU SURE?

Continuing may delete information you may want
to keep.  This is your last chance to stop
before continuing.

Press Enter to continue.
Press Cancel to return to the application.

F1=Help                 F2=Refresh              F3=Cancel
F8=Image                F10=Exit                Enter=Do
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Figure 28.  Volume Group Status Screen

2.2.9  Step 9 - Create a Logical Volume for the Domino Data Directory
Now that your new volume group has been created, you will create a logical 
volume for our Domino data directory. To do this, use the command: smitty 
mklv

# smitty mklv

The SMIT utility then displays the screen to create a new logical volume. On 
this screen, type in the name of the volume group you just created and press 
Enter.

Figure 29.  Logical Volume Configuration Screen

Next you will see the configuration screen for your new logical volume. Enter 
a new logical volume name. In our example, we will use the preferred name 
dominodatalv. Enter the total number of logical partitions to allocate for this 
logical volume. The minimum amount of space needed is 200 MB. Since our 
physical partition size is 4 MB, we specified 50 logical partitions in our 
example. Next change the position on the physical volume to center. This 

COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

dominovg

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next

Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [dominovg] +

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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improves system performance by reducing disk arm movement when 
accessing data. Also, change the range of the physical volume to maximum. 
This also improves system performance by making sure that the data is 
spread evenly across all disks in the volume group. When you have 
completed this screen, press Enter.

Figure 30.  Logical Volume Configuration Screen

If everything worked, you will see a screen similar to the one in Figure 31. 
Press F10 to exit the screen and return to the prompt.

Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Logical volume NAME                                [dominodatalv]
* VOLUME GROUP name                                   dominovg
* Number of LOGICAL PARTITIONS                       [50]                      #
  PHYSICAL VOLUME names                              []                       +
  Logical volume TYPE                                []
  POSITION on physical volume                         center                  +
  RANGE of physical volumes                           maximum                 +
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                        #
    to use for allocation
  Number of COPIES of each logical                    1                       +
    partition
  Mirror Write Consistency?                           yes                     +
  Allocate each logical partition copy                yes                     +
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                     +
    reorganization?
  Logical volume LABEL                               []
  MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]
  Enable BAD BLOCK relocation?                        yes                     +
  SCHEDULING POLICY for reading/writing               parallel                +
    logical partition copies
  Enable WRITE VERIFY?                                no                      +
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]            +
  
  

  
F1=Help             F2=Refresh          F3=Cancel           F4=List           
F5=Reset            F6=Command          F7=Edit             F8=Image          
F9=Shell            F10=Exit            Enter=Do                              
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Figure 31.  Logical Volume Status Screen

2.2.10  Step 10 - Create a Logical Volume for the Domino Binaries
Our next step will be to create a logical volume for our Domino binaries. To do 
this, use the command: smitty mklv

# smitty mklv

The SMIT utility then displays the screen to create a new logical volume. On 
this screen, we’ll use the recommended volume group rootvg for our new 
logical volume to keep our binaries on. Type rootvg and press Enter.

Figure 32.  Logical Volume Configuration Screen

Next, you will see the configuration screen for your new logical volume. Enter 
a new logical volume name. In our example, we will use the preferred name 
dominobinlv. Enter the total number of logical partitions to allocate for this 
logical volume. The minimum amount of space needed is 160 MB. Since our 
physical partition size is 4 MB, we specified 40 logical partitions in our 
example. Next, change the position on the physical volume to edge. Since the 
binaries are only executed once at server startup, we place them on the outer 
most band of the disk. Also, change the range of the physical volume to 

COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

dominodatalv

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next

Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [rootvg] +

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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maximum. This also improves system performance by making sure that the 
data is spread evenly across all disks in the volume group. When you have 
completed this screen, press Enter.

Figure 33.  Logical Volume Configuration Screen

If everything worked, you will see a screen similar to the one in Figure 34. 
Press F10 to exit the screen and return to the prompt.

Figure 34.  Logical Volume Status Screen

Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Logical volume NAME                                [dominobinlv]
* VOLUME GROUP name                                   rootvg
* Number of LOGICAL PARTITIONS                       [40]                      #
  PHYSICAL VOLUME names                              []                       +
  Logical volume TYPE                                []
  POSITION on physical volume                         edge +
  RANGE of physical volumes                           maximum +
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                        #
    to use for allocation
  Number of COPIES of each logical                    1                       +
    partition
  Mirror Write Consistency?                           yes                     +
  Allocate each logical partition copy                yes                     +
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                     +
    reorganization?
  Logical volume LABEL                               []
  MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]
  Enable BAD BLOCK relocation?                        yes                     +
  SCHEDULING POLICY for reading/writing               parallel                +
    logical partition copies
  Enable WRITE VERIFY?                                no                      +
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]            +
  
  

  
F1=Help             F2=Refresh          F3=Cancel           F4=List           
F5=Reset            F6=Command          F7=Edit             F8=Image          
F9=Shell            F10=Exit            Enter=Do                              

 COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

dominobinlv

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next
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2.2.11  Step 11 - Create a File System for the Domino Data Directory
Now that your logical volumes are created and ready, you need to create a 
new journaled file system (JFS) for your Domino data directory. To create the 
file system, use the command: smitty crjfslv

# smitty crjfslv

The SMIT utility displays a menu for creating a journaled file system. Select 
Add a Standard Journaled File System and press Enter.

Figure 35.  JFS Selection Screen

Next, you will see the configuration screen for the new file system. Select 
dominodatalv for the logical volume name. The mount point we are going to 
use in our example will be /server1. It is a good idea to name the mount point 
to something that will be descriptive to the server you are installing. For 
example, if the Domino server you’re installing was called northeast, you 
would probably want to call your mount point /northeast. You then need to 
change the mount automatically at the system restart to yes. After you have 
finished, press Enter.

Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System
  Add a Large File Enabled Journaled File System

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 36.  JFS Configuration Screen

If everything worked, you will see a screen similar to the one in Figure 37. 
Press F10 to exit the screen and return to the prompt.

Figure 37.  JFS Status Screen

2.2.12  Step 12 - Create a File System for the Domino Binaries
Your next step will be to create a new journaled file system (JFS) for your 
Domino binaries. To create the file system, use the command: smitty crjfslv

# smitty crjfslv

The SMIT utility displays a menu for creating a journaled file system. Select 
Add a Standard Journaled File System and press Enter.

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 dominodatalv            +
* MOUNT POINT                                        [/server1]               
  Mount AUTOMATICALLY at system restart?              yes                     +
  PERMISSIONS                                         read/write              +
  Mount OPTIONS                                      []                       +
  Start Disk Accounting?                              no                      +
  Fragment Size (bytes)                               4096                    +
  Number of bytes per inode                           4096                    +
  Allocation Group Size (MBytes)                      8                       +
  

  
F1=Help             F2=Refresh          F3=Cancel           F4=List           
F5=Reset            F6=Command          F7=Edit             F8=Image          
F9=Shell            F10=Exit            Enter=Do 

 COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

Based on the parameters chosen, the new /server1 JFS file system
is limited to a maximum size of 134217728 (512 byte blocks)

New File System size is 409600

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next                                                         
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Figure 38.  JFS Selection Screen

Next, you will see the configuration screen for the new file system. Select 
dominobinlv for the logical volume name. The mount point we are going to use 
in our example will be /usr/domino. This mount point is the preferred directory 
for the Domino binaries. You then need to change the mount automatically at 
system restart to yes. After you have finished, press Enter.

Figure 39.  JFS Configuration Screen

If everything worked, you will see a screen similar to the one in Figure 40. 
Press F10 to exit the screen and return to the prompt.

Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System
  Add a Large File Enabled Journaled File System

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 dominobinlv            +
* MOUNT POINT                                        [/usr/domino]               
  Mount AUTOMATICALLY at system restart?              yes                     +
  PERMISSIONS                                         read/write              +
  Mount OPTIONS                                      []                       +
  Start Disk Accounting?                              no                      +
  Fragment Size (bytes)                               4096                    +
  Number of bytes per inode                           4096                    +
  Allocation Group Size (MBytes)                      8                       +
  

  
F1=Help             F2=Refresh          F3=Cancel           F4=List           
F5=Reset            F6=Command          F7=Edit             F8=Image          
F9=Shell            F10=Exit            Enter=Do 
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Figure 40.  JFS Status Screen

2.2.13  Step 13 - Mount the File Systems
After you create the file systems, you must then mount the new file systems. 
To mount the file system, use the command: mount <file system>

Figure 41.  Mount File Systems

You can verify that the file systems are mounted by using the command mount 
by itself. The mount command will display the file systems that are mounted.

Figure 42.  Check Mounted File Systems

 COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

Based on the parameters chosen, the new /usr/domino JFS file system
is limited to a maximum size of 134217728 (512 byte blocks)

New File System size is 327680

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find 
n=Find Next                                                         

# mount /usr/domino
# mount /server1
# 

# mount

  node       mounted        mounted over    vfs       date        options      
-------- ---------------  ---------------  ------ ------------ --------------- 
         /dev/hd4         /                jfs    Feb 01 08:11 rw,log=/dev/hd8 
         /dev/hd2         /usr             jfs    Feb 01 08:11 rw,log=/dev/hd8 
         /dev/hd9var      /var             jfs    Feb 01 08:11 rw,log=/dev/hd8 
         /dev/hd3         /tmp             jfs    Feb 01 08:11 rw,log=/dev/hd8 
         /dev/hd1         /home            jfs    Feb 01 08:12 rw,log=/dev/hd8 
         /dev/lv00        /usr/vice/cache  jfs    Feb 01 08:12 rw,log=/dev/hd8 
         /dev/lv01        /var/dce         jfs    Feb 01 08:12 rw,log=/dev/hd8 
         /dev/lv02        /var/dce/adm/dfs/cache jfs    Feb 01 08:12 rw,log=/dev
/hd8 
         DFS              /...             dfs    Feb 01 08:13 rw              
         AFS              /afs             afs    Feb 01 08:13 rw              
         /dev/dominobinlv /usr/domino      jfs    Feb 01 10:50 rw,log=/dev/hd8 
         /dev/dominodatalv /server1         jfs    Feb 01 10:50 rw,log=/dev/loglv00
#
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2.2.14  Step 14 - Change Ownership of the New File Systems
In order for the Domino server to run correctly, you must change the 
ownership of the file systems you created. To change the ownership, use the 
command: chown -R <user>.<group> <file system>

Figure 43.  Change Ownership of Directories

You can verify that the ownership has changed by using the command ls -l 
from the parent directory. To verify that the file system mounted at /server1 
has been changed, you would change to the parent directory, which, in this 
case, is the root directory and then use the command: ls -l To verify that the 
file system mounted at /usr/domino has been changed, you would change to 
the /usr directory and then use the command: ls -l The results should look 
similar to the screen below.

Figure 44.  Show Ownership of a Directory

2.2.15  Step 15 - Paging Space
You must make sure that you have enough paging space available in order 
for the Domino server to function properly. The simple rule of thumb is:

For systems below 512 MB of memory, use ( 2 * memory).

For systems above 512 MB of memory, use (1 * memory).

However, the recommended by-the-book formula is:

# chown -R notes.notes /server1
# chown -R notes.notes /usr/domino
# 

# cd /usr

# ls -l

total 240
drwxr-xr-x   7 root     system       512 Dec 21 08:04 IMNSearch
drwxr-xr-x   2 root     system       512 Dec 21 08:03 TT_DB
lrwxrwxrwx   1 root     adm            8 Dec 21 07:51 adm -> /var/adm
drwxr-xr-x   3 root     system       512 Jan 07 13:21 afs
lrwxrwxrwx   1 root     system        46 Jan 07 13:21 afsws -> /afs/austin/afs34
a.devtest.0198/rs_aix42/dest/
drwxr-xr-x   4 bin      bin        10752 Jan 07 14:17 bin
drwxr-xr-x   4 bin      bin          512 Dec 21 07:46 ccs
lrwxrwxrwx   1 root     system        51 Jan 08 08:03 contrib -> /.../austin.ibm
.com/fs/system/current/@sys/contrib/
drwxr-xr-x   6 root     system       512 Dec 21 08:04 docsearch
drwxr-sr-x   3 notes    notes        512 Feb 01 10:38 domino
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For systems below 256 MB of memory use, ( 2 * memory).

For systems above 256 MB of memory, use ( 512 MB + (memory - 256 MB) * 
1.25 ).

In our example, our RS/6000 has 128 MB of memory. Using the by the book 
formula, we should have 256 MB of paging space.

To check the amount of paging space available on your system, use the 
command: lsps -a

Figure 45.  Check Paging Space

From the screen above, you can see that our paging space is called hd6, and 
on our system, we have 128 MB of paging space. We need to add an 
additional 128 MB of paging space to meet the minimum requirement. We 
need to specify the additional space needed in physical partitions. To figure 
out how many physical partitions we will need, first we have to find out how 
large each of our physical partitions are. To identify the size of each physical 
partition located on the volume group, use the command: lsvg <volume group>

Figure 46.  Check Physical Partition Size

Our paging space happens to be in the volume group rootvg and each 
physical partition is 4 MB in size. To get the additional 128 MB of paging 
space needed, we would need 32 additional physical partitions to be added to 
our current paging space. To increase the size of the paging space, use the 
command: chps -s<additional partitions> <paging space name>

# lsps -a

Page Space  Physical Volume   Volume Group    Size   %Used  Active  Auto  Type
hd6         hdisk0            rootvg         128MB       7     yes   yes    lv
# 

# lsvg rootvg

VOLUME GROUP:   rootvg                   VG IDENTIFIER:  00ffffffdd543111
VG STATE:       active                   PP SIZE: 4 megabyte(s)
VG PERMISSION:  read/write               TOTAL PPs:      515 (2060 megabytes)
MAX LVs:        256                      FREE PPs:       121 (484 megabytes)
LVs:            12                       USED PPs:       394 (1576 megabytes)
OPEN LVs:       11                       QUORUM:         2
TOTAL PVs:      1                        VG DESCRIPTORS: 2
STALE PVs:      0                        STALE PPs:      0
ACTIVE PVs:     1                        AUTO ON:        yes
MAX PPs per PV: 1016                     MAX PVs:        32
# 
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Figure 47.  Increase Paging Space Size

To verify that the change to the paging space has taken place, use the 
command: lsps -a

Figure 48.  Check Paging Space

As you can see, we now have enough paging space for our system.

2.2.16  Step 16 - Check AIX Kernel Configuration
We also need to check the AIX kernel configuration for the maximum number 
of processes allowed per user and the maximum number of fixed licenses.

To check the current setting for the maximum number of processes allowed 
per user (maxuproc), use the command: lsattr -El sys0 | grep maxuproc

Figure 49.  List Value of maxuproc

As you can see, in our example the value of maxuproc is 64. This value must 
be a minimum of 128 or more. To increase or change the value, use the 
command: chdev -l sys0 -a maxuproc=128

Figure 50.  Change Value of maxuproc

To check the current setting for the maximum number of fixed licenses, use 
the command: lslicense

# chps -s32 hd6
# 

# lsps -a

Page Space  Physical Volume   Volume Group    Size   %Used  Active  Auto  Type
hd6         hdisk0            rootvg         256MB       4     yes   yes    lv
# 

# lsattr -El sys0 | grep maxuproc

maxuproc 64  Maximum number of PROCESSES allowed per user 
#

# chdev -l sys0 -a maxuproc=128
sys0 changed
# 
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Figure 51.  List Value of Fixed Licenses

As you can see by our example, the value is 1. This value must be a minimum 
of 2 in order for Domino server to function properly. To increase or change the 
value, use the command: chlicense -u 2

Figure 52.  Change Value of Fixed Licenses

If you make any changes to this value, you must reboot the system in order 
for the change to become effective.

2.2.17  Step 17 - Mounting the CDROM
The final step in preparing the AIX environment is to mount the CDROM that 
contains the Lotus Domino server install program. First, you have to make 
sure that a directory exists as a mount point. On our system, we will use 
/cdrom for our mount point, If you don’t have a directory to use as a mount 
point such as /cdrom, you must create a directory using the mkdir /<directory> 
command.

Figure 53.  Make Directory for Mount Point

You can verify that the directory was created by using the command ls from 
the root directory.

# lslicense

Maximum number of fixed licenses is 1.
Floating licensing is disabled.
#

# chlicense -u 2

chlicense: The system must be rebooted before the new number of
           fixed licenses will take effect.
# 

# mkdir /cdrom
# 
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Figure 54.  Verify Directory Creation

Once a directory has been created for use as a mount point, you can then 
mount the CDROM. Before you continue, you should take your Lotus Domino 
CD and insert it into the CDROM drive at this time.

You will also need to know the name of the CDROM device. In most cases, 
this will be cd0, but if you’re not sure, or if you’d like to double check, use the 
command: lsdev -C -c cdrom The name of the CDROM drive will be in the first 
column.

Figure 55.  Check for CDROM Device Names

With the CD in the CDROM drive, mount the drive using the command: mount 
-r -v cdrfs /dev/<device name> /<mount point>

Figure 56.  Mount CDROM Device

You will receive no conformation that the CDROM has mounted, but you can 
verify by changing to the /cdrom directory and do a directory listing.

# cd /

# ls

...           .sh_history   cdrom         lost+found    smit.script

.:            :             dev           lpp           tftpboot

.Xauthority   TT_DB         etc           mnt           tmp

.dt           afs           home          opt           u

.dtprofile    audit         image.data    sbin          unix

.profile      bin           krb5          server1       usr

.rgy_editrc   bosinst.data  lib           smit.log      var
# 

# lsdev -C -c cdrom

cd0 Available 04-B0-00-3,0 SCSI Multimedia CD-ROM Drive
# 

# mount -r -v cdrfs /dev/cd0 /cdrom
# 
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Figure 57.  Verify That the CDROM Mounted

You should see the directory listing of the CD if everything worked.

2.3  Installing the Lotus Domino Server

Installing the Lotus Domino server is a two part process. The first part is to 
install the software from the CD, and the second part is the basic 
configuration of the server. We will walk through the complete installation 
step by step.

2.3.1  Step 1 - Log Into AIX as the Root User
Log in to your AIX system as the root user either from a login prompt or by 
using the command su - at the prompt if you are already logged in as another 
user.

Figure 58.  Login as Root User

2.3.2  Step 2 - Run the Install Program from the CD
To start the install program, you need to change to the /cdrom directory and 
start the install program by typing install at the command prompt and then 
press Enter.

Figure 59.  Start the Installation Program

2.3.3  Step 3 - Welcome Screen
The welcome screen is displayed. Press the Tab key to continue.

# cd /cdrom

# ls

install      license.txt  script.dat   sets         tools
# 

$ su -
root’s Password: ******
# 

# cd /cdrom
# ./install
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Figure 60.  Welcome Screen

2.3.4  Step 4 - License Agreement Screens
The next screen to appear asks you to read the license agreement. Press the 
Tab key to continue to the next screen of the license agreement.

Figure 61.  License Agreement Screen 1

The second license agreement screen appears. Press the Tab key to 
continue to the next screen.

===============================================================================
                         Domino Server Installation
===============================================================================
 
 
    Welcome to the Domino Server Install Program.
 
 
    Type h for help on how to use this program.
    Press TAB to begin the installation.
 
 
-------------------------------------------------------------------------------
    Type h for help
    Type e to exit installation
    Press TAB to continue to the next screen.
-------------------------------------------------------------------------------

===============================================================================
                         Domino Server Installation
===============================================================================
 
 
    In order to proceed with the installation of the Domino Server,
    you must read and agree with the terms and conditions of the 
    Lotus Domino/Notes Software Agreement.
 
    Press TAB to read the Lotus Domino/Notes Software Agreement.
 
 
-------------------------------------------------------------------------------
    Type e to exit the Install program.
    Press ESC to return to the previous screen
    Press TAB to continue to the next screen.
-------------------------------------------------------------------------------
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Figure 62.  License Agreement Screen 2

The third license agreement screen appears. Press the Tab key to continue 
to the next screen.

Figure 63.  License Agreement Screen 3

The fourth license agreement screen appears. Press the Tab key to continue 
to the next screen.

===============================================================================
                         Domino Server Installation
===============================================================================
LOTUS DOMINO AND NOTES BETA SOFTWARE AGREEMENT

IF YOU DO NOT AGREE WITH THESE TERMS AND CONDITIONS, 
YOU MAY NOT INSTALL OR USE THE SOFTWARE.

1. Use.  Lotus Development Corporation ("Lotus") grants you the right to 
install, copy and use this beta version of the Lotus Notes or Domino 
software, and related documentation, (the "Software") solely for the 
purpose of you  evaluating the Software and subject to the terms and 
conditions of this Agreement.  This Agreement gives you the right to use 
the Software for a period of ninety (90) days (the "Trial Period").  By 
installing or using the Software, you agree to be bound by the terms and 
conditions of this Agreement.

2. Obligations. You agree with Lotus that the Software and related 
information is owned by Lotus and its suppliers, and that unless 
otherwise specifically agreed by Lotus in writing, you:

         (a) shall not distribute, transfer, loan or otherwise provide the 
Software to any third party, and shall not modify, reverse compile, 
reverse engineer or disassemble the Software;
>>> Press any key to continue <<<

Software to any third party, and shall not modify, reverse compile, 
reverse engineer or disassemble the Software;
                                 
         (b) shall not copy the Software other than as reasonably 
necessary for your use in evaluating the Software; 

        (c) shall not use or rely upon the Software for any purpose other 
than your evaluation purposes, and you acknowledge the pre-release 
nature of the Software and the possibility that the Software may not 
operate as intended;

         (d) shall, at the expiration of the Trial Period (or earlier if 
so requested by Lotus), promptly de-install and discontinue use of the 
Software, and destroy all copies of the Software and all other materials 
made available to you by Lotus under this Agreement (and any copies 
thereof); 

         (e) shall comply with all U.S. and foreign export regulations 
applicable to the Software; and

         (f) shall not alter or remove Lotus’ copyright and other 
proprietary notices in the Software.

3. Evaluations. You may provide Lotus with evaluations, suggestions and 
>>> Press any key to continue <<<
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Figure 64.  License Agreement Screen 4

The fifth license agreement screen appears. Press the Tab key to continue to 
the next screen.

Figure 65.  License Agreement Screen 5

The sixth license agreement screen appears. Press the Tab key to continue 
to the next screen.

3. Evaluations. You may provide Lotus with evaluations, suggestions and 
analysis of the Software.  Lotus shall have an unrestricted royalty-free 
right to use any such information provided to Lotus.  You  may not 
publish or provide to any third party the results of any benchmark or 
other performance tests performed with the Software without first 
obtaining Lotus’ written consent.

4. No Warranty; No Support. Due to the pre-release nature of the 
Software, the Software is provided "as is" and Lotus will not provide 
any support or bug-fixes for the Software.  Additionally, Lotus does not 
guarantee compatibility between the Software and any prior or future 
versions of the Software.  Lotus makes no warranty, representation, 
promise or guarantee, either express or implied, statutory or otherwise, 
with respect to the Software.  LOTUS DISCLAIMS ALL WARRANTIES WITH 
REGARD TO THE SOFTWARE, INCLUDING WITHOUT LIMITATION ALL 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  Some states or provinces do not allow the exclusion or 
limitation of implied warranties, so the above exclusion or limitation
may not apply to you.

5. Limitation of Liability.  LOTUS SHALL HAVE NO LIABILITY FOR DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR TORT DAMAGES 
ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE, EVEN IF 
>>> Press any key to continue <<<

INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR TORT DAMAGES 
ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE, EVEN IF 
LOTUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
Some states or provinces do not allow the limitation of liability for 
incidental or consequential damages, so the above exclusion or limitation
may not apply to you. 

6. Term. You may use the Software for the Trial Period, provided that 
Lotus may terminate this Agreement at any time with or without cause.

7. No Obligation. Lotus is under no obligation to further develop the 
Software or market the Software. Your participation in this evaluation 
program shall not obligate you to purchase any software licenses from 
Lotus.

8. U.S. Government Restricted Rights. The Software and accompanying 
documentation are provided with RESTRICTED AND LIMITED RIGHTS. Use, 
duplication, or disclosure by the U.S. Government is subject to 
restrictions as set forth in FAR 52.227-14 (June 1987) Alternate 
III(g)(3) (June 1987), FAR 52.227-19 (June 1987), or DFARS 52.227-7013 
(c)(1)(ii) (June 1988), as applicable.  Contractor/Manufacturer is Lotus 
Development Corporation, 55 Cambridge Pkwy., Cambridge, MA 02142. In the 
event the Government seeks to obtain the Software pursuant to standard 
commercial practice, this software agreement, instead of the noted 
>>> Press any key to continue <<<
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Figure 66.  License Agreement Screen 6

And, the seventh and final license agreement screen appears. This screen 
asks if you agree to the license agreement. The default answer is yes. Press 
the Tab key to continue, or press the Spacebar to change to the answer to no 
and press Tab to continue.

Figure 67.  License Agreement Screen 7

2.3.5  Step 5 - Select the Type of Domino Server to Install
The next screen asks you which of the different types of Lotus Domino 
servers you want to install. The default answer is Domino Mail Server. You are 

event the Government seeks to obtain the Software pursuant to standard 
commercial practice, this software agreement, instead of the noted 
regulatory clauses, shall control the terms of the Government’s license.

9. Miscellaneous. You may not assign any rights or delegate any duties 
or obligations under this Agreement without Lotus’ prior written 
consent.  You acknowledge that a violation of this Agreement may cause 
irreparable harm to Lotus, and you agree that, in addition to any other 
remedies provided by law, Lotus shall be entitled to seek injunctive 
relief against any such violation without having to post a bond. This 
Agreement supersedes all other prior agreements, oral or written, and 
all other communications between us relating to this Software, and the 
terms of Sections 3 through 9 shall survive the expiration or 
termination hereof.  This Agreement shall be governed by and construed 
in accordance with the laws of The Commonwealth of Massachusetts, 
excluding its conflicts of laws rules.

IF YOU DO NOT AGREE WITH THE ABOVE TERMS AND CONDITIONS, 
DO NOT INSTALL OR USE THE SOFTWARE.

If you accept the above terms and conditions press the accept button 
below:

Press the Escape key to go back to the previous screen
  or                             
Press the Tab key to continue...

===============================================================================
                         Domino Server Installation
===============================================================================
 
 
    You may proceed with the installation only if you agree to the
    terms and conditions of the Lotus Domino/Notes Software Agreement.
 
 
-------------------------------------------------------------------------------
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you agree to the terms of the license agreement ?  [Yes]
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going to install a standard Domino server. Press the Spacebar until you see 
Domino Server between the brackets and press the Tab key.

Figure 68.  Type of Domino Server Selection Screen

2.3.6  Step 6 - Select the Directory Location for the Domino Binaries
On the next screen, we need to select the directory location for the Domino 
binaries. The default directory is /opt/lotus. We need to change this to 
/usr/domino. 

Figure 69.  Directory Location for Domino Binaries Screen

To edit the directory, press Enter, type the new directory name, and press 
Enter again.

===============================================================================
                         Domino Server Installation
===============================================================================
 

    Select the type of installation you want.
 

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Select Setup type : [Domino Server           ]

===============================================================================
                         Domino Server Installation
===============================================================================

    The program directory is the path where the Install program 
    installs the Domino program files.  The Install program 
    automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current program directory setting : /opt/lotus
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Figure 70.  Change Directory Location Screen

The changed directory will be displayed on the screen. You will notice that the 
install program will append lotus to the end of the directory automatically. 
Press Tab to continue.

Figure 71.  Directory Location for Domino Binaries Screen

2.3.7  Step 7 - Setup for Partitioned Domino Servers
The next screen that appears asks if you want to install multiple instances or 
partitioned servers on this RS/6000. The default answer is no. In our example 
we will only install one Domino server but see 7.4, “Domino Server 
Partitioning” on page 162 for details on partitioning. Press Tab to continue.

===============================================================================
                         Domino Server Installation
===============================================================================

    The program directory is the path where the Install program 
    installs the Domino program files.  The Install program 
    automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current program directory setting : /opt/lotus

New program directory setting     : /usr/domino

===============================================================================
                         Domino Server Installation
===============================================================================

    The program directory is the path where the Install program 
    installs the Domino program files.  The Install program 
    automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current program directory setting : /usr/domino/lotus
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Figure 72.  Domino Partitioned Servers Screen

2.3.8  Step 8 - Select the Directory Location for the Domino Data
On the next screen, you need to select the directory location for the Domino 
data. The default directory is /local/notesdata. You need to change this to 
/server1.

Figure 73.  Directory Location for Domino Data Screen

To edit the directory, press Enter, type the new directory name, /server1, and 
press Enter again.

===============================================================================
                         Domino Server Installation
===============================================================================
 

    You can run more than one Domino Server on a single computer 
    at a time.  This feature is called Domino Partitioned Servers.
 

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you want to run more than one Domino Server on this computer ?  [No ]

===============================================================================
                         Domino Server Installation
===============================================================================

    The data directory is the path where the Install program
    installs the Domino data files.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current data directory setting : /local/notesdata
48 Lotus Domino R5 on IBM RS/6000



Figure 74.  Change Directory Location Screen

The changed directory will be displayed on the screen. Press Tab to continue.

Figure 75.  Directory Location for Domino Data Screen

2.3.9  Step 9 - Select AIX User
Next, select the appropriate AIX user. The default is notes, which, in this case, 
is the correct user. Press the Tab key to continue.

===============================================================================
                         Domino Server Installation
===============================================================================

    The data directory is the path where the Install program
    installs the Domino data files.
 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current data directory setting : /local/notesdata

New data directory setting     : /server1

===============================================================================
                         Domino Server Installation
===============================================================================

    The data directory is the path where the Install program
    installs the Domino data files.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current data directory setting : /server1
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Figure 76.  AIX User Selection Screen

2.3.10  Step 10 - Select AIX Group
Next, select the appropriate AIX group. The default is notes, which, in this 
case, is the correct group. Press the Tab key to continue.

Figure 77.  AIX Group Selection Screen

2.3.11  Step 11 - Configuration Review
The next screen that appears tells you that you have finished the 
configuration of the install program and that you are about to review the 
information you have entered. Press the Tab key to continue.

===============================================================================
                         Domino Server Installation
===============================================================================

    The Domino UNIX user is the UNIX user name which will own the
    Domino data files, and be used to run the Domino Server.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current UNIX user setting : notes

===============================================================================
                         Domino Server Installation
===============================================================================

    The Domino UNIX group is the UNIX group name which will own the 
    Domino data files.  The UNIX user that runs the Domino server 
    must be a member of this group.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current UNIX group setting : notes
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Figure 78.  Configuration Review Screen 1

The installation settings and configurations are displayed. If everything 
displayed is correct, press the Tab key to start the installation. Otherwise, 
press the Escape key to reconfigure.

Figure 79.  Configuration Review Screen 2

2.3.12  Step 12 - File Installation Completed
You should see a screen similar to Figure 80., “File Installation Completed 
Screen” on page 52 if the installation completed successfully.

===============================================================================
                         Domino Server Installation
===============================================================================
 
    Your configuration of the Install program is complete.
 
    By continuing, the Install program will first allow
    you to review your configuration settings before
    beginning the installation.
 
 
-------------------------------------------------------------------------------
    Type e to exit the Install program.
    Press ESC to return to the previous screen
    Press TAB to continue to the next screen.
-------------------------------------------------------------------------------

===============================================================================
                         Domino Server Installation
===============================================================================
Installation settings:

    Installation type    : Domino Server

    Program directory    : /usr/domino/lotus
    Data directory       : /server1
    UNIX user name       : notes
    UNIX group name      : notes

Press the Escape key to re-configure the settings
  or
Press the Tab key to perform the installation...
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Figure 80.  File Installation Completed Screen

2.3.13  Step 13 - Logoff
You must completely logoff the system before starting the next step that 
begins the configuration. Running the Domino server with a different user 
other than the one we specified in 2.3.9, “Step 9 - Select AIX User” on page 
49 is not a supported configuration.

To logoff, simply type exit and press Enter. Repeat this until you return to the 
login prompt.

Figure 81.  Login Prompt

2.3.14  Step 14 - Login
Log in as the user we specified in 2.3.9, “Step 9 - Select AIX User” on page 
49.

Installing files...

The OS appears to have the correct patches.
Installing...

Installation successful.

Please be sure to log in as the appropriate UNIX user
before running Domino - Do not run as root.

# 

AIX Version 4
(C) Copyrights by IBM and by others 1982, 1996.
login: 
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Figure 82.  Login Screen

2.3.15  Step 15 - Change to the Data Directory
When you log in, you should already be in the Domino data directory. You can 
display the current directory you are in by using the pwd command.

Figure 83.  Display Current Directory

If you’re in the wrong directory, use the command cd /<data directory> and 
press Enter.

$ cd /server1

2.3.16  Step 16 - Start the HTTP Server Task for Server Configuration
Next, you will start the Domino HTTP task so you can configure the new 
Domino server with your web browser. To start the HTTP task, type 
/opt/lotus/bin/http httpsetup at the prompt and press Enter.

$ /opt/lotus/bin/http httpsetup

If everything worked, you will see a screen similar Figure 84., “HTTP Task 
Server Configuration Startup Screen” on page 54.

AIX Version 4
(C) Copyrights by IBM and by others 1982, 1996.
login: notes
notes’s Password: *****
*******************************************************************************
*                                                                             *
*                                                                             *
*  Welcome to AIX Version 4.3!                                                *
*                                                                             *
*                                                                             *
*  Please see the README file in /usr/lpp/bos for information pertinent to    *
*  this release of the AIX Operating System.                                  *
*                                                                             *
*                                                                             *
*******************************************************************************
Last login: Thu Feb  4 09:52:26 CST 1999 on /dev/lft0

$ 

$ pwd
/server1
$    
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Figure 84.  HTTP Task Server Configuration Startup Screen

2.3.17  Step 17 - Start the Web Browser
You should start your Web browser now: Either Netscape or Internet Explorer. 
The Web browser can be located on any machine. You do not have to install a 
Web browser on your RS/6000 to configure your Domino server. Point your 
Web browser to: http://<IP address of the RS/6000>:8081/ In our example, 
the URL will be: http://9.3.240.6:8081/

2.3.18  Step 18 - Create a New Domino Server
You will see the first screen of the Domino server configuration on your Web 
browser. It’s asking if this is the first server, or are you adding an additional 
server to an existing domain. In our example, this will be our first server. 
Make sure that First Domino Server is selected and press the Next button.

02/04/99 11:31:11 AM  Created new log file as /server1/log.nsf
02/04/99 11:31:11 AM  Server setup mode entered. Please continue the setup
process by connecting to server with a browser on port 8081
02/04/99 11:31:13 AM  HTTP Web Server started
54 Lotus Domino R5 on IBM RS/6000



Figure 85.  Create New Domino Server Screen

2.3.19  Step 19 - Server Audience
On the second screen, it is asking if any additional services need to be 
installed. The default choices are Calendar Connector, Schedule Manager, Event 
Manager, and Statistics. In our example, we are going to leave the default 
choices and press the Next button.
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Figure 86.  Server Audience Screen

2.3.20  Step 20 - Administration Settings
On the third screen, you need to specify the administrative information for the 
Domino server. This includes organization name, domain name, certifier name, 
server name, and the administrators name. For our example, the organization, 
domain, and certifier names are ibm. The country code is us. The server name 
is ausres29. Our administrator’s name is Domino Admin. After entering this 
information, press the Next button.
56 Lotus Domino R5 on IBM RS/6000



Figure 87.  Administration Settings Screen

2.3.21  Step 21 - Network and Communication Settings
On the fourth screen we will configure the network ports. By default, the Use 
all available ports option is selected. Since we only have one port, we’re 
going to leave the default selected and click the Finish button.
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Figure 88.  Network and Communications Settings Screen

2.3.22  Step 22 - Server Setup is Complete
Congratulations! The server setup is complete. The fifth and final screen 
displays the configuration and password information we gave in the above 
steps. After you have read the screen, click on the Exit button. 

If you forget to click on the Exit button, the setup will not complete properly.
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Figure 89.  Server Setup Is Complete

2.3.23  Step 23 - Starting the Domino Server
To start the Domino server, make sure you are in the server data directory. In 
our example, this would be /server1. From that directory, use the command: 
/opt/lotus/bin/server

$ /opt/lotus/bin/server

The server will start.

Remember that you must start the Domino server while logged in as the 
user specified in 2.3.9, “Step 9 - Select AIX User” on page 49. Using any 
other user, including the root user, is an unsupported configuration and 
may cause unpredictable results.

Reminder
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2.4  Conclusion

In this chapter, we reviewed the hardware, software, and system 
requirements. We showed step by step instructions on how to prepare the 
AIX environment prior to installation of the Domino server. And, finally, we 
showed step by step instructions on how to do the Domino server installation.
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Chapter 3.  Upgrading from Domino R4.x to R5

Upgrading a Domino Server can be broken into two distinct levels; the first is 
to prepare for and install the later version of software onto the machine, the 
second is to exploit the features and functionality made available by that 
software.

The goal of a successful upgrade is to minimize downtime and disruption to 
the users of the existing Domino Servers while maintaining a similar or 
enhanced level of service.

Although this chapter will serve to guide the administrator in upgrade 
methodology and good practice, it cannot cover every eventuality since every 
installation will be different in some way.

With this goal in mind, much of the early preparation for the upgrade will 
involve testing and fine tuning the procedures through which the upgrade of 
the environment will be achieved. This will ensure that everyone involved in 
carrying out upgrades will be familiar with the procedures and will be aware of 
any specific issues that may be encountered within their own environment.

The upgrade process and its duration will be significantly different for each 
organization and are directly affected by the size of the current 
implementation and the resources available to perform the upgrades required 
in that environment.

3.1  Preparation

The key to a successful upgrade is careful planning and preparation. One of 
the earliest tasks will be to identify members of the project team and their 
associated roles and responsibilities. For small installations, the team may 
consist of one or two people, but in large enterprise installations, the teams 
will not only contain more members, but they may also be geographically 
dispersed. Everyone involved must be comfortable with the new software and 
the procedures that will be followed to carry out the upgrade. Training and 
testing in a separate test environment will be the key to achieving the 
required level of competence.

An upgrade schedule is important so that the project is properly co-ordinated, 
and everyone is kept informed of the current status and of the next stages. 
Users must be notified of impending changes to the servers that will affect 
them so that they are prepared for downtime, unless, of course, the resources 
are available to perform server upgrades during out-of-hours periods.
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3.1.1  System Requirements
Prior to installation of the R5 server software, it is necessary to ensure that 
the server hardware and supporting software, such as the operating system, 
meet or exceed the specified requirements as defined in Chapter 2, “Installing 
a Lotus Domino R5 Server” on page 15. If the current system does not meet 
the new requirements, then to continue with the Domino Server upgrade 
those elements of the platform that do not meet these requirements must be 
upgraded first.

During the planning stage, decisions may be taken to re-organize the current 
infrastructure design; server consolidation may be one result afforded by the 
increased performance of the R5 server and its ability to support more users 
per instance of the server than was the case with R4.x. 

Where server consolidation is deemed appropriate, care must be taken that 
the platform has sufficient resources to cope with the intended number of 
additional users.

Should new servers, hardware, or software be required to meet these 
requirements, then the time taken to procure such items must be taken into 
consideration during the scheduling of the upgrades.

3.1.1.1  Additional Disk Space Considerations
For a new installation of an R5 Domino Server, the system requirements 
referenced in the previous section provide a good starting point in terms of 
the disk capacities required. However, when upgrading an existing server, 
some of the changes made to enhance the functionality of R5 increase the 
amount of disk space that will be needed not only for storing databases but 
also for core server processes.

1. Existing databases converted to the new R5 On-Disk Structure (ODS) will, 
in the majority of cases, take up a very similar amount of disk space as 
they do using the current R4 ODS. However, the index directories for 
databases that have full-text indexes will increase by approximately 50 
percent.

It is important to remember that the AIX platform does not include a Notes 
or Administration client component. See Chapter 5, “Installing the Lotus 
Domino Administration Client” on page 125for details about installation of 
the Administration Client on other platforms.

Note
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2. New mail databases now have both Notes and web browser access 
functionality integrated into a single database design; a new empty mail 
database has a default size of approximately 5 MB as opposed to 2 MB for 
an R4.6 mail database.

3. The new R5 indexing algorithm now produces temporary working files 
while it is building or updating database and full-text indexes. The amount 
of space required for these files depends on the number and size of the 
databases hosted on the server. By default, the temporary files are 
created in the server data directory as specified by the operating system.

For optimal performance of the indexing process, it is better to store the 
temporary files on a different physical disk to the Domino data directory. 

4. The introduction of Transaction Logging creates another requirement for 
additional disk space that was not necessary with previous releases of the 
Domino Server. Instead of always writing data directly to the database, 
transaction logging allows for writing to a central location on disk that can 
be replayed against the databases intermittently to commit the actual 
changes to the data stored in the database. Once again, optimal 
performance is achieved if the transaction logs, known as the Transaction 
Log Extent, are located on a different physical disk to the Domino data 
directory so that writing to the logs and reading requests for databases do 
not compete with each other.

To change the location in which temporary files are stored during 
indexing, specify

View_Rebuild_Dir=/directoryname

in the server’s notes.ini file

Indexing File Location

To change the location in which the transaction logs are stored, edit the 
server document as shown in Figure 90 on page 64 and change the 
value for the field Log path on the Transaction Logging tab.

Transaction Log Extent 
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Figure 90.  Changing the Location of the Transaction Log Extent

A minimum of 200 MB of free space must be available to enable 
transaction logging, but unlike view indexing, a maximum size can be 
stipulated for the Transaction Log Extent. The maximum size allowed is 4 
GB, and with circular logging enabled, disk space is re-used by overwriting 
older log entries.

Domino R5 can now support significantly larger databases than previous 
releases, and although currently certified up to 64 GB, there is no imposed 
maximum size. To take advantage of this capacity, the AIX file system in 
which the data directory is stored must be a large file enabled journaled file system; 
otherwise, the AIX-imposed maximum single file size limit of 2 GB will restrict 
the capabilities of the Domino Server.

Since the transaction logs are critical to data integrity and maximum 
performance, it is also strongly recommended that the disk used to 
contain the Transaction Log Extent be mirrored and, if possible, 
connected to a separate disk controller than that used to service the 
Domino data directory. 

Recommendation
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3.1.1.2  Non-Domino Infrastructure Considerations
As the upgrade process inevitably requires that the server be shut down for a 
period of time, advantage is sometimes taken of this scheduled downtime to 
upgrade other elements of the platform, for example, to add an additional 
processor, extra disk space, or to change the network adapter card in the 
server.

The reason behind this recommendation is simply that should a problem 
occur with the server after upgrading the Domino Server software, the 
number of possible causes of the problem are reduced, and troubleshooting 
is a less complex task.

If changes such as these are required, then they should be done either before 
or after the Domino Server upgrade. By doing them before, it is possible to 
ensure that the existing environment continues to function correctly, and the 
Domino Server upgrade can be started with confidence that the current 
server is stable.

Alternatively, once the R5 upgrades are complete, and the environment is 
functioning correctly, the hardware changes can be started in the confidence 
that the new R5 environment is stable.

3.1.2  Planning the Order of Your Upgrade
As mentioned in 3.1, “Preparation” on page 61, a schedule is very important 
to maintain a structured approach to the upgrade process. The key to this 
schedule will be the order in which the elements of the infrastructure will be 
upgraded. The following is the recommended order in which to tackle the 
project.

To allow Domino to fully utilize its storage capacity, the data directory must 
be stored on a large file-enabled journaled file system. If the current file 
system is not large file-enabled, then the data should be backed up, the file 
system must be removed and re-created with large file support, and then 
the data can be restored.

Note

It is recommended that such changes are not made at the time of the 
Domino Server software upgrade to ensure that a minimum amount of 
change is made to the server. 

Recommendation
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1. Public Name and Address Book (NAB)

Since the new public NAB, now called the Domino Directory, is designed to 
be backwardly compatible with earlier releases of software, the design can 
be upgraded on the existing servers prior to them having the R5 software 
installed. This is the most critical database in any Domino environment 
and is one of the main steps in the upgrade process. Having the new 
Domino Directory in operation before starting to install new software will 
give everyone confidence in the next stages of the project.

2. Servers

Upgrading the servers before clients ensures that a user cannot request a 
service from a server that cannot be provided because the server is 
running an earlier release of the software.

a. Hub Servers

Hub servers generally exhibit two characteristics that make them prime 
candidates for upgrades early in the schedule. First, hub servers do not 
usually have any or many active users connected to them; so, a 
problem with the upgrade impacts the user community much less 
severely than a problem with an upgraded mail server. Secondly, they 
are typically small in number, are located centrally, and are managed 
by skilled administrators.

b. Mail and Application (Spoke) Servers

Once the hub servers are upgraded and are performing satisfactorily, 
attention can be turned to the servers that make up the bulk of the 
infrastructure, and procedures can be fine tuned with any additional 
lessons learned. The mail and application (Spoke) servers may or may 
not be located centrally. Where they are remote, the team members 
responsible for carrying out upgrades should have achieved the 
necessary level of competency in the upgrade process. The testing and 
training stages of the project should be used to produce extensive 
documentation tailored to the specific environment.

c. Other Servers

Lastly, in terms of servers, those performing specific tasks utilizing 
add-in or 3rd party API products (such as gateways) can be 

If the first server upgraded is not the server designated as the 
Administration Server of the Domino Directory, then the server that is 
the Administration Server should be the next one to be upgraded.

Note
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considered. Here there are some choices and possibly restrictions on 
what can be done. The server may have to be left alone to continue 
running the R4.x version until an R5 specific version of the add-in 
product is produced; or where there are no version specific 
dependencies, the server can be upgraded. Specific attention should 
be paid to these types of servers during the testing phase of the project 
to ensure that the add-in tasks or API programs perform as expected 
after the upgrade to R5.

3. Clients

Although outside of the scope of this particular redbook, the clients should 
be upgraded once server upgrades have been completed.

4. Applications

Finally, when all clients have been successfully upgraded, the process is 
completed by upgrading mail databases and applications to take 
advantage of the new features afforded by R5. 

In practice, clients and applications can be upgraded in parallel with servers 
provided that the servers that a particular group of clients access have 
already been upgraded to R5.

3.1.3  Testing Your Upgrade Procedures
In order to achieve competence, understanding, and faith in the upgrade 
process, a significant amount of time must be allowed for testing and training. 
R5 contains many new features for both the administrator and end user, and 
prior to upgrading, the administrator must be comfortable with the way they 
will be required to work after the upgrade has been completed.

The R5 setup program ignores an R3.x workspace and desktop.dsk file; 
so, an R3 to R5 upgrade will result in an empty bookmarks database.

Note

Build an isolated test environment, modeled exactly on the existing 
environment, with good backup and restore capabilities. Use at least two 
servers and two clients in this environment.

Use this environment to also test application functionality and 
interoperability.

Recommendation
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3.1.3.1  Defining A Test Environment
The simplest way to produce a test environment that exactly mimics the real 
live environment is to register and configure two additional servers in the 
existing public NAB and install two servers using the current releases of the 
operating system and Domino software in use on the production servers. This 
should produce two servers that have identical characteristics to the other 
servers in the domain. Replicate any critical applications that require testing 
onto these servers. Disconnect these servers from the live network and 
create an isolated private network through which they can communicate only 
with themselves. Once the servers are disconnected, all references to them 
can be removed from the live public NAB. 

As mentioned in 3.1.2, “Planning the Order of Your Upgrade” on page 65, 
specialized servers running add-in or API tasks must also be considered. A 
test server utilizing these types of programs can be created in the same way 
as mentioned previously.

Install test clients, again with the same releases of software as are already in 
use, and connect them to the same test network.

Before testing begins, take a complete backup of the servers and clients. The 
upgrade process will undoubtedly be performed several, if not many, times in 
this environment, and a full restore is the quickest and easiest way to reset 
one of the systems to its original state.

Throughout the testing process, detailed documentation should be created 
that can be used to produce the final upgrade procedure. It is important not 
only to document the correct steps but also to record mistakes and problems 
in the process so that others reading the documentation are made fully aware 
of specific key points or pitfalls and to help in their understanding of why 
things are done in a particular way.

3.1.4  Consider Clustering
For servers that are particularly critical, or during the early stages of the 
upgrade project, clustering the server with an R4.6x server can be a very 
valuable way of providing standby resilience. By clustering the existing server 
with another running a well proven level of Domino software, users are 
protected from server crashes as their requests for data can be failed-over to 
the R4.x server until the problems with the R5 server are resolved.
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3.1.5  Database Design Considerations
When the new version of the software is applied to the server, many of the 
existing templates that are shipped with Domino will be overwritten with 
newer versions. 

An important exercise to undertake before the upgrade project commences is 
an audit of the databases on all of the servers in the domain. This will provide 
information to allow administrators to ensure that any design elements that 
have been changed are preserved when system database designs are 
updated. 

Use should be made of the testing environment to ensure that the 
customizations are still necessary and that they work as expected with the 
new design. Some of the customizations may no longer be required as the 
needs they addressed may have been satisfied by new features of the 
standard R5 database designs.

The audit should record all databases that have been based upon any of the 
standard templates and any changes or customizations that have been made.

During this audit, administrators should also ensure that all database and 
template access control lists contain an entry for an appropriate 
administration group with manager access as all administration must now be 
done from remote clients. Agents could be written to crawl the server and 
return the required information in an appropriate format.

Once the installation is completed, (see 3.3, “Installing the R5 Server 
Software” on page 79) the customized design elements can be re-applied 
using the audit list to check and track the changes that are required.

Make sure that design elements that are not to be changed by a design 
refresh or replace have the property: Do not allow design refresh/replace to modify 
enabled.

Recommendation

Make sure all databases and templates allow manager access to all users 
responsible for their administration.

Recommendation
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3.2  Pre-Installation Upgrade Requirements

The importance of backups during the upgrade project cannot be stressed too 
much. Refer to 10.4, “Backup and Recovery” on page 283 and subsequent 
sections for details regarding backing up the contents of the AIX filesystems.

Before actually installing new code on a server, there are some steps that can 
be taken to prepare for the install. As mentioned in 3.1.2, “Planning the Order 
of Your Upgrade” on page 65, the public NAB can be upgraded on all servers 
in the domain since it contains all of the information required by an R4.x or 
even R3.x server. Any new features or information added to the forms for use 
by an R5 server is ignored by servers running older releases of the software. 
The following sections detail the steps to upgrade the design of the public 
NAB and also changes that need to be made to the notes.ini file just prior to 
installation of the R5 software.

3.2.1  Upgrading the Public Name and Address Book
Upgrading the design of the public NAB is a straightforward task and is much 
the same as changing the design of any database. The test environment 
recommended in 3.1.3.1, “Defining A Test Environment” on page 68 should 
be used to perform a test upgrade from the R4.x design to the new R5 
Domino Directory design. Once it is confirmed that the R4.x server will 
operate correctly with this new design, the production NAB can be upgraded 
as described below.

The new template for the R5 Domino Directory has the same filename, 
pubnames.ntf, and has the same template name, StdR4PublicAddressBook, 
as the existing NAB template. There are two possible ways to upgrade the 
design.

Ensure that a complete backup is taken of any server prior to carrying out 
any of the upgrade procedures detailed in this chapter.

To reverse a software upgrade by restoring from backup will be significantly 
easier and less time consuming than having to re-install and configure 
original software.

Recommendation
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3.2.1.1  Replace the Existing R4.x NAB Template
This procedure assumes that the R5 template is present on an 
administrator’s R4.x client machine and is ready to be placed on the servers 
and that the administrator has permission to overwrite the existing template 
on the chosen server.

1. Choose a server from which design changes will replicate to all other 
servers in the domain, usually a hub server.

2. Choose File -> Database -> Open from the Notes client menu and a 
dialog box similar to the one shown in Figure 91 will be displayed.

Figure 91.  Adding the pubnames.ntf icon to the R4.x Desktop

3. Ensure that the entry in the box labelled Server is Local.

4. Press the Tab key twice so that the cursor moves to the input box labelled 
Filename.

5. Over-type any existing filename with: pubnames.ntf

6. Click on the Add Icon to place the icon on the current workspace and then 
click on the Done button to return to the workspace.

7. Click on the template icon once so that it is selected on the desktop.

8. Choose File -> Replication -> New Replica from the client menu and a 
New Replica dialog box similar to the one shown in Figure 92 will appear.

Before attempting to upgrade to the Domino Directory, the first step must 
be to make a backup of both the existing public NAB and the template from 
which it inherits its design.

Note
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Figure 92.  Creating a New Database Replica

9. Change the entry in the Server input box to match the server on which the 
new template will be replicated.

10.Ensure that the options for Immediately and Copy Access Control List are 
selected.

11.Click on the OK button and then confirm that you wish to replace the 
existing file named pernames.ntf as shown in Figure 93.

Figure 93.  Replace the Existing pubnames.ntf Template

12.Click the Yes button to confirm replacement and complete the process of 
replacing the existing R4.x template with the new R5 one.

13.The decision can then be made to force replication to other servers or wait 
for scheduled replication to propagate the new template to the other 
servers in the domain.

14.The Design task will upgrade the NAB during its next scheduled execution 
on each server.
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3.2.1.2  Replace the Existing R4.x NAB Design
As with the first method, this procedure assumes that the R5 template is 
present on an administrator’s R4.x client machine and is ready to be used to 
replace the design of the existing NAB and that the administrator has 
permission to replace the design of the NAB on the chosen server.

1. Choose a server from which design changes will replicate to all other 
servers in the domain, usually a hub server.

2. Click on the NAB icon once so that it is selected on the desktop.

3. Choose File -> Database -> Replace Design from the Notes client menu 
and the Replace Database Design dialog box, shown in Figure 94, will be 
displayed.

Figure 94.  Replacing the Design of the Public NAB

4. Ensure that the entry in the box labelled Template Server is Local.

5. Scroll down the list of templates and select Domino Directory. The filename 
next to the About button should reflect the name of the template, usually 
pubnames.ntf.

6. The Inherit future design changes is selected by default.

If there are servers that should not have their NAB upgraded at this time, 
then before replacing pubnames.ntf, the replication of the template to these 
servers must be disabled or restricted. The template on the server to be left 
with an R4.x NAB can either have the option Temporarily disable 
replication selected in the Replication Settings dialog box, or the access 
control list of the templates should be modified to not allow any design 
changes to be propagated.

Note
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7. Click the Replace button to continue, and the following warning will be 
displayed (see Figure 95).

Figure 95.  Replace Database Design Warning

8. Click on Yes to complete replacing the design.

9. A decision can then be made to force replication to other servers or wait 
for scheduled replication to propagate the new design.

3.2.2  Preserving Directory Design Customizations
The procedures detailed previously for updating the design of the NAB 
assume that a direct replacement for the standard design is required. In many 
environments, the design of the NAB may have been customized by 
administrators or application developers to support specific application or 
administration needs. Under these circumstances, a direct replacement is 
clearly not a good idea.

In the test environment, follow these steps to reproduce the design 
customizations that are still required to create a new customized template:

1. Create a backup of the existing NAB and template that contain the 
customizations.

2. Upgrade a test copy of the R4.x NAB with the standard R5 design.

3. Use this design on one of the test servers to verify that the server operates 
correctly.

4. Apply the customizations to this upgraded design.

If you choose to Inherit future design changes at this point, then the R4.x 
pubnames.ntf template must be replaced on the servers to which this new 
design will replicate; otherwise, the design task will revert the design back 
to an R4.x NAB when it next executes.

If you do not want to have to replace the template on all servers at this 
time, do not select Inherit future design changes.

Note
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5. Create a new R5 customized template from this database design, giving it 
a name other than pubnames.ntf to distinguish it from the original.

6. Use one of the methods described in 3.2.1, “Upgrading the Public Name 
and Address Book” on page 70 to upgrade the design using this new 
template. Wherever reference is made to pubnames.ntf, substitute the 
name given to the newly customized template.

To simplify the task of determining what elements have been added or 
removed from the design, they are listed for reference in Appendix B.17, 
“Domino Directory Design Changes” on page 356.

3.2.3  Administration During the Upgrade Period
Since the new R5, database designs make extensive use of a feature called 
tabbed tables. Administering forms that use this feature from an R4.x client is 
possible but difficult.

In addition the R5 software imposes some limitations in the creation and use 
of ID files. An R4.x client must be retained if either of the two following 
scenarios apply to the environment:

1. New ID files are required for use by an R3.x client

2. Flat (non-hierarchical) ID files are required, and new ones need to be 
created

However, R5 does fully support the maintenance of existing flat ID files. The 
renewal of existing flat certificates and the certification of new hierarchical ID 
files with a flat certificate are supported.

Administrators should have their clients upgraded to R5 in readiness for 
the start of the upgrade process so that they can view the database 
contents correctly and take advantage of the new features of the 
Administration Client (see Chapter 5, “Installing the Lotus Domino 
Administration Client” on page 125).

Recommendation

If the environment still uses flat ID files, consider moving to a hierarchical 
certification model for increased security, flexibility of access control, and 
simpler administration through use of the administration process.

Recommendation
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3.2.4  Updating the Contents of the Domino Directory
When the Domino Directory is opened for the first time after upgrade, a form 
called the Domino Directory Profile will be presented that must be completed. 
This form is shown below, in Figure 96, as seen using an R5 client.

Figure 96.  Editing the Domino Directory Profile

The fields and their meanings are listed in Table 5.

Table 5.  Fields Used in the Domino Directory Profile

Field Name Description 

Domain defined by this directory The Notes domain for this directory is completed 
automatically when the server is configured.

Directory catalog filename for 
domain

The filename of the directory catalog database if 
one is to be created.

Sort all new groups by default Select Yes to automatically sort alphabetically the 
members of each new group created. 
Performance slows if yes is selected.

Select No to have members displayed in the 
order in which they were added to the group. 
Member list can be sorted as needed.

Use more secure Internet 
passwords

Select Yes to use strong encryption for Internet 
passwords or No to use basic encryption.
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3.2.5  Modifying the NOTES.INI File
This procedure should be carried out once the server has been shut down 
and is ready to be upgraded.

Domino R5 no longer uses the Report task for statistics reporting and 
collection. The file statistics collection, once performed by Report, is now 
done by the Directory Catalog task instead. In addition, the Collector task is 
used to enable a server to collect its own statistics or to act as a central 
gathering server for others in the domain in the same way that servers could 
be designated collectors in R4.x.

To remove the Report task from the notes.ini file, enter the following 
commands at an AIX terminal command prompt:

Figure 97.  Editing the notes.ini File 

This will open the notes.ini file in the UNIX vi editor, see Appendix D, “Using 
UNIX's vi Editor” on page 361 for details of available commands for use in 
this editor.

Scroll down the file to the line that starts ServerTasks= as shown in Figure 98 
on page 77.

Figure 98.  Removing the Report Task from the notes.ini File

Allow the creation of alternate 
language information

Select yes to allow creation of alternate language 
documents to be used in LDAP directory queries 
or no to prevent creation.

Field Name Description 

# cd /server1
# vi notes.ini

EDITEXP23=Word for Windows 6.0,2,_XW4W,W4W49T/V0,.DOC,,2,
DDETimeout=10
$$$OpenSpecial=NotesNIC
$$$NotesNIC=CN=Home/OU=Notes/O=NET, welcome.nsf, Notes NIC Welcome, Notes Networ
k Information Center on the Internet
ServerTasks=Replica,Router,Update,Stats,AMgr,Adminp,Sched,CalConn,Event,Report
ServerTasksAt1=Catalog,Design
ServerTasksAt2=UpdAll,Object Collect mailobj.nsf
ServerTasksAt3=Object Info -Full
ServerTasksAt5=Statlog
:wq
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If one of the tasks listed along this line is report, then delete it from the line by 
moving the cursor to the r of report and press the x key, which should delete 
a letter at a time. Once the word is removed, save and exit the modified file by 
pressing the Escape key then type :wq (as shown above) and press Enter.

If any of the following entries exist in the notes.ini file, then they should also 
be removed:

  • NSF_Buffer_Pool_Size=
  • NSF_DbCacheMaxEntries=
  • Server_Name_Lookup_Noupdate=
  • Any other debugging parameters

Some other entries in the notes.ini file may be ignored by the R5 server. 
Many of these now have an equivalent setting option on a server 
configuration document and do not need to be listed explicitly in the notes.ini 
file. They will not impact server performance if left in the file, but they should 
be noted so that after upgrade the equivalent options can be completed in the 
relevant fields on the configuration forms.

By default, the Domino Server on AIX does not generate a core file in the 
event of a fatal error. To change this behavior, the value of the 
DEBUG_ENABLE_CORE environment variable should be set to 1.

3.2.6  Modifying AIX Environment Settings
For Domino R5 running on AIX, the value of the 
Notes_SHARED_DPOOLSIZE environment variable can be specified 
manually and is set in bytes. If it is not specified explicitly, then it is calculated 
automatically using the formula (Physical RAM/2)/7. The aim of this is to use 
no more than 50 percent of the physical RAM in the machine and to keep the 
number of shared memory segments at seven or less.

Using debug variables is not supported during normal server 
operation.They should only be used if requested to do so by Lotus Support.

Note

If the number of shared memory segments exceeds seven, then the value 
of the variable Notes_SHARED_DPOOLSIZE should be increased.

The Domino Server can use an absolute maximum of 10 shared memory 
segments with AIX 4.2.x or 11 if using AIX 4.3.

Recommendation
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By increasing the value of Notes_SHARED_DPOOLSIZE, the number of 
segments required to allocate a specific amount of memory is reduced.

To check the current number of shared memory segments at an AIX terminal 
command prompt, type ipcs and press Enter (see Figure 99).

Figure 99.  Checking Shared Memory Segment Details

Segments that have keys starting with 0xF8 are in use by the Domino Server. 
In Figure 99, only segment 13 is currently in use.

3.3  Installing the R5 Server Software

The upgrade installation of the R5 code can be performed over the existing 
installed release providing it is currently at release R4.1 or higher.

In R5, to co-ordinate all variables in a central location, the 
Notes_SHARED_DPOOLSIZE parameter is now specified in the notes.ini 
file and not as an environment variable.

When upgrading, remove this variable from user profile or environment 
definition files and put it in the notes.ini of the server.

Note

$ ipcs
IPC status from /dev/mem as of Mon Feb  8 10:21:51 CST 1999
T        ID     KEY        MODE       OWNER    GROUP
Message Queues:
q         0 0x4107001c -Rrw-rw----     root   printq
Shared Memory:
m         0 0x5805502e --rw-rw-rw-     root   system
m         1 0x00001a4c --rw-------     root   system
m         2 0x00000001 --rw-r--r--     root   system
m         3 0x4704028f --rw-r--r--   imnadm   imnadm
m         4 0x5804028f --rw-r--r--   imnadm   imnadm
m         5 0x4d04028f --rw-r--r--   imnadm   imnadm
m         6 0x4904028f --rw-r--r--   imnadm   imnadm
m         7 0x5004028f --rw-r--r--   imnadm   imnadm
m         8 0x45040296 --rw-rw-rw-   imnadm   imnadm
m         9 0x43040296 --rw-rw-rw-   imnadm   imnadm
m        10 0x42040296 --rw-rw-rw-   imnadm   imnadm
m        11 0x41040296 --rw-rw-rw-   imnadm   imnadm
m        12 0x44040296 --rw-rw-rw-   imnadm   imnadm
m        13 0xf800d000 --rw-rw----    notes    notes
Semaphores:
s         0 0x5805502e --ra-ra-ra-     root   system
s         1 0x4405502e --ra-ra-ra-     root   system
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See Chapter 2, “Installing a Lotus Domino R5 Server” on page 15, for the 
specific details of installing the R5 software for AIX and the necessary 
pre-requisites for doing so.

During the install, the program and data directories displayed by the install 
routine may not match the directory names in which the current program and 
data is stored. These must be changed as detailed below.

1. When prompted to supply the program directory, press Enter to change the 
setting.

2. Type in the new directory name to match the currently used program 
directory and press Enter to confirm as shown in Figure 100.

Figure 100.  Changing the Program Install Directory during Upgrade

3. When the new directory is displayed, press the Tab key to continue.

4. When prompted to supply the data directory, press Enter to change the 
setting.

To ensure the greatest level of stability and ease of upgrade, it is 
recommended that the current release of the code be brought up to the 
latest Quarterly Maintenance Release (QMR).

For example, a server currently running base version R4.5 should be 
brought up to R4.5.7 through installation of the incremental install 
packages available from Lotus or for download from http://www.notes.net.

Recommendation

To ensure the greatest level of stability and ease of upgrade, it is 
recommended that the current release of the code be brought up to the 
latest Quarterly Maintenance Release (QMR).

For example, a server currently running base version R4.5 should be 
brought up to R4.5.7 through installation of the incremental install 
packages available from Lotus or for download from http://www.notes.net.

===============================================================================
                         Domino Server Installation
===============================================================================

    The program directory is the path where the Install program 
    installs the Domino program files.  The Install program 
    automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current program directory setting : /opt/lotus

New program directory setting     : /usr/domino
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5. Type in the new directory name to match the currently used data directory 
and press Enter to confirm as shown in Figure 101 on page 81.

Figure 101.  Changing the Data Install Directory during Upgrade

6. When the new directory is displayed, press the Tab key to continue.

Once the software has been installed, customizations must be re-applied to 
templates that come shipped with the product (see 3.1.5, “Database Design 
Considerations” on page 69).

Examples of such templates are listed below. 

  • pubnames.ntf
  • admin4.ntf
  • log.ntf

3.4  Restarting the Upgraded Server

There are other necessary tasks to carry out after the completion of the 
software installation both before and after restarting the new R5 server. 
These tasks are described in the following sections.

3.4.1  Upgrading MAIL.BOX
To take advantage of the new R5 ODS and performance enhancing features 
of the new R5 router mail box design, the mail.box file must be upgraded. 
Before the server is restarted, rename the file mail.box to mail.old.

For example, see Figure 102 on page 82, enter the following commands at an 
AIX terminal command prompt:

===============================================================================
                         Domino Server Installation
===============================================================================

    The data directory is the path where the Install program
    installs the Domino data files.
 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current data directory setting : /local/notesdata

New data directory setting     : /server1
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Figure 102.  Renaming MAIL.BOX

When the server is eventually restarted, it will create a new router mail box, 
mail.box. To improve performance and reduce disk space requirements, the 
database properties should be changed. This should be done using an 
administrator’s R5 client who has access to change the properties of the new 
mail.box database.

1. Right-click on the server mailbox icon or bookmark.

2. Choose Database -> Properties from the popup menu to show the 
database properties.

3. Click the right-most tab in the infobox and select the three options as 
shown in Figure 103.

Figure 103.  Setting Properties for the R5 Router Mailbox Database

Any messages that had not been transferred or routed before the server was 
shut down will still be in the old router mail box database, mail.old.

Once the server is restarted, it will be necessary to move the messages 
waiting in mail.old back into the router mail box, mail.box, so that they can be 
delivered or transferred.

# cd /server1
# mv mail.box mail.old

The steps shown below must be carried out using a Notes ID that has 
manager access to both the old router mail box, mail.old, and the new router 
mail box, mail.box.

Note

The steps shown below must be carried out using a Notes ID that has 
manager access to both the old router mail box, mail.old, and the new router 
mail box, mail.box.
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The steps to achieve this are described below.

1. Start a Notes or Administration client and enter a password if prompted to 
do so.

2. Open the original mail router database, mail.old.

3. Select all of the messages in the Mail view.

4. Select Edit -> Copy from the client menu.

5. Close the mail.old database.

6. Open the new mail router database, mail.box.

7. Select Edit -> Paste from the client menu.

8. Once the mail has been delivered or transferred from the new mail.box, 
delete the original mail.old database.

3.4.2  Domino Directory Compaction and Indexing
Although the design of the Domino Directory was upgraded in a previous 
stage of the upgrade, see 3.2.1, “Upgrading the Public Name and Address 
Book” on page 70, and now that the server has the R5 software installed, 
some additional steps must be taken to complete this process.

To take advantage of the performance and new features of the R5 ODS, it is 
necessary to compact the Domino Directory database twice. 

Perform these steps at an AIX terminal command prompt before the server is 
restarted after the upgrade.

3.4.2.1  Compact and View Index Rebuild
1. Type whoami and press Enter to determine the name of the current user.

2. If the current user is not the user defined to run the Domino server, type su 
- notes and press Enter (where notes is the user defined to run the 
Domino server).

3. Enter the user’s password and press Enter.

4. Type cd /server1 and press Enter to move to the Domino data directory for 
the server.

The first compact upgrades the database structure to the R5 ODS. The 
second compact enables any database properties that have been chosen, 
such as don’t retain unread marks or allow soft deletions.

Note
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5. Type compact names.nsf and press Enter to compact the directory 
database (see Figure 104).

Figure 104.  Compacting the Domino Directory (names.nsf)

6. Type compact names.nsf and press Enter again to compact the directory 
database for the second time.

After the compact process has completed, the view indexes can be rebuilt so 
that they are already up-to-date prior to the server being restarted.

At the AIX terminal command prompt, type updall names.nsf and press Enter 
as shown in Figure 105 below.

Figure 105.  Updating names.nsf View Indexes

The server is now ready to be started.

3.4.3  Server Task and API Program Testing
Once the server has been started, the tasks that run outside of normal office 
hours or that are not core Domino server tasks should be manually loaded to 
ensure that they run satisfactorily.

$ whoami
ausres27
$ su - notes
notes’s Password: 
$ cd /server1 
$ compact names.nsf
04/02/99 15:57:16     Compacting database names.nsf (IBM’s Address Book)
04/02/99 15:57:26     Finished compacting names.nsf, 126K bytes recovered (3%)
04/02/99 15:57:26     Database compact process shutdown

$ updall names.nsf
04/02/99 15:58:39     Index update process started
04/02/99 15:59:01     Index update process shutdown

When the server restarts, it will still prompt to upgrade the design of the 
Address Book; however, since this will have been done prior to software 
installation, there is no need to perform this step again.

Press N to answer No to this question

Note
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Enter each of the following commands at the Domino server console followed 
by pressing Enter and ensure that the tasks start, do not produce any 
unexpected errors and then exit successfully. 

  •load updall
  •load design
  •load catalog

Note any error messages or problems that are encountered during this 
process.

Finally, load any other third party add-in or API tasks in the same way and 
check that they perform as expected.

3.5  Additional System Database Upgrades

To ensure that the new R5 servers in the environment have the necessary 
features they require to operate to the best of their ability. Some of the other 
system databases must be upgraded with new designs in a similar way to the 
way in which the Domino Directory is updated. The main databases are 
discussed in the following sections.

3.5.1  Administration Requests Database
Once the administration server of the Domino Directory has been upgraded, 
one of the next steps in the project should be to upgrade the design of the 
Administration Requests database, admin4.nsf, to take advantage of the new 
features.

As with other elements, backwards compatibility is ensured so that the new 
design can be replicated to other servers in the domain that may not yet have 
been upgraded and that they will continue to operate successfully.

To enable a faster upgrade, outstanding requests should be processed prior 
to the database design upgrade. 

1. Type tell adminp process all  at the Domino server console and press 
Enter as shown in Figure 106

After the administration server is restarted and operational, upgrade the 
administration requests database on this server and then replicate to the 
other servers in the domain.

Note

After the administration server is restarted and operational, upgrade the 
administration requests database on this server and then replicate to the 
other servers in the domain.
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Figure 106.  Forcing Adminp to Process Outstanding Requests

Check the Administration Requests database to ensure that the outstanding 
actions have been completed.

2. Shutdown the admin process on the server, type tell adminp quit at the 
Domino server console and press Enter (see Figure 107).

Figure 107.  Stopping the Adminp Task

3. From an administrator’s client, replace the design of the database with the 
new template entitled Administration Requests (R5.0)

4. Allow or force the database to replicate to the other servers in the domain.

3.5.2  Directory Assistance Database
If the Directory Assistance database is used to provide multiple domain directory 
support, then it should be upgraded.

To upgrade the design, do the following:

1. From an administrator’s client, replace the design of the database with the 
new template entitled Directory Assistance with a filename of da50.ntf

2. Allow or force the database to replicate to the other servers in the domain.

3.5.3  Statistics and Events Database
As discussed in 3.2.5, “Modifying the NOTES.INI File” on page 77, the report 
task is no longer used by R5, and therefore, some changes need to be made 
in the configuration to specify statistics collection servers.

05/02/99 14:12:36     Periodic full text indexer terminating
05/02/99 14:17:40     Searching Administration Requests database.

> tell adminp process all
> 05/02/99 14:40:32     Checking for all requests to perform

The upgrade process can be performed with outstanding requests in the 
database but may take longer to complete.

Note

> tell adminp quit
05/02/99 14:50:48     Administration Process shutdown
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Instead of the report task, the server should load the collect task if it is to be 
used for either of the following scenarios:

  • Local logging of its own statistics reports.
  • It will collect remote statistics from other servers.

When the R5 server is restarted, the error shown in Figure 108 will be 
displayed on the console if the Statistics Reports database ( statrep.nsf) has 
not been upgraded.

Figure 108.  Error on Event Task Startup after Server Upgrade

If the collect task is started on a server before the design of the Statistics and 
Events database (events4.nsf) has been upgraded, the error message shown 
in Figure 109 will be displayed.

Figure 109.  Error on Collect Task Startup after Server Upgrade

The database designs should be replaced with the updated R5 templates 
installed on the server. Refer to 3.1.5, “Database Design Considerations” on 
page 69 for information regarding the preservation of any design 
customizations that may have been used.

After the Statistics and Events database has been upgraded, Server Statistics 
Collection documents must be created or edited to ensure that statistics 
collection is performed properly. These can be found under the view named 
Server Statistic Collection, and there should be one document per server that will 
collect statistics.

3.5.3.1  Local Collection
To enable a server to collect its own statistics locally, it must be running the 
collect task, and it must have its own Statistics Server Collection document.

1. Edit or create a new document and fill in the fields on the form.

2. On the Basics tab, enter the name of the server in the Server field.

09/02/99 11:13:33     Event Dispatcher started
09/02/99 11:13:34     The server access view does not exist. Update the
Statistics Report template

> 09/02/99 11:22:34     Collector started
09/02/99 11:22:34     Collector: Could not locate Server Statistics Collection
document for ’Server1/IBM’ in the Statistics & Events Configuration database.
09/02/99 11:22:35     Collector shutdown
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3. Choose From the following servers and select the same server name 
again as shown in Figure 110.

Figure 110.  Specifying a Server to Collect Statistics

4. Switch to the Options tab.

5. Check the Log statistics to a database checkbox.

6. Enter the name of the statistics reporting database; it is usually 
statrep.nsf.

7. Enter the collection report and alarm interval values. Examples are shown 
in Figure 111 on page 89.
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Figure 111.  Specifying Statistics Collection Intervals

8. Save and exit the document.

3.5.3.2  Remote Collection
The concept of remote collection of statistics introduced in R4.5 is the same 
in R5. Once again, any server designated as a remote collector for other 
servers must be running the collect task, and it must have a Server Statistic 
Collection document.

A single server can be designated to collect from all other servers in the 
domain. It can be designated to collect from a specific list of servers, or it can 
also be designated to collect from all servers that are not already explicitly 
listed in another document.

3.5.3.3  Additional Monitoring Tools
Statistics and Event monitoring now includes the provision of timed probes for 
the server, mail, and TCP/IP services. These can be used to periodically 
check that the server and its services are available and responding to 
external requests.

The server access probe checks connectivity using Notes Remote Procedure Calls 
(NRPC) as made by Notes clients. The mail probe is used to test the routing 
connectivity between two defined servers by sending a probe message to a 
specific recipient on the chosen server at a given interval. Each of the TCP/IP 
services, such as HTTP or NNTP, can be probed to monitor availability.
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When a probe fails, it generates an event that can be trapped and reported in 
one the usual ways, such as mail to administrators, log to database, or SNMP 
trap.

For more information on the changes to Statistics and Events, refer to the 
on-line Lotus Domino R5 Administration Help database.

3.6  Upgrading Domino Mail Topologies

The R5 mail router is fully backwardly compatible with previous releases of 
the server software. All servers can be upgraded to R5 with no changes 
required in the routing topology; however, to benefit from the new features, 
some changes will have to be implemented. These changes can be 
implemented on a server-by-server approach and do not all have to be made 
at the same time.

Although this section details steps for upgrading an existing SMTP MTA 
server, more information on the configuration of the SMTP routing functions 
can be found in Chapter 8, “Lotus Domino R5 and the Internet” on page 209.

3.6.1  Router Transfer and Delivery Options
After a server has had the R5 software installed, the router can be configured 
to perform tasks in parallel, multi-threading, to increase throughput of 
message transfer and delivery.

Firstly, multiple mail router mailboxes can be specified so that the router 
threads do not have to contend with each other for exclusive access to a 
single mail router database. To specify how many router mailboxes should be 
used on a server, edit the server configuration document and enter a number 
in the field labelled Number of mailboxes on the Router/SMTP - Basics tab of 
the table. An example is shown in Figure 112 on page 91.
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Figure 112.  Increasing the Number of Router Mailbox Databases

When the server is restarted, additional databases named mail1.box, 
mail2.box, and so on will be created up to the value specified.

By default, Domino allows the router to use a maximum of one transfer thread 
per configured port. An administrator can override this default to increase the 
total number of threads available to the router for mail transfer to other 
servers.

To specify a different value, edit the field labelled Maximum transfer threads 
on the Router/SMTP-Restrictions and Controls-Transfer Controls tab of the 
server configuration document.

On the same tab, the field labelled Maximum concurrent transfer threads is 
used to specify how many of the total number of threads are allowed to 
execute concurrently. If this is not specified, the default will be the value of 
Maximum transfer threads divided by two. An example is shown in Figure 113 
on page 92.
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Figure 113.  Increasing the Maximum Router Transfer Threads

With R5, the delivery process of the router also became multi-threaded. The 
default value is one. To change this value, edit the field labelled Maximum 
delivery threads on the Router/SMTP-Restrictions and Controls-Delivery 
Controls tab. An example is shown in Figure 114.

Figure 114.  Increasing the Maximum Router Delivery Threads
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The R5 router has many more controls available than the previous router or 
SMTP MTA. These can be implemented through fields on the server 
configuration document found in the Router/SMTP-Restrictions and Controls 
and associated tabs.

3.6.2  SMTP/MIME Considerations
The R5 router now supports native SMTP routing /delivery, and MIME format 
storage. When an R5 server routes a MIME message to an R4 server, it first 
converts it back to the Compound Document (CD) format, as the R4.x server 
does not understand native MIME, but it also attaches a copy of the full MIME 
content so that message fidelity is preserved should that message be 
required by a MIME-compliant client at a later stage.

In a mixed environment, to deliver a Notes CD format message, the R5 server 
utilizes the field Format preference for incoming mail on the Mail tab of the 
Person Document of a recipient to determine the user’s message format 
preference (see 3.6.4.9, “Defining a User’s Internet Mail Storage Options” on 
page 100). The R5 router then delivers a message to that user in the format 
indicated by that setting. 

3.6.3  Considerations in a Mixed-Release Cluster
Should clustering be used to provide resilience during the upgrade process, 
then there are some important points to note especially if some clients and 
mail databases have been upgraded to R5 before all of the servers.

1. The R5 mail template uses features not available in releases of Domino 
prior to R4.6.3b; so, a client failing over to an R4.x server will have a 
reduced feature set and may even be subjected to error messages if the 
other cluster members are not running R4.6.3b.

2. R4 servers do not support soft deletions. The trash folder on an R4 server 
appears to contain all the documents in the mail file; and although this 
may be intimidating, it can be ignored.

The recommended range for the maximum delivery threads is three to 25.

Recommendation

Person documents in the Domino Directory must be updated for users with 
a MIME-compliant client, such as Notes R5, and for use with POP3/IMAP 
access protocols when accessing an R5 server.

Note
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3. R5 servers can deliver native MIME, but R4 servers cannot. Thus, when a 
Notes client fails over to an R4 server from an R5 server, MIME messages 
are converted to Notes format documents and appear different than when 
viewed on the R5 server.

4. Attempting to send a MIME message through an R4 server means that the 
message must be converted to Notes format with an attachment 
containing the original MIME. 

5. Though failover is indicated in the Notes status bar at the bottom of the 
screen, this is not obvious, and a failover from an R5 to an R4 server may 
not be apparent. However, as noted above, there are changes in 
functionality between R5 and R4 in clusters.

Details of clustering Domino Servers can be found in 7.5, “Domino Server 
Clustering” on page 173.

3.6.4  Upgrading an SMTP MTA Server
Where SMTP MTA servers exist in a domain, other R5 servers not configured 
to route SMTP mail themselves will recognize and use the routing information 
in the Domino Directory to continue to route mail to the MTA for ongoing 
delivery outside of the local domain. This gives flexibility in terms of when 
MTA servers are upgraded; SMTP can be implemented all at once, gradually 
or not at all.

There are three main upgrade strategies for the MTA servers:

1. Leave the existing R4.x MTA in place until all other elements are upgraded

This ensures a known level of service for SMTP traffic during the upgrade 
process; however, it does not allow other upgraded elements to take 
advantage of new features and imposes conversion processing for mail to 
be delivered to the R4.x MTA.

2. Replace all MTAs with R5 mail servers first.

This allows immediate access to new R5 SMTP features and enhanced 
performance but still requires message conversion for mail routing to the 
other servers until they are upgraded.

3. Replace all MTAs with R5 mail servers during the system upgrade.

In larger environments, this strategy allows the MTA servers to be 
upgraded at the same time as other servers in their vicinity to which they 
route the majority of their SMTP traffic.

4. Re-design the Internet messaging infrastructure.
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In an R4.x messaging infrastructure, the nature of the SMTP 
implementation dictated that specific servers be designated to perform 
SMTP routing functions to locations outside of the local domain. With R5, 
this restriction is no longer necessary since all servers can route natively 
through some relay host, such as a virus scanning server or firewall. Once 
mail servers that used to route through the MTA have been upgraded, the 
MTA is no longer required and does not need to go through the upgrade 
process.

The following sections describe the stages through which an existing R4.x 
SMTP MTA server can be upgraded to a native R5 SMTP mail server.

3.6.4.1  Disabling MTA Housekeeping
MTA housekeeping must be disabled. If this is left enabled, after 
housekeeping is performed, it will restart the MTA, and inbound/outbound 
transport will be available, which may contaminate work queues that have 
been cleared down ready for the upgrade. To disable housekeeping:

1. Open the server document in the Domino Directory

2. Click on the MTAs tab

3. Click on the R4.x Internet Message Transfer Agent (SMTP MTA) section 
header to expand the section

4. Change the value of the field Enable daily housekeeping to Disable as 
shown in Figure 115 on page 96 below.

As noted earlier, ensure a full backup of the system is taken prior to 
commencing the upgrade process.
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Figure 115.  Disable MTA Daily Housekeeping Task

5. Save and close the document

3.6.4.2  Shutting Down the Router
Shutting down the router prevents any new messages being delivered from 
internal sources into the smtp.box database for processing. To stop the 
router, type tell router quit at the Domino server console and press Enter 
as shown in Figure 116.

Figure 116.  Stopping the Mail Router

3.6.4.3  Shutting Down the Inbound Message Transport Task
To allow the work queues to be cleared of any messages prior to upgrade, the 
task that accepts inbound routing connections must be disabled. To do this, 
type tell smtpmta stop inbound transport at the Domino Server console and 
press Enter as shown in Figure 117.

> tell router quit 
08/02/99 16:10:01     Router: Shutdown is in progress
08/02/99 16:10:01     Mail Router shutdown
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Figure 117.  Stopping the SMTPMTA Inbound Message Transport Task

3.6.4.4  Clearing Down the Work Queues
Using a Notes or Administration client, check the databases Outgoing SMTP 
Mail (smtp.box), SMTP Inbound Work Queue (smtpibwq.nsf), and SMTP 
Outbound Work Queue (smtpobwq.nsf) to ensure that all pending messages 
are processed by the MTA. Any dead messages can be ignored. They will not 
be routed, but it may be worthwhile noting details so that the sender or 
recipients can be notified later that they had a problem with those messages.

Once the queues are clear, the server can be shut down. Type quit at the 
Domino server console and press Enter.

3.6.4.5  Editing the NOTES.INI file
To remove the SMTPMTA task from the notes.ini file, enter the following 
commands at an AIX terminal command prompt:

Figure 118.  Editing the notes.ini File

This will open the notes.ini file in the UNIX vi editor. See Appendix D, “Using 
UNIX's vi Editor” on page 361 for details of available commands for use in 
this editor.

Scroll down the file to the line that starts ServerTasks= as shown in Figure 119 
on page 98.

> tell smtpmta stop inbound transport
08/02/99 16:15:05 SMTPMTA: isesctl Shutting down
08/02/99 16:15:05 SMTPMTA: iseshlr0 Shutting down
08/02/99 16:15:05 SMTPMTA: iseshlr0 Shutdown complete
08/02/99 16:15:05 SMTPMTA: isesctl Shutdwon complete

# cd /server1
# vi notes.ini
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Figure 119.  Removing the SMTPMTA Task from the notes.ini File

One of the tasks listed along this line is smtpmta. To delete it, move the cursor 
to the s of smtpmta and press the x key which should delete a letter at a time. 
Once the word is removed, save and exit the modified file by pressing the 
Escape key, then type :wq (as shown above) and press Enter.

3.6.4.6  Installing the R5 Server Software
See Chapter 2, “Installing a Lotus Domino R5 Server” on page 15, for the 
specific details of installing the R5 software for AIX and the necessary 
pre-requisites of doing so.

Once the server software has been installed, the server must be restarted so 
that documents in the Domino Directory can be configured using an 
administration client.

3.6.4.7  Configuring SMTP on the Server Configuration Document
Edit the server configuration document for this server. If one does not already 
exist for this server, then one must be created.

1. Start the administration client.

2. Select the required server from the bookmarks.

3. Click on the Configuration tab.

4. Open the server panel and click on Configurations.

5. Select the configuration document and press Edit Configuration. If one 
does not exist, then click Add Configuration. An existing document is 
shown in the view in Figure 120.

EDITEXP23=Word for Windows 6.0,2,_XW4W,W4W49T/V0,.DOC,,2,
DDETimeout=10
$$$OpenSpecial=NotesNIC
$$$NotesNIC=CN=Home/OU=Notes/O=NET, welcome.nsf, Notes NIC Welcome, Notes Networ
k Information Center on the Internet
ServerTasks=Replica,Router,Update,Stats,AMgr,Adminp,Sched,CalConn,SMTPMTA
ServerTasksAt1=Catalog,Design
ServerTasksAt2=UpdAll,Object Collect mailobj.nsf
ServerTasksAt3=Object Info -Full
ServerTasksAt5=Statlog
:wq
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Figure 120.  Adding or Editing a Server Configuration Document

6. Enter a group or server name in the field Group or Server name.

7. Complete all required fields found under the Router/SMTP and MIME tabs.

8. Save and close the document.

3.6.4.8  Enabling the SMTP Listener Task
To make the server’s router aware that it is to accept incoming SMTP mail 
connections, the SMTP listener task must be enabled.

1. Edit the server document.

2. On the Basics tab, change the value of the SMTP listener task field to be 
Enabled as shown in Figure 121 on page 100.
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Figure 121.  Enabling the SMTP Listener Task

3. Save and close the document.

4. Restart the server to ensure all configuration changes are invoked.

3.6.4.9  Defining a User’s Internet Mail Storage Options
Each person document contains a field that the R5 router uses to determine 
whether a user prefers to receive messages in a Notes or MIME format.

Once a server is upgraded to R5, this field should be populated for all users 
who have their mail delivered on that server. To ensure they receive 
messages in the best format for the client that they are using, the choices 
are:

  • No Preference
  • Prefers MIME
  • Prefers Notes Rich Text

3.6.4.10  Configuring Relay Host Information
In many R4.x MTA installations, the server is configured to relay all SMTP 
messages to a relay host which is, often a virus scanner or firewall. By 
entering a value in the field labelled Relay host for messages leaving the 
local internet domain on the server configuration document, the server will 
relay all SMTP mail that is bound for an address outside of the local domain 
to this host.
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This directly replaces the SMTP connection document that used to specify a 
relay host.

In addition, a smart host can be specified in the field labelled Local internet 
domain smart host through which all messages are routed if the server cannot 
find a match for the recipient’s address in the Directory, and the address is in 
the local internet domain. Examples are shown in Figure 122.

Figure 122.  Setting a Relay Host and Smart Host for External SMTP Traffic

3.6.4.11  R4.x vs. R5 Configuration
The global domain documents that were used by R4 are still used by the R5 
router to get information about the local internet domains for which it will 
process and route mail.

The foreign SMTP domain document is no longer required by an R5 router. 
Domain routing restrictions are specified on the Restrictions and Controls tab 
of the server configuration document.

The SMTP connection document is no longer required by an R5 router. 
Details of the relay host are specified on the Router/SMTP- Basics tab of the 
server configuration document.
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The configuration settings specified in the Internet Message Transfer Agent 
(SMTP MTA) section of the server document are now either superseded by 
those available on the server configuration document or are no longer 
required by the R5 router.

For detailed descriptions of the fields used, refer to the document Configuration 
in R4 vs. R5 in the Lotus Domino R5 Administration Help database.

3.7  Searching and Indexing

R5 introduces a brand new searching and indexing engine called Global Text 
Retrieval (GTR). An important point to note, as mentioned previously, is that 
full-text indexes are approximately 50 percent larger.

Indexes will be rebuilt automatically as databases are used; and since the 
changes have been implemented below the API level, earlier releases of the 
client and applications performing search functions will continue to function 
correctly.

Although the search indexes can be used by all releases of the client, users 
may come across an error during index rebuilding.

3.8  Recovering from a Failed Upgrade

Provided that a full backup of the server is taken prior to any upgrade work 
being started, then to recover from a failure in the upgrade process should be 
a relatively straightforward task. 

An administrator may run the updall task to update all databases indexes at 
the same time. The indexing process is very CPU intensive. If a server has 
many full-text indexes to rebuild, its performance will be degraded for a 
significant period of time; in which case, it may be desirable to perform this 
task out-of-hours with the server off-line.

Note

If users attempt to search a database that is being updated from an R4 to 
an R5 full-text index, they will get an error message stating that they must 
wait for the indexing process to complete before they can search the 
database.

Note
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If, however, for any reason a backup cannot be used to restore the original 
state of the server, then there are several things to consider.

If the compact task has been run on the R5 server, then all of the databases 
will have been converted to the R5 ODS. If the R4.x server software is 
re-installed, then it will not be able to read the contents of the databases. 
Prior to re-installing R4.x, the R5 version of the compact task must be used to 
revert back to the R4 ODS.

To do this, at an AIX terminal command prompt, do the following:

1. Type whoami and press Enter to determine the name of the current user.

2. If the current user is not the user defined to run the Domino server, type su 
- notes and press Enter (where notes is the user defined to run the 
Domino server).

3. Enter the user’s password and press Enter.

4. Type cd /server1 and press Enter to move to the Domino data directory for 
the server.

5. Type compact -r and press Enter to compact the directory database (see 
Figure 123).

Figure 123.  Reverting Databases Back from R5 to R4 ODS

$ whoami
ausres27
$ su - notes
notes’s Password: 
$ cd /server1 
$ compact -r

This process will only revert databases, not templates. If any templates 
have been manually compacted then the following command must be used 
to revert them back to the R4.x ODS:

compact <template>.ntf -r

where <template> is the first part of the template filename.

Also, templates on another server still running R4.x could be copied to this 
server to replace those that have been compacted.
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To prevent this from happening unintentionally until confident that the server 
does not need to be downgraded back to R4.x, the following options may be 
considered:

  • Disable the automatic running of the compact task.
  • Rename databases to use a .ns4 extension.
  • Disallow the creation of new or replica databases on the server.

Any changes made to the notes.ini file (see 3.2.5, “Modifying the NOTES.INI 
File” on page 77), should be reversed.

The above options limit the risk of a database being automatically changed 
to an R5 ODS, but they will not prevent an administrator with sufficient 
access rights from manually compacting from their workstation client.

Note
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Chapter 4.  Customizing AIX for Lotus Domino R5

This chapter details how to customize the Domino server environment by 
using AIX scripts to perform various administrative tasks, such as starting 
and stopping the Domino server.

Several examples are presented throughout this chapter. The following Lotus 
Domino Server configuration will be used for the examples:

  • The Lotus Domino software is installed in a file system mounted on 
/usr/domino.

  • The server is run as the AIX user notes and AIX group notes.
  • The Domino server data directory is in another file system mounted on 

/server1.

The code and examples in this chapter were created assuming this 
configuration, and you will need to customize them to work properly in your 
environment. To do so, you will be required to know about administering AIX 
systems and Korn Shell scripts. Also environment variables that had to be 
defined in earlier releases of Notes have been moved to the notes.ini file. 
More details of environment settings can be found in 3.2.6, “Modifying AIX 
Environment Settings” on page 78.

4.1  Lotus Domino Server Startup

This section covers the following topics:

  • How to start up the Lotus Domino Server manually from an AIX command 
line

  • How to startup the Lotus Domino Server using a startup script
  • How to start up the Lotus Domino Server on an AIX machine automatically 

at bootup

4.1.1  Lotus Domino Server Startup from AIX Command Line
These are the steps to start up the Lotus Domino Server on an AIX machine 
and view a server console:

1. Log in to the system as the notes user.

2. Change directory to /server1 if your notes.ini is not in your path.

3. Type in the command: server if you have not already added the directory 
/opt/lotus/bin to your path statement.

4. You may need to type the Lotus Domino Server password.
© Copyright IBM Corp. 1999 105



This procedure will start the server, and you will be able to view the server 
console on a screen or window. If you kill this screen, the server will crash 
and will not respond to any requests. To recover from this situation, you have 
to kill the server and all the child processes and remove the corrupted shared 
memory and semaphores that they created. 12.1, “Cleaning Lotus Domino 
Processes” on page 327 contains an explanation about killing these 
processes and removing corrupted shared memories and semaphores. It also 
contains a script to achieve this.

4.1.2  Server Startup in Background
To run the server in the background, use the following command:

Figure 124.  Running the Lotus Domino Server in the Background

The server output will be directed to the file nohup.out. You will need to type 
your Lotus Domino Server password. If your server doesn't need a password, 
press Enter. If you wish to see the server output, you will have to read the 
nohup.out file. You can send commands to this server through the server 
remote console (see 4.4.1, “Shutting Down Lotus Domino Server on Server 
Console” on page 120).

The recommended way to start up a server is by using a startup script as 
given in the next section.

4.1.3  Starting the Lotus Domino Server Using a Startup Script
In case you wish to start the Lotus Domino Server in the background using a 
shell script, we give below the following two shell scripts to be executed for 
fully accomplishing the task. The scripts should be owned and executed by 
user notes. Hence, the scripts should have the right file permissions to be 
executable. 

$ nohup /opt/lotus/bin/server <notes_data_directory> <<EOF &
> <Server_Password>
> EOF

The Domino server should be started as a background task from either the 
/etc/inittab file or as a cron job to prevent unexpected task interruptions 
and hangs instead of using the nohup command.

Note 
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4.1.3.1  Defining the Environment
The script provided below defines essential parameters for use by other 
scripts.

#!/bin/ksh
# Domino Application Server Environment Variable Script
# Licensed Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - env_domino
#
#      This script makes variable definitions that are common to 
#      the start_domino, stop_domino scripts
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.

NOTES_USER=notes # AIX userid for this server
NOTES_PATH=/server1 # Path for server data directory
NOTES_SERVER=noteserv # Name of Domino Server
OUTPUT_LOG=/tmp/$NOTES_SERVER.log # Output file for server console
INPUT_FILE=$NOTES_PATH/$NOTES_USER.input # Input file for server console
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH# Ensure PATH is set for 
scripts

4.1.3.2  Starting the Server
The following script starts the server in the background redirecting the 
console to $OUTPUT_LOG, and reading commands from $INPUTFILE. The 
size of the output log file will need to be monitored as it can grow big in size, 
so you may want to direct the output to /dev/null. The /dev/null special file 
provides character access to the null device driver. This device driver is 
normally accessed to write data to the bit bucket (when the data is to be 
discarded).

 The INPUT file allows any command to be issued to the Domino Server; 
so, this file should be treated accordingly, that is, hidden with the 
appropriate permissions to prevent unauthorized access to the server

Note
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Type the command /(path where the script resides)/start_domino to start 
the server.

#!/bin/ksh -x
# Domino Server Start Script
# Licensed Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - start_domino
#
# This is a server startup script to start the Domino Server in background      
# that gets command input from a file and pipes the output to another which
# can be monitored by administrators.
#
# The INPUT file allows any command to be issued to the Domino Server so
# this file should be treated accordingly ...hidden with the appropriate
# permissions to prevent unauthorized access to the server
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. /(path of dir where the script exists)/env_domino

# Script Logic

if ((‘id -u‘ == 0))
then
   print "Run the Domino Server as the $NOTES_USER user "
   exit
fi

#
# if you are using /etc/hosts for tcpip name resolution rather than a name 
# server or NIS, then uncomment the following line:     
#export NSORDER=bind,local,nis
# 

if [ ! -x /opt/lotus/bin/server ] ; then
     echo "Cannot access server command - exiting"
     exit 1
fi
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if [ ! -d $NOTES_PATH ] ; then
     echo "Cannot access notes data directory - exiting"
     exit 1
fi

NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
if [[ -n $NOTES_RUNNING ]] ; then
     echo "Domino Server is already running - exiting"
     exit 1
fi

cd $NOTES_PATH
#
# Clean up if the Domino Server terminated abnormally earlier
#

rm -f ~notes.lck
mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print 
$2 }’ | awk ’{ print $1 }’‘ 
sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print 
$2 }’ | awk ’{ print $1 }’‘
for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
#
# For servers using Notes passwords,
# replace the previous line with the following two lines.
#
cat .secure_hidden_passwd > $INPUT_FILE
echo "show server" >> $INPUT_FILE

cp -p  $OUTPUT_LOG $OUTPUT_LOG.‘date +"%m%d%y_%H%M"‘
#cp -p  $OUTPUT_LOG $OUTPUT_LOG.backup
print "Starting Domino for AIX ($NOTES_SERVER)"
/opt/lotus/bin/server < $INPUT_FILE > $OUTPUT_LOG 2>&1 &

4.1.4  Starting the Lotus Domino Server Automatically
To start up the Lotus Domino Server automatically after a reboot, you need to 
create an entry in the /etc/inittab file and a script to start up the server. In our 
example, the script is called start_domino, which is described in 4.1.3.2, 
“Starting the Server” on page 107. It will be in the directory /server1/bin. The 
output of the server will be moved into the /tmp directory.

Use the following procedure to implement our example. 

1. Log in as the notes user, and do the following:

  • Create a directory called bin
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$ mkdir -m 700 /server1/bin

  • Move the file start_domino in the directory /server1/bin

$ mv start_domino /server1/bin

2. Log in as root to do the following:

  • Type in the command below to create an entry in the /etc/inittab file for 
the Lotus Notes startup script to execute during machine startup

# /usr/sbin/mkitab "notes:2:once:/bin/su - notes -c 
/server1/bin/start_domino #Domino Server Startup"

This is a one line command. This command will make the necessary 
changes to the inittab file. 

After the next boot, the Lotus Domino Server will be started up automatically. 
If you want to start up the server without rebooting the machine, as the notes 
user type:

$ nohup /server1/bin/start_domino &

This a simple example. You can change this sample program to customize 
your logs and directories.

4.1.5  Using the AIX alog Facility
AIX provides a command called alog. This function allows the output from 
installp to be recorded in the log file /var/adm/ras/bosinstlog. 

The characteristics of the new alog command are the following: 

1. It is a circular logging program. It reads from stdin and writes to stdout and 
copies the information into a file that has a fixed size. The logging program 
writes to the file, and when it is filled, new entries will be written over the 
oldest ones. The output does not include any time stamps, and the logging 
program does not provide any concurrency control (for example, the 
synchronization of multiple processes trying to log the same file at the 
same time).

If you want to remove the above entry from /etc/inittab, use the command 
below. This is a one line command. This command will make the necessary 
changes to the inittab file. 

# /usr/sbin/rmitab "notes:2:once:/bin/su - notes -c 
/server1/bin/start_domino #Domino Server Startup"

Note
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2. It is configurable. With alog, you can create or view log types, configure 
the log file size, verbosity, and location. The default path for the alog files 
is /var/adm/ras. 

The alog command works with log files that are specified on the command 
line or with logs that are defined in the alog configuration database. Logs that 
are defined in the alog configuration database are identified by LogType. The 
File, Size, and Verbosity attributes for each defined LogType are stored in the 
alog configuration database with the LogType. You can add a new LogType to 
the alog configuration database using the odmadd command. You can change 
the attributes of LogType defined in the alog configuration database using the 
alog command. 

To use the alog command, you must:

To use the alog facility, you need to have at least AIX 4.1.5, and the 
bos.rte.serv_aid fileset must be installed in the system. Without this, the 
alog facility won’t work properly with Lotus Notes. You can use the 
command:

lslpp -l | grep bos.rte.serv_aid

to check if the fileset is installed in your system.

You also can run the following test to ensure that your alog version will 
work properly with Lotus Notes:

Run the command:

alog -f /tmp/test.log

Type some words and press Enter. The alog command echoes your input.

Suspend the alog command by pressing Ctrl-Z (stop signal).

Run the command:

alog -f /tmp/test.log -o

If it shows what you’ve typed, it is working. If it shows only what you’ve 
typed when you finish the previous alog command (you have to put it in the 
foreground again and press Ctrl-D), it won’t work with Lotus Notes. The 
reason for this is that it outputs the messages to the log file only when its 
standard input is finished.

Note
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  • Create a log file definition in the Software Service Aids Attributes Object 
Class (SWservAt) of the host's Object Data Manager (ODM)

  • Modify the startup script to use the alog command.

The script configure.alog, given below, creates a log file definition (file name 
/server1/log/server.alog, file size 512 KB) and creates the inittab entry to start 
up the server.

It first tries to remove the old definitions, if there are any, with the odmdelete 
command. It then creates the log file ODM definition. The log name is notes, 
the file name is /server1/log/server.alog, and the file size is 512 KB.

It then removes any inittab entry that begins with notes (take care to not 
destroy your inittab) and creates the inittab to call the script 
/server1/bin/startup.alog.

#!/bin/ksh
#@(#) Configures Automatic Notes Startup.
# Script startup must be in ~notes/bin/startup

if [[ ‘/bin/id -u‘ != 0 ]]
then
  echo "Error: you must be root..." >&2
  exit 1
fi

LHOME=~notes
LOG=$LHOME/log/server.alog
SIZE=524288

# Deletes previous old odm for the log notes...
echo "Deleting previous ODM entries..."
/bin/odmdelete -o SWservAt -q ’attribute=alog_type AND deflt=notes’
/bin/odmdelete -o SWservAt -q attribute=notes_logname
/bin/odmdelete -o SWservAt -q attribute=notes_logsize
/bin/odmdelete -o SWservAt -q attribute=notes_logverb

# Define in ODM an alog for Domino Server with size 512K
echo "Defining new ODM entries..."
/bin/cat <<EOF | /bin/odmadd
SWservAt:
    attribute="alog_type"
    deflt="notes"

 Make user to backup the ODM.

Note
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    value="notes"
SWservAt:
    attribute="notes_logname"
    deflt="$LOG"
    value="$LOG"
SWservAt:
    attribute="notes_logsize"
    deflt="$SIZE"
    value="$SIZE"
SWservAt:
    attribute="notes_logverb"
    deflt="1"
    value="1"
EOF

# Delete old inittab entries...
ENTRY=‘/bin/awk -F: ’$1 == "notes" {print}’ /etc/inittab‘
if [[ -n $ENTRY ]]
then
  echo Removing inittab entry: $ENTRY
  /usr/sbin/rmitab "$ENTRY"
fi

# Create the new one...
echo Creating inittab entry...
/usr/sbin/mkitab "notes:2:once:/bin/su - notes -c $LHOME/bin/startup.alog \
# Domino Server Startup"

The new script, startup.alog, is shown in Figure 125 on page 114. The 
difference is that this script redirects the standard output to the alog 
command instead of to the log file. Note that the server messages will appear 
in the host console. If you don’t want this, redirect the alog standard output to 
/dev/null. You need to put the password of the user notes in the file named 
~/bin/.notes.
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Figure 125.  Script to Start Up a Lotus Domino Server (startup.alog)

To view the log contents, use the command:

$ alog -tnotes -o

You also can use smitty to view the log. Run: smitty alog_show, type: notes in 
the Alog TYPE field and press Enter (Figure 126). Press Enter again, and 
the log file will be displayed.

Figure 126.  Show an alog File

To change the file name, or the log size, run: smitty alog_change. Then type 
notes in the Alog TYPE field and press Enter (Figure 127 on page 115). To 
change the file name, type the new one in the Alog file NAME field. To change 
the file size, type the new one in the Alog file SIZE field. Note that if you 
change the file size, the prior log messages will be erased.

#!/bin/ksh
#@(#) Starts up Lotus Domino Server...
#
. /etc/environment | /bin/alog -tnotes > /dev/console

NOTESPATH=/opt/lotus/bin
export PATH=$NOTESPATH:~/notesr4:$PATH
export LANG=C

echo "----------------------> ‘date‘ <----------------------" | \
   /bin/alog -tnotes > /dev/console
$NOTESPATH/server < ~/bin/.notes 2>&1 | \
   /bin/alog -tnotes > /dev/console &

 Show an Alog File

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Alog TYPE                                           notes
  Alog File NAME                                     [/server1/log/server.alog]  /

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 127.  Change / Show Characteristics of an alog File

4.2  Viewing the Domino Server Live Console

If the server has been started using the start_domino script, then you will not be 
able to view the Domino server console as the script starts the server in the 
background. Also, when a server crashes, the last few lines may not be 
logged to the notes log, and there may be instances when the log file gets 
corrupt. In such cases, being able to view the server live console is very 
useful. The script given below displays the Domino server console when 
executed and allows remote administrators to interact with the AIX Domino 
server console. 

The scripts should be owned and executed by user notes. Hence, the scripts 
should have the right file permissions to be executable. Type the command 
/(path where the script resides)/notes_screen to view the Domino server 
console. The size of the output log file will need to be monitored as it can 
grow big in size. 

#!/bin/ksh
# (C) COPYRIGHT International Business Machines Corp. 1985, 1994
# All Rights Reserved
# Licensed Materials - Property of IBM
# US Government Users Restricted Rights - Use, duplication or
# disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
# Setup a few variables
# Who is running this script
Me=‘whoami‘
# What command is being run

 Change / Show Characteristics of an Alog File

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Alog TYPE                                           notes
  Alog File NAME                                     [/server1/log/server.alog] /
  Alog File SIZE                                     [524288]                  #
  VERBOSITY                                          [1]                       #

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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FullCommand=$0
Command=‘basename ${FullCommand}‘

# Where is the Notes data directory
NotesDir="/server1"

# Where is the Notes INI file
NotesINI=${NotesDir}"/notes.ini"

# What directory should we log to
# NotesServerLogDir=${NotesDir}"/logs"

# What login owns the Notes server on this node
if [ -f ${NotesINI} ]
then
        NotesID=‘ls -l ${NotesINI} | awk ’{print $3}’‘
else
        echo "${NotesINI} does not exist.  Cannot run notes here!"
        exit 1
fi

# Make sure we are running as the notes owner
if [ ${Me} != ${NotesID} ]; then
        su - ${NotesID} -c ${FullCommand}
        exit 0
fi

#data_dir=/server1
data_dir=${NotesDir}

# OUTPUT_LOG=${NotesServerLogDir}/server.log
OUTPUT_LOG=/tmp/ausres28.log
#INPUT_FILE=$data_dir"/profile/.notes"
INPUT_FILE=/server1/notes.input
CURRENT_TTY=‘tty‘

if [[ $# -gt 0 ]]; then
   echo "\nSyntax: ${Command}\n"
   echo "This program attaches to the Lotus Notes Server input and output"
   echo "streams so you may interact with the server."
   echo "\nUse ctrl-c to exit the monitor.\n"
   exit 1
fi

function stop_monitor
{
   echo ""
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   echo "Exiting notes monitor..."
   echo ""
   kill -9 $TAILPID
   exit 0
}

PCOUNT=‘fuser $OUTPUT_LOG 2>/dev/null | wc -w‘
if [ $PCOUNT -lt 1 ]; then
   echo ""
   echo "The notes server does not appear to be started.  Monitor 
terminating."
   echo ""
   exit 1
fi

trap "stop_monitor" 1 2 3

echo ""
echo "******************************************************************"
echo "     To exit this monitor enter a <CTRL>-C"
echo "******************************************************************"
echo ""

#tail -f $OUTPUT_LOG | sed ’s/^\>/Notes Monitor>>/’ >> $CURRENT_TTY &
tail -f $OUTPUT_LOG >> $CURRENT_TTY &
TAILPID=$!

while [ 1 -eq 1 ]
do
  CMD=""
  OPT=""
  read CMD OPT
  case $CMD in
       "cls") clear
              echo "" >> $INPUT_FILE ;;
       "CLS") clear
              echo "" >> $INPUT_FILE ;;
     "clear") if [[ "$OPT" = "log" || "$OPT" = "LOG" ]]; then
                 echo "Log cleared on ‘date‘" > $OUTPUT_LOG
                 echo "" >> $OUTPUT_LOG
              fi
              echo "" >> $INPUT_FILE ;;
     "quit")  echo "Are  you sure you want to shut down the Notes server ? 
" >> $OUTPUT_LOG
              echo "enter the command  shutdown   if you mean it " >> 
$OUTPUT_LOG
              echo "enter CNTL-C to exit this log session  " >> $OUTPUT_LOG
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              echo "" >> $OUTPUT_LOG ;;
     "QUIT")  echo "Are  you sure you want to shut down the Notes server ? 
" >> $OUTPUT_LOG
              echo "enter the command  shutdown   if you mean it " >> 
$OUTPUT_LOG
              echo "enter CNTL-C to exit this log session  " >> $OUTPUT_LOG
              echo "" >> $OUTPUT_LOG ;;
     "exit")  echo "Are  you sure you want to shut down the Notes server ? 
" >> $OUTPUT_LOG
              echo "enter the command  shutdown   if you mean it " >> 
$OUTPUT_LOG
              echo "enter CNTL-C to exit this log session  " >> $OUTPUT_LOG
              echo "" >> $OUTPUT_LOG ;;
     "EXIT")  echo "Are  you sure you want to shut down the Notes server ? 
" >> $OUTPUT_LOG
              echo "enter the command  shutdown   if you mean it " >> 
$OUTPUT_LOG
              echo "enter CNTL-C to exit this log session  " >> $OUTPUT_LOG
              echo "" >> $OUTPUT_LOG ;;
     "?")    echo "If you want to shut down the Notes server ? " >> 
$OUTPUT_LOG
              echo "enter the command  shutdown   if you mean it " >> 
$OUTPUT_LOG
              echo "enter CNTL-C to exit this log session  " >> $OUTPUT_LOG
              echo "otherwise just type a Notes server command " >> 
$OUTPUT_LOG
              echo "" >> $OUTPUT_LOG ;;
  "shutdown") echo "quit " >> $INPUT_FILE
              echo "" >> $OUTPUT_LOG ;;
  "SHUTDOWN") echo "quit " >> $INPUT_FILE
              echo "" >> $OUTPUT_LOG ;;
     "CLEAR") if [[ "$OPT" = "log" || "$OPT" = "LOG" ]]; then
                 echo "Log cleared on ‘date‘" > $OUTPUT_LOG
                 echo "" >> $OUTPUT_LOG
              fi
              echo "" >> $INPUT_FILE ;;
           *) echo $CMD $OPT >> $INPUT_FILE ;;
   esac
done
stop_monitor

4.2.1  AIX Command Line Access to the Server Console
You can also view the server console through the AIX command line access 
to the server console.
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A new command cconsole provides a way to access the server console from 
the command line. This feature is supported only in R5 for Unix platforms. 
More details of this can be found under 6.4.1, “Starting Domino Character 
Console” on page 154.

4.3  Monitoring Disk Space on File Systems on the Domino Server

A very important task that an administrator needs to perform is to check free 
disk space periodically on file systems. This process of checking disk space 
can be automated using the script given below and creating a crontab entry to 
run the script at a regular interval.

#!/bin/ksh
# Domino Application Server Disk Space Checking Script
# Licensed Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - This script sends an e-mail message to the administrator if 
# the disk usage of a file system is above the warning threshold specified 
# by the administartor
########################################################################
 
# This script is provided "As Is".
# Run this script only in cron as local root.
#-----------------------------------------------------------
# servername and name of admin will need to be entered below
HOST=$servername
ADMIN=$name of admin"
DATE=$(date +"%b_%d")
LOG=/tmp/$(hostname).df
LOG_DIR=/tmp
att_mark=$1

echo ${att_mark:=90} >/dev/null 2>&1

df -k | tail +2 | sed "s/%//g" | sed "s/$/ $att_mark/" | 
awk ’ 
{($4 >= $8 ) ? warning="WARNING" :warning=""} 

{printf("%-45s: %3s%s %s %s\n", $7,$4,"%","used",warning)} ’ > $LOG # 
contains all file systems

#-----------------------------------------------------------
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# check some file systems
#-----------------------------------------------------------
cat $LOG
if [ -s $LOG ]
 then         #check only /, *var*, /tmp, and /server1
  MESSAGE=$(grep WARNING $LOG | grep -E "/$|var|tmp$|server1")
  if [ $? = 0 ]
   then echo "$MESSAGE\n" | mail -s "CHECK_DF WARNING on Host $HOST" $ADMIN
  fi
 else echo "Could not check_df on ${HOST}" |mail -s "Could not check_df on 
${HOST}" $ADMIN
 exit 1
fi

/usr/bin/rm $LOG

4.4  Lotus Domino Server Shut Down

This section covers the following topics:

  • How to shut down the Lotus Domino Server on server console.
  • How to shut down the Lotus Domino Server on remote console.
  • How to shut down the Lotus Domino Server using AIX commands.
  • How to shutdown the Lotus Domino Server using a shell script.

4.4.1  Shutting Down Lotus Domino Server on Server Console
If you are viewing the Lotus Domino Server console on a screen, just type the 
command exit or quit. It may take 10 seconds or more for the server to shut 
down.

4.4.2  Shutting Down Lotus Domino Server w/ Domino Administrator
Another way to shut down the server is to use the R5 Domino Administrator. 
Follow the steps mentioned below to start the Domino Administrator and shut 
down the server. 

1. Choose File->Tools -> Server Administration... from the Lotus Notes 
Workspace screen to get the Domino Administration screen (Figure 128 
on page 121).
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Figure 128.  Lotus Notes - Domino Administrator

2. Choose the server you want to shut down and select Tools -> Server -> 
Shutdown, or from the menu bar, Server -> Server -> Shutdown.

3. You will be prompted to confirm the shutdown. If you want to shut down 
the server, click on the Yes button. This will shutdown the server.

4. The Domino Administrator will indicate that the server no longer responds.
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4.4.3  Shutting Down Lotus Domino Server Using an AIX Command
At the operating system level, log into the server as user notes, then you can 
use the command server -q to shut down the Lotus Domino Server (assuming 
the directory containing the installation binaries, /opt/lotus/bin, is already in 
your PATH statement).

4.4.4  Shutting Down Lotus Domino Server Using Shell Script
In case you wish to stop the Lotus Domino Server using a shell script, we give 
below the following two shell scripts to be executed for fully accomplishing 
the task. The scripts should be owned and executed by user notes. Hence, 
the scripts should have the right file permissions to be executable. Type the 
command /(path where the script resides)/stop_domino to stop the Domino 
server. 

4.4.4.1  Defining the Environment
This script defines essential parameters for use by the other scripts.

#!/bin/ksh
# Domino Application Server Environment Variable Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - env_domino
#
#      This script makes variable definitions that are common to 

You can also use the remote console to shut down the server and send 
other console commands to a server. Refer to Appendix F in the Lotus Notes 
Administrator’s Guide for additional information on server commands.

Note

If the server is not responding, you have to kill (with -9 signal) the server 
and the child processes. You also have to clean the shared memory and 
semaphores used by the notes user. The script in Figure 293 on page 330 
describes how to kill notes processes and clean shared memory and 
semaphores.

Note
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#      the start_domino, stop_domino scripts
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.

NOTES_USER=notes # AIX userid for this server
NOTES_PATH=/server1 # Path for server data directory
NOTES_SERVER=noteserv # Name of Domino Server
OUTPUT_LOG=/tmp/$NOTES_SERVER.log # Output file for server console
INPUT_FILE=$NOTES_PATH/$NOTES_USER.input # Input file for server console
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH# Ensure PATH is set for 
scripts

4.4.4.2  Stopping the Server
The script below is used to do a complete shutdown of a Domino server. If the 
server does not respond anymore, the script kills the server processes and 
cleans up system resources.

#!/bin/ksh -x
# Domino Server Stop Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - stop_domino
#
# This is the script to STOP the Domino Server which has been started using
# the corresponding script (start_domino).
# The script attempts to QUIT the server gracefully and waits 2 minutes.
#
# If Domino Server has not shut down by then, the plug is yanked.
# Depending on your environment, you may want to change this time-out 
period.
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. /(path of dir where the script exists)/env_domino

# Script Logic
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print "Stopping Domino for AIX ($NOTES_SERVER)"
print " ... waiting for shutdown to complete"
echo " quit " >> $INPUT_FILE
#
#
#
count=0
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
while [[ -n $NOTES_RUNNING ]] ; do
sleep 10
count=‘expr $count + 1‘
echo " ... waiting "$count"0 seconds"
#
# Terminate Domino Server if still running
#
if [ $count -eq 13 ] ; then
   echo "Domino Server is still running after 2 minutes"
   echo " ... now for the ungraceful method"
   for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print 
$2 }’‘; do
     kill -9 $i
   done
   mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ 
print $2 }’ | awk ’{ print $1 }’‘
   sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ 
print $2 }’ | awk ’{ print $1 }’‘
   for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
   for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
   echo "Domino Server ($NOTES_SERVER) TERMINATED"
   exit
fi
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
done
#
echo "Domino for AIX ($NOTES_SERVER) shutdown completed"
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Chapter 5.  Installing the Lotus Domino Administration Client

The Administration Client is a brand new task-oriented administration client 
that brings all of the tools and information required to administer a Domino 
infrastructure within easy reach.

The various areas of concentration are segregated in a tabbed interface to 
aid in navigation and speed of access. This chapter will detail the 
requirements and procedures for the installation of the client on an 
administrator’s workstation.

Although the new R5 administration client is very different to the 
administration panel of an R4.x client, backwards compatibility was a major 
design goal to enable the new administration client to be used successfully in 
a mixed server environment.

5.1  System Requirements

Since there is no client support for AIX in R5, the details given in this chapter 
will relate to the installation of the administration client on the Win32 platform.

The Win32 platform clients require the following machine specification:

  • An Intel Pentium processor or higher
  • Win95/98: 16 MB RAM minimum, 32 MB+ recommended
  • Win NT: 24 MB RAM minimum, 32 MB+ recommended
  • Minimum of 150 MB free disk space for full install

5.2  Pre-Installation Steps

As with any software upgrade, the first and most important step is to back up 
important client files. The main ones are listed in Table 6.

Table 6.  Backing Up Important Client Files

Files Default Location

Notes configuration (notes.ini) Windows directory - e.g. C:\WINNT

Although backwards compatibility is achieved, not all of the new features 
will work when used against an R4.x server, and, in some cases, errors 
may be experienced.

Note
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5.3  Client Software Installation

The client installation has four options:

1. Install all clients
2. Install the Notes client
3. Install the Domino Administrator 
4. Install the Domino Designer

Before starting to install the client, decide whether to install the single 
administration client or all clients on the machine.

The following steps should be followed to perform the installation of the client 
software:

1. For a client upgrade, move the existing notes.ini file from the Windows 
directory into the Notes data directory.

2. Click Start -> Run from the Start menu and type x:\.....\setup.exe in the 
dialog box and then press Enter (where x: is the drive letter of the 
CD-ROM).

3. Click Next and then click Yes to accept the license agreement.

4. Confirm or type in Name and Company details, see Figure 129.

Desktop configuration (desktop.dsk) Notes data directory - e.g. C:\NOTES\DATA

Personal address book (names.nsf) Notes data directory - e.g. C:\NOTES\DATA

User ID files (*.id) Notes data directory - e.g. C:\NOTES\DATA

Local databases (*.nsf) Notes data directory - e.g. C:\NOTES\DATA

Local templates (*.ntf) Notes data directory - e.g. C:\NOTES\DATA

Local database directory links (*.dir) Notes data directory - e.g. C:\NOTES\DATA

Files Default Location

In a Win32 server environment, where the administration client can be 
installed on the server, a Domino Administrator only installation is relevant.

In an AIX server environment, the administration client must be run from an 
administrator’s workstation, and since the administrator is also a user (and 
will usually require designer capabilities), it is easier to install all clients in 
one go using the Install all clients option.

Recommendation
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Figure 129.  Set or Edit User Name and Company Details

5. This is assumed to be a local install on a workstation, not a shared 
fileserver installation, so ensure the Shared Installation option is not 
selected and click Next.

6. Set the Notes program and data directories. If they are incorrect, click the 
appropriate Browse button and choose the required directory, then click 
Next to continue; see Figure 130.

Figure 130.  Choosing Client Program and Data Directories

7. Select either All Clients or Domino Administrator, see Figure 131.
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Figure 131.  Choosing the Client Installation Type

8. To customize the installation options, click on the Customize button, see 
5.3.1, “Customizable Installation Options” on page 129 for further details.

9. Click Next to continue.

10.Choose an existing program folder for the application icons or type in a 
new one and click Next; see Figure 132.
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Figure 132.  Choosing a Folder for the Client Program Icons

11.Click Next to begin the installation of the files.

12.Once installation is complete, restart the workstation if prompted to do so.

5.3.1  Customizable Installation Options
During the installation, an option is presented to customize the items that will 
be installed with the clients. The list of customizable options depends on 
whether the All Clients or Domino Administrator install option is chosen. 
Figure 133 shows some of these options.

Figure 133.  Customizing Client Installation Options
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A tick in the box to the left of the option name means that the option will be 
installed. It may be made up of sub-options, and when clicking on an option, 
the Change button is either available or greyed out depending on whether the 
current option has customizable sub-options. When clicking on the Change 
button, a dialog box is shown, see Figure 134, containing the sub-options that 
can be selected or de-selected as required.

Figure 134.  Changing Sub-Components of an Install Option

A description of the install options and their sub-components is shown in 
Table 7.

Table 7.  Client Installation Components

Component Name Sub-Component Names

Administration Client <None>

Common Data Optional Data Files
Domino Admin
Optional Templates

Designer Client <None>

DECS DECS

Domino Designer Domino Designer Data

Help Administration Guided Tour
Designer Guided Tour
Administration Help
Client Help
Designer Help
Client Guided Tour
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Migration Tools cc:Mail Client Migration Tools
cc:Mail Admin Migration Tools
Calendar Client Migration Tools
Eudora Client Migration Tools
Organizer Migration
Groupwise 4 Admin Migration
Groupwise 4 Client Migration
Groupwise 5 Admin Migration
Groupwise 5 Client Migration
Netscape Admin Migration
Netscape Client Migration
Exchange Admin Migration
Exchange Client Migration
MS Mail Admin Migration
MS Mail Client Migration
LDIF Admin Migration
NT Admin Migration

Notes Data Files Required Data Files
Modem Command Scripts
Icons
Readme

Notes Minder <None>

Component Name Sub-Component Names

Notes Program Files Extended Viewers
Required Program Files
Java Support
Network Drivers
JIT Debugger
Import Export Engine
Client Mail
MS Office Main Integration
Windows System Files

NT Client Single Logon Uninstaller
System Files

Shared Install <None>

Spell Checker International Directories
Chinese Spell Checker
English Dictionaries

Component Name Sub-Component Names
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5.3.2  Client Configuration
The installation may have been performed over an existing client 
configuration, or it may be a brand new setup where there was no previous 
Notes client on the machine. There are additional steps that must be carried 
out if the machine did not have a previous release of the client already 
installed.

5.3.3  Configuration of New Client
Follow this procedure to perform client setup once the installation of the files 
is complete:

1. Click Start -> Programs -> Folder Name -> Lotus Domino 
Administrator.

2. The client will present the Lotus Notes Client Configuration wizard 
welcome screen, see Figure 135, click on Next to continue.

Figure 135.  The Client Configuration Wizard

3. Select the I want to connect to a Domino server option and then click 
Next; see Figure 136.
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Figure 136.  Choosing to Connect to a Domino Server

Select the Set up a connection to a local area network (LAN) option and 
then click Next; see Figure 137.

Figure 137.  Choosing to Connect through a LAN

4. Type in the name of the server to make the initial connection. See Figure 
138 for an example server Server1/IBM. and then click Next.
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Figure 138.  Enter the Server Name

5. Specify whether the Notes ID file has been provided in a file, used in this 
example, or is stored in the Domino Directory.

6. Type in the filename (use the Browse button if necessary to locate the file) 
or the user name. See Figure 139 for an example of user.id and then click 
Next.

Figure 139.  Specifying the User ID File During Client Setup

7. Enter the password for the ID file specified in step 6 and click OK.

8. Click Next to continue; see Figure 140.
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Figure 140.  Completed Client Connection Definition

9. Choose whether an Internet mail account is required; See Figure 141 for 
an example where no Internet account will be set up.

Figure 141.  Choosing Not to Create an Internet Mail Account

10.The Client Configuration Wizard is now complete; See Figure 142. Click 
Finish to end the wizard and complete the configuration.
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Figure 142.  Completing the Client Configuration Wizard

11.A progress indicator, shown in Figure 143, will be displayed showing the 
percentage of setup tasks complete.

Figure 143.  Client Setup Progress Indicator

12.When the setup is complete, click OK to close the last dialog box.

The remaining stages of configuration are the same whether it is a new 
installation or an upgrade of an existing client. Please refer to the following 
section for details of these common steps.

5.3.4  Configuration of an Upgraded Client
All of the settings from a previous notes.ini file will be preserved. When the 
administration client is started for the first time, it will prompt for the current 
ID’s password, and then the following stages must be completed:

1. A bookmark database will be created automatically to store references to 
servers in the domain; see Figure 144.
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Figure 144.  Creating the Bookmark Database

2. The Administration Client Splash screen will be displayed, see Figure 145, 
that has a link called Show me the new R5 Domino Administrator that 
goes to pages of information relating to new functions and features of the 
administration client.

Figure 145.  The Administration Client Welcome Screen

3. To stop this screen from displaying each time the administration client is 
started, click the option Don’t show this help screen again  at the bottom 
of the page.

4. To close the splash screen click on the cross on the right-hand side of the 
window tab labelled Temporary Splash ; see Figure 146.
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Figure 146.  Closing the Administration Client Splash Screen

5. The initial pane of the bookmarks is blank. To see the servers in the 
domain, click on the bookmark tab that looks the one shown in Figure 147.

Figure 147.  Administration Client Servers Bookmark Icon

6. This will display the main bookmark view of the servers in the domain, as 
shown in Figure 148.

Figure 148.  The Administration Client Server Bookmarks

7. To populate the Favorites bookmark pane, right click the mouse on one of 
the servers displayed, and from the popup menu, click on Add Server to 
Favorites as shown in Figure 149.
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Figure 149.  Adding a Server to Bookmark Favorites

8. To customize the administration preferences, click on File -> Preferences 
-> Administration Preferences on the client menu; see Figure 150.

Figure 150.  Setting Administration Client Preferences
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9. The first panel displayed is Basics, see Figure 151, and shows details of 
the domains to be managed. Additional domains other than the current 
specified can be added here along with specific client locations that 
should be used for each of those domains. 

10.The Directory server field entry determines which server the client will 
query for directory details about that domain.

Figure 151.  Administration Preferences - Basics

11.Click on the Files icon to display a panel where the columns of the file 
display can be customized and ordered as shown in Figure 152.
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Figure 152.  Administration Preferences - Files

12.Click on the Monitoring icon to configure specific monitoring details, see 
Figure 153, such as the amount of local memory to use to store monitoring 
information. In addition, servers can be defined to be monitored on a per 
location document basis.

Figure 153.  Administration Preferences - Monitoring

13.Click the Registration icon to configure standard registration details, such 
as registration server and certifier as shown in Figure 154. These will be 
used as defaults for future registration actions.
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Figure 154.  Administration Preferences - Registration

Once these preferences are completed, the client is ready for use to manage 
and monitor the Domino infrastructure.

Additional materia, such as details of specific settings and features, can be 
found in the on-line database entitled Lotus Domino R5 Administration Help.
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Chapter 6.  Simple Admin Tasks

In this chapter, we will describe some simple administration tasks, such as 
creating a new user ID and registering a new server. 

For the majority of administration tasks, you have to launch the Domino 
Administrator first. 

6.1  Choose Other Server in Domino Administrator

One of the most simple administration tasks, and one you will do a lot of 
times, is choosing a server in your Domino Administrator.

6.1.1  Select Server
If you want to change the current server, click on the icon on the left side of 
Domino Administrator showing two servers; see Figure 155.

Figure 155.  Server Icon

A new window will pop up0 showing all servers categorized in different views.

Figure 156.  Listing of All Servers in the Domain

Select the server you want to make changes to in the Domino Directory by 
clicking on the server name.
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6.1.2  Refresh Server List
If you have added a server, and the new server is not in the list, or if the 
server icon is not shown, you have to refresh the server list. You do this by 
selecting Administration -> Refresh Server List. You have to choose 
between Current Domain and All Configured Domains. The server list will 
now be refreshed and the icon shown.

6.2  Registering a User

As in the previous notes release, you can register one person at a time or 
read many user details from a file. In Lotus Domino R5, you can also import 
users from other directory servers. Only the registration of a single user is 
described in this chapter. 

To register a person, follow these steps:

1. In Domino Administrator, choose the desired server.

2. Click on People & Groups.

3. Open the Menu Tools -> People on the right side and click on Register....

4. Choose certifier and enter the certifier password.

5. There are two options: basic and advanced registrations as shown in 
Figure 157. In the normal panels, you can enter Name, Password, and the 
groups.
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Figure 157.  User Registration

If you select the Advanced checkbox, you have more options for each 
user as shown in Figure 158.
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Figure 158.  User Registration - Advanced Options

Because it is most likely that you are using the advanced options, we will 
only describe these.

a. Basics Section:

  • First, you should check the registration server and change it if 
needed.

  • Next, you should enter first and last name.

  • Choose the Password Quality. Longer passwords are more secure. 
eight characters is a good choice if you want to use the password as 
the Internet password as well.

  • Enter the password.

  • Check Set Internet password if the user will have access to the 
Domino Server through the browser client.

  • Enter the Internet address or choose how to create it by pressing 
the Format... button. First and last name separated by a dot is a 
widespread mail-user name.
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Figure 159.  Set Internet Address Format

b. Mail section:

  • First you should choose the Mail system. If you choose Other 
Internet or Other, you have to enter the forwarding address.

  • Choose the Mail server.

  • Choose the Mail file template.

  • Change the Mail file name.

  • Choose the access permissions for the mail file.

  • Set the database quotas and warning threshold if you want to use 
this feature.

  • Choose whether to create the mail database during registration or 
later in the background.
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Figure 160.  User Registration - Mail Section

c. ID Info section:

  • Choose the Certifier ID first.

  • Choose the Security type and the Certificate expiration date.

  • Choose where the created ID file should be stored.

If you only want to create a POP3 or IMAP mail user, deselect both 
locations for storing the user ID. In this case, no Notes Certificate will be 
created for the user ID.

Note
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Figure 161.  User Registration - ID Info Section

d. Groups section:

  • Choose the groups the user should belong to.

e. Click on the Other section:

  • If you have created a User Setup Profile, you can choose it here.

  • Enter additional user information such as Location, Local 
Administrator, and Comment.

  • If you have created an alternate name language you can add an 
alternate name here. For more information about the feature please 
refer to the Lotus Domino R5 Administration Help database.

  • If you have a mixed AIX and Windows NT environment, you can 
register this person in Windows NT by selecting Add this person to 
Windows NT and entering the Windows NT user name and the 
Windows NT group.
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Figure 162.  User Registration - Other Section

6. Press the Add Person button.

7. If you want to add more people, go back to Step 5 on page 144. All user 
details will be added to the Registration Status window.

8. Press Options to set the Advanced Person Registration Options. These 
are:

  • Do not continue on registration errors.

  • Keep successfully registered people in the queue.

  • Try to register queued people with error status.

  • Allow registration of previously registered people.

  • Don’t prompt for a duplicate person (skip registration or update existing 
entry).

  • Don’t prompt for a duplicate mail file (skip registration, generate unique 
mail file name, or replace existing mail file).
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Figure 163.  Advanced Person Registration Options

9. Press Register if you want to register only the selected person, or press 
Register All if you want to register all persons listed in the registration 
queue. The following dialog box should signal the end of the registration 
process.

Figure 164.  Person Registered Successfully Dialog Box

If you need more information about registering people please refer to the Lotus 
Domino R5 Administration Help database.

6.3  Registering a Domino Server

If you want to install an additional Domino server you have to register it first. 
Follow the steps below to register a new Domino server.

1. Start Domino Administrator.

2. Choose the desired registration server.

3. Choose the Configuration tab.

4. Select Server in the left column. This is shown in Figure 165. 
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Figure 165.  Prepare for Domino Server Registration

5. Choose Tools -> Registration -> Server.

6. Enter the password for the current certifier ID.

7. Verify the Registration Server.

8. Select the correct Certifier ID if the current one is not correct. 

9. Select the Security Type.

10.Enter the Certificate expiration date.

Figure 166.  Register a Domino Server

11.Press Continue.

12.In the Basics section:

  • Enter the Server Name.

  • Set the password and the password quality.
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  • Enter the Domain name.

  • Enter the Administrator name.

Figure 167.  Register a Domino Server - Basics Section

13.In the Other section:

  • Enter the server title.

  • Enter the network name.

  • Enter the local administrator.

  • Select whether to store the ID file in the Domino Directory or in the 
local file system. Storing the ID file in the local file system is more 
secure, but you have to give the ID file to the user for setup.

Figure 168.  Register a Domino Server - Other Section

14.If you want to register another server, press Next and repeat starting from 
Step 12 on page 152.
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15.Press Register.

16.After successfully registering the new Domino Server, a dialog box will be 
shown. Press No to end the registration process.

Figure 169.  End of Registration Process

Now, you can install the new Domino server.

6.4  The Domino Character Console

The Domino Character Console is a new Domino feature. It is only available 
on UNIX platforms.

6.4.1  Starting Domino Character Console
The Domino Character Consol is started by changing the current directory to 
the Notes data directory and running /opt/lotus/bin/cconsole. The following 
table shows the command line switches.

Table 8.  Domino Character Console Command Line Switches

For example, to start the console and specify the admin.id as the user ID file 
so that there is no prompt, you would type:

/opt/lotus/bin/cconsole -f /server1/admin.id

and then press Enter. Please make sure that the ID file has appropriate file 
permission. Your notes user has to have read and write permissions.

Switch Result

-f Enter the path and filename of the Notes
ID to be used

-i Allow warnings to be ignored, no response
required

-l Start console with live display already
activated
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6.4.2  Commands
In addition to the usual Domino Server console commands, the character 
console supports a few extra.

Table 9.  Domino Character Console Commands

Command Result

done Exit the console and leave server running

live on Enable live display of console activity

live off Disable live display of console activity
Simple Admin Tasks 155



156 Lotus Domino R5 on IBM RS/6000



Part 2.  Customization and Administration
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Chapter 7.  Domino Enterprise Server

In July of 1998, the Domino Advanced Services license ceased to exist and 
was incorporated into the Domino Enterprise Server (DES) offering. The 
logical features provided by the DES license remain unchanged; however, R5 
provides additional functionality in some areas.

The Domino Enterprise Server features consist of:

  • Partitioning: See 7.4, “Domino Server Partitioning” on page 162

  • Clustering: See 7.5, “Domino Server Clustering” on page 173

  • Billing: See 7.6, “Domino Server Billing” on page 201

The Domino Enterprise Server enables sites to exploit Lotus Domino and 
Lotus Domino service providers to make their service more reliable and 
scalable, better manageable and secure, and allows for more detailed and 
customized usage tracking for billing their services.

For details regarding high availability and scalability in this book, refer to 
Chapter 11, “High Availability, Scalability, RS/6000 SP” on page 317.

Additional material on Clustering and Partitioning can be found in the 
following locations:

  • The redbook High Availability and Scalability with Domino Clustering and Partitioning 
on AIX (SG24-5163-00)

  • The Domino Cluster Zone at http:/www.lotus.com/cluster.
  • The following Iris Today articles at http://www.notes.net

  • Workload Balancing with Domino Clusters (Michael Kistler - IBM)
  • Fine Points of Configuring a Domino Cluster (Michael Kistler - IBM)
  • The Domino Internet Cluster Manager (Lori Fucarile - Lotus)

7.1  Domino Enterprise Server Lab Environment

Table 10 shows the naming conventions used for the partitioned servers 
running in the lab environment on the host itsosmp.itsc.austin.ibm.com.

Table 10.  Partitioned Server Lab Parameters

Partition Domino Server Name AIX Account Name Data Directory Names

1 Server1/IBM notes1 /server1

2 Server2/IBM notes2 /server2
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Figure 170 shows the lab environment that was used for testing server 
partitioning and the relevant server details.

Figure 170.  Partitioned Server Lab Environment

7.2  File System Requirements

The creation of logical volumes and file systems has already been covered in 
detail in the following sections of this redbook:

  • 2.2.9, “Step 9 - Create a Logical Volume for the Domino Data Directory” on 
page 28

  • 2.2.11, “Step 11 - Create a File System for the Domino Data Directory” on 
page 32

  • 2.2.13, “Step 13 - Mount the File Systems” on page 35
  • 2.2.14, “Step 14 - Change Ownership of the New File Systems” on page 

36

ausres27

dbell

itsosmp
Server1/IBM
9.3.187.210

Data = /server1
User = notes1

Server2/IBM
9.3.187.209

Data = /server2
User = notes2

Partitioned servers with
individual IP addresses

Win32 R5 Client

Server3/IBM
9.3.240.4
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The only additional requirements relate to the use of multiple partitioned 
Domino Servers on a single physical machine. 

Since each partitioned server requires its own data directory file system, the 
procedures detailed in the sections of the redbook listed above must be 
repeated for each partitioned server prior to the start of any software 
installation so that the multiple required file systems are generated.

7.3  Domino Enterprise Server Installation

All of the enterprise features are installed at the same time by selecting a 
particular type of server installation. This preliminary step is defined here as it 
is a common prerequisite to all of the configurations discussed later in the 
chapter. In effect, some configuration may be required before this step is 
reached, for instance, in setting up multiple file systems for partitioned 
servers.

The installation steps are described in detail in Chapter 2, “Installing a Lotus 
Domino R5 Server” on page 15; so, only details that differ from a standard 
installation are shown in this section.

After the license agreement has been accepted, the next question asks which 
type of server installation is required. Press the Spacebar until the selection 
is Domino Enterprise Server (Figure 171) and then press the Tab key.

Figure 171.  Selecting the Domino Enterprise Server Installation Type

Choosing this option ensures that the additional program and data files 
needed for the Domino Enterprise Server features are installed.

===============================================================================
                         Domino Server Installation
===============================================================================
 

    Select the type of installation you want.
 

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Select Setup type : [Domino Enterprise Server]
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7.4  Domino Server Partitioning

This section covers the installation and configuration of multiple Domino 
Servers on a single machine. Partitioned servers share the same binary files, 
and hence, run at the same version but have individual data directories that 
allow for independent configuration of resources.

There are several reasons for implementing partitioned servers.

1. To reduce operating system and hardware limiting factors.

Multiple Domino partitions make more efficient use of server resources 
than a single server instance as certain processes can be run in parallel.

2. Segregation of server tasks on a single machine.

For example, a mail server and application server can have individually 
tuned tasks but run on the same hardware.

3. Segregation of independent user communities.

For example, hosting multiple Domino domains or Domino-hosted web 
sites on a single machine.

4. Independent operation of services and resources.

Partitions operate independently and do not have any effect on each 
other.

This allows an administrator the flexibility to treat each partitioned server as 
though it were a separate system.

7.4.1  Planning a Partitioned Server Deployment
The following are basic guidelines to help plan a partitioned server 
deployment:

  • The limit of six supported partitioned servers on one system has been 
removed in Domino R5; available system resources is the limiting factor.

  • Partition identifiers are based on the server data directory names and 
these should be unique especially in an HACMP-managed environment.

  • Each additional partitioned server should have an additional 128 MB of 
memory; depending on the expected number of concurrent users, it may 
be necessary to increase this value.

  • A minimum of 200 MB disk space for each separate data directory must be 
allocated.
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  • As a rule of thumb, use one or two Central Processing Units (CPUs) per 
partition but not more than one partition per CPU in any one system. 

  • Use the TCP/IP protocol as this is the only supported configuration for 
Domino Enterprise Server R5 services.

  • Partitioned servers can share a single network interface card or can use 
multiple network interface cards. 7.4.4, “Configuring TCP/IP for Partitioned 
Servers” on page 168.

  • Each partitioned server requires disk space for its own Lotus Domino data 
directory file system.

  • A partitioned server may be a member of a cluster; however, it is 
recommended that the other Lotus Domino servers in the cluster be 
located on other systems.

7.4.2  Installing Partitioned Servers
After choosing to install a Domino Enterprise Server, as shown in 7.3, 
“Domino Enterprise Server Installation” on page 161, the following additional 
steps must be carried out.

1. At the question Do you want to run more than one Domino Server on this 
computer ? press the Spacebar to change the answer to Yes and then 
press Tab.

Figure 172.  Choosing to Run Multiple Server Partitions

2. Press the Enter key to edit the number of data directories and type in the 
number required (one per partition) and then press Enter.

===============================================================================
                         Domino Server Installation
===============================================================================
 

    You can run more than one Domino Server on a single computer 
    at a time.  This feature is called Domino Partitioned Servers.
 

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you want to run more than one Domino Server on this computer ?  [Yes]
Domino Enterprise Server 163



Figure 173.  Setting the Number of Server Partitions

3. Press Tab to continue.

4. The install routine will then ask whether to generate data directory path 
names automatically. The default is Yes.

5. Press the Spacebar to change the answer to No and then press Tab.

===============================================================================
                         Domino Server Installation
===============================================================================

 
    Each Domino Partitioned Server requires its own data directory.

    How many Domino Partitioned Server data directories 
    would you like to install ?

 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Number of data directories current setting : 5

Number of data directories new setting     : 2

Manually specify the data directories since file system mount points will 
already have been created and may not match the default names.

Consider associating the name of the server with the mount point of the file 
system for clarity and ease of administration.

Recommendation
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Figure 174.  Choosing To Manually Generate Partitioned Data Directory Names

6. A default path will be presented. Press Enter to edit this and type in the 
required name, for example /server1, and then press Enter.

===============================================================================
                         Domino Server Installation
===============================================================================

    The install program can generate path names for the individual
    data directories by appending the numbers 1 through 2 to a 
    base path name you supply.

    If you do not want the path names to be generated, you will be 
    prompted for them each individually.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you want install to generate the pathnames for you ? [No ]

The file used to identify the partition number for the server, 
.sgf.notespartition, is no longer used in R5. Instead, the partition name is 
based upon the data directory name; so, data directory names should be 
unique.

For example, a data directory name of /server1 generates a partition 
identifier of .server1.

Note
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Figure 175.  Changing the Name of the Partitioned Data Directory

7. Press Tab to continue.

8. Repeat steps 6 and 7 for each partitioned server until all directory names 
have been entered. Notice the screen display in Figure 175 shows how 
many data directories have been entered and the total number being 
installed.

9. Continue the installation process as normal noting that only one AIX user 
account can be specified at this time. The first of the set of accounts 
created specifically for the purpose (see 2.2.7, “Step 7 - Create AIX Users” 
on page 26) should be used.

10.Manual configuration is required once the install routine has completed; 
see 7.4.3, “Manual Configuration of File Ownership” on page 167 for 
details.

11.At the final review screen (Figure 176 on page 167), review the data 
directory names listed to ensure that they are unique.

===============================================================================
                         Domino Server Installation
===============================================================================

    Enter the pathname for data directory 1 of 2.

-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current path : /local/notesdata

New path     : /server1 
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Figure 176.  Reviewing Installation Settings for Partitioned Servers

12.Once satisfied that this is correct, press Tab to perform the installation.

7.4.3  Manual Configuration of File Ownership
Since the install routine allows only one user account to be specified, all 
partitioned data directories are installed with reference to this one account.

The ownership of each set of data files must be changed except for those in 
the first data directory. The ownership of the files in the first data directory 
should be set correctly using the user name specified during install. In this 
example, it was notes1.

To change the ownership of subsequent data directories, use the chown 
command. For example, to change the ownership of all files in /server2 to be 
notes2:notes, enter the following command at an AIX command prompt and 
then press Enter.

chown -R notes2:notes /server2/*

This will change all files in /server2 and any subdirectories located under that 
file structure.

===============================================================================
                         Domino Server Installation
===============================================================================
Installation settings:

    Installation type    : Domino Enterprise Server

    Program directory    : /usr/domino/lotus
    Data directories     : /server1
                           /server2
    UNIX user name       : notes1
    UNIX group name      : notes

Press the Escape key to re-configure the settings
  or
Press the Tab key to perform the installation...

For ease of administration, for example, identification of the owner of 
processes, each partitioned server should run using a different UNIX user 
account name. 

Recommendation
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7.4.4  Configuring TCP/IP for Partitioned Servers
There are two ways to configure partitioned servers for TCP/IP network 
access. You can:

  • Use unique IP addresses--one unique IP address for each partitioned 
server (recommended).

  • Use unique TCP/IP port numbers--one unique port number for each 
partitioned server that shares an IP address.

7.4.4.1  Using Unique IP Addresses
By using unique IP addresses, all TCP/IP services can be accessed through 
standard port numbers, for example, each POP server can be accessed 
through port 110. Multiple IP addresses can be defined on one Network 
Interface Card (NIC), or each IP address can be assigned to a single NIC 
depending on the network topology and capacity required.

For the purposes of the lab environment, multiple IP addresses were bound 
to a single token-ring network adapter.

1. Assign a unique IP address to each partitioned server; see Figure 170 on 
page 160.

Use the ifconfig command to assign additional IP address aliases to the 
chosen network adapter. For example, to assign the IP address 
9.3.187.209 to the token ring card in itsosmp.itsc.austin.ibm.com, type the 
following command at an AIX command prompt while logged in as the root 
user:

ifconfig tr0 alias 9.3.187.209 netmask 255.255.255.128

where the netmask parameter is the required IP subnet mask.

2. Type ifconfig tr0 and press Enter to confirm that the alias has been 
assigned (Figure 177).

Figure 177.  Checking Network Interface IP Address Assignments

3. Make sure that name resolution is set up properly, either using DNS or 
client hosts files, so that the planned server name can be resolved to the 
correct IP address.

4. Make sure that all IP addresses map to the correct network interface card.

[root@itsosmp:] / # ifconfig tr0
tr0: flags=e0a0043<UP,BROADCAST,RUNNING,ALLCAST,MULTICAST,GROUPRT,64BIT>
        inet 9.3.187.210 netmask 0xffffff80 broadcast 9.3.187.255
        inet 9.3.187.209 netmask 0xffffff80 broadcast 9.3.187.255
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5. Use the hostname of each server as its server name during Lotus Domino 
Server setup. For example, for the partitioned server with the hostname 
server1.itsc.austin.ibm.com, use the server name server1/ibm.

6. Edit the notes.ini file of each partitioned server to include the line

TCPIP_TcpIpAddress=0,IPaddress:1352

where TCPIP is the port name as specified in the server document of the 
Domino Directory in the Network Configuration section, and IPddress is the 
TCP/IP address of the specific partitioned server.

7. For example, for the server server1/ibm:

TCPIP_TcpIpAddress=0,9.3.187.210:1352

and for server2/ibm, the newly added alias from the example in step 1:

TCPIP_TcpIpAddress=0,9.3.187.209:1352

8. Edit the server document in each partitioned server Domino Directory to 
include the host names in the Network Configuration section of the 
server’s document.

7.4.4.2  Using Unique TCP/IP Port Numbers
You can use TCP/IP port mapping to configure multiple partitioned servers to 
share the same network interface card and the same IP address. TCP/IP port 
mapping requires that you assign a unique IP port number to each partitioned 
server that shares the IP address, and assign one of these servers to be the 
port mapper server.

The port mapper server’s role is to dispatch (map) incoming IP requests to 
the appropriate server. It must be running for the partitioned servers that 
share its IP address to receive new connections from workstations. If the port 
mapper server is down, new sessions cannot connect. Existing sessions, 
however, remain connected. Also, each client maintains a cache of recent 
server connections requiring redirection by the port mapper. This means the 
clients can still reach other partitioned servers if the requested server 
connection information is in the cache.

To provide higher availability for partitioned servers, you can set up the first 
partitioned server to function only as a listener/port mapper (not a customer 
server). This reduces the chance of failure by the first partitioned server but 
causes additional overhead as you need one partition only for port mapping.

To reduce resource use for a dedicated port mapper server, you can remove 
all the ServerTasks from your notes.ini to minimize the number of server 
processes. You can also remove large databases (such as the help database) 
Domino Enterprise Server 169



from the data directory for this server. Do not remove the Domino Directory 
from this server.

For details of how to configure using TCP/IP port numbers refer to the Lotus 
Domino R5 Administration Help database.

7.4.5  Considerations for Internet Server Tasks
On a partitioned server, you have to specify additional parameters for the 
tasks HTTP, IMAP4, POP3, LDAP, NNTP, and for the SMTP MTA.

7.4.5.1  Considerations for HTTP
If you plan to use the HTTP task for multiple partitions, you have to ensure 
that each server responds only to requests for its own particular IP address. 
This is achieved by enabling a technique called binding where each server is 
told explicitly to only accept requests for a specified host name or IP address.

For each partitioned server, edit the server document and then perform the 
following steps.

1. Switch to the Internet Protocols-HTTP tab.

2. Enter the IP address or fully qualified host name of the server in the field 
labelled Host name(s).

3. Change the value of the field Bind to host name to Enabled.

Port mapping works only for Notes to Domino NRPC communication; it 
does not work for the Internet protocols, such as HTTP and LDAP. Each of 
these services must be configured through the server document to use 
unique non-standard TCP/IP port numbers. These port numbers must then 
be made available to users wishing to connect clients to those services.

Note
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Figure 178.  Enabling Bind to Host Name for HTTP Task

4. If the HTTP task is running, then stop it and restart it to enable the change.

7.4.5.2  Considerations for IMAP4, POP3, NNTP and LDAP
If there are multiple network adapters in the server, the following entries must 
be added to the notes.ini file for these tasks to run in a partitioned server 
environment for the respective protocol:

  • IMAPAddress=<IP address or fully qualified hostname>

  • LDAPAddress=<IP address or fully qualified hostname>

  • NNTPAddress=<IP address or fully qualified hostname>

  • POP3Address=<IP address or fully qualified hostname>

7.4.6  Starting and Stopping Partitioned Servers
Each server must be started in such a way that it runs with a unique AIX user 
account identifier and uses its own data directory.
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If the server startup is performed through a scripted startup routine, as in 
4.1.3, “Starting the Lotus Domino Server Using a Startup Script” on page 
106, then each server must have its own unique script.

7.4.6.1  Handling a Partitioned Server Failure
Partitioned server shutdowns and failures do not affect other partitioned 
servers that run on the same computer. If one server shuts down, the others 
continue to run. The setting KillProcess=1 should be present in the notes.ini 
file of each partitioned server (or in a server configuration document) 
enabling automatic clean up of all of the processes associated with a 
partitioned server. With this default setting, you can restart a failed partitioned 
server without restarting the machine, but you have to make sure to clean up 
the interprocess communication resources (shared memory and 
semaphores) before restarting the server. See 12.1, “Cleaning Lotus Domino 
Processes” on page 327 for more details.

7.4.7  Tuning Partitioned Server Memory Usage
The parameter NSF_Buffer_Pool_Size may or may not have been specified 
for a machine running a single server partition. In R5, it is recommended that 
it is not specified manually for single instance servers. It should always be 
specified for partitioned servers as the physical memory in the machine has 
to be shared between multiple servers instead of just one.

If each AIX user has a separate .profile file defining a unique PATH 
environment variable, then it is safe to edit each .profile and add the 
particular Domino Server data directory for that user to the path statement.

If a generic profile is used by all AIX user accounts then do not add any data 
directories to this path.

Recommendation

If each AIX user has a separate .profile file defining a unique PATH 
environment variable, then it is safe to edit each .profile and add the 
particular Domino Server data directory for that user to the path statement.

If a generic profile is used by all AIX user accounts,then do not add any data 
directories to this path.

Create one script per server and ensure that the correct user account and 
data directory are referenced in each script.

Recommendation

By running each partition with a separate AIX user account, finding 
processes, shared memory, and semaphores relating to a specific server is 
a much simpler task.

Note
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Figure 179.  Specifying NSF_Buffer_Pool_Size for Partitioned Servers

7.5  Domino Server Clustering

Multiple Domino Enterprise Servers can be interconnected to provide high 
availability, scalability, and load balancing to Lotus Notes users and browser 
clients (HTTP and HTTPS requests). This is achieved by placing multiple 
replicas of some or all databases onto different servers within the cluster. 
Subsequently, transparent failover or load balancing can redirect the open 
request for a database on a broken or overloaded server to another member 
of the cluster. These clustered servers should be interconnected through a 
sufficiently high-data transfer bandwidth network to allow for the tight 
real-time synchronization between the databases in the cluster; in LAN 
environments, a minimum of LAN speed but usually up to FDDI, ATM or 
FastEthernet; in RS/6000 SP environments, the SP switch is commonly used.

While clustering affords the benefits discussed below, it is important to 
remember that it adds extra complexity to the domain and additional 
administrative responsibilities that are not apparent in non-clustered 
environments.

The main advantages of clustering are:

  • High availability

See Chapter 11, “High Availability, Scalability, RS/6000 SP” on page 317 
and the redbook High Availability and Scalability with Domino Clustering on AIX 
(SG24-5163) for more information.

Use the following formula to calculate the value of NSF_Buffer_Pool_Size 
that should be specified for each partitioned server:

(Physical RAM / No. of partitions) / 4

Recommendation

A common misconception is that there is an upper limit of six member 
servers in any one cluster. This is not a hard limit, but a guide, and can be 
exceeded provided that the server resources and server-to-server network 
interconnections can support the synchronization traffic.

However, a cluster with more than six member servers is not officially 
supported by Lotus.

Note
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  • Scalability - growing the cluster to accommodate more users

The clustering strategy also offers the advantage of gradual, scalable 
growth. It is easy to add another server to the cluster to share the growing 
workload. Clusters allow for a heavily used database to be distributed over 
several servers to balance the client requests. Replication in a cluster 
provides almost real-time synchronization of databases; however, some 
caveats do apply (see 7.5.2, “Cluster Replication versus Scheduled 
Replication” on page 175). As a cluster scales to contain more servers, an 
administrator can migrate users from one machine in the cluster to 
another. But, keep in mind to plan your requirements carefully and do 
consider the overhead clustering causes as well as the additional 
administration effort.

  • Load balancing within the cluster

Clustering allows for the efficient use of server resources and better user 
response times. An administrator can balance the workload across all 
servers in the cluster by adjusting the availability threshold of each server. 
Through its load balancing and failover capabilities, the cluster software 
shifts users attempting to access a database on a loaded (busy) cluster 
member to a tightly synchronized replica on an available cluster member. 
It will not shift users that already have a database opened at that server.

7.5.1  How Many Servers Should a Cluster Contain?
A requirement to cluster many servers usually results in the question:

Should you have a small number of large clusters (five or six servers) or a large number of 
small clusters (two or three servers) ?

While there is no easy way to say one or the other, and no hard and fast rules 
apply, take the following consideration into account.

If a server in a cluster fails, then its workload must be absorbed by its peers in 
the cluster. For a two node cluster, this means that each server must have the 
capacity to handle an additional 50 percent workload, or, in other terms, they 
each run normally at 50 percent of their capacity. This is wasteful of 
resources. For a cluster of six servers, each of the other five servers need 
only cope with an additional 20 percent workload; so, they can in fact run at 
80 percent of their total capacity under normal conditions.

This argument also applies to disk capacity since each database needs at 
least one other replica in the cluster to make it highly available.
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7.5.2  Cluster Replication versus Scheduled Replication
There are some important feature differences between the event-driven 
cluster replicator and the usual schedule-driven replicator. 

7.5.2.1  Cluster Replicator Caveats
The following is a list of reasons for configuring regular schedule-driven 
replication in addition to running the cluster replicator task.

  • Although it is possible to disable cluster replication for databases, more 
than likely they will still need to replicate but not in real-time. For example, 
template updates still need to replicate.

  • Cluster replication events are held in memory only, and if a source server 
is shutdown before pushing these changes to other members, then the 
real-time replication event is lost. No data is lost, but the change will not 
propagate until the next scheduled replication.

  • Cluster replication ignores all selective replication formulas due to the 
overhead of computing what may turn out to be a complex formula. As a 
result, all changes are replicated whether they match a selective 
replication formula or not. The standard replicator may then revert these 
changes back to honor the replication formula being used.

  • The cluster replicator pushes changes to other servers that have a replica 
of the changed database, but it does not update other replicas on its own 
server. A situation may arise where a server hosts more then one replica 
of a database, and it may seem perfectly reasonable to have two replicas 
on a server if one is a selective replica. In this scenario, scheduled 
replication must be used to keep the two replicas synchronized.

Design elements, deletions, and access control list settings enabled or 
disabled through the Advanced section of a database’s replication 
settings dialog box are implemented as a selective replication formula.

Cluster replication will propagate all design, deletions, and ACL changes 
regardless of these settings.

Note

When there are multiple replicas of a database on a server, the Cluster 
Manager uses "failover by pathname to select the replica for a user to 
open in a failover situation. So, if there are multiple replicas of a 
database on a server, make sure path names (directory path and file 
name) are consistent on all servers in the cluster.

Note
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  • In R4.x, when one of the servers in a cluster fails, the cluster replicators 
on the other servers queue replications that must be pushed to that server 
and periodically check for the server to become active again. In Domino 
R5, the cluster replicator detects servers rejoining the cluster much more 
rapidly, usually within a minute or two, and so the delay in updates to a 
failed server that may have been noticed in an R4.x environment should 
no longer be an issue.

Regular and frequent scheduled replication is the solution to all of the above 
issues.

Each time a server starts, it performs any due or overdue replications. With a 
replication set for every 60 minutes and always enabled, if a cluster server 
has been down for more than 60 minutes, when it restarts, it immediately 
replicates with the other servers in the cluster.

Finally, to allow clients to experience a consistent set of database features 
regardless of the server they access in the cluster. The cluster replicator and 
the scheduled replicator both propagate private folders.

7.5.2.2  Replication with Servers Outside of the Cluster
One of the benefits of Domino clusters is that they can help simplify a 
replication topology, and at the same time, improve its reliability and 
performance. This is because Domino allows you to configure a server 
outside the cluster to effectively replicate with all servers in the cluster using 
a single Server Connection document that specifies the server outside the 
cluster as the source and the cluster name as the target server of the 
replication. When a server replicates with a cluster, any databases on the 
server that also have a replica on any server in the cluster will replicate. 
Databases do not have to be on the same server in the cluster. If more than 
one replica of a database exists in the cluster, Domino replicates with one 

Enable scheduled replication 24 hours a day, seven days a week at an 
interval of 60 minutes.

Recommendation

Private folders can only be accessed by the creator or a server within a 
cluster. Only servers defined by a server or server group entry type in the 
database ACL can access and replicate the private folders within the 
database.

Note
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replica, and cluster replication propagates the changes to the other replicas. 
The server that initiates the replication does not have to be a Domino 
Enterprise Server but must be running Release 4.6.3b or higher.

Replication with a cluster is also more reliable since Domino replicates with 
any server in the cluster that has a replica of the database. So, if one server 
in the cluster is unavailable, replication can continue as normal as long as all 
databases on the unavailable server also reside on another server in the 
cluster. Furthermore, when replicating with a cluster, Domino uses its 
workload balancing mechanisms to choose the target servers so that 
replication performs as quickly as possible.

7.5.3  Domino R5 Clustering Enhancements
Enhancements have been made to the operation of R5 clustered servers to 
support the following features not previously available:

  • Failover and load balancing for Web clients

  • Free-time calendaring and scheduling lookup

  • Synchronous new mail agents that execute regardless of host server

  • Type-ahead addressing and address resolution

  • Synchronised unread marks across cluster replicas

7.5.4  Private LAN Configuration
By configuring the servers in a cluster to communicate through a separate 
dedicated network segment, three benefits are immediately realized.

1. Maximized bandwidth availability, solely for the use of the cluster servers.

2. Client-server and server-server traffic are isolated and have dedicated 
adapter cards.

3. Redundancy of connectivity within the cluster since each server has two 
physical network connections.

If the configured port for intra-cluster communication becomes 
unavailable, then the servers can use information from the Domino 
Directory to determine a backup port on which to continue 
communication.

NoteNote
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A typical configuration would consist of each server having two network 
adapter cards, each connected to a separate network segment (Figure 180). 
Each cluster member must use an identical set of ports.

Figure 180.  Dual Network Cluster Server Connectivity

The IBM RS/6000 SP is particularly well suited for this type of server 
configuration since the intra-cluster traffic between server nodes can be 
directed over the SP’s internal High Performance Switch (HPS). Current 
implementations of this switching architecture give a bi-directional throughput 
of 300 MBytes/sec. The only external LAN traffic is then communication 
between a client and server.

Each adapter should be configured with its own individual IP address and be 
connected to the appropriate network segment.

The following steps can be carried out to set up the second network segment 
for use by the clustered Domino Server.

1. Start the administration client and select the cluster server from the 
bookmarks.

2. Click on the Server tab.

3. Click on the Server tools pane on the right hand side and an entry labelled 
Setup Ports should be visible as shown in Figure 181.

Cluster Server 1

Cluster Server 2

9.3.187.x

9.3.187.y 10.a.b.d

10.a.b.c

Cluster
Replicator
and Probes

Client
Traffic

Private LAN
10.a.b

Public LAN
9.3.187
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Figure 181.  Setting Up a New Server Port

4. The familiar port configuration dialog box should be displayed as shown in 
Figure 182.

Figure 182.  Server Port Configuration

5. Click on New, type in a name for the port, for example Cluster, and choose 
the TCP protocol and then click OK.
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Figure 183.  Creating a New Network Port

6. Click OK again and then a new port definition will be made in the notes.ini 
file on the server.

7. Edit the notes.ini file for each server and add the following lines (examples 
shown are based on Figure 180 on page 178 and using ports named 
TCPIP and Cluster):

TCPIP_TcpIpAddress=0,9.3.187.x:1352
Cluster_TcpIpAddress=0,10.a.b.c:1352
Server_Cluster_Default_Port=Cluster

8. Edit the server document.

9. Click on the Ports tab.

10.Enter the name of the new port (example Cluster), a Notes Named 
Network entry (example Cluster Network), and the IP address.
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Figure 184.  Adding a Cluster Port Entry on the Server Document

11.Close and save the document.

12.The server must be restarted for this port change to take effect.

13.Once the server is started, issue the show cluster command at the Domino 
Server console to ensure that the cluster replicator is using the specified 
port for cluster traffic. Check the port name at the end of the line starting 
Server cluster default port.

Figure 185.  Output of the Show Cluster Command

7.5.5  Configuration of a Cluster
The conceptual ideas behind clustering are discussed in detail in other 
redbooks and articles mentioned at the beginning of this chapter; so, only R5 
specific configuration methods will be described here.

> show cluster
Cluster Information
 Cluster name: ITSO, Server name: Server3/IBM
 Server cluster probe timeout: 1 minute(s)
 Server cluster probe count: 220
 Server cluster default port: Cluster
 Server availability threshold: 0
 Server availability index: 100 (state: AVAILABLE)
 Cluster members (2)...
        server: Server4/IBM, availability index: 100
        server: Server3/IBM, availability index: 100
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7.5.5.1  System Requirements
The following points should be observed prior to setting up servers for 
clustering:

1. Prepare for the cluster by ensuring consistent protocol usage on existing 
servers; only TCP/IP is supported in R5.

2. Determine database distribution in the cluster and acquire sufficient 
storage for the existing and new servers. You would replicate application 
databases for load balancing and/or high availability and mail databases 
only for high availability.

3. Ensure each server was installed with the Domino Enterprise Server 
installation type (see 7.3, “Domino Enterprise Server Installation” on page 
161). Servers do not have to have the same Lotus Domino version, but 
they must be part of the same domain. 

4. Make sure that an Administration Server is specified in the Advanced section 
of the access control list of the Domino Directory before trying to create a 
cluster.

5. In a private LAN configuration, ensure that appropriate network adapter 
cards have been installed, configured, and connected to the correct 
network segments.

7.5.5.2  Creating the Cluster
Using an administration client, open the replica of the Domino Directory 
database on the server specified as the Administration Server for the domain.

The following procedure can now be executed to generate the cluster.

1. Click on the Configuration tab.

2. Expand the Server section in the left-hand pane.

3. Click on All Server Documents.

In a mixed-release cluster, all R4.x servers must be upgraded to R4.6.3b 
as this will be the required minimum for clustering with R5 servers.

Note

Using the replica of the Domino Directory on the server designated as the 
Administration Server means that requests do not have to be replicated 
between servers in the Administration Requests database before they can 
be actioned.

Recommendation
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4. Highlight (select) the servers that will be in the cluster that you are about 
to create.

5. Click on the Add to Cluster action button (see Figure 186).

Figure 186.  Selecting Servers to Create a Cluster

6. Confirm that the action should continue by clicking Yes in the Verification 
dialog box (Figure 187).

Figure 187.  Confirm Creation of a Cluster

7. For new clusters choose the *Create New Cluster option and click OK or 
choose the appropriate existing cluster name (Figure 188).

Figure 188.  Choosing or Adding a Cluster Name
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8. Type in the name of the cluster and click OK (Figure 189).

Figure 189.  Creating a New Cluster Name

9. Decide whether the cluster should be created immediately or through the 
administration process and click the appropriate button as shown in Figure 
190.

Figure 190.  Create Cluster Immediately or through Administration Process

10.If the choice in step 9 was Yes, then a confirmation dialog, such as that 
shown in Figure 191, should be displayed when the process is completed.

Figure 191.  Confirmation of Cluster Creation

11.If the choice in step 9 was No, then a dialog box, such as that shown in 
Figure 192, should be displayed, and the following extra steps are 
needed.

Figure 192.  Confirm Submission of Admin Request to Create Cluster
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12.Opening the Administration Requests database should reveal an Add Server 
to Cluster document for each server selected. An example is shown in 
Figure 193.

Figure 193.  Add Server to Cluster Administration Request

13.When the changes in the Domino Directory replicate to the servers who 
are now members of the cluster. The Cluster Administration task, cladmin, is 
started on each server.

14.Then the Cluster Directory task, cldbdir, will start and create the Cluster 
Directory Database (cldbdir.nsf). Example server console output is shown 
in Figure 194.

Figure 194.  Cluster Directory Task Startup

02/03/99 11:18:39     Cluster Database Directory started
02/03/99 11:18:42     Opened session for Server3/IBM (Build 164)
02/03/99 11:18:42     Starting replication with server Server3/IBM
02/03/99 11:18:42     Unable to replicate cldbdir.nsf
02/03/99 11:18:44     Pulling names.nsf from Server3/IBM names.nsf
02/03/99 11:18:48     Finished replication with server Server3/IBM
02/03/99 11:18:52     Created database Cluster Database Directory: cldbdir.nsf
02/03/99 11:18:55     Cluster Replicator started
02/03/99 11:18:58     Finished initialization of Cluster Database Directory
02/03/99 11:18:58     Replicating Cluster Database Directory with Server3/IBM
02/03/99 11:18:59     Opened session for Server3/IBM (Build 164)
02/03/99 11:18:59     Starting replication with server Server3/IBM
02/03/99 11:18:59     Pulling cldbdir.nsf from Server3/IBM cldbdir.nsf
02/03/99 11:19:00     Finished replication with server Server3/IBM
02/03/99 11:19:08     Cluster Administration Process shutdown
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15.The entries cldbdir and clrepl will be added automatically to the 
ServerTasks= line of the notes.ini file so that they start automatically on 
each server restart.

16.Before continuing, stop the cluster replicator clrepl and cluster directory 
cldbdir tasks on each member server of the new cluster with the 
commands tell clrepl quit and tell cldbdir quit, respectively.

The cluster creation is now complete, but there are some additional tasks that 
must be carried out to improve the operation of the cluster. These should be 
done before allowing the servers to replicate but are not critical.

7.5.5.3  Modifying the Contents of the Cluster Directory Database
When the cluster directory manager task creates the cluster directory 
database (cldbdir.nsf), it populates it with every database (*.nsf) and template 
(*.ntf) it can find in the server’s data structure.

Figure 195.  A New Cluster Directory Database

Many databases and templates do not need to be replicated in real-time, and 
if they are left enabled, impose an overhead (albeit a small amount per 
database) on the operation of the cluster.
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The cluster directory databases are replicas on each server in any given 
cluster, and hence, each server replica will contain a list of all databases and 
templates on all servers available on the clustered servers once the servers 
have replicated with each other.

7.5.5.4  Removing a Server From a Cluster
Using an administration client, open the replica of the Domino Directory 
database on the server specified as the Administration Server for the domain.

The following procedure removes a server from a cluster:

1. Click on the Configuration tab.

2. Expand the Cluster section in the left-hand pane.

3. Click on Clusters.

4. Highlight (select) the servers that will be removed from the cluster.

5. Click on the Remove from Cluster action button (see Figure 196).

Use the action Tools -> Disable Cluster Replication of Selected 
Databases to disable cluster replication of non-critical databases and 
templates.

The action Tools -> Enable Cluster Replication of Selected Databases 
can be used at any time to re-enable particular entries.

Recommendation

Whenever a new database or template is added to a cluster server, an 
entry will be placed in the Cluster Directory database, and it will be enabled 
by default and may have a corresponding replica on other cluster 
members.

Remember to check whether this new database or template has a replica 
on another cluster member, and if it does, decide whether they really need 
to be cluster replicated and disable them if they do not.

Note
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Figure 196.  Removing a Server from a Cluster

6. Confirm that the action should continue by clicking Yes in the Verification 
dialog box.

Figure 197.  Confirm Removal of Server from Cluster

7. Decide whether the server should be removed immediately or through the 
administration process and click the appropriate button as shown in Figure 
198.

Figure 198.  Remove Cluster Immediately or through Administration Process

8. If the choice in step 7 was Yes, then a confirmation dialog like that shown 
in Figure 199 should be displayed when the process is completed.
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Figure 199.  Successful Removal of Server from Cluster

9. If the choice in step 7 was No, then a dialog box, such as that shown in 
Figure 200, should be displayed.

Figure 200.  Submission of Admin Request to Remove Server from Cluster

10.The cluster processes clrepl and cldbdir will be stopped on the server, 
and the entries removed from the ServerTasks= line in notes.ini.

11.The database entries in the Cluster Directory database (cldbdir.nsf), for 
databases on the server being removed, will be purged from the replica 
copy on the least busy of the remaining cluster servers.

12.The local Cluster Directory database will be deleted from the server that is 
being removed from the server.

7.5.6  NOTES.INI File Settings
There are several notes.ini variables that are required to tune or modify the 
behaviour of clustered servers.

Table 11 shows the relevant notes.ini variables and their purpose.

Table 11.  Clustering Specific notes.ini Variables

Variable Name Purpose

Server_Cluster_Default_Port The default port on which to send/receive all 
intra-cluster server-to-server communications.

Server_Restricted Disable acceptance of new client connection 
requests.

Server_MaxUsers In a load-balancing scenario, set a limit to the number 
of concurrent client connections to the server.
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Details of specific values can be found in the Lotus Domino R5 Administration Help 
database.

7.5.7  Mail Delivery Failover
Mail cluster failover is a process that allows a router on one server to deposit 
mail into a replica of a user’s mail database that resides on a clustered server 
other than the home server specified in a person document.

To achieve this, the field Cluster failover on the 
Router/SMTP-Advanced-Controls tab of a server configuration document 
must be set. An example is shown in Figure 201.

Figure 201.  Enabling Mail Cluster Failover

This configuration document must be set for all members of the cluster and 
for all servers that route mail to servers in the cluster. For example, a mail 

Server_Availability_Threshold A threshold set to determine when a server is
considered busy; new requests will fail over to another
cluster member when the threshold is reached.

MailClusterFailover Enable router delivery failover to another replica of a
user’s mail database when the home server is
unavailable.

RTR_Logging Enable cluster replication event logging.

Variable Name Purpose
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routing hub may not be a member of a cluster, but since it may route mail for 
delivery to clustered servers, it must also have a configuration document to 
enable failover. The default value is Enabled for last hop only and allows a 
router to fail over delivery on the final hop of a message route only. To always 
allow fail over at any point in the routing of a message, the setting Enabled for 
all transfers in this domain should be used instead.

7.5.8  Calendaring and Scheduling Support
In previous releases of Domino, when a client failed over to a server other 
than the home server, it was not possible to perform a free-time lookup for 
any user when their home server was unavailable, because the only copy of 
the busy time database containing their information existed on that failed 
server.

With Domino R5, a version of the free time database that can be replicated 
between cluster members resolves the problem so that full calendar 
scheduling support can be provided in times of particular server failure.

When the schedule manager task sched starts up on a server that has 
become a member of a cluster, a new busy time database is created that can 
be replicated across cluster members. If an original busytime.nsf database 
exists, then this is deleted first, and the information is recreated in the new 
database. 

The reverse process is executed when a server is removed from a cluster. 
The sched task deletes the clubusy.nsf database and recreates a standard 
busytime.nsf. Each of the servers remaining in the cluster purge the deleted 
information from their replica copies of clubusy.nsf.

7.5.9  The Internet Cluster Manager (ICM)
The ICM is the task that manages failover and load balancing of Web client 
requests for data stored on clustered Domino Enterprise Servers. ICMs can 
be deployed in four main configurations; a single ICM inside or outside of the 
cluster or multiple ICMs inside or outside of the cluster.

Each ICM is dedicated to one and only one cluster; however, one cluster can 
be supported by multiple ICM’s and the ICM server must belong to the same 
domain as the cluster.

The new cluster-wide free time database has a filename of clubusy.nsf.

Note
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The ICM can be used to broker client requests in a mixed-release cluster; 
however, since R4.x Domino Servers cannot reference the ICM in the URLs 
they return. Load balancing of requests cannot be achieved. When a client is 
redirected to a cluster member that is not R5, all subsequent requests for 
data will be sent to that server until failover or redirection to another server 
through a specific URL link occurs. Individual requests will not be load 
balanced across the other member servers in a mixed release cluster.

The characteristics of the ICM are end-to-end security and authentication. 
Whatever authentication method is required for access to protected data 
served through HTTP or SSL connections, the ICM will preserve those 
connection types. All requests to the ICM are anonymous; that is, there is no 
authentication between the Web client and the ICM. Once the ICM has 
received a request and has decided where that request can be best fulfilled, it 
sends a redirection response code and target server details back to the Web 
client, and a connection is made directly between the client and the specified 
server. At this point, any authentication controls maintained by the target 
clustered server will be obeyed.

Although no authentication exists between the client and ICM, the transport of 
requests between the two can be protected through SSL encryption.

Since no authentication takes place at the ICM, protecting it from 
unauthorized access is best served by implementing a firewall.

7.5.9.1  ICM Outside of the Cluster
Figure 202 shows the way that a server running the ICM task can front-end 
traffic destined for clustered Web servers. As was said previously, multiple 
servers running the ICM could be used with incoming requests being 
balanced between them using techniques such as round-robin DNS (where 
the same hostname is used for all instances of the ICM). 
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Figure 202.  Running the ICM Outside the Cluster

In this scenario, the server is running solely to provide the ICM, and by 
removing all redundant services (such as the mail router and schedule 
manager), the server will be able to concentrate its resources into responding 
to Web client requests.

7.5.9.2  ICM Inside the Cluster
Figure 203 shows the way that a server that is already a member of a cluster 
can host the ICM task. Once again, multiple cluster members could be 
configured to run the ICM with incoming requests being balanced between 
them using techniques such as round-robin DNS.

Domino Enterprise
Server 1

Domino Enterprise
Server 2

Domino Enterprise
Server 3

Domino Enterprise
Server with ICM

Domino Cluster

Browser

Browser

ICM

Remove all unnecessary tasks from a server dedicated to running an ICM 
task to improve stability and performance of the server.
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Figure 203.  Running the ICM Inside the Cluster

7.5.9.3  Configuring a Server to Provide ICM Services
Whether the ICM server is inside or outside of the cluster, the configuration is 
essentially the same. Differences will be highlighted where appropriate. 

Start the administration client and select the server that will run the ICM from 
the bookmarks:

1. Click on the Configuration tab.

2. Click on the Server section in the left-hand pane.

3. Edit the server document.

4. Click on the Server Tasks-Internet Cluster Manager tab, and the form 
shown in Figure 204 on page 195 will be visible.

Domino Enterprise
Server 1 with ICM

Domino Enterprise
Server 2

Domino Enterprise
Server 3

Domino Cluster

Browser

Browser

ICM
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Figure 204.  Configuring ICM in the Server Document

5. In the Cluster name field, enter the name of the cluster that this ICM will 
support (if the server is a member of the cluster, this can be left blank).

6. If the ICM will share the IP address of the server, then skip to step 10.

7. Create a new Notes port definition, with a name of ICM for example, in a 
similar way to that described in steps 1-12 of 7.5.4, “Private LAN 
Configuration” on page 177.

8. Add the following entry in the notes.ini file:

ICM_TcpIpAddress=0,a.b.c.d

assuming the new port name created in step 7 was ICM.

9. Enter the Notes port name in the field ICM Notes port.

10.If SSL connections are required, specify the keyring file name in the ICM 
SSL keyfile field.

11.Ensure that browsing is not allowed.
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12.Choose whether the ICM for this server should use this server document 
for its configuration or whether it should use another server document.

13.If the option another server document is chosen, then the form will 
present a field named Obtain ICM configuration in which a server name 
should be entered.

14.Enter the fully-qualified hostname that clients will use to connect to the 
ICM. This can either be a registered DNS name (recommended) or an IP 
address.

15.The TCP/IP port number need only be changed if the ICM is running on a 
cluster member that already has HTTP enabled, and no spare IP address 
is available. See 7.4.4.1, “Using Unique IP Addresses” on page 168 for 
details regarding assigning IP address aliases, as the same method 
applies as was used to install partitioned servers.

16.Unless all traffic between clients and the ICM requires encryption, the field 
TCP/IP port status should be left enabled.

17.To specify a non-standard SSL port number (where a single IP address 
may be in use, and the HTTP server already uses SSL) enter a new port 
number in the SSL port number field.

18.Change the SSL port status field value to enabled if SSL is required 
between client and the ICM.

At first glance, this may seem a strange option to provide. Why would 
an ICM on this server not use its own server document?

The reason for allowing the ICM on one server to use the configuration 
of another ICM is so that multiple ICMs serving one cluster can share 
the same configuration more easily.

Note

Providing the ICM with its own IP address is much simpler than sharing 
a single IP address, as standard TCP/IP port definitions can be used.

If a separate IP address is assigned to the ICM task, ensure that the 
HTTP task is bound to its specific IP address only (see 7.4.5.1, 
“Considerations for HTTP” on page 170 for details on setting this up).

This is not an issue when the ICM is running on a dedicated server 
outside of the cluster.

Recommendation
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19.Close and save the server document.

20.Edit the notes.ini file of the server on which the ICM will run.

21.Add the entry ICM to the end of the ServerTasks= line.

7.5.10  Monitoring Cluster Processes
General information about a server in a cluster can be found using the show 
cluster command at the server console. Details of the cluster name, 
availability thresholds, and other other servers in the cluster are shown. An 
example of this has already been seen in Figure 185 on page 181.

Logging of cluster replication events is disabled by default since they are, by 
nature, large in volume. Logging should be turned on only when problems are 
suspected, and tracking information is required.

To enable logging, add the line RTR_Logging=1 to the notes.ini file of the server 
to be logged.

7.5.10.1  Cluster Servers
To determine whether the intra-cluster (server-to-server) traffic is performing 
at optimum levels, use the statistics shown in Table 12. They do not appear 
on the normal cluster statistics reports but can be seen using the show stat 
command on the server console.

Table 12.  Intra-Cluster Traffic Statistics

Statistic Name Description

Replica.Cluster.Successful Number of successful replications since server 
startup.

Replica.Cluster.Unsuccessful Number of unsuccessful replications since 
server startup.

Replica.Cluster.SecondsOnQueue.Avg Average time in seconds that database spent on 
work queue.

Replica.Cluster.SecondsOnQueue.Max Maximum time in seconds that database spent 
on work queue.

Replica.Cluster.WorkQueueDepth Current number of databases awaiting 
replication by the cluster replicator.

Replica.Cluster.WorkQueueDepth.Avg Average work queue depth since server startup.

Replica.Cluster.WorkQueueDepth.Max Maximum work queue depth reached since 
server startup.
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The value indicated by Replica.Cluster.SecondsOnQueue.Avg shows the 
average amount of time taken for changes made on this server to be pushed 
to the other cluster members. A value of 60 or less means all changes are 
reaching the other servers within one minute of the change occurring.

The Replica.Cluster.WorkQueueDepth.Avg depends upon the number of 
databases on the server and the volatility of the data contained in them. 
Typically, this value should be consistently below 15, and values higher than 
this may indicate that the network bandwidth is restricting the server’s ability 
to push changes to the other cluster members.

If the cluster servers are not using a separate private network for intra-cluster 
replication, then moving to this topology should resolve this problem.

When load-balancing is implemented in a cluster, the statistics shown in 
Table 13 can be monitored to determine whether the workload is well 
balanced.

Table 13.  Workload Balancing Statistics

7.5.10.2  ICM Servers
The statistics shown in Table 14 can be used to monitor the general use and 
performance of the ICM task.

Table 14.  General ICM Statistics

Statistic Name Description

Server.AvailabilityIndex The current value of the availability index.

Server.Cluster.OpenRedirects.LoadBalance.Successful Number of times a busy server successfully 
redirects to another server.

Server.Cluster.OpenRedirects.LoadBalance.Unsuccessful Number of times a busy server 
unsuccessfully redirects to another server.

Server.Cluster.OpenRequest.ClusterBusy Number of times a busy server tries to 
redirect a request when all other servers are 
busy.

Server.Cluster.OpenRequest.LoadBalanced Number of times a client tried to open a 
database on this server when the server 
was busy.

Statistic Name Description

ICM.Command.Total The number or URL commands received.

ICM.Command.Unknown The number of unrecognized URL 
commands.
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7.5.11  Managing Databases in a Cluster
Within the administration, clients choose the server to work with from the 
bookmarks and then select the Files tab to display the databases and 
templates on the chosen server.

The following steps change the characteristics of one or more databases:

1. Select the files from the list using the Shift or Ctrl keys as appropriate to 
make multiple selections.

2. Right-click the mouse on one of the selected files.

3. Click on Cluster from the popup menu as shown in Figure 205.

ICM.Command.Redirects.Successful Number of successful client redirects to a 
cluster member.

ICM.Command.Redirects.Unsuccessful Number of unsuccessful client redirects to 
a cluster member.

ICM.Command.Redirects.ClusterBusy Number of client requests received when 
all cluster members were busy.

ICM.Command.Redirects.Per1Hour.Total Number of requests received in the past 
hour.

ICM.Command.Redirects.Per1MinuteTotal Number of requests received in the past 
minute.

ICM.Command.Redirects.Per5MinutesTotal Number of requests received in the past 
five minutes.

Statistic Name Description

Statistic Name Description
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Figure 205.  Selecting Databases for Cluster Management

4. Choose the appropriate action from the Cluster Management dialog box, 
an example is shown in Figure 206, and then click OK to carry out the 
action.

Figure 206.  Choosing a Cluster Management Action

The available options are:

  • Out of Service

The database cannot be accessed, and client requests are failed over to 
another replica in the cluster.

  • In Service

To make a previously out of service database available again.
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  • Pending Delete

Mark database for deletion only after all active user sessions have 
completed.

7.6  Domino Server Billing

The billing activity of a server provides an enterprise with additional data to 
enable it to perform several tasks.

  • Charge for usage of servers.
  • Monitor usage trends.
  • Conduct resource planning.

When enabled, the server collects client and server activity information and 
places the information in the billing message queue. Periodically, the billing 
process takes this data and writes it to disk creating records that can be 
reviewed and used for the tasks described above.

The billing process on a Domino Enterprise Server consists of two major 
components:

1. Lotus Domino Server enabled for billing: The server provides billing 
information according to seven billing classes (see below).

2. The Lotus Domino billing task collects the information provided by the 
server and generates billing records stored either in a database 
(billing.nsf), a binary file (billing.nbf), or both.

7.6.1  Billing Classes
The BillingClass setting in notes.ini controls which of the seven allowed 
billing classes are to be tracked as shown in Table 15 below.

Table 15.  Billing Classes

Billing Class Tracks

Session When users and servers start or end sessions with a billing server, 
and when network-related activities such as document creation and 
editing, occur during the session. It also includes client-initiated 
replication and mail events.

Database When users and servers open and close databases and duration of 
use including mail delivery events.

Document Read and write activity for specified documents. The document form 
must contain a hidden field named $ChargeRead or $ChargeWrite 
that has a cost value in it.
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See the Lotus Domino R5 Administration Help database for further details.

7.6.2  Enabling the Billing Process
To enable billing on a server, either the notes.ini file can be edited directly, or 
the settings shown below can be specified through the NOTES.INI Settings tab 
of a server configuration document.

  •ServerTasks=...,Billing

To enable the billing task at server startup

  •BillingClass=<all or some of the classes defined in Table 15>

The list of billing class events that are to be tracked

  •BillingAddInWakeup=seconds <default = 60>

How often the billing tasks processes items in the billing message queue

  •BillingAddInRuntime=seconds <default = 10>

The amount of time that the billing task will execute after wakeup

  •BillingSuppressTime=minutes <default = 15>

The frequency of record stamping during session and database activities if 
those classes are specified by BillingClass

  •BillingAddInOutput=value

Replication When a billing server initiates replication with another server. It does 
not include cluster replication events.

Mail When the mail router on a billing server transfers mail to another 
server.

Agent When users and servers run server-based agents on the billing 
server, as well as the execution time of the agents, but does not 
include agents executed on Web servers.

HTTPRequest When a billing server responds to a Web browser request.

Billing Class Tracks

This value must be greater than the value specified for 
BillingAddinRuntime .

Note
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Determines where the records will be stored or displayed according to the 
following table.

Table 16.  Locations for Billing Records

As an example, assume we want billing to be active for Mail, Replication and 
Web, and to start generating records every 10 minutes for 2 minutes and log 
to a binary file, we would specify in notes.ini:

ServerTasks=...,Billing
BillingClass=Mail,Replication,HttpRequest
BillingAddInWakeup=600
BillingAddInRuntime=120
BillingAddInOutput=8

7.6.3  Optimizing Billing Performance
During times of peak usage, if system performance is an issue, reduce the 
frequency with which the server posts session and database activity 
information on the billing message queue by increasing the BillingSuppressTime 
parameter.

In addition, the billing load can be reduced by running the billing task less 
frequently (increase BillingAddInWakeup) and/or shortening the amount of 
execution time that it is allowed (reducing BillingAddInRuntime).

Finally, multiple billing tasks can execute in parallel to transfer records from 
the billing message queue to the chosen storage location. For example, to 
enable two billing tasks to run on a server, specify the following line in 
notes.ini:

ServerTasks=......,Billing,Billing

Value Location

1 Notes database (billing.nsf)

2 Server console

3 Notes database and server console

8 Binary file (billing.nbf)

9 Both database and binary file

10 Binary file and server console

11 Database, binary file and server console
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7.6.4  Sample Billing Records
This section contains samples from the billing.nsf database only, since the 
binary file billing.nbf cannot be displayed. Notes API programs must be used 
to produce reports based on the contents of the binary file.

The standard billing database does not provide any totalling across 
documents listed in the views of the database. For better analysis, records 
should be categorized and totalled to provide at-a-glance totals and 
sub-totals of relevant numeric indicators, such as document read and write 
charges.

7.6.4.1  Session Billing
Session billing collects information of the data volume of a certain user 
session that indicates who has transferred how many bytes.

Figure 207.  Sample Session Billing Document

7.6.4.2  Database Billing
Database billing delivers two types of records (DBOpen and DBClose), which 
allow tracking of how long a database has been in use by a certain user and 
how long it has taken to actually perform the open and close actions.
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Figure 208.  Sample Database Billing Document

7.6.4.3  Document Billing
Document billing shows a read or write charge associated with documents 
that contain either the $ChargeRead or $ChargeWrite hidden fields.

Figure 209.  Sample Document Billing Document

The value stored in $ChargeRead or $ChargeWrite is interpreted as whole 
currency units.

For example, assuming a currency denomination of US dollars, a numeric 
value of ten in these fields is translated and displayed as $10.00 in the 
views of the billing database.

Note
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7.6.4.4  Replication Billing
Replication billing offers information on which servers exchanged data during 
replication, how much data for which database, and when the replication 
occurred.

Figure 210.  Sample Replication Billing Document

7.6.4.5  Mail Billing
Mail billing indicates which mail has been routed where, who created it, the 
size, and the recipient.

Figure 211.  Sample Mail Billing Document
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7.6.4.6  Agent Billing
Agent billing allows tracking of the time an agent executed on the server, 
which database it acted on, and who started the agent.

Figure 212.  Sample Agent Billing Document

7.6.4.7  HTTP Request Billing
HTTP Request billing provides extensive information about which objects 
have been retrieved from the Web server, the time elapsed to fulfill the 
request, the user who retrieved the data, the number of bytes retrieved, and 
the IP address of the client system.
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Figure 213.  Sample HTTP Request Billing Document
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Chapter 8.  Lotus Domino R5 and the Internet

The tasks described in this chapter are mostly not RS/6000 specific. 
Therefore, only the major topics are described to provide a general overview 
and to help you get them up and running. We will not go deep into all the 
Internet features except if there is something RS/6000 specific, but we will 
provide references that will help you getting into details.

8.1  Lotus Domino Web Server

One of the major tasks of Lotus Domino R5 is the HTTP task. It brings 
together the world of Lotus Notes and the World Wide Web. The HTTP task 
can be used to publish Lotus Notes databases to the Internet. It can also be 
used like a simple HTTP daemon, which means you can use publish flat 
HTML files to the Internet, and it can also run Client Gateway Interface (CGI) 
scripts or programs.

Whenever you want to change the settings of the Domino Web Server, you 
have to follow these steps first:

1. Start the Domino Administrator.

2. Choose the Server you want to reconfigure. If you do not know how to 
choose a server, please refer to 6.1, “Choose Other Server in Domino 
Administrator” on page 143.

3. Choose the Configuration tab.

4. Choose Server -> All Server Documents.

5. Double click on the Domino Server you want to change or select the 
server and click on Edit Server.

Whenever running the HTTP task on a Lotus Domino R5 server, remember 
that all databases on this server can be accessed through the Internet 
unless they are protected.

You will have to make sure that the ACLs of all databases are set 
appropriately. You should add the Anonymous user to every database and 
assign the appropriate access permission to this user.

Note
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Figure 214.  Web Server Configuration

8.1.1  Setting up a Domino Web Server
To setup a Domino Web server click on Ports -> Internet Ports in the server 
document. The Web tab should be selected by default. In the section SSL 
settings, you can choose the key file and other SSL settings. We will cover all 
security related topics in 9.5, “Secure Sockets Layer (SSL)” on page 259.

To enable the Web server, you have to choose the TCP/IP ports you want 
your server to use. It is best to use the default port 80 for the non-secure Web 
server and port 443 for the secure Web server. The secure server will not run 
until you create a server certificate.

Next you should go to Internet Protocols -> HTTP. In this section, you should 
at least make the following changes:

  • Enable logging to log files or to Domlog.nsf if you want to create statistics 
telling you about, for example, who, how much, and which pages were 
accessed on your Web server.

  • If you have chosen Log files, then you have to choose a Directory for log 
files. We recommend to create a logical volume for the log files. If you 
have a lot of hits on your Web server, you might get several megabytes of 
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log files per day. You should also choose which log files you want to be 
written. If you do not need, for example, the agent log, just empty the field.

  • In the Mapping section, you should customize the Home URL. It should be 
either a notes database or an HTML file.

Figure 215.  HTTP Server Setup

If you need further information, please refer to the Lotus Domino R5 Administration 
Help data base.

8.1.2  Starting, Stopping, and Refreshing the Domino Web Server
There are two ways to start the Domino Web server. You can start it by 
entering load http at the server console, or you can start it at Lotus Domino 
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R5 start-up by adding it to the ServerTasks in notes.ini. By default, the HTTP 
task is added to the notes.ini file. 

To stop the Web server, enter tell http quit at the server console or remove 
http from the ServerTasks in notes.ini and restart the Domino server.

Type tell http restart at the server console to refresh the Web server.

8.1.3  Lotus Domino Virtual Web Servers
Starting with Lotus Domino R5, all Web server settings are made in the 
Domino Directory. Select the server document and choose Action -> Web 
and the appropriate sub panel. While there is a database template for 
creating a domino configuration database domcfg.nsf as in the previous 
versions, you should use the domino directory to do so. If you need any 
information about how to use domcfg.nsf, please refer to the redbook Lotus 
Domino Release 4.6 on IBM RS/6000, SG24-4694-02.

There are some enhancements to the configuration of Web servers you might 
have missed in the previous versions. Now you can:

1. Create Virtual Servers and Host

2. Create URL Mappings and Redirections

  • URL to URL

  • URL to Directory

  • Redirection URL to URL

3. Create File Protection

4. Create Realm

The difference between a virtual server, and a virtual host is that virtual 
servers have different IP addresses and different hostnames while virtual 
host are using the same IP address but different hostnames.

Prior to installing a virtual server, you have to change the network setup, and 
prior to installing a virtual host, you have to change your DNS settings (see 
8.1.3.2, “Changing DNS Setup” on page 213). Although both types could 
co-exist, you should either use virtual servers or virtual hosts.

8.1.3.1  Network Setup
Assuming the basic IP setup has already been done using the network 
interface tr0, you now have to add additional IP addresses to be used by your 
virtual server. This has to be done with the ifconfig command, which may be 
placed into the file /etc/rc.net to be automatically activated on system 
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start-up. The screen shot below refers to this setup. The network interface tr0 
now has three IP addresses.

Figure 216.  IP Aliasing

8.1.3.2  Changing DNS Setup
There is one very good reason to use multiple machine names instead of 
multiple IP addresses. You can run out of IP addresses, but you will never run 
out of names. 

The normal way of getting the DNS settings updated will be writing a note to 
the DNS administrators. However, you might be your own DNS administrator. 
Go to the directory containing the DNS files and open the DNS data file. The 
only thing you have to do is to go to the entry for your machine running Lotus 
Domino R5 and add one line for each alias name. Do not forget to update the 
Serial number in the first line of your data file. Without this update, the 
changes won’t take effect even after you restart the DNS server.

Figure 217.  DNS Entry for Name Aliasing

Restart the DNS server using the command refresh -s named. 

If you do not use DNS on your network, you have to change the /etc/hosts file 
on any system that might want to access the virtual Web server. You will have 

# hostname
itsosmp
# host itsosmp
itsosmp.itsc.austin.ibm.com is 9.3.187.210
#/usr/sbin/ifconfig tr0 alias 9.3.187.220 netmask 255.255.255.0
#/usr/sbin/ifconfig tr0 alias 9.3.187.221 netmask 255.255.255.0
# netstat -i
Name  Mtu   Network     Address            Ipkts Ierrs    Opkts Oerrs  Coll
lo0   16896 link#1                            4049     0     4049     0     0
lo0   16896 127         localhost             4049     0     4049     0     0
lo0   16896 ::1                               4049     0     4049     0     0
tr0   1500  link#2      10.0.5a.c9.7c.f1    468252     0   315434     0     0
tr0   1500  9.3.1       itsosmp.itsc.aust   468252     0   315434     0     0
tr0   1500  9.3.1       itsosmp1.itsc.aust 468252 0   315434     0     0
tr0   1500  9.3.1       itsosmp2.itsc.aust 468252     0   315434     0     0
# 

itsosmp in A 9.3.187.210
;these are the names used for virtual Web servers
itsosmp1 in CNAME itsosmp
itsosmp2 in CNAME itsosmp
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to add the alias name to the line assigning an IP address to your Domino 
server.

Figure 218.  Setting Alias Names in /etc/hosts File

8.1.3.3  Create Virtual Servers or Hosts
If you want to create a Virtual Server or Host, you have to select Actions -> 
Web -> Create Virtual Servers from menu bar. Now you will be asked 
whether you want to create a Virtual Host or a Virtual Server (see Figure 
219).

Figure 219.  Creating Virtual Host

Choose Virtual Host. Creating a virtual server is pretty much the same 
except you will be asked for the IP address instead of the hostname.

Figure 220.  Virtual Server

# this is the old entry
#9.3.187.210 itsosmp
# added virtual Web server names
9.3.187.210 itsosmp1 itsosmp2
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In the Mapping tab, you can specify the path names mapping to the HTML 
directory, the Icon directory, the CGI directory, and the home URL. This tab is 
the same for both server types.

Figure 221.  Virtual Server Mapping

The Security tab lets you make some security settings for your virtual 
servers. You can decide if Name and password and/or anonymous 
authentication can be used. You can also customize the SSL settings. For 
more information, please refer to 9.5, “Secure Sockets Layer (SSL)” on page 
259.
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Figure 222.  Virtual Server Security

8.1.3.4  Create URL Mappings
There are three different types of URL Mappings. Depending on your choice, 
you will get three or four tabs to configure the Mapping.

1. URL to URL mapping enables you to define an alias name for URL paths. 
For example, you could map /gifs to /images.

Figure 223.  URL to URL Mapping

2. URL to Directory Mapping: This enables you to specify which URL path 
should be mapped to which real directory on your server. For example, if 
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you have all the images you are using in your Web pages in a directory 
/web/images, you have to create a directory mapping /web/images to /gifs 
to be able to access these pictures through the Internet.

Figure 224.  URL to Directory Mapping

3. Redirection URL to URL. Using this, you can move pages to a different 
server without making the old URL invalid.

Figure 225.  Redirection URL to URL

In each choice, you have to specify in the Site Information tab which virtual 
server is affected by this mapping. In the Mapping tab, you have to specify the 
actual mapping. 

If you have defined a URL to directory mapping, you will also have to specify 
if your data can only be read or if it should be executable.
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8.1.3.5  Create File Protection
One of the things really missing in Domino Release 4.x is the ability to protect 
flat files. In Lotus Domino R5, this can be done by choosing Actions -> Web 
-> Create File Protection. This ability might be needed in mixed 
environments where you have some data in the Notes databases and other 
data in flat files. These protection settings apply to all Web servers on a Lotus 
Domino R5 server. 

Figure 226.  File Protection - Basic Setting

You can only grant access to users specified in the server’s Domino 
Directory, even if you are allowed to enter any user. You assign these 
permissions by pressing the Set/Modify Access Control List button in the 
Access Control tab. 
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Figure 227.  Access Control for File Permissions

There are three access levels you can assign to a user:

1. Read/Execute access (GET method)

2. Write/ Read/ Execute access (POST and GET method)

3. No Access

Figure 228.  Access Control List for File Protection

In the Name field, you can specify the user name by typing or by using the 
Domino Directory lookup. After assigning the appropriate access permission, 
you have to press the Next button to apply this user to the Access Control 
List. To remove a user, click on the name and press Clear.
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8.1.3.6  Create Realm
Also new in Lotus Domino R5 is the ability to set a realm in the browser 
authentication dialog. The browser uses the realm to determine which 
credentials (username and password) to send with the URL for subsequent 
requests. If you want to grant users access to different directories without 
having to reauthenticate, you should define a realm for them. You do this by 
choosing Actions -> Web -> Create Realm.

Figure 229.  Creating a Realm

8.1.3.7  Domino Web Server Application Programming Interface
The Lotus Domino R5 http task provides a C API for writing extensions. It’s 
called Domino Web Server Application Programming Interface (DSAPI). 
Using DSAPI, you can evaluate events that occur in the Web server. For 
example, an authentication request or access to a URL. DSAPI programs are 
built as shared libraries. A DSAPI program runs using the server id. This 
means it has the same access permission granted to the Lotus Domino R5 
server. DSAPI is available on all server platforms. For further information, 
please refer to the Release Notes: Domino Server R5 database in the doc directory 
of each Lotus Domino R5 server.

8.2  Internet Cluster Manager

To use the Internet Cluster Manager, you will have to set up the Domino 
Enterprise Server. All you need to know about it is covered in 7.5.9, “The 
Internet Cluster Manager (ICM)” on page 191.
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8.3  Server Web Navigator

The Server Web Navigator could be compared to a Proxy server. A Notes 
client can access Web pages through the Server Web navigator without 
having access to the Internet itself. The Server Web Navigator loads a Web 
page from the Internet and stores it in a Notes database called web.nsf that is 
automatically created at the first start of the Web retrieving process. If a client 
requests a page that is already in web.nsf, the Server Web Navigator sends it 
directly to the client.

There are two options to start the Server Web Navigator. You can run the 
command load web at the server console, or you simply add web to the 
notes.ini ServerTasks line. It will automatically be started at each Lotus 
Domino R5 server restart.

To stop the Server Web Navigator simply enter tell web quit at the console.

If you want to connect to servers on the Internet through a firewall, you have 
to specify a proxy or socks server. You can do this from the Domino 
Administrator by clicking on the Configuration tab and opening the Server 
document for Web Navigator server. Choose the Ports -> Proxies tab. 
Please keep in mind not to use IP addresses in the No proxy for these hosts 
and domains section. You can use wildcards. For example, *.ibm.com would 
mean that all addresses in the domain ibm.com will be accessed directly.
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Figure 230.  Server Proxy Settings

8.4  Lotus Domino R5 Web Administration Tools

You can administer your Lotus Domino R5 server using a normal Web 
browser by accessing the Web Administrator’s database (webadmin.nsf). 
Lotus Domino R5 creates this database at the first start of the http task. 
Domino assigns a unique replica ID to this database. It, therefore, cannot be 
replicated between servers. The Web Administrator uses several system 
databases. If one database is missing, the Web Administrator does not show 
the associated command. 

Perform the following setup steps:

1. Add the names of the Lotus Notes users or group going to administer the 
server to the access control list (ACL) of webadmin.nsf as Managers with 
the ServerAdmin, ServerMonitor, DatabaseAdmin, FileRead, and 
FileModify roles.

2. Add the names of the Lotus Notes users or group going to administer the 
server from a browser field in the Security tab of the server document in 
the Domino Directory.

3. Add the names of the Lotus Notes users going to administer the server to 
the Run restricted LotusScript agents field in the Agent Manager section 
of the server document in the Domino Directory.
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4. Make sure that each User has an Internet Password set in their Person 
document.

5. You can further refine access to the Web Administration tool by allowing 
administrators to access only a subset of the available Web Administration 
commands by modifying the ACL.

Figure 231 shows an example of what the Web Administration pages look 
like.

Figure 231.  Web Administration Example
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8.5  Messaging

One of the major changes between Lotus Domino Release 4.x and R5 took 
place in the messaging component. Starting with Lotus Domino R5, the 
Simple Mail Transfer Protocol (SMTP) and the Multipurpose Internet Mail 
Extension (MIME) are native to Notes. There is no special SMTP message 
transfer agent (SMTP MTA) any more. If you selected SMTP during the Lotus 
Domino R5 server setup, you are ready to send messages to the Internet.

8.5.1  Setting up Notes Messaging
If you are running a stand-alone Domino Server, and you have selected 
SMTP at server installation, you are able to send mail to other users on your 
server and Internet mails to any Internet host you can reach on your network. 

If you are sending a mail through SMTP, the Domino Server looks up the 
user’s Person record in the Domino Directory for the Internet Mailing address. 
If there is no Internet Address specified, Domino can be configured to create 
the Internet address as Domino 4.6 servers did.

If you have not configured the SMTP at server installation, the following 
chapter will tell you how to do it manually. After making the described 
changes, you should either shut down your server or stop and restart the 
router task to activate the changes.

To stop the mail router task, type in tell router quit at the server console. To 
restart the task, type in load router at the server console.

When entering your user ID in the Web browser authentication window, you 
have to enter your Common Name, or your fully qualified name, but not 
your shortname. For example, our administrative user has been named 
domino admin. He might authorize as domino admin/ibm or domino admin, 
but not as dadmin.

Note

To send and receive messages from the Internet, you need to have a 
domain name server (DNS) up and running. Mail exchange (MX) records 
for your Internet Domain Name(s) and Address (A) records for your mail 
server have to be specified.

Note
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8.5.1.1  Setting up Internet Mailing
This chapter shows you: 

  • How to setup Internet Mailing manually.

  • How to block so called SPAM mails.

  • How to control who can route documents over a given size.

There are four things you have to configure:

1. Enabling SMTP Ports

In order to be able to send and receive SMTP messages, the adequate 
mail ports have to be enabled.

a. Start Domino Administrator.

b. Select the desired server.

c. Click on Configuration tab.

d. Select Servers -> Current Server Document.

e. Click on Edit Server to open the Server document.

f. Choose Ports -> Internet Ports -> Mail.

g. Enable SMTP inbound and outbound mail on port 25 (default mail port).
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Figure 232.  Configuring Internet Mail Ports

2. Enabling SMTP Listener

The SMTP listener is a task that checks for incoming SMTP messages. 
These messages can originate from any Internet host or another Domino 
Server in your domain. If you want to receive any inbound mail, this task 
must be running.

a. Start Domino Administrator.

b. Select the desired server.

c. Click on Configuration tab.

d. Select Servers -> Current Server Document.

e. Click on Edit Server to open the Server document.

f. Choose the Basics tab.
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g. Enable the SMTP listener task in the right column.

h. Save and Close the Server document.

Figure 233.  Enabling SMTP Listener Task

3. Enabling SMTP Outbound Messages

In order to be able to send mail to Internet addresses, you have to enable 
outbound routing. If you do not enable SMTP outbound traffic on all your 
Domino servers, you have to specify foreign SMTP domain document and 
Foreign SMTP connection document (see Lotus Domino 5 Administration Help 
for more information). 

a. Start Domino Administrator.

b. Select the desired server.

c. Click on Configuration tab.

d. Choose Messaging -> Configurations.

e. Select your server and click on Edit Configuration button.

f. Choose the Router/SMTP tab.

g. In the Basics tab:

  • Enable SMTP used when sending messages outside of the local 
Internet domain.
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  • Choose whether you want mails within your local Internet domain 
sent by SMTP or not (see Step 4 on page 229).

  • Add a relay host. This might be needed if your network is protected 
by a firewall to be able to send mail to the Internet.

Figure 234.  Messaging Settings - Basic Tab

h. In the Restrictions and Controls tab, you can enter many restrictions 
for SMTP mailing. You should consider to use the following restrictions.

  • In the Restrictions tab, set the maximum message size.

  • If you have problems with large amounts of unwanted mail from 
certain hosts, you can block these hosts in the SMTP Inbound 
Controls tab. You should enter these host in the field Deny 
connections from the following SMTP Internet hostnames/IP 
addresses. But, you should keep in mind that all mail from these 
hosts will be blocked, even those you might want to receive.

  • In 9.6, “Restricting SMTP Server Access” on page 259 you will find 
information about how to avoid someone using your server for mail 
relaying and other topics concerning mail security.
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Figure 235.  Messaging Settings - Restrictions and Control Tab

4. Enabling SMTP routing

If you enable SMTP routing, mail between users within a local Notes 
domain can be sent using SMTP instead of traditional Notes mail routing. 
SMTP routing has to be enabled if you want to send mail to the Internet.

To enable SMTP routing:

a. Start Domino Administrator.

b. Select the desired server.

c. Click on Configuration tab.

d. Choose Messaging -> Configurations.

e. Select you server and click on Edit Configuration button.

f. Choose the Router/SMTP -> Basics tab.

g. Enable SMTP allowed within the local Internet domain by selecting:

  • All messages, if you want all messages to be sent through the 
SMTP.
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  • MIME messages only, if you want only MIME messages sent 
through the SMTP.

h. Save and Close the document.

Figure 236.  Enable SMTP Routing

8.5.2  POP and IMAP
Post Office Protocol Version 3 (POP3) and Internet Message Access Protocol 
Version 4 (IMAP4) are two wide spread Internet protocols used for e-mail 
messaging. POP3 allows clients, such as Netscape, Eudora Pro, or Microsoft 
Internet Explorer to retrieve mail from a host server. IMAP4 allows even more 
advanced messaging manipulation. While POP3 can only be used for off-line 
reading after download from the server, IMAP4 allows both off-line and 
on-line reading of messages. IMAP4 also permits manipulation of remote 
message folders in a way that is functionally equivalent to local message 
folders. Netscape Navigator and Microsoft Outlook 98 are examples of IMAP4 
clients.

Since Lotus Domino Release 4.6, mail can be read using POP3 and IMAP4 
clients. Starting with Lotus Domino R5, the mail stored in a mail database 
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does not have to be converted to be MIME compliant. Now MIME is a native 
feature. This saves time, but the most important difference to the previous 
version is that there is no loss of fidelity.

8.5.2.1  Starting and Stopping the POP3/IMAP Servers
There are four options for starting the Internet Mail servers.

  • If you selected POP and/or IMAP when you installed Lotus Domino, the 
respective server task(s) will be automatically activated.

  • If you want POP3 and/or IMAP4 enabled or disabled at next server start 
you will have to change the settings in the server document. Open the 
server document and go to Ports -> Internet Ports -> Mail. In this server 
document tab, you can also change the TCP/IP port used.

  • If you did not select POP and/or IMAP when you installed Lotus Domino, 
you may start it manually using one of the following commands on the 
server console:

load pop3

for POP3, or

load imap

for IMAP4.

  • To start the POP and IMAP server tasks automatically at Lotus Domino 
Server start-up, add POP3 and/or IMAP to the ServerTasks entry in 
notes.ini. For example:

ServerTasks=POP3, IMAP, REPLICA,...

You can verify that your Internet Mail server(s) are running by executing 
the command show tasks at the server console. The output should include 
a few lines similar to these:

POP3 Server Listen for connect requests on TCP/IP port 110
POP3 Server Control task
IMAP Server Listen for connect requests on TCP Port:143 
IMAP Server Control task

To shut down the Internet Mail servers, you have two options:

  • Shut down manually by executing one of the following commands at the 
server console:

tell pop3 quit

for POP3, or

tell IMAP quit

for IMAP4.
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  • Deactivate the automatic start-up by removing POP3 and/or IMAP from 
the ServerTasks entry in notes.ini and then restart the Lotus Domino 
Server.

8.5.2.2  Preparation for an Internet Mail Client
If you want to prepare for an Internet mail client, who is not already a Lotus 
Notes user, and therefore, has neither a Notes mail database nor a person 
document, you have to create them using the new user wizard (see 6.2, 
“Registering a User” on page 144) or manually:

1. Create a Lotus Notes mail file:

a. Log into the Domino Administrator as an administrative user.

b. Choose File -> Database -> New...

c. In the Server field, select a Lotus Domino Server that is running the 
POP3 or IMAP4 server.

d. In the title field, enter the title of the client's mail file, for example, 
Jochen’s Mail

e. In the File name field, enter a path name and file name for the mail file, 
for example, mail/jweiss.nsf.

f. Select the template Mail (R5.0).

g. Click on OK.

If you are using the new user wizard to create the person document and 
the Notes mail database, deselect both locations for storing the user ID in 
the ID Info section.

Note
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Figure 237.  Create New Mail Database

2. Create a Person document:

a. Log into the Domino Administrator as an administrative user.

b. Open the Domino Directory.

c. Choose your registration server. If you don’t know how to select the 
registration server, please read 6.1, “Choose Other Server in Domino 
Administrator” on page 143.

d. Click on the People & Groups tab.

e. Select People.

f. Choose Add Person.

g. Complete the Basics tab:

  • Enter a first name, middle initial, and last name. Lotus Domino uses 
this to display the user's name in the People view of the Domino 
Directory.

  • In the User name field, enter the hierarchical name for the client.

  • In the Short name field, enter a string (without spaces), which is 
unique in your domain (for example, not equal to any other First, 
Last, or Short name in the Domino Directory). This will be used as 
the Internet mail client user name. You may choose the first 
character of the First name followed by the Last name, for example, 
jweiss.
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  • In the HTTP password field, enter the password the Internet mail 
client will use to log on to the server. Lotus Domino scrambles the 
password. This field is required.

Figure 238.  Person Document - Basic Tab

h. Complete the Mail tab:

  • In the Mail system field, select POP or IMAP.

  • In the Domain field, enter the Lotus Domino domain of the Internet 
mail server.

  • In the Mail server field, enter the name of the Internet mail server.

  • In the Mail file field, enter the path to the client's mail file on the 
Internet mail server relative to the Lotus Domino data directory. For 
example, enter mail/jweiss.nsf.

  • In the Internet address field, enter the Internet address specified in 
the POP3 or IMAP client.

  • In the Internet message storage field, choose Prefers MIME.

  • In the Encrypt incoming mail field in the Misc section, you must 
select No since Internet mail clients cannot receive encrypted mail.
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Figure 239.  Person Document - Mail Tab

To make preparations to allow existing Lotus Notes mail users to access their 
mail from POP3 or IMAP4 clients, specify a password in the HTTP password 
field of their existing Person documents. Also, configure the Internet mail 
clients so that mail is not automatically removed from the server since, 
otherwise, they cannot be read from the Lotus Notes client after retrieving 
them through the Internet mail client.

8.5.2.3  Enabling a Mail Database for IMAP access
If you want to use IMAP to access your mails, the mail database template has 
to be based on the Lotus Domino R5 mail template mail50.ntf. The mail 
database has to be prepared for IMAP by using the server console command:

load convert -m mail/jweiss.nsf

The option -m indicates conversion for use of IMAP. mail/jweiss.nsf is a 
sample path and mail database name. You can also use wildcards to specify 
the mail database name. By adding * mail50.ntf to the command, the 
database template is upgraded to the Lotus Domino R5 mail template.

For information about how to setup a POP3 or a IMAP4 Client please refer to 
redbook Lotus Domino Release 4.6 on IBM RS/6000, SG24-4694-02.
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8.6  NNTP

Network News Transfer Protocol (NNTP) is an Internet protocol for reading 
and distributing Network News or newsgroups. It is used both for client-server 
connections and for communications between servers. It is an alternative to 
setting up a mailing list using direct mail to distribute messages. Such 
remailing is inefficient when the number of subscribers grows beyond a dozen 
or so people. What you really want is efficient, centralized storage of 
messages that people can access if and when they need them. NNTP 
provides means for distribution, inquiry, retrieval, and posting of news articles 
using a reliable stream client-server model. NNTP is designed so that news 
articles need only be stored on one host while subscribers on other hosts 
may read news articles over TCP/IP connections, thereby, minimizing the 
disk and CPU resources necessary on the client hosts.

The following NNTP features are supported by Lotus Domino R5.

  • Support for Notes Release 4.6 clients and above, standard newsreader 
clients, and Web browser clients

  • Support for USENET newsgroups that are distributed across the Internet

  • Support for private newsgroups for use within your organization

  • Distribution of news articles using NNTP feeds to and from other NNTP 
servers

  • Security for servers, including the security features

  • Anonymous access
  • Basic authentication
  • Secure Sockets Layer (SSL) encryption and authentication

  • Archiving of newsgroup articles

8.6.1  Starting and Stopping a NNTP Server
There are three options for starting the NNTP server:

  • If you selected NNTP when you installed Lotus Domino, the NNTP server 
task will be automatically activated.

  • If you did not select NNTP when you installed Lotus Domino, you may 
start it manually using the following command at the server console:

load nntp

  • To start the NNTP server task automatically at Lotus Domino Server 
start-up, add NNTP to the ServerTasks entry in notes.ini. For example:

ServerTasks=NNTP, REPLICA, ROUTER, UPDATE, ...
236 Lotus Domino R5 on IBM RS/6000



You can verify that the NNTP server is running by using the command show 
tasks at the server console. The output should include a few lines similar to 
these:

NNTP Server          Scheduler
NNTP Server          Listen for connect requests on TCP Port:119
NNTP Server          Control task

To shut down the NNTP server, you have two options:

  • Shut it down manually by executing the command tell nntp quit at the 
server console.

  • Deactivate the automatic start-up by removing NNTP from the ServerTasks 
entry in notes.ini and then restart the Lotus Domino Server.

8.6.2  Configuring Newsfeeds
Lotus Domino R5 has four types of newsfeeds: Accept, Push, Pull, and 
Push-Pull. A push newsfeed allows your Lotus Domino Server to connect to a 
remote NNTP server and send new articles to that server. A pull newsfeed 
connects to a remote NNTP server and requests new articles from that 
server. A pull-push newsfeed will copy articles in both directions. If you want 
another NNTP server to be able to initiate a push newsfeed to your server, 
you need to set up an accept newsfeed. Please refer to the Lotus Domino R5 
documentation for more information.

To connect to another news server, you have to create a connection 
document in the server’s Domino Directory. In Domino Administrator, click on 
Configuration -> Server -> Connections Documents. Select the server 
running the NNTP task. Click on Add Connection.

Prior to configuring a newsfeed, you have to contact your Internet 
newsfeed provider or the administrator of the remote news server. The 
newsfeed won’t work unless the remote administrator permits it.

Note
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Figure 240.  Adding NNTP Connection

On the Basics tab, you have to specify the Connection type as News/NNTP Feed 
and the Destination server, which is the news server you want to connect 
(see Figure 241).

Figure 241.  NNTP Server Connection - Basic Tab

Next you have to click on the NNTP tab. Here you choose the News feed 
type, the Authentication as agreed with the administrator of the remote news 
server, whether you want your server to create new newsgroups 
automatically or not, and the names of the remote newsgroups you want to be 
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downloaded to your news server. You can use wildcards to specify the 
newsgroups, e. g. *. or ibm.*.

Figure 242.  NNTP Server Connection - NNTP Tab

That’s all you need for the first set-up of the newsfeed.

8.6.3  Creating a Newsgroup
A newsgroup on a Lotus Domino R5 server is a Notes database created 
using the NTTP Discussion template in the nntp directory. Make sure that the 
userid you are using is allowed to create new databases. Follow these steps 
to create a newsgroup itso.redbooks.aix.domino on server1/ibm. 

1. Start Domino Administrator.

2. Choose File -> Database -> New.

3. In the Server field, select server1/ibm.

Access control lists for newsgroups are not distributed through an NNTP 
newsfeed. If you include private newsgroups in a newsfeed, you must trust 
the remote NNTP server to enforce the access control policy. To enforce 
access control for private newsgroups within your organization, you should 
use Lotus Domino replication instead of an NNTP newsfeed.

Notes
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4. In the file name field, enter nntp/itso.redbooks.aix.domino.nsf.

5. Select server server1/ibm as the template server and highlight the 
template NNTP Discussion (R5.0). Your dialog box should now look similar 
to the one below.

Figure 243.  Create a Newsgroup Database

6. Click OK to create the database. It might take a little while before you see 
the next window.

7. The next window you should see is the Database Profile window for the 
database you just created (see Figure 244). There might also be an 
About... window popping up, but it is safe to close it down. Verify that the 
settings are the ones you entered when you created the database. The 
Database Profile Editor field will be filled in with the creator of the 
database. You might want to add people or groups to this field. By 
checking Private, you make it a private newsgroup. Private newsgroups 
can be moderated or not. When you’re done, click on Save and Close.
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Figure 244.  Newsgroup Database Profile

Congratulations! Your newsgroup has been created, and you can start 
posting news articles to it. If the NNTP server task is running, NNTP clients 
can also connect and post news articles at this time.

8.7  LDAP

The Lightweight Directory Access Protocol (LDAP) is an Internet standard 
protocol that has evolved to meet the needs of sharing information in a 
directory between computers that might be on different networks using 
different operating systems and different applications. LDAP is quickly 

The newsgroup may not be visible to NNTP clients and remote NNTP 
servers for up to two hours. To make the newsgroup immediately visible, 
type tell nntp quit and then load nntp to stop and then restart the NNTP 
server.

Note
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gaining wide acceptance as the directory access method of the Internet and 
is, therefore, also becoming strategic within corporate intranets. It is being 
supported by a growing number of software vendors and included in a 
growing number of software applications.

8.7.1  Lotus Domino R5 and LDAP
Lotus Domino R5 LDAP service supports the following features:

  • LDAP v3 and v2

  • Different access protections including anonymous access to specified 
fields, user and password authentication, SSL and X.509 certificates, and 
others

  • Support of third-party LDAP clients

  • Use of LDAP clients to add, delete, and modify directory entries

  • Schema publishing and customization

  • Searches based on alternate languages

8.7.2  Installation and Configuration
The Lotus Domino R5 LDAP server task is automatically installed when you 
install Lotus Domino R5. There is no need to install additional software to 
enable Lotus Domino to function as an LDAP server. There is also very little 
extra configuration needed. The following is a quick overview of the steps 
involved in turning Lotus Domino into an LDAP server.

1. Configure LDAP server security including who is authorized to access the 
directory and whether or not to encrypt and sign transfers.

2. Create full-text index of the Domino Directory on the server that runs the 
LDAP service.

3. If you are using more than one Global Domain, specify which one the 
LDAP service should use to form Internet addresses.

4. Load Domino LDAP task.

5. Configure LDAP clients to connect to LDAP server.

6. (Optional) Customize the default LDAP service configuration.

7. Check if the LDAP service is set-up correctly.

These are the steps you have to perform to configure your LDAP task:

1. Start Domino Administrator.

2. Select the desired server.
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3. Click on Configuration tab.

4. Select Servers -> Current Server Documents.

5. Click on Edit Server to open the Server document.

6. Choose Ports -> Internet Ports -> Directory.

7. Set the LDAP port (it is best to keep the default port), enable the service, 
and choose the appropriate authentication options.

Figure 245.  LDAP Configuration

8.7.3  Starting and Stopping the LDAP Server Task
There are three options for starting the LDAP server:

1. If you selected LDAP when you installed Lotus Domino, the LDAP server 
task will be automatically activated.
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2. If you did not select LDAP when you installed Lotus Domino, you may start 
it manually using the following command at the server console:

load ldap

3. To start the LDAP server task automatically at Lotus Domino Server 
start-up, add LDAP to the ServerTasks entry in notes.ini. For example:

ServerTasks=LDAP, REPLICA, ROUTER, UPDATE, ...

You can verify that the LDAP server is running by using the command show 
tasks at the server console. The output should include a few lines similar to 
these:

LDAP Server          Listen for connect requests on TCP Port:389 
LDAP Server          Control task

To shut down the LDAP server, you have two options:

1. Shut it down manually by executing the command tell ldap quit at the 
server console.

2. Deactivate the automatic start-up by removing LDAP from the ServerTasks 
entry in notes.ini and then restarting the Lotus Domino Server.

The show tasks console command should now show no more LDAP entry.
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Chapter 9.  Security

Security of AIX and Lotus Domino are each very extensive topics and cannot 
be completely covered in this redbook. However, it should be noted that, to 
ensure maximum security, the features of both must be considered and 
configured appropriately. Weaknesses in one or the other may lead to a 
security breach since both are open standards-based environments providing 
many possible types of local and remote access.

It is important to remember that both physical access to the machine and 
remote access through the network are equally important to the protection of 
the data stored therein.

This chapter does not discuss all of the possible security implications or the 
methods by which attacks can be prevented but is intended to point out the 
main areas for consideration and how better security might be achieved.

The redbook Lotus Domino Release 4.6 on IBM RS/6000, SG24-4694-02 should be 
referenced for the majority of the material that has not changed from previous 
releases of the server.

9.1  AIX File System Security

All file system objects (including files, directories, special files, link files, 
symbolic link files, and pipes) have security mechanisms associated with 
them. The most commonly used is the access control list (ACL), but the 
following additional ways of controlling file security can be used:

Base ACLs Specifies the permissions for the owner, group, and 
others. These permissions are controlled through the 
chmod command. 

Extended ACLs Provides finer access control than the base ACLs. 

Status of Extended ACLs
The extended ACL must be enabled for a file system 
object; otherwise, the extended ACL is ignored.

Owner ID This is the user ID of the owner of the file system object. 
Only this user ID has the permissions granted for the 
owner of the object.

Group ID This is the ID of the group associated with the object. Only 
members of this group have the permissions granted for 
the group associated with the object.
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Sticky bit If the sticky bit is set for a directory, only the owner of the 
directory or the owner of a file can delete or rename a file 
within that directory. This can be set with the t flag with 
the chmod command.

TCB bit If the TCB bit is set for a file system object, it identifies 
that object as part of the Trusted Computing Base (TCB).

umask The umask environment parameter specifies the default 
permissions for any file or directory created.

Status of the file system
A file system can be mounted with read/write or read-only 
permissions.

Follow these guidelines when dealing with file system objects:

  • In general, do not use extended ACLs. For most systems, base ACLs are 
sufficient for administration. If you do need the extra security control 
provided by extended ACLs, use them only when necessary and in an 
organized manner. Maintaining relevant entries in many extended ACLs 
can become very time-consuming. Also, do not use extended ACLs at all if 
you are in a heterogeneous network because they are only recognized by 
AIX systems.

  • Use the sticky bit on directories where everyone has write permissions. For 
example the /server1/notesr4/mail directory for Lotus Domino.

  • Protect user .profile files with 740 permissions.

  • Do not let users have write access to system directories.

  • Do not change permissions on any files or directories installed as part of 
the system. Changing those permissions affects system integrity.

9.1.1  Validating the User Environment
The commands pwdck, usrck, and grpck can be executed by root or any user 
in the security group to clean up after a change to the user configuration. 
Because they run with root permissions, they give administrative users the 
ability to make necessary changes to the /etc/security/passwd file in a 
controlled way without knowing the root password.

The usrck command verifies the validity of the user definitions in the user 
database files by checking the definitions for ALL the users or for the users 
specified by the user parameter. You must select a flag to indicate whether 
the system should try to fix erroneous attributes.

All the options for pwdck, usrck, and grpck are as follows:
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-n reports errors but does not fix them.
-p fixes errors but does not report them.
-t reports errors and asks if they should be fixed.
-y fixes errors and reports them.

9.1.2  Documenting Security Policy and Setup
The documentation on security policy is a very important part of the system 
security. It is used to:

  • Identify the different types of users and what data they will need to access.
  • Organize groups around the type of work that is to be done.
  • Organize ownership of data to fit with the group structure.
  • Set save-text (SVTX) on shared directories.
  • Remember that UNIX/AIX has no concept of application ownership.

AIX security, in itself, only controls access to the system and its files and 
directories. Once an additional application (for example, Lotus Domino) is 
installed, you must further the application security by using tools within Lotus 
Domino. This last function cannot be provided for by AIX.

9.1.3  Network File System Security
The Network File System (NFS) is widely know as being a security risk. We 
strongly recommend not to use NFS on any server running Domino Servers. 
You should disable NFS if it is installed. If you have to use NFS for whatever 
reason, please read 9.1.3.2, “NFS Export Security” on page 247.

9.1.3.1  Disabling the NFS Daemons
To stop the NFS daemons and remove their /etc/inittab entry, execute the 
following command as root user:

/usr/sbin/rmnfs -B

All NFS daemons will be stopped immediately. No NFS daemons will be 
started after system restart.

9.1.3.2  NFS Export Security
When using NFS, never export a read-write file system without restricting the 
hosts’ access. You have to specify the hosts that are allowed to mount the file 
system. If you don't, all the hosts connected to your IP network will be able to 
mount your file system. This might be your LAN, your company, or possibly 
the entire Internet depending on your site’s setup.
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You have to pay attention to the groups and user numbers of your file system 
while exporting it. If you are exporting a file system with files owned by a 
regular user, ensure that, on the machines that mount this file system, the 
same user exists with the same user ID.

For example, an NFS server exports a file system with files owned by a user 
with user ID 210. A host mounts this file system and has another local user 
with the same ID. This local user will own these files and will be able to do 
anything with them. This means, of course, that you must trust the remote 
host completely. A user with root access to the remote host could easily 
create users with UIDs matching those on the exported file system, and, 
thereby, gain read or write access to the files.

9.2  AIX Security Checklist

The following list is intended to serve as a basic reminder of the most 
important things to keep in mind when trying to secure your AIX server. It is 
not a detailed list; however, AIX security is a very large topic, and we can only 
begin to scratch the surface in this redbook. Don’t believe that this list tells 
you everything that you need to know about AIX security because it doesn’t. 
Also, when designing secure AIX servers, new issues will appear as well as 
new methods to deal with those new issues. Keep this in mind, and you are 
well on your way to achieve AIX security awareness.

  • Keep your servers and server consoles physically protected (locked away) 
and restrict access to as few people as possible.

  • If you are on the Internet, set up router filters or firewalls to minimize the 
number of services accessible from outside your domain.

  • Examine carefully the services offered by inetd and the portmapper. 
Eliminate any that aren't explicitly needed. A Lotus Domino Server will 
probably need a minimum of AIX services; most can be disabled. Use an 
inetd wrapper if you can, if, for no other reason, than to log the sources of 
connections to your host. This will help you to detect and prevent network 
attacks.

  • Protect your root account as well as you can. Restrict root access to one, 
or very few, persons.

  • Disable root network logins.
  • Don't run NIS unless it's absolutely necessary. Use NFS as little as 

possible.
  • Never export NFS filesystems unrestricted to the world. Specify 

fully-qualified host names when exporting. Export file systems read-only 
when possible.
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  • Fortify and protect Lotus Domino Servers. Don’t allow any regular AIX 
user accounts on these hosts. If you need an AIX server where many 
users will use the Lotus Notes client, set up a separate server for that 
task.

  • Use shadow passwords and the password restriction parameters in AIX to 
disallow poor passwords. Enable password check methods to ensure 
good user passwords. Disable or delete unused/dormant system or user 
accounts.

  • Force users to change their passwords every once in a while. Don’t 
overdo it, however. If users need to change their passwords too often, 
they tend to write them down instead of memorizing them. The root 
password is an exception to this rule. Change it often and make sure it is 
safe.

  • Install all AIX security patches as soon as possible on all of your hosts.
  • Eliminate trust relationships unless there is an absolute need for it. Create 

a cron job to remove .rhosts files that have not been authorized.
  • Check your log files regularly. They are your key to uncovering any 

attempts to compromise system security.
  • Use all available tools that can help you check your system. There are 

many good tools in the Public Domain that you can use.
  • Keep abreast of current literature and security tools; communicate to 

others about security problems and incidents. Read security newsgroups 
and subscribe to the various security mailing lists on the Internet. You can 
find a subscription Web page at: 
http://www.rs6000.ibm.com/resource/maillist.html.

There are many resources on the Web relating to AIX security. We can’t list 
all of them here, but a very good starting point for finding information is: 
http://www.ers.ibm.com/security-links/index.html.

9.3  System Security

In order to make your server as secure as possible you should limit the 
access to the system. This also includes physical access to the server. 

  • Place your server in a special room with access for only a few people. 
  • Always secure the server console.
  • Make full system backups regularly.
  • Make backups of your data at least once or twice a day (for example, by 

using ADSM).
  • Store backup tapes in other locations (never in server room) and lock 

them away.
  • Consider using an Uninterruptible Power Supply (UPS).
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  • Only create administrative user accounts.
  • Limit Telnet access to the server.
  • Limit FTP access to the server.
  • Do not use sendmail.
  • Do not use NFS (see 9.1.3, “Network File System Security” on page 247).
  • Do not run HTTP daemons.

9.3.1  Telnet Security
You should limit the number of users who have telnet access. You can disable 
telnet and rlogin for a user using SMIT. 

Execute smitty user in a root shell. Select Change / Show Characteristics 
of a User and press Enter. Enter the name of the user or function key 4 (F4) 
and select the user and press Enter. Change the settings Another user can SU 
TO USER?, User can LOGIN? and User can LOGIN REMOTELY? to false. You do this 
by selecting the setting and pressing the Tab key until false is shown. Now 
your screen should look like this:

Figure 246.  Change User Characteristics

Press Enter to make the changes. Now remote login through Telnet. The 
rlogin is now disabled for this user.

 Change / Show Characteristics of a User

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
[MORE...4]                                              [Entry Fields]
  Group SET                                          [notes]                  +
  ADMINISTRATIVE GROUPS                              []                       +
  ROLES                                              []                       +
  Another user can SU TO USER?                        false +
  SU GROUPS                                          [ALL]                    +
  HOME directory                                     [/server1]
  Initial PROGRAM                                    [/usr/bin/ksh]
  User INFORMATION                                   []
  EXPIRATION date (MMDDhhmmyy)                       [0]
  Is this user ACCOUNT LOCKED?                        false +
  User can LOGIN?                                     false +
  User can LOGIN REMOTELY?                            false +
  Allowed LOGIN TIMES                                []
  Number of FAILED LOGINS before                     [0] #
[MORE...32]

F1=Help             F2=Refresh          F3=Cancel           F4=List            
F5=Reset            F6=Command          F7=Edit             F8=Image           
F9=Shell            F10=Exit            Enter=Do 
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9.3.2  FTP Security
If you want to restrict access to your server you should also disable the FTP 
access. If you disable access through the Telnet and rlogin, FTP access is 
normally still possible. There are several ways to disable FTP access. 

1. If you do not need FTP access at all, disable FTP completely.

2. You can also disable FTP access to a certain user only, but you can do this 
only if Telnet access for this user is also disabled. There are two methods 
of doing this:

  • Redo the steps described in 9.3.1, “Telnet Security” on page 250 and 
also set Is this user ACCOUNT LOCKED? to True. Now neither Telnet, 
rlogin, nor FTP access is possible.

  • Edit the file /etc/passwd using vi while logged on as root. You have to 
change the line containing the user. For example, change the 
exclamation mark in the line

notes:!:201:201::/server1:/usr/bin/ksh

to NOLOGIN. It should look like this:

notes:NOLOGIN:201:201::/server1:/usr/bin/ksh

You do this by placing the cursor on the exclamation mark, type cw and 
enter NOLOGIN:. Press Escape to enter command mode. Enter :wq to 
write and close the file. For information about vi, please refer to 
Appendix D, “Using UNIX's vi Editor” on page 361.

9.3.3  AIX User Accounts
A separate user account should be created for each Domino Server instance, 
and each of these user names should be a member of the notes group only.

All currently active users are logged in /etc/utmp. The commands who and who 
/etc/utmp show all the currently logged in users. All user logins are logged to 
/var/adm/wtmp. The command who /var/adm/wtmp shows all user logins since 
the creation of the log file. The administrator can track all login sessions by 
viewing these logs.

Even if you disable login and remote login for a user, FTP access is still 
possible.

Note
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9.4  Domino Server Protection

Many of the security features are unchanged in R5. Details are provided 
regarding changes that have been implemented.

After installation, a Domino Server has relaxed security against access by 
Notes clients assuming that they already have legitimate ID files or browser 
clients. It is up to the administrator to ensure that all necessary precautions 
are undertaken to harden the server before making access available.

9.4.1  Access During Domino Server Setup
The http httpsetup task can be loaded on the server to provide access for an 
administrator to perform server setup since there is no client for AIX that can 
be executed locally on the machine.

Once the setup forms have been completed in the setupweb.nsf database 
with details, such as domain, certifier name, server name, and administrator 
name, they are submitted to the server for the setup task to process.

One last concern is that the administrator may use FTP to retrieve copies of 
newly created certifier, server, or administrator ID files. Using an unsecured 
FTP session means that the contents of the ID files are vulnerable to network 
sniffers during transit between the server and the receiving machine.

9.4.2  Domino Server Access and Network Connectivity
The following sections of the Security tab of the server document should be 
reviewed and configured appropriately to limit initial access to the server 

To ensure that all security mechanisms are covered, disable all access and 
then re-enable only the specific areas of access that are known to be 
required.

Having to remember to enable a feature is much less of a risk than having 
to remember to disable one as security may already have been breached.

Recommendation

The field details from the form are sent in clear text format to the server; so, 
ID names and password details are vulnerable during this time.

Note
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through Notes or Web browser clients or the execution of agents on the 
server.

1. Security Settings
2. Server Access
3. Web Server Access

Web Server Access is a new configuration setting available on the server 
document. It contains a field named Web server authentication that allows 
the administrator to choose what type of names will be accepted during 
name and password authentication. Figure 247 on page 254 shows this 
field near the top right of the form beside the Security Settings section.

The following table describes the options and their meanings.

Table 17.  Web Server Authentication Definitions

By restricting the number of available entries, a hacker is less likely to find 
a match by guessing a user name.

4. Passthru Use
5. Agent Restrictions
6. IIOP Restrictions

The inclusion of support for CORBA-based application communication 
between applets and the Web server requires a level of security. This is 
implemented in a similar fashion to the familiar agent restrictions from 
previous releases.

Settings Results

More name variations with lower security User can enter any of the following and 
Domino will try to match it in the Domino 
Directory:
Last name
First Name
Short name
Alternate name
Common name
Full hierarchical name
Alias names
Soundex number

Fewer name variations with higher 
security

Users can enter only one of the following 
names:
Common name
Full hierarchical name
Alias name
Alternate name
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The options Run restricted Java/Javascript and Run unrestricted 
Java/Javascript can be found in the IIOP Restrictions section of the 
Security tab on the server document.

Figure 247.  Restricting Server Access and Execution of Java/JavascriptApplets

To restrict access through Internet standard protocols, the following sections 
of the Ports-Internet Ports tab should be considered:

  • HTTP (Web)
  • SSL

It is now possible to specify the SSL ciphers that the server will accept 
when negotiating an SSL connection with a client. These can be found in 
the SSL ciphers field of the SSL Security section of the Ports-Internet 
Ports-Web tab of the server document.

These fields should be populated with the appropriate groups to restrict 
access and provide easy administration.

Note
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Figure 248.  Setting Available SSL Cipher Types

  • LDAP (Directory)

Domino R5 allows authenticated LDAP users to add, delete, or modify 
entries in the Domino Directory provided they have at least author access 
and are members of the UserCreator and UserModifier roles. However, at 
this time, no popular commercially available LDAP clients are capable of 
supporting this feature.

  • NNTP (News)
  • IMAP (Mail)
  • POP (Mail)
  • SMTP Inbound/Outbound (Mail)
  • IIOP (Inter-Application Object Communication)

The IIOP ports for normal and SSL connectivity can be found on the 
Ports-Internet Ports-IIOP tab of the server document.
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Figure 249.  Setting TCP/IP Port Information for IIOP Communication

9.4.3  Database Access Controls
Once the actual connections to the server have been restricted, access to the 
data in the databases and applications on the server must be considered.

In R5, all of the familiar database security measures remain unchanged.

First of all, the contents of the server should not be visible. To prevent this, 
disable the Allow HTTP clients to browse databases option on the Internet 
Protocols-HTTP tab of the server document.

The following areas of database access control must then be reviewed and 
set for all databases and templates on the server:

  • An Anonymous User entry in the ACL with appropriate access level
  • A default ACL access level of No Access
  • Appropriate use of Read public documents and Write public documents in the ACL
  • An appropriate Maximum Internet Name & Password access level

As discussed previously in Chapter 8, “Lotus Domino R5 and the Internet” on 
page 209, R5 introduces a mechanism for protecting native HTML files that 
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may be served by the HTTP Web server task to browser clients. The user or 
group entries used in a protection document must belong to the Domino 
Directory and do not have any correlation with UNIX filesystem security 
settings. Provided that the UNIX user account under which the server 
executes has appropriate access to the files and directories involved, then 
the Domino Server exerts control over the remote usage of the files.

9.4.4  Session-Based Web Client Authentication
With Domino R5, Web client access can be session-based, like a Notes client 
sessions, and allow the server to track session details. This allows the server 
to provide additional functionality not normally available with standard user 
name and password authentication:

  • Customized HTML login page
  • Default logout time period expiration
  • Programmed logout through URL
  • Maximum Web client user sessions

The implementation of the session tracking uses cookies; so, this type of 
access can only be supported by clients that support the use of cookies.

To enable session-based authentication for browser clients, it is necessary to 
edit the server document and switch to the Internet Protocols-Domino Web 
Engine tab, and in the HTTP Sessions section, set the Session authentication 
field to Enabled. The Idle session timeout and Maximum active sessions are 
also configured in this section.

Servers accessed by round-robin DNS cannot support the use of 
session-based Web authentication as they cannot maintain the session 
details in memory.

Note
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Figure 250.  Enabling Web Client Session-Based Authentication

9.4.5  Access through the Internet Cluster Manager
One of the main changes in R5 is the support of clustered servers for Web 
client access using the Internet Cluster Manager. The ICM supports both 
standard and SSL connections, and details of the configuration can be found 
in Chapter 7, “Domino Enterprise Server” on page 159.

It is important to note that the ICM itself accepts only anonymous 
unauthenticated requests from browser clients and then redirects those 
requests to one of the available servers. At this point, the target server 
security settings govern the extent of the access allowed to the browser client 
and the nature of the authentication options available.

Since the ICM does not authenticate requests, protecting it through 
controlled access must be achieved with the use of a firewall especially if it 
is used to provide access to the Internet community.

Note
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9.5  Secure Sockets Layer (SSL)

Much of the SSL support in R5 is the same as that for the Domino R4.6 
Server. This section will only describe changes or additional functions.

9.5.1  SSL and the Internet Cluster Manager
As mentioned previously, the ICM can handle requests for SSL connections 
to the clustered servers that it serves. Once a client has connected to a 
server in the cluster, subsequent requests will be handled by that server 
unless the requested information is not available or the server fails. In this 
case, the ICM will redirect requests to another server in the cluster that can 
provide the necessary resources.

If the user had not previously authenticated on the new server, then they will 
be required to do so. However, if the connection was over SSL and both client 
and server support SSLv3, then establishing a new SSL connection is 
automatic.

9.6  Restricting SMTP Server Access

More and more companies rely on working mail systems, but not every 
company is aware of the threats caused by the connection of their mail 
system to the Internet. Unsolicited Commercial Email (UCE), widely know as 
"Spam" mail, could cause a mail server to slow down or even crash. There 
are two types of Spam mails. 

The first uses your mail server to send mails to many other mail users who 
are normally not registered at your server. This type of Spam mail could slow 
down your mail server. If you are paying your Internet Service Provider (ISP) 
by Megabytes of transferred data, this could cost you a lot of money. You 
should also be aware that the receiver of the Spam mails could make your 
company responsible for the damage the Spam mails caused on their mailing 
system. This is also know as mail relaying. 

If you want to restrict the mail server access to certain IP address ranges, 
you have to enclose the IP range in square brackets. For example, if you 
want to enable all IP addresses in the range 9.3.240.0 to 9.3.240.255 you 
have to enter [9.3.240.*].

Note
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The second type is actually receiving these large volumes of mail. Large 
numbers of Spam mails could cause your mail system to run out of disk 
space and, therefore, prevent it from delivering any other mails. This type of 
mail is referred to as Spam mails in this book.

9.6.1  Mail Relaying
The Domino mailing system has several options you can use to prevent 
others from using your mail server for mail relaying. But, you have to be very 
careful using these restrictions. You might disable some of your own servers 
or clients.

Figure 251 shows how you can restrict sending mails to machines within a 
DNS domain.

Figure 251.  Mail Relaying - Outbound Control

9.6.2  Mail Spamming
If your company is receiving a lot of unwanted mail from a certain mail 
domain, you can disable this domain. But, you have to be aware that you 
might block mail you want to receive too. To deny mail form a certain mail 
domain, follow these steps:
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1. Start the Domino Administrator

2. Select the desired server

3. Click on the Configuration tab

4. Select Messaging > Configuration

5. Select your mail server

6. Click on Edit Configuration to open the Server document

7. Choose Router/SMTP > Restrictions and Controls > SMTP Inbound 
Controls

8. Enter the SMTP domain you want to prevent from sending mails to your 
server in the field Deny connections from the following SMTP Internet 
hostnames/IP addresses

Figure 252 on page 262 shows how to prevent hosts in the DNS domain 
mainz.ibm.com from sending mails to server1/ibm.
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Figure 252.  SMTP Inbound Control - Deny SMTP Domain

9.7  Domino Server Character Console

The Domino Server is usually started as a background process on the AIX 
platform, which means that the standard server console window is not visible.

As mentioned in 6.4, “The Domino Character Console” on page 154, R5 
provides a local console access program so that an administrator working 
locally or from a remote terminal can enter console commands.

Making a console available in this way introduces some security issues that 
must be considered.

When the CConsole program is started, the administrator must specify which 
Notes user ID file to use and must then enter the password for that ID.
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It also checks to see if the Domino Server is active on the same physical 
machine and, if it is not, the console program shuts down. If the server fails, 
then the console may not exit automatically in which case the administrator 
must type done and press Enter to close it manually.

Running cconsole from a remote client, using telnet or a remote X-display, 
introduces a security risk as it means that the server must accept Telnet and 
remote login sessions. 

The ID used must be listed as an administrator for the server, explicitly or 
as a member of a group, in the Administrators field of the server document, 
and it must have a password associated with it or CConsole will not run.

It must also be available in the filesystem of the server itself, and to ensure 
security of the ID, it should have a strong password with a minimum length 
of eight characters.

Note

Consider registering a user ID specifically for this purpose, for example, 
CConsole Admin, that does not have access to databases. Should the ID 
file be copied from the filesystem and the password compromised, it will be 
of limited use.

If a specific user ID is not created, then consider creating a separate 
administration group, for example, CConsoleAdmin, to contain user IDs 
allowed to use the UNIX remote console, and add this group name to the 
field on the server document in addition to the existing entries. Relevant 
users can then be specified as being able to use the remote console but do 
not obtain the same access privileges to databases that existing 
administrators may have.

Use the Domino Server command Set Secure <password> to increase 
security of the Domino Server console especially if remote console access 
is allowed.

Recommendations

The password entered for the user ID will be transmitted to the server over 
the network in clear text format.

Important Note
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The risks can be reduced by using the available tools appropriately.

Only run the character console program locally on the Domino Server. 

Use the Domino Administration client functions for remote access to the 
console.

Note
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Chapter 10.  Lotus Domino R5 Advanced Administration on AIX

This chapter outlines how to set up a modem connection between a Domino 
server on AIX and a remote Domino server. It also covers one of the most 
important tasks in Lotus Domino administration, backup and recovery. We will 
focus mainly on the tools that come with AIX, but we will also provide a quick 
overview on other means of backing up your Lotus Domino System.

10.1  Configuring Remote Servers to Communicate through Dialup

For servers and remote servers to communicate properly, one or more 
modems are required to be connected to serial communications ports. 
Domino serial communication ports use the X.PC protocol driver, which is the 
protocol used for dialup modem connections. The X.PC protocol driver is 
installed automatically when you install a Domino server. The following 
sections explain how to set up the AIX system so that the Lotus Domino 
Server can communicate with a remote Domino server using the X.PC 
protocol. You will need to set up both servers as per the instructions provided 
in the following sections.

10.1.1  Setting Up the AIX Server’s Communication Port
The steps to setup a communication port (tty) are as follows:

1. Log on to the AIX machine as root.

2. Make sure that there is at least one free serial port physically available 
(serial1, serial2).

3. Type smitty tty to view the tty configuration menu (Figure 253 on page 
266).
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Figure 253.  Smitty’s TTY Screen

4. Select Add a TTY to add a new serial device to the system’s configuration, 
and press Enter.

Figure 254.  Smitty’s Select the TTY Port Type

5. Select tty rs232 Asynchronous Terminal (Figure 254) for an 
asynchronous connection to the modem, and press Enter.

Figure 255.  Smitty’s Select the Serial Adapter

                                      TTY

Move cursor to desired item and press Enter

  List All Defined TTYs
  Add a TTY
  Move a TTY to Another Port
  Change / Show Characteristics of a TTY
  Remove a TTY
  Configure a Defined TTY
  Generate Error Report
  Trace a TTY

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do

                                    TTY Type

    Move cursor to desired item and press Enter.

      tty rs232 Asynchronous Terminal
      tty rs422 Asynchronous Terminal

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next

                                 Parent Adapter

    Move cursor to desired item and press Enter.

      sa0 Available 01-G0 Standard I/O Serial Port 1
      sa1 Available 01-H0 Standard I/O Serial Port 2

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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6. Select sa0 Available 01-G0 Standard I/O Serial Port 1 (Figure 255 on 
page 266) and press Enter.

Figure 256.  Settings of the TTY

You should select either serial port1 or serial port2. If you have a multi-IO 
adapter in your system, check if the serial device has full rs232 capability.

Note

                                   Add a TTY

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  TTY type                                            tty
  TTY interface                                       rs232
  Description                                         Asynchronous Terminal
  Parent adapter                                      sa0
* PORT number                                        [s1]                     +
  Enable LOGIN                                        disable                 +
  BAUD rate                                          [38400]                  +
  PARITY                                             [none]                   +
  BITS per character                                 [8]                      +
  Number of STOP BITS                                [1]                      +
  TIME before advancing to next port setting         [0]                      +#
  TERMINAL type                                      [dumb]
  FLOW CONTROL to be used                            [xon]                    +
  OPEN DISCIPLINE to be used                         [dtropen]                +
  STTY attributes for RUN time                       [hupcl,cread,brkint,icr> +
  STTY attributes for LOGIN                          [hupcl,cread,echoe,cs8,>
  LOGGER name                                        [
  STATUS of device at BOOT time                      [available]              +
  TRANSMIT buffer count                              [16]                     +#
  RECEIVE trigger level                              [3]                      +#
  STREAMS modules to be pushed at OPEN time          [ldterm,tioc]            +
  INPUT map file                                     [none]                   +
  OUTPUT map file                                    [none]                   +
  CODESET map file                                   [sbcs]                   +

  POSIX special control characters:

  INTERRUPT character                                [c]
  QUIT character                                     [
  ERASE character                                    [h]
  KILL character                                     [u]
  END OF FILE character                              [d]
  END OF LINE character                              [
  2nd END OF LINE character                          [
  DELAY SUSPEND PROCESS character                    [y]
[MORE ..]
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7. As shown in Figure 256, you need to enter the PORT number (you can press 
F4 for selection) and also the BAUD rate for the connection to the modem, 
and press Enter.

SMITTY will return the following COMMAND STATUS (Figure 257) if the device 
was created successfully:

Figure 257.  Command Status OK of Creating a TTY

Alternatively, you can type the following command, for example, using 
serial port #1, to add and configure a tty.

mkdev -c tty -t tty -s rs232 -p sa0 -w s1 -a speed=38400

8. Check if the device exists by typing:

ls -la /dev/tty<X>

/dev/tty<X> is the tty that will be returned after entering the previous 
command or noted by the COMMAND STATUS screen. For our system, X = 0. 
Enter:

ls -la /dev/tty0

Output is as shown in Figure 258.

Figure 258.  Output of the Command ls -la /dev/tty0

On the AIX platform, Domino communicates through the device file 
/dev/cua<N>, where <N> corresponds to the Notes port number.

The Enable LOGIN must be set to disable; otherwise, X.PC will not work 
correctly!

Note

                                COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

tty0 Available
F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find
n=Find Next

crw-rw-rw-   1 root     system    16,  0 Feb 05 16:53 /dev/tty0
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9. If /dev/cua<N> does not exist on your system, link /dev/cua<N> to the 
previous configured asynchronous port. For example, to specify port 
number <N> = 1 and using tty0, type:

ln -s /dev/tty0 /dev/cua1

10.Enter ls -la /dev/cua1 (Figure 259).

Figure 259.  Output of the Command ls -la /dev/cua1

10.1.2  Setting Up the Modem on Lotus Domino Server for AIX
The following steps are required to correctly set up a modem for use on a 
Domino Server for AIX.

1. Install the modem on the server communications port and ensure that the 
operating system recognizes the port.

2. From any client workstation, click on File -> Tools -> Server 
Administration to launch the Domino Administrator.

3. From the Servers pane, select the server on which to set up the port. You 
can set up a port remotely for servers that do not have a client, for 
example, UNIX or OS/2.

4. From the Tools pane, click Server -> Setup Ports

lrwxrwxrwx   1 root     system         9 Feb 05 16:54 /dev/cua1 -> /dev/tty0
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Figure 260.  Setting Ports Using the Domino Administrator

5. The screen in Figure 261 on page 271, displays port setup information for 
the server that you specified. Select the name of the port on which you 
installed the modem. If the communication port name does not exist, 
select New, type the name of the communication port on which you 
installed the modem, select XPC for the driver, and then click OK.
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Figure 261.  Port Setup for Server

6. (Optional) Select Encrypt network data to secure data sent to or received 
by the server. Click on Port Enabled to enable the port.

7. Select portname Options, where portname is the name of the port whose 
settings you want to change. In our example, it is serial1. Then scroll 
through Modem Types to select the type of modem you are setting up.
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Figure 262.  Modem Configuration Screen

8. Modify default port settings if you want. The default port settings work in 
most situations. 

9. Select the Modem type in as shown in Figure 262 (the default is Auto 
Configure).

If you don’t know your modem type, or if your modem is not on the list, try 
Auto Configure. The Auto Configure modem command file (auto.mdm) 
checks the modem’s speed and then selects the appropriate generic 
modem command file.

For more information, review the template.mdm file in the data directory of 
the server under the directory modems.

10.Select the maximum port speed (default is 19200). Be aware of the 
configuration of the TTY.

  • The maximum port speed is the maximum speed at which the 
communication port on the computer sends data to the modem and 
receives data from the modem.

  • The modem carrier speed is the speed at which modems communicate 
with one another.

  • The modem carrier speed may be lower than the port speed.

  • When using a null modem, the maximum port speed selected on both 
computers must be identical.
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11.Select a volume from the Speaker Volume field (the default is Off). 
Selections are Low, Medium, or High.

12.Select a dial mode in the Dial mode field (the default is Tone).

13.Log modem I/O (the default is deselected).

14.Select Log modem I/O to record information about the modem connection 
in the Notes Log if you suspect a problem with the modem.

15.Log script I/O (the default is deselected).

Select Log script I/O if you are using modem scripts and want to record 
asynchronous script file responses and replies in the Notes Log. Use this 
option if you suspect a problem with a modem script file.

16.Hardware flow control (default is selected for all operating systems except 
UNIX).

If you do not select Hardware flow control, the modem may generate 
cyclic redundancy check (CRC) errors and retransmissions. CRC is a form 
of error detection that Domino uses to ensure that data is transferred 
correctly. Deselect Hardware flow control if the modem doesn’t support 
flow control.

17.Wait for dial tone before dialing (the default is selected).

18.Dial timeout field (the default is 60 seconds).

19.Hang up if idle (the default is 15 minutes).

This field refers to the amount of time the modem waits before hanging up 
if there is no data passing through the connection. On a port that 
workstation users dial into, you might want to specify a longer idle time 
then the default since users may need more time to read or compose long 
documents. Domino uses the lower of the settings on the calling and 
answering computers.

20.Port number (the default is the number one through five, entered in the 
Communication Port field). On an AIX system, specify a port number N 
that matches the /dev/cuaN device file that you linked to the asynchronous 
port.

21.If you need to make changes to the modem file, click on Modem File....
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Figure 263.  Edit Modem Command File

22.Edit the modem file and click Done (Figure 263).

Modem command files have the file extension mdm. If your modem, or if 
the default modem command file auto.mdm does not work, Notes provides 
the Generic All-Speed Modem File, gen_all.mdm, which you can modify. 
For information on modem command files and instructions on modifying 
them, please read the template.mdm file. The modem files exist in the 
Domino data directory under modems.

23.To associate an acquire script with the current port, select Acquire Script; 
select a script file to use, and click on OK.

24.To check the connection status, click on Show Status..., as shown in 
Figure 261 on page 271. You will get the following output: (Figure 264 on 
page 275)
274 Lotus Domino R5 on IBM RS/6000



Figure 264.  Show Status of Connection

Notes also records the information for the communication port in the 
Miscellaneous Events and Phone Calls views of the Notes Log, log.nsf.

Table 18 explains the entries in the Notes Log:.

Table 18.  Name and Description as Shown in the log.nsf Database 

Name Description

Bit per second connection (port 
speed)

The speed at which the server’s port 
is communicating with the modem.

Bit per second connection (carrier 
speed)

The speed at which the server’s 
modem is communicating with the 
other modem.

Currently active sessions The number of users or servers 
currently connected to the server.

User messages sent The number of transmit requests 
issued by the user for one or more 
packets.

User messages received The number of transmit requests 
issued by the sender for one or more 
packets.

User bytes sent The number of bytes sent from this 
port.
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25.Click on Cancel (Figure 264 on page 275).

26.Click on OK (Figure 262 on page 272).

27.Click on OK (Figure 261 on page 271).

28.Restart the Domino Server so that Domino listens to incoming phone calls 
on the port.

You may see other messages on the server console after starting the 
server if Log modem I/O and Log script I/O are enabled as in Figure 262 
on page 272. The Notes log on the server will contain lines as shown 
below.

27/02/99 00:44:29     Serial2: Send to Modem:  ATE0V1 (2400 bits per second)
27/02/99 00:45:34     Serial2: Send to Modem:  +++ (4800 bits per second)
27/02/99 00:45:35     Serial2: Send to Modem:  ATE0V1 (4800 bits per second)
27/02/99 00:46:40     Serial2: Send to Modem:  +++ (9600 bits per second)
27/02/99 00:46:42     Serial2: Send to Modem:  ATE0V1 (9600 bits per second)
27/02/99 00:47:47     Serial2: Send to Modem:  +++ (19200 bits per second)
27/02/99 00:47:48     Serial2: Send to Modem:  ATE0V1 (19200 bits per second)
27/02/99 00:48:53     Serial2: Send to Modem:  +++ (1200 bits per second)
27/02/99 00:48:54     Serial2: Send to Modem:  ATE0V1 (1200 bits per second)
27/02/99 00:49:09     Searching Administration Requests database.
27/02/99 00:49:59     Serial2: Send to Modem:  +++ (2400 bits per second)
27/02/99 00:50:00     Serial2: Send to Modem:  ATE0V1 (2400 bits per second)

User bytes received Number of bytes received on this port.

Retransmitted packets The number of packets retransmitted 
because of errors. Use this statistic to 
check remote transmissions. A high 
number (more than one per minute) 
indicates a problem that will adversely 
affect performance. Use Hardware 
flow control, if supported, or choose a 
lower port speed.

CRC errors detected The number of cyclic redundancy 
check (CRC) errors. The CRC errors 
mean that the CRC included in the 
frame is not consistent with the actual 
number of bits in the frame. Such 
errors slow transmission speed.

Port errors detected Port errors on this port indicates 
operating system port driver buffer 
overflow or possible parity errors.

Name Description
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27/02/99 00:51:05     Serial2: Send to Modem:  +++ (4800 bits per second)
27/02/99 00:51:07     Serial2: Send to Modem:  ATE0V1 (4800 bits per second)
27/02/99 00:52:11     Serial2: Send to Modem:  +++ (9600 bits per second)
27/02/99 00:52:12     Serial2: Send to Modem:  ATE0V1 (9600 bits per second)
27/02/99 00:53:17     Serial2: Send to Modem:  +++ (19200 bits per second)
27/02/99 00:53:19     Serial2: Send to Modem:  ATE0V1 (19200 bits per second)
27/02/99 00:54:09     Searching Administration Requests database.
27/02/99 00:54:24     Serial2: Send to Modem:  +++ (1200 bits per second)
27/02/99 00:54:25     Serial2: Send to Modem:  ATE0V1 (1200 bits per second)
27/02/99 00:55:30     Serial2: Send to Modem:  +++ (2400 bits per second)
27/02/99 00:55:31     Serial2: Send to Modem:  ATE0V1 (2400 bits per second)

10.1.3  Connecting to Remote Servers
To replicate databases and exchange mail, servers must connect to each 
other. To help establish connections through a dialup modem, you need to 
create connection documents in the Domino Directory. A Connection 
document establishes a connection and specifies how and when servers 
connect to replicate and exchange mail.

Most connection documents have two parts: A network part and a schedule 
part. The network part defines the connection: Which server to connect to 
and how that connection is made. The schedule part determines when to 
perform activities, such as replication and routing to a particular server. 
Information in the network part is used whenever connecting to a specified 
server whether or not the connection is related to any task defined in the 
schedule part.

Mail routing between a pair of servers requires one connection document on 
each server because mail routing between servers works in only one 
direction unless they are in the same notes named network. For example, 
Server A needs a connection document to route mail to Server B, and Server 
B needs a connection document to route mail to Server A. 

10.2  Using PPP to Set Up Communication on the AIX Server

The asynchronous Point-to-Point Protocol (PPP) subsystem provides a 
standard method for transporting multiprotocol datagrams over point-to-point 
media.

1. Log on to the AIX machine as root.

2. Use the lslpp -l bos.net.ppp command to check if the following software 
is installed:

bos.net.ppp          4.3.2.0  COMMITTED  Async Point to Point Protocol
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3. Create a TTY. Please refer to 10.1.1, “Setting Up the AIX Server's 
Communication Port” on page 265, Step 1 on page 265 through Step 7 on 
page 268. The only parameter you have to change is the Enable LOGIN 
field. This option must be set to share. Check also if the BAUD rate is 
correct.

4. Create a PPP user to give a PPP client access to your system by typing 
the following command: 

mkuser gecos="PPP client user" pppuser. 

5. Define a password for user pppuser by issuing the command pwdadm 
pppuser

6. Confirm and change the password by typing the following from the lowest 
login shell:

login pppuser

7. Add the following line in the .profile file located in $HOME:

exec /usr/sbin/pppattachd server 2>/dev/null

8. Change user ID back to root by typing:

su - root

9. To configure the Asynchronous Point-to-Point Protocol, use the SMIT 
fastpath: smitty ppp (Figure 265 on page 279).

You must have installed at least AIX 4.1.4 or greater.

Note

You may add a separate user ID and password for each remote PPP client.

Note
278 Lotus Domino R5 on IBM RS/6000



Figure 265.  Smitty’s PPP Screen

10.Select Link Control Configuration to configure the link control stored in 
the file /etc/ppp/lcp_config, and press Enter.

Figure 266.  Smitty’s PPP Link Control Configuration Screen

11.To create a new file, /etc/ppp/lcp_config, select Add a Link Configuration 
as shown in Figure 266, and press Enter.

 PPP

Move cursor to desired item and press Enter.

  Link Control Configuration
  PPP IP Interfaces
  PAP  Authentication
  CHAP Authentication
  Start PPP
  Stop PPP
  
  
  
  
  

F1=Help             F2=Refresh          F3=Cancel           F8=Image          
F9=Shell            F10=Exit            Enter=Do                              

                           Link Control Configuration

Move cursor to desired item and press Enter.

  Add a Link Configuration
  Change / Show a Link Configuration
  Remove a Link Configuration

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 267.  Smitty’s PPP Link Configuration Screen

12.Enter a name without spaces into the PPP subsystem name field as 
shown in Figure 267. This name will identify the system to PPP and has no 
meaning to any other interface, such as IP. The first 20 bytes must be 
unique.

13.Enter the number of clients that can access this machine in the max server 
connections field.

14.Enter the maximum number of servers that can be accessed through client 
connections on this machine into the max client connections field.

15.Enter the maximum number of demand connections in the max demands 
connections field.

16.To define the maximum number of allowed TCP/IP interfaces, enter a 
number not greater than the total maximum number of server and client 
connections into the field max ip interfaces.

17.Enter the maximum number of concurrent asynchronous PPP sessions, 
both client and server, that can be active into the max ip interfaces field. 
The value cannot be greater than the total maximum number of server and 
client connections.

 LINK Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
[TOP]                                                   [Entry Fields]
  PPP subsystem name                                 [domino_ppp_entry]
  max server connections                             [8] #
  max client connections                             [2] #
  max demand connections                             [8] #
  max ip interfaces                                  [8] #
  max async hdlc attachments                         [8] #
  mru                                                []                        #
  async character map                                []                        X
  transmit async character map                       []                        X
  negotiate MRU                                       yes                     +
  negotiate magic number                              yes                     +
  negotiate async map                                 yes                     +
  negotiate protocol compression                      yes                     +
  negotiate address control compression               yes                     +
[MORE...7]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do                    
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18.All other fields on the LINK Configuration panel are optional. If you do not 
have a deeper knowledge of PPP and a complete understanding of the 
options, you can leave them set to the default.

19.Press Enter to create the link configuration file.

The file /etc/ppp/lcp_config in our example will look like this:

Figure 268.  PPP Link Configuration File /etc/ppp/lcp_config

20.Press F3 twice to return to smitty’s first menu (Figure 265 on page 279).

21.To create the PPP IP Interfaces, select PPP IP Interfaces as shown in 
Figure 265 on page 279, and press Enter.

Figure 269.  Smitty’s PPP IP Interfaces Screen

22.To create a new server interface, select Add a Server Interface as shown 
in Figure 269, and press Enter. The file /etc/ppp/if_conf will be created for 
you.

server_name domino_ppp_entry
lcp_server 8
lcp_client 2
lcp_demand 8
num_if 8
num_hdlc 8

 PPP IP Interfaces

Move cursor to desired item and press Enter.

  Add a Server Interface
  Change / Show a Server Interface
  Remove a Server Interface
  Add a Demand Interface
  Change / Show a Demand Interface
  Remove a Demand Interface

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do                    
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Figure 270.  Smitty’s PPP IP Configuration

23.Enter the IP address of your current system into the Local IP address field.

24.Enter the first remote IP address into the Starting Remote IP address field. 
If you enter more than one into the Number of addresses field, this 
address will be the first IP address, and the following remote IP addresses 
will always be incremented by one.

25.As mentioned before, you can define more that one remote IP address. 
You may specify only one if you desire a single interface. The value of the 
Number of addresses field should not exceed the value specified in the 
/etc/ppp/lcp_config file for max server connections. Do not specify zero (0) 
for this field.

26.Press Enter to accept the settings.

The /etc/ppp/if_conf file in our example will look like this:

                              PPP IP Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Local IP address                                   [9.3.16.243]
  Starting Remote IP address                         [9.244.8.110]
  Number of addresses                                [8]
  Netmask                                            [255.255.255.0]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

Please be aware that all remote IP addresses must be unique for a given 
local (server) IP address.

Note
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Figure 271.  PPP IP Configuration File (/etc/ppp/ip_conf)

27.To start PPP, return to smitty’s first menu by pressing F3 twice (Figure 265 
on page 279). Select Start PPP, accept the defaults, and press Enter. The 
PPP subsystem will then be up and running.

10.3  SLIP Remote Communication Method to Use with an AIX Server

You can also use SLIP, the Serial Line Internet Protocol, a protocol that 
TCP/IP uses when operating through a serial connection. (IBM TCP/IP for 
DOS V 2.1.1, OS/2 Warp Connect and AIX support SLIP.) For further 
information on how to set up and configure SLIP, please refer to the 
appropriate TCP/IP product manual(s).

10.4  Backup and Recovery

Performing regular backups is critical. Back up Lotus Domino Servers often to 
protect from data loss. This is a very laborious task that needs your attention 
daily. For your assistance, there are many good tools that come with AIX.

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.110
netmask 255.255.255.0

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.111
netmask 255.255.255.0
  .
  .
  .
  .
  .
  .
interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.116
netmask 255.255.255.0

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.117
netmask 255.255.255.0
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We will present several ways to back up your Lotus Domino servers in this 
chapter. You are free to choose the one solution that will best suit your 
environment. When choosing your backup plan, remember that the goal of all 
backups is to minimize server downtime. When one or more servers are down 
and you have hundreds, or maybe thousands, of users waiting for Lotus 
Domino to come back on-line, you will find that you don’t have time for 
lengthy recovery procedures or many mistakes. Make sure to have a well 
documented recovery plan.

When setting up your backup environment, it is also crucial to know for 
certain that it is functional. A backup is not a backup unless you have tested 
your recovery plan. It is a good idea to test out backup as well as recovery 
before taking the Lotus Domino Server into production. When in production, 
make sure to make a recovery test every six months or so.

Assuming that the server was installed as described in 2.2, “Preparing the 
AIX Environment” on page 16, you need to back up the following directories 
and files.

/usr/domino/lotus

This is the Lotus software file system. You need to back it up only before 
you install new Lotus software or an upgrade in this directory. If resources 
allow, it is recommended that you include this file system in your regular 
backups.

/server1

This is the file system that contains the Lotus Domino Server data-like 
databases, the templates, the mail files, and others. This file system may 
require one or more daily backups if your organization produces a lot of 
data. Be aware that with the procedures described in this chapter, you 
must shut down your Lotus Domino Server software before you make a 
backup.

notes.ini, server.id, cert.id, user.id

Keep a copy of these files on a floppy disk in a secure place. They are 
present in the Lotus Domino Server data directory (/server1).

Don’t make the mistake of storing your recovery plan as only a Lotus Notes 
database. At the time you need it, it might be unavailable. Keeping an 
up-to-date hardcopy physically near the Lotus Domino Server is a good 
idea.

Note
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In this chapter, we discuss the following examples:

  • How to back up only one server.
  • How to back up a server that contains user data.
  • How to back up more than one server.

For our examples, we will assume that a backup server exists with two 
identical tape units. In order to make examples easier to understand, the 
capacity of these tape units are assumed to be sufficient for all of your 
backup needs. These tape units may be 4 mm DAT, 8 mm Exabyte, or maybe 
DLT depending on the size of the data to be backed up. In our case, the 
device names will be /dev/rmt0 and /dev/rmt1.

Additionally, it is also assumed that you have installed the scripts from 4.1.3, 
“Starting the Lotus Domino Server Using a Startup Script” on page 106 for 
starting the server in the background. This is normally required when running 
Lotus Domino on AIX in a production environment. In scripts and examples, 
we will assume that these scripts are installed in the directory /server1/bin.

All the examples here can be used in small organizations with some work and 
customization. For a larger organization, consider using a professional 
backup tool like the IBM ADSTAR Distributed Storage Manager Solution 
(ADSM). There is a redbook on using IBM ADSM to back up Lotus Notes; 
Using ADSM to Back Up Lotus Notes, SG24-4534.

10.5  Server Backup Using AIX Native Tools

The backup and restore commands are the native AIX tools for backups that 
will be used in this section. These tools are capable of incremental backup, 
but since a Lotus Notes database is one file, the modification of one 
document in a huge database will change the file, and, thereby, force a 
backup of the entire file. Obviously, it would be more economical to be able to 
make an incremental backup of the database saving only the modified 
documents. Refer to 10.8, “Advanced Backup Solutions” on page 303 for 
backup solutions that can make incremental backups of Lotus Notes 
databases at the document level.

Do not rely on replication as your only backup method. Corrupted, 
damaged, or accidentally changed databases can replicate, and all replicas 
may become damaged.

Note
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10.5.1  Stopping and Starting the Database Server
To ensure the integrity of a Lotus Domino Server backup using native AIX 
tools, the server should be stopped, and the file system where it resides 
preferably unmounted. It is not necessary to unmount the file system if you 
know that there are no users on the server and that no process will work with 
the server file system during the backup. If you are uncertain, unmount the 
file system before the backup.

The details for starting and stopping a server using scripts is described in 
4.1.3, “Starting the Lotus Domino Server Using a Startup Script” on page 
106.

10.5.2  How to Back Up the Lotus Domino Software File System
You have to back up the /usr/domino/lotus file system only after you install the 
new Lotus software or perform an upgrade.

If you have a local tape on the system, you can use the backup command.

1. Insert a blank and unprotected media in the tape unit.

2. Log in as root.

3. Enter the following command to set the tape block size:

# /usr/sbin/chdev -l rmt0 -a block_size=1024

4. Before running a file system backup, you should check the file system 
integrity. Run the command:

# fsck /usr/domino/lotus

Always run the fsck command on file systems after a system malfunction. 
Corrective actions may result in some loss of data. The default action for 
each consistency correction is to wait for the operator to enter yes or no. If 
you do not have write permission for an affected file system, the fsck 
command defaults to a no response in spite of your actual response.This 
command will report the problems you may have. If you have any 
problems, you must unmount the file system and run fsck again to correct 
the problem, and then remount it. For additional information, please refer 
to the fsck AIX manual page by typing in the command: man fsck.

Change the rmt0 to your tape unit name; you can use other block sizes 
than 1024. You can list your system's tape names with the following 
command:
lsdev -C -c tape

Note
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Alternatively, you can also find relevant documentation, including a 
commands reference for AIX, at: 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide 
Web.

5. If /usr/domino/lotus is a file system, enter:

# backup -u -0 -f /dev/rmt0 /usr/domino/lotus

This command will perform a level 0 file system backup by i-node.

If it is not a file system, you can use the following commands:

# cd /usr/domino/lotus
# find . -print | backup -i -v -f /dev/rmt0

This creates a backup by file name on the tape. Invoked this way, the 
backup command needs a list of files and directories to backup. The find 
command, as used above, lists the entire directory structure starting at the 
current directory.

6. If you need to copy the backup tape, just insert the target tape in the tape 
unit, rmt1, and enter the command:

# tcopy /dev/rmt0 /dev/rmt1

In this example, rmt0 is the source tape unit, and rmt1 is the target tape 
unit. Don’t forget to set the block size for rmt1 to be the same as for rmt0.

See 10.5.5.1, “Restoring Files with Restore” on page 293 for information on 
restoring backups. Also see the manual pages for a detailed explanation of 
the commands find, tcopy, backup, and restore. To get an explanation of any 
AIX commands, type: man <command>. For example, you can get an explanation 
of backup by typing in the command:

man backup

Alternatively, you can also find relevant documentation, including a 
commands reference for AIX, at: 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide 
Web.

  • Change rmt0 to the name of your tape unit.

  • To ensure the data integrity of the backup when performing a backup by 
i-node, you must unmount the file system before doing the backup. 
Don’t forget to remount it again after the backup.

Note
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10.5.3  How to Back Up Only One Server
It is very important to have a backup schedule. The AIX backup command 
offers 10 different levels (0 through 9) of incremental backup. Level 0 is the 
full backup. On the other levels, all the files that have been changed since the 
last lower-level backup are backed up.

For our example, we will use the following backup schedule:

Weekly Full Backup (Level 0)
This should be performed every Wednesday. The full backup tape will be 
copied for security reasons. The second copy from this tape can be stored in 
a secure place in another building, for example.

Incremental Daily Backup (Level 5):
This should be performed on Monday, Tuesday, Thursday, Friday, and 
Saturday.

To implement this schedule, we will use the script backtape given below and 
the AIX crontab facility. The cron and crontab commands give you the ability to 
schedule commands to be executed at given times. Please refer to the 
crontab manual page if you are not familiar with crontab.

Simple Script to Back Up Lotus Notes Data
The following is an example of the Simple Script to back up Lotus Notes data:

#!/bin/ksh
#@(#) backtape Lotus Notes backup procedure
#
# Usage: backtape [-copy] <level> <tape0> <tape1>
#
COPY=NO
FS=/server1

# Display error message and exits
Error () {
  echo "Usage: backtape [-copy] <level> <tape0> <tape1>"
  echo "Example: backtape 5 rmt0 rmt1" >&2
  exit 1
}

NARGS=$#
# Test for the copy option
[[ $1 = -copy ]] && { COPY=YES ; shift ; let NARGS=${NARGS}-1 ; }
# Test the number of flags, must be 3
[[ $NARGS -ne 3 ]] && Error
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LEVEL=$1
TAPE0=$2
TAPE1=$3

echo "Backup level $LEVEL, tape0 $TAPE0, tape1 $TAPE1, copy=$COPY"
echo "Started on ‘date‘ on server ‘uname -n‘"

# These tape attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of $TAPE0..."
/usr/sbin/chdev -l $TAPE0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape $TAPE0..."
/bin/tctl -f /dev/$TAPE0 rewind

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server..."
$FS/bin/stop_domino

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $TAPE0..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/$TAPE0 $FS

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/start_domino

# Making the tape copy...
if [[ $COPY = YES ]]
then
  # These tape attributes apply to the 8mm 2.3/5GB tapes
  # Check for the attributes that applies to your tape
  echo "\nChanging the attributes of $TAPE1..."
  /usr/sbin/chdev -l $TAPE1 -a block_size=1024 -a mode=yes -a extfm=yes

  # We have to rewind the tapes
  echo "\nRewinding the tape $TAPE0 for copy..."
  /bin/tctl -f /dev/$TAPE0 rewind
  echo "\nRewinding the tape $TAPE1 for copy..."
  /bin/tctl -f /dev/$TAPE1 rewind

  # Make the copy
  echo "\nMaking the copy of $TAPE0 on $TAPE1..."
  /bin/tcopy /dev/$TAPE0 /dev/$TAPE1
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  # Ejecting the tape
  echo "\nEjecting $TAPE1..."
  /bin/tctl -f /dev/$TAPE1 offline
fi

# Ejecting the tape
echo "\nEjecting $TAPE0..."
/bin/tctl -f /dev/$TAPE0 offline

echo "\nEnd of the backup program..."

This script will back up the file system /server1 to the specified device (rmt0 or 
rmt1) using the backup command then makes a copy of the backup tape, if 
specified (using the command tcopy), and finally ejects the backup tape(s) 
(using the command tctl).

To implement the backup schedule, you have to add the lines shown in Figure 
272 to the root crontab. As root, run the command: crontab -e and add the 
lines at the end of the file.

The first line is only a comment to remember the crontab file fields. The 
second line implements the Monday, Tuesday, Thursday, and Friday daily 
incremental level 5 backup on rmt0. The third one implements the Saturday 
backup on rmt1. The last one is the weekly full backup that is made on rmt0 
and copied to rmt1.

Figure 272.  Crontab for the Backtape Script

The backup operator will need five tapes (one for each day of the week) for 
the level 5 backup. These five tapes may be labeled with the weekday name 
and reused weekly. So, for example, on Monday the operator inserts the 
Monday tape in rmt0, and on Friday the Friday tape is inserted in rmt0 and the 
Saturday tape is inserted in rmt1.

For each week, two tapes will be needed for the full backup. They have to be 
labeled with the backup date. On Wednesday, the operator will have to insert 
the backup tape in rmt0 and the copy tape in rmt1. On Thursday, the tapes 

#minute  hour  day_of_month  month  weekday  command
0 23 * * 1,2,4,5 /server1/scripts/backtape 5 rmt0 rmt1 2>&1 | /bin/mail -s "Backup 
root
0 23 * * 6 /server1/scripts/backtape 5 rmt1 rmt0 2>&1 | /bin/mail -s "Backup level 
0 23 * * 3 /server1/scripts/backtape -copy 0 rmt0 rmt1 2>&1 | /bin/mail -s "Full Ba
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must be backed up and the copy sent to another place. In the table given 
below, there is an example of the backup schedule and tape labels.

Table 19.  Backup Schedule and Tape Labels

Another decision that needs to be made is how long you want to keep these 
tapes. For example, you can keep the backup tapes for the last year. For the 
most recent three months, you keep all the weekly backups. For the previous 
nine months, older tapes can be reused.

10.5.4  Backing Up a Server That Contains User Data
If you have a file system that contains all of the user data directories on the 
Lotus Domino Server, just replace the lines shown in Figure 273 in the script 
backtape with the lines shown in Figure 274 on page 292.

Figure 273.  Lines to Be Removed

Weekday Tape Labels

Tape rmt0 Tape rmt1

Monday Monday level 1 n/a

Tuesday Tuesday level 1 n/a

Wednesday MM/DD/YY level 0 MM/DD/YY level 0 copy

Thursday Thursday level 1 n/a

Friday Friday level 1 Saturday level 1

You must be careful when storing tapes for a long time because they 
maintain the data integrity only for a defined time period (generally one to 
two years). You also must be careful about reusing tapes.

Note

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $TAPE0..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/$TAPE0 $FS
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Figure 274.  Lines to Be Added

You will have the same backup schedule for the users’ data file system using 
the same tapes.

To restore the data of the /server1 file system, run the restore command (see 
10.5.5.1, “Restoring Files with Restore” on page 293). To restore the data of 
the /home file system, you must use the tctl command to advance the tape. 
With the restore command, specify the -f flag to indicate a non-rewinding 
device. The commands below list the table of contents of the /home file 
system backup. They assume the backup tape is available at the unit rmt0.

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 1
# restore -T -f /dev/rmt0.1

10.5.5  Restoring Data from Tape
To restore a whole file system, first ensure you have an empty and error-free 
file system before restoring the data from tape to it. Then, you will have to use 
the restore command.

To restore a database that is stored on tape or in a file, you must use the 
restore command. This command copies the database files you select from 
the tape to the hard disk. You can copy the backup file over the damaged file 
to restore the whole database or use one of the following tips to manage at 
the document level.

  • To preserve the new documents added since the last backup, restore the 
backup to a different directory, move it to the databases directory using a 
new file name, then copy and paste the new documents from the live 
database to the backup. Delete the live database, and rename the backup 
to the original name.

  • To restore a single, damaged, or deleted document, you must restore the 
backup of the whole database with a new file name and copy the 

# Make the system backup of the /server1
echo "\nMaking backup level $LEVEL of /server1 on ${TAPE0}.1..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 /server1
# Make the system backup of the /home
echo "\nMaking backup level $LEVEL of /home on ${TAPE0}.1..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 /home
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document from the backup to the live database. Following this, delete the 
backup database from the hard disk.

10.5.5.1  Restoring Files with Restore
The restore command extracts files from archives created with the backup 
command. To check a backup tape, you can use the restore command with 
the -T flag: restore -T -f /dev/rmt0. This command produces a list of all 
backed up files.

For example, if you lost the /server1 file system, to recover it on the last 
backup, you must take the appropriate actions (for example, remove the old 
files, remove the file system and create a new one, and so on) until you have 
an empty, mounted, and error-free file system in /server1. After that, as root:

1. Change directory to /server1. This is very important.

2. First restore the last full backup:

a. Make sure that your media (the tape or the file) is available.

b. Run the command:

# restore -x -v -f <device name>

If you are using the tape, use /dev/rmt0.1. You may need to run the 
tctl command. Use the tctl command when you have made more 
than one backup on a single tape. If you are using a file archive, use its 
name.

c. When the system prompts with the message

Specify the next volume number:

press 1 and Enter, and the restoration proceeds.

d. When the system prompts with the message

Do you want to set the owner or the mode for the current
        directory? [ yes or no ]

answer yes to set the owner and the mode for the /server1 directory.

3. If you have performed incremental backups since the last full backup, 
restore only the last incremental one. Insert the correct tape, or specify the 
new file name, and run the same command as above. Be sure to be in the 
/server1 directory, and run the same restore command.

If you want to restore only some files, restore them to a temporary directory, 
and then move them into place using the mv command. For example, as root, 
do the following:

1. Create a temporary directory, /server1/restore.
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2. Change the owner and group of this directory to notes.

3. Change the current directory to /server1/restore.

4. Make the archive media available as described above.

5. Run the command:

# restore -i -f <filename>

6. Use the -i flag subcommands to list the files. Select the ones you want 
and restore them.

Given below is an example to restore the file, names.nsf (Domino 
Directory database). What you need to type is highlighted.

Script for restoring the names.nsf file

# mkdir -m 750 /server1/restore
# chown notes.notes /server1/restore
# cd /server1/restore
# restore -i -f /dev/rmt0.1
Please mount volume 1 on /dev/rmt0.1.
        Press the Enter key to continue.

restore > ls
.:
 .Xpdefaults    .sh_history    notesr4/
 .profile       log/           scripts/

restore > cd server1
restore > ls
./server1:
 .notes4000     certlog.ntf    doclibm4.ntf   mail/          readme.nsf
 admin4.nsf     cluster.ncf    events4.ntf    mail.box       reserve4.ntf
 admin4.ntf     dba4.ntf       help4.nsf      mail4.ntf      server.id
 alog4.ntf      dblib4.ntf     helplt4.nsf    mailbox.ntf    statrep.ntf
 approve4.ntf   desktop.dsk    journal4.ntf   modems/        unix/
 cache.dsk      discuss4.ntf   log.nsf        names.nsf      user.id
 catalog.nsf    doc/           log.ntf        notes.ini      web.ntf
 catalog.ntf    doclib4.ntf    loga4.ntf      pernames.ntf   ~console.tmp
 cert.id        doclibl4.ntf   lotusen1.dic   pubnames.ntf   ~notes.lck

restore > add names.nsf
restore > extract
You have not read any media yet.
Unless you know which volume your file or files are on, you should start
with the last volume and work towards the first volume.
Specify the next volume number: 1
Do you want to set the owner or the mode for the current
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        directory? [ yes or no ] yes
restore > quit
# pwd
/server1/restore
# ls
server1
# cd server1
# ls
names.nsf
# mv names.nsf /server1
# cd ..
# rmdir server1
#

10.6  Backup and Recovery of the AIX System

It is very important to do a full system backup from the AIX server machine at 
least weekly. You will need to have a tape unit locally attached to each server 
you want to back up.

You can take a system backup to a file on a backup server, but you will need 
to set up a Network Install Manager (NIM) environment to be able to restore 
the AIX system from this file. 

To take a system backup, you need the bos.sysmgt.sysbr fileset installed in 
your system. You can use the command lslpp -l bos.sysmgt.sysbr to see if 
this file set is installed on your system. The mksysb command only backs up 
the rootvg volume group. If you have other Volume Groups, you can use the 
smitty savevg command.

10.6.1  Backing Up the AIX System
In this redbook, we show only the minimal procedure to do a system backup 
for the rootvg volume group. Please refer to the AIX Version 4.3 Installation Guide, 
SC23-4112 for more information about the system backup.

To backup the system:

1. Log in as root.

2. Mount all file systems (in the rootvg) you want to back up. Refer to the 
mount command for details.
Lotus Domino R5 Advanced Administration on AIX 295



3. Enter the smitty mksysb command. The Back Up the System screen, as 
shown in Figure 275, appears

Figure 275.  Back Up the System

a. Press F4 in the Backup DEVICE or FILE field and choose the tape for the 
backup.

b. Select yes on the EXPAND /tmp if needed? field.

c. Insert the tape in the unit, and press Enter.

The mksysb command does not back up file systems mounted across an 
NFS network.

Note

 Back Up the System

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
    WARNING:  Execution of the mksysb command will
              result in the loss of all material
              previously stored on the selected
              output medium. This command backs
              up only rootvg volume group.

* Backup DEVICE or FILE                              [/dev/rmt0]
  Create MAP files?                                   no
  EXCLUDE files?                                      no
  List files as they are backed up?                   no
  Generate new /image.data file?                      yes
  EXPAND /tmp if needed? yes
  Disable software packing of backup?                 no
  Number of BLOCKS to write in a single output       []
     (Leave blank to use a system default)

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do 
296 Lotus Domino R5 on IBM RS/6000



10.6.2  Restoring the AIX System Backup
In this redbook, we show only the minimal procedure to restore the system 
from the backup tape. Please refer to the AIX Version 4.3 Installation Guide, 
SC23-4112, for more information about the system backup.

To restore the system:

1. Insert the backup tape (write protected) in the tape unit.

2. Shut down and power-off the system.

3. Put the system key in the Service position, if there is a key.

4. Power on the system.

5. After several minutes, c31 is displayed in the LED. Choose the system 
console.

After this, turn the key to the normal position (when asked) and follow the 
installation menus.

10.7  Other Native AIX Backup Tools

Instead of the commands backup and restore, you may choose between 
several other tools for backup. Each of these tools have advantages and 
disadvantages over the others. One reason to choose another tool might be 
that your site is already using tar or cpio for other backups. It might then 
make sense to look into using the same tool for your Lotus Domino Server as 
well. In this section, we will give a quick overview of the other tools you may 
choose from. If you need more information, please refer to the man pages of 
the respective command.

  • The mksysb command will create a bootable tape on an ISA-bus 
(Industry Standard Architecture) machine, but not every ISA-bus 
machine will boot from tape. To determine if your system will boot from 
tape, run the command: bootinfo -e. If a 0 is returned, it will not boot 
from tape, and you must boot from CD-ROM to install your mksysb tape.

  • The mksysb tapes that are created on ISA-bus machines will not boot 
Micro Channel-based uniprocessor or Micro Channel-based symmetric 
multiprocessor machines, and mksysb tapes made from Micro 
Channel-based uniprocessor and Micro Channel-based symmetric 
multiprocessor machines will not boot on ISA-bus machines.

Note
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10.7.1  tar
tar (Tape Archiver) is a traditional AIX tool that has been around since the 
early days. As the name suggests, it archives files and puts them on a tape. 
The tar command works with the usual AIX files; so, it is not really restricted 
to archiving to tape. You can put your archives on almost anything that is a 
file in AIX. Basically, it is a very simple tool. All it really does is to take one or 
more files and directories and archives them into one single file. Nothing 
more, nothing less. There is no compression or encryption involved as in 
some other tools. If you want compression, for instance, you have the option 
of adding that after the archive is created.

It is possible to exchange the backup and restore commands that we have 
used so far with tar. This might be preferable if there is a mixed environment 
at your site, and the other hosts on your network don’t support the backup and 
restore commands. If you choose to do this, there are a few things to be 
aware of. First of all, unlike backup, tar can only back up files by file name. 
This is not really a problem, just different. Also, tar does not read files to back 
up from standard input. You must add the files and the directories to the 
command line when invoking tar. However, if you specify directories on the 
command line, tar will search those directories recursively; so, normally, you 
only need to specify one or a few. Finally, tar has some restrictions on file 
names, sizes, and attributes. For example, tar does not back up ACLs.

If you want to back up the directory (or file system), /usr/domino/lotus to tape 
device /dev/rmt0 using tar, you could use the following sequence of 
commands (note that the tar command ends with a space and a period):

The tar command does not normally perform any translations of file and 
directory names. Therefore, if you specify absolute path names when you 
back up files or directories, they will also appear at the very same location 
if you extract them later potentially overwriting an old file. A good rule of 
thumb is to always try to use relative path names with tar. A relative path 
name is a path name that does not begin with the character /.

Note
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Figure 276.  tar Command to Back Up /usr/domino/lotus

To list the entire archive, you would use tar -tvf /dev/rmt0, and to extract the 
entire archive to the current directory, you would use tar -xvf /dev/rmt0. Be 
advised that, when extracting files, tar will overwrite any existing files with the 
archived version if a file with the same name exists.

The tar command isn’t really able to create archives on remote hosts, but if 
your file system is on one host, and the tape device on another, and they can 
talk to each other over a network, you can use the following trick to copy your 
archive to the remote host. First of all, the root user on the local host must be 
trusted as root on the remote host; that is, the local machine name must be in 
the file /.rhosts on the remote host. Then, to back up the local directory 
/usr/domino/lotus to the remote tape unit /dev/rmt0, you would use the 
following commands. In this example, the remote host with the tape unit is 
called noteserv.

# cd /usr/domino/lotus
# tar -cvf . | remsh noteserv "dd bs=1024 of=/dev/rmt0"

The tar command has many more options worth exploring that are beyond 
the scope of this book. 

# cd /usr/domino/lotus
# tar -cvf /dev/rmt0 .
a .
a ./notes
a ./notes/5000
a ./notes/5000/ibmpow
a ./notes/5000/ibmpow/Notes.jar 401 blocks.
a ./notes/5000/ibmpow/icsclass.jar 447 blocks.
a ./notes/5000/ibmpow/getgroup 67 blocks.
a ./notes/5000/ibmpow/amgr 357 blocks.
a ./notes/5000/ibmpow/chronos 68 blocks.
a ./notes/5000/ibmpow/notes 28984 blocks.
...

  • This trick will only work with a remote host running AIX or some other 
version of UNIX.

  • Depending on the OS and the tape unit on the remote host, you might 
need to give a different block size. See the user manuals for the OS in 
question.

Note
Lotus Domino R5 Advanced Administration on AIX 299



10.7.2  cpio
The name cpio comes from the intended use of the command: CoPy files In 
and Out of archives. Just like tar, cpio has been around since the beginning 
of AIX. The cpio command differs from backup and tar by only working with 
the standard input and output of the shell. You must use shell redirection to 
send a cpio archive to permanent storage. To specify the files to be archived 
or extracted, you must supply them on the standard input of cpio. It may 
sound difficult, but it really isn’t. It also gives you great flexibility in how you 
want to list filenames and where to store the archive. Just like tar, cpio does 
not compress or encrypt the archived files, but it is very easy to add with 
other commands.

You may want to choose cpio for your backups if you are on a mixed 
environment network, or if your site already uses cpio for regular backups. 
The cpio command has similar restrictions on file name, size, and attributes 
to tar. The main difference is that cpio takes file names on standard input 
instead of the command line.

If you want to back up the directory (or file system) /usr/domino/lotus to tape 
device /dev/rmt0 using cpio, you could use the following sequence of 
commands:

The cpio command does not normally perform any translations of file and 
directory names. Therefore, if you specify absolute path names when you 
back up files or directories, they will also appear at the very same location 
if you extract them later potentially overwriting an old file. A good rule of 
thumb is to always try to use relative path names with cpio. A relative path 
name is a path name that does not begin with the character /.

Note
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Figure 277.  cpio Command to Back Up /usr/domino/lotus

To list the entire archive, you would use cpio -itvB < /dev/rmt0, and to extract 
the entire archive to the current directory, you would use cpio -idumvB < 
/dev/rmt0. Be advised that, when extracting files, cpio will overwrite any 
existing files with the archived version if a file with the same name exists.

For storing the archive on a remote tape unit, it is possible to use a trick 
similar to the one we used for tar in 10.7.1, “tar” on page 298. The same 
restrictions on network connectivity and trust relationship applies to cpio. For 
example, to back up the local directory /usr/domino/lotus to the remote tape 
unit /dev/rmt0 you would use the following commands. In this example, the 
remote host with the tape unit is called noteserv.

# cd /usr/domino/lotus
# find . -print | cpio -ovC2 | remsh noteserv "dd bs=1024 of=/dev/rmt0"

The cpio command has many more options worth exploring that are beyond 
the scope of this book. For more information, refer to the cpio manual page. 
Alternatively, you can also find relevant documentation, including a 
commands reference for AIX, at; 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide 
Web.

# cd /usr/domino/lotus
# find . -print | cpio -ovB > /dev/rmt0
.
notes
notes/5000
notes/5000/ibmpow
notes/5000/ibmpow/Notes.jar
notes/5000/ibmpow/icsclass.jar
notes/5000/ibmpow/getgroup
notes/5000/ibmpow/amgr
notes/5000/ibmpow/chronos
...

  • This trick will only work with a remote host running AIX or some other 
version of UNIX.

  • Depending on the OS and the tape unit on the remote host, you might 
need to give a different block size. See the user manuals for the OS in 
question.

Note
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10.7.3  savevg/restvg
If you followed the installation instructions in Chapter 2, “Installing a Lotus 
Domino R5 Server” on page 15, you have a good setup for using the 
commands savevg and restvg to back up your Lotus Domino Server. These 
two commands are significantly different from the ones we’ve described so 
far since they back up an entire volume group not just files or filesystems. 
However, this also means that you can’t perform incremental backups, nor 
can you backup or restore individual files or filesystems. (It is, however, 
possible to recover single files from a savevg backup using the restore 
command. See 10.5.5.1, “Restoring Files with Restore” on page 293 for more 
information.) These tools make it really quick for you to restore your system 
after a disk crash. They do not, however, provide very good help if you’ve 
accidentally removed a file and want to recover just that single file.

With savevg and restvg, you have the option, just like with tar and cpio, to 
save the backup to tape, a regular file on disk, or any other AIX supported 
file. It is not, however, possible to use the remote remsh trick above with 
savevg. Your only option, if you can’t save the backup locally, is to save the 
backup file to an NFS server or some other shared file system.

If you have a volume group dominovg that contains the logical volumes 
noteslv and notesdatalv, then you can use the following command to back up 
both your server file system and your Lotus Domino software file system. It is 
assumed that the directory or file system /backup exists and can hold 
dominovg in its entirety. Remember to shut down your Lotus Domino Server 
before starting the backup.
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Figure 278.  savevg Command To Back Up Dominovg

To restore the backup in the previous example, you would use:

# restvg -f/backup/savevg-dominovg-980731 -q

to restore dominovg to the same physical volume that it came from, or

# restvg -f/backup/savevg-dominovg-980731 -q hdisk1

to restore it to the physical volume hdisk1. You can specify more than one 
physical volume if you wish.

The commands savevg and restvg have many more options worth exploring 
that are beyond the scope of this book. For more information, refer to the 
savevg and restvg manual pages. Alternatively, you can also find relevant 
documentation, including a commands reference for AIX, at: 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide 
Web.

10.8  Advanced Backup Solutions

If you have a large installation of Lotus Domino with many hosts, and/or high 
demands of availability, you may want to consider using a more advanced 
backup solution. Some of these solutions can give you easier administration, 
on-line backup of your databases, and shorter recovery time in case of a 
system failure. They may also give you the opportunity to use multiple tape 
devices and tape libraries on several servers throughout your network.

# savevg -f/backup/savevg-dominovg-980731 -v dominovg

Creating list of files to back up.
Backing up 2366 filesBacking up to /backup/savevg-dominovg-980731.
Cluster 51200 bytes (100 blocks).
Volume 1 on /backup/savevg-dominovg-980731
a           70 ./tmp/vgdata/vgdata.files
a         2569 ./tmp/vgdata/dominovg/filesystems
a         2707 ./tmp/vgdata/dominovg/dominovg.data
a            0 ./server1
a            0 ./server1/lost+found
a          391 ./server1/.profile
a          654 ./server1/.sh_history
a            0 ./server1/
a            0 ./server1/unix
a          406 ./server1/unix/123.bmp
a           28 ./server1/unix/123.mac
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10.8.1  Backup of More Than One Server
If you have a small number of servers, you can implement local backups for 
each of them as described in 10.5.3, “How to Back Up Only One Server” on 
page 288.

Another idea is to make the backups on a host with enough disk space or to 
use the rdump command to back up to a remote tape. You will find a simple 
implementation of these two methods in the following subsections.

10.8.1.1  Backup on Disk
If you have a host with enough disk space and tape units, you can make it a 
backup server. First, you have to create the file system(s) for backups and, 
after that, export it/them through NFS or AFS.

Next, mount the backup file system on the servers you want backed up and 
change the script backtape to make the backups to files instead of on tapes. 
The updated script is presented in Figure 279 on page 305.

On the backup server, you need to back up the backup file system(s) to one 
or more tapes. This can be done using the backup command.

This sample environment will be used for our discussion on backup:

  • The backup server will be called noteserv. This is also a Lotus Domino 
Server. The /backup is the backup file system.

  • There are two other Lotus Domino Servers, called ah1610a and ah1610b. 
Both use NFS to mount the /backup file system from noteserv.

The new version of the backtape script is in Figure 279 on page 305. It is 
called backfile.
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Figure 279.  Modified Script to Back Up on Files (backfile)

This script makes the backup on the file 
/backup/<hostname>/backup.<level>.<date>.<weekday> where:

<hostname> is the machine host name.
<level> is the level of the backup. In our example, it will be 0 or 5.
<date> is the date of the backup in the format: YYMMDD (year, month, 

day).
<weekday> is the number of the weekday, beginning with 0 (Sunday) and 

ending with 6 (Saturday).

It also removes the old backup files for the same weekday. The backup 
operator must be sure that the copy to the tapes is working well. This is a 
critical part of this backup environment.

#!/bin/ksh
#@(#) backfile Lotus Notes backup procedure
#
# Usage: backfile <level>
#
FS=/server1
LEVEL=$1
FILE=/backup/‘/bin/uname -n‘/backup.$LEVEL.‘/bin/date ’+%y%m%d.%w’‘

echo "Backup level $LEVEL, file $FILE"
echo "Started on ‘date‘ on server ‘uname -n‘"

# Remove the old file for the last week.
echo "\nRemoving old backup files..."
/bin/ls -la /backup/‘/bin/uname -n‘/backup.$LEVEL.*.‘/bin/date ’+%w’‘

/bin/rm -f /backup/‘/bin/uname -n‘/backup.$LEVEL.*.‘/bin/date ’+%w’‘

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server..."
$FS/bin/stop_domino

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $FILE..."
/usr/sbin/backup -u -$LEVEL -f $FILE $FS

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/start_domino

echo "\nEnd of the backup program."
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In order to set up the backup environment, the following steps are required:

1. Create the /backup file system on noteserv. Remember, it must be large 
enough to hold all the backup files. Running smitty crjfs, you can create 
the file system. You have to specify the size of the file system, specify the 
mount point name (/backup), and ask for the automatic mount after the 
system restart. If you want, you can use a compressed file system.

2. Mount the new file system: mount /backup.

3. Export this file system to the machines you want to back up and do one of 
the following:

a. Give the client machines write access to the backup file system.

b. Export the file system and allow the hosts to have root access to the 
client machines.

c. Give 1777 permission to the directories that the client machines must 
write to.

The smitty fastpath for exporting a file system is mknfsexp.

4. Create a directory for each machine you want to back up. In our example, 
the directories /backup/noteserv, /backup/ah1610a, and /backup/ah1610b 
have to be created. These directories need permissions 1777 if you 
haven’t exported the /backup file system with the hosts allowed root 
access option to the client hosts.

5. Copy the script backfile to the /server1/scripts directory of all hosts.

6. Mount the /backup file system on ah1610a and ah1610b. Use smitty 
mknfsmnt and complete the fields as follows:
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Figure 280.  Mount the Remote /backup File System Using smitty

7. Create the crontab entries shown in Figure 281 on all hosts:

Figure 281.  Crontab for the Backtape Script

In this case, the level 5 backup is done every day except Wednesday 
when the full backup is done. This script must be present in the 
/server1/scripts directory for all the servers you want to back up. Also, the 
crontab lines must be present. Note, the backup server needs to run this 
script because it is a Lotus Domino Server too.

8. The backup server needs another script (See Figure 282 on page 308) to 
handle the backup files and copy them to the tapes. Put this script in 
/server1/scripts on noteserv.

Add a File System for Mounting

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
* PATHNAME of mount point                            [/backup]                 /
* PATHNAME of remote directory                       [/backup]
* HOST where remote directory resides                [noteserv]
  Mount type NAME                                    []
* Use SECURE mount option?                            no                      +
* MOUNT now, add entry to /etc/filesystems or both?   both                    +
* /etc/filesystems entry will mount the directory     yes                     +
   on system RESTART.
* MODE for this NFS file system                       read-write              +
* ATTEMPT mount in foreground or background           background              +
  NUMBER of times to attempt mount                   []                        #
  Buffer SIZE for read                               []                        #
  Buffer SIZE for writes                             []                        #
  NFS TIMEOUT. In tenths of a second                 []                        #
[MORE...21]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do 

#minute  hour  day_of_month  month  weekday  command
0 23 * * 0,1,2,4,5,6 /server1/scripts/backfile 5 2>&1 | /bin/mail -s "Backup level5" 
root
0 23 * * 3 /server1/scripts/backfile 0 2>&1 | /bin/mail -s "Full Backup" root
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Figure 282.  Script to Dump Backup Files to Tape (dumpfiles)

9. Create the crontab entry shown in Figure 283 on noteserv:

Figure 283.  Crontab for the Dumpfiles Script

The script dumpfiles copies all the data in the /backup file system to a 
tape. It must end before the Thursday backup begins.

To recover a file, if it is an old backup that is on tape, you have to copy it back 
to the hard disk and then use the restore command as described in 10.5.5.1, 
“Restoring Files with Restore” on page 293. To copy it to your hard disk, 

#!/bin/ksh
#@(#) dumpfiles:  Dump the backup files to
the tape.
# It must run on thursday night, after the operator confirm
# the success of the full backup from wednesday.
# Usage: dumpfiles
#

echo "dumpfiles: started on ‘date‘ on server ‘uname -n‘"

# These tapes attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of rmt0..."
/usr/sbin/chdev -l rmt0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape rmt0..."
/bin/tctl -f /dev/rmt0 rewind

#
# Make the backup of the /backup file system
#
cd /backup
find . -print | backup -q -f/dev/rmt0

# Ejecting the tape
echo "\nEjecting rmt0..."
/bin/tctl -f /dev/rmt0 offline

echo "End of the backup..."

#minute  hour  day_of_month  month  weekday  command
0 17 * * 4 /server1/scripts/dumpfiles 2>&1 | /bin/mail -s "Dumpfiles" root
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create a temporary directory, for example, /backup/tmp, and make it your 
current directory (using cd /backup/tmp). Then, use the restore command to 
extract the files you want.

To list the contents of the tape, you can use the following:

Figure 284.  List Contents of Tape

to extract the level 0 file from 2/21/96:

Figure 285.  Extract the Level 0 File

10.8.1.2  Backup Using rdump
Using the rdump command, you can use another machine tape for performing 
backups. The host with the tape will be called tape server, and the others will 
be called clients.

To use this command, the client machines must have root .rhosts access to 
the tape server machine. In our example, the tape server will be noteserv, 
and the clients will be ah1610a and ah1610b. The /.rhosts file for noteserv is 
shown in Figure 286:

Figure 286.  The /.rhosts File for the Tape Server noteserv

# restore -T -q -f/dev/rmt0
./noteserv
./noteserv/backup.5.960215.4
./noteserv/backup.5.960216.5
./noteserv/backup.5.960217.6
./noteserv/backup.5.960218.0
./noteserv/backup.5.960219.1
./noteserv/backup.5.960220.2
./noteserv/backup.0.960214.3
./noteserv/backup.0.960221.3
...

# cd /backup/tmp
# restore -x -q -f/dev/rmt0 ./noteserv/backup.0.960221.3
x ./noteserv/backup.0.960221.3

ah1610a.itsc.austin.ibm.com root
ah1610b.itsc.austin.ibm.com root
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The group and other users can’t have any access to this file.

Let’s again modify the backtape script as given below.

Script to backup several hosts (backhosts):

#!/bin/ksh
#@(#) backhosts Lotus Notes backup procedure
#
# Usage: backhosts [-copy] <level> <tape0> <tape1>
#
COPY=NO
FS=/server1
SERVER=noteserv
HOSTS="noteserv ah1610a ah1610b"

# Display error message and exits
Error () {
  echo "Usage: backhosts [-copy] <level> <tape0> <tape1>"
  echo "Example: backhosts 5 rmt0 rmt1" >&2
  exit 1
}

NARGS=$#
# Test for the copy option
[[ $1 = -copy ]] && { COPY=YES ; shift ; let NARGS=${NARGS}-1 ; }
# Test the number of flags, must be 3
[[ $NARGS -ne 3 ]] && Error

LEVEL=$1
TAPE0=$2
TAPE1=$3

echo "Backup level $LEVEL, tape0 $TAPE0, tape1 $TAPE1, copy=$COPY"
echo "Started on ‘date‘ on server ‘uname -n‘"

# These tapes attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of $TAPE0..."
/usr/sbin/chdev -l $TAPE0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape $TAPE0..."
/bin/tctl -f /dev/$TAPE0 rewind

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server"
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$FS/bin/stop_domino

for HOST in $HOSTS
do
  if [[ $HOST != $SERVER ]]
  then
    # Make the system backup of the $HOST:$FS
    echo "\nMaking backup level $LEVEL of $HOST:$FS on $TAPE0..."
    rsh $HOST /usr/sbin/sync
    rsh $HOST /usr/sbin/sync
    # The values of density (-d 6250) and tape length (-s 33000)
    # refers to the 8mm 2.3GB
    rsh $HOST /usr/sbin/rdump -d 6250 -s 33000 -u -$LEVEL \
        -f ${SERVER}:/dev/${TAPE0}.1 $FS
  else
    /usr/sbin/sync
    /usr/sbin/sync
    # Make the system backup of the $HOST:$FS
    echo "\nMaking backup level $LEVEL of $HOST:$FS on $TAPE0..."
    /usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 $FS
  fi
done

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/start_domino

# Making the tape copy...
if [[ $COPY = YES ]]
then
  # These tape attributes apply to the 8mm 2.3/5GB tapes
  # Check for the attributes that apply to your tape
  echo "\nChanging the attributes of $TAPE1..."
  /usr/sbin/chdev -l $TAPE1 -a block_size=1024 -a mode=yes -a extfm=yes

  # We have to rewind the tapes
  echo "\nRewinding the tape $TAPE0 for copy..."
  /bin/tctl -f /dev/$TAPE0 rewind
  echo "\nRewinding the tape $TAPE1 for copy..."
  /bin/tctl -f /dev/$TAPE1 rewind

  # Make the copy
  echo "\nMaking the copy of $TAPE0 on $TAPE1..."
  /bin/tcopy /dev/$TAPE0 /dev/$TAPE1

  # Ejecting the tape
  echo "\nEjecting $TAPE1..."
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  /bin/tctl -f /dev/$TAPE1 offline
fi

# Ejecting the tape
echo "\nEjecting $TAPE0..."
/bin/tctl -f /dev/$TAPE0 offline

echo "\nEnd of the backup program."

This script performs a remote shell on the client machines to do the remote 
backup. On the client machines, you will need the /.rhosts file (Figure 287) to 
permit noteserv to perform the remote shell.

Figure 287.  /.rhosts File for the Clients

The crontab entry on the tape server (noteserv) is shown in Figure 288.

Figure 288.  Crontab for the Backtape Script

Note that only one tape is required to perform all the backups. This can be 
done with the non-rewinding device; the tape name ends with "a .1".

In order to restore the files, you will need to run the tctl command to position 
the tape on the right backup. In our case, to restore the noteserv files, you 
don’t need to run tctl because it is the first backup. To restore the ah1610a 
backup, you need to advance to the second backup:

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 1

The first command rewinds the tape. On the second, it is very important to put 
the .1 at the end of the tape name. This command advances the tape to the 
second backup. To access the ah1610b backup, enter:

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 2

noteserv.itsc.austin.ibm.com root

#minute  hour  day_of_month  month  weekday  command
0 23 * * 1,2,4,5 /server1/scripts/backhosts 5 rmt0 rmt1 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 6 /server1/scripts/backhosts 5 rmt1 rmt0 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 3 /server1/scripts/backhosts -copy 0 rmt0 rmt1 2>&1 | /bin/mail -s "Full Backup" root
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The restore command is described in 10.5.5.1, “Restoring Files with Restore” 
on page 293.

10.8.2  ADSM
ADSTAR Distributed Storage Manager (ADSM) is an IBM product that can 
give you much more than the native AIX tools. Together with the 
ADSMConnect Agent for AIX, the Notes Agent, you get access to the 
following features:

  • Perform incremental backups of Lotus Notes databases at the document 
level backing up only those documents that have changed since the 
previous backup.

  • Recover individual documents in a database that have previously been 
backed up by the Domino Agent.

  • Recover individual documents that have been deleted from a Lotus Notes 
database.

  • Recover an entire Lotus Notes database.

  • Perform an incremental restore function by merging changed documents 
into a previously restored database.

  • On-line backup of a Lotus Notes database; that is, you can still use the 
database while backing it up.

  • Backup and recovery of access control lists.

  • Point in time recovery, meaning that you can restore your Lotus Domino 
Server to the state at a certain point in time.

  • Centralized backup of all Lotus Domino Servers.

When ADSM and the Domino Agent is installed, performing a backup is very 
simple. The following is a transcript of a sample backup session:
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Figure 289.  Transcript of a Sample Backup Session Using ADSM

Recovery is also very simple. For example, this is the command that you 
would type on the command line to recover a single database that already 
exists on your server: dsmnotes restore /server1/names.nsf -merge=yes.

For detailed installation and usage instructions, please refer to the Redbook 
on using ADSM with Lotus Notes, Using ADSM to Back Up Lotus Notes, 
SG24-4534. There is also a spot on the IBM Web site for ADSM.You find it at 
the following address: 
http://www.storage.ibm.com/software/adsm/adsmhome.htm.

10.8.3  Legato NetWorker
If you are currently using Legato NetWorker for backups on your system, you 
might be interested in using the Legato NetWorker BusinesSuite Module for 

# dsmnotes incr \*
ADSTAR Distributed Storage Manager
ADSMConnect Agent for Lotus Notes - Version 2.1.7
(C) Copyright IBM Corporation, 1990, 1997, All Rights Reserved.
Backing up database: /server1/busytime.nsf
Documents sent: 40
Documents sent: 80
Documents sent: 96
Documents deleted: 5
Backing up database: /server1/catalog.nsf
Documents sent: 29
Backing up database: /server1/log.nsf
Documents sent: 15
Documents deleted: 5
Backing up database: /server1/names.nsf
Documents sent: 40
Documents sent: 53
Documents deleted: 5
Summary:
Database: /server1/busytime.nsf
Documents backed up: 96, documents deleted: 5
Database: /server1/catalog.nsf
Documents backed up: 29, documents deleted: 0
Database: /server1/log.nsf
Documents backed up: 15, documents deleted: 5
Database: /server1/names.nsf
Documents backed up: 53, documents deleted: 5
Total number of documents backed up: 193
Total number of documents deleted: 15
Total number of bytes sent: 2210.5 KB
ANS09001 dsmnotes completed
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Lotus Notes to back up your Lotus Domino Server (the Notes Module). You 
will need to have the Legato NetWorker server software already installed on 
your system. With the Notes Module, you gain the following features in 
addition to what NetWorker normally offers:

  • Perform incremental backups of Lotus Notes databases at the document 
level backing up only those documents that have changed since the 
previous backup.

  • Recover individual documents in a database that have previously been 
backed up by the Notes Module.

  • Recover individual documents that have been deleted from a Lotus Notes 
database.

  • Recover an entire Lotus Notes database.

  • On-line backup of a Lotus Notes database; that is, you can still use the 
database while backing it up.

  • Point in time recovery, meaning that you can restore your Lotus Domino 
Server to the state at a certain point in time.

  • Centralized backup of all Lotus Domino servers.

It is beyond the scope of this book to describe installation and operation of 
Legato NetWorker and the Notes Module. For more information on these 
products, contact Legato Systems, Inc., or see their Web site at: 
http://www.legato.com/.
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Chapter 11.  High Availability, Scalability, RS/6000 SP

This chapter provides an overview regarding the various high availability and 
scalability issues related to Lotus Domino and the RS/6000 as well as the 
RS/6000 SP. For information about the RS/6000 SP, refer to 11.3, “Scalability 
and RS/6000 SP” on page 322. It does not provide a detailed description 
regarding all these issues, but it is a good starting point for getting familiar 
with these topics.

In general, you have to cover different areas of availability to provide high 
availability for a Lotus Domino Server. Each area is addressed by certain 
features or solution packages. 

1. System availability:

  • Addressed by hardware features, such as redundant components, fault 
tolerant components, service processor, and service director.

2. Data availability:

  • Addressed by operating system or hardware (RAID, AIX LVM, Lotus 
Domino replication); if data is not available by these mechanisms, you 
have to take care about restoring from a backup.

3. Service availability:

  • Addressed by Domino Enterprise Server (application failover and 
loadbalancing) for mail and application databases:

  • Focused on application errors.

  • Client view: Client does not reach their database.

  • Addressed by HACMP (restart of service in case the system is no 
longer available on another system):

  • Focused on hardware or operating system errors.

  • Server view: System is not working properly.

11.1  RS/6000 and AIX Issues

This section addresses high availability issues related to the RS/6000.

11.1.1  RS/6000 and AIX Basics
Depending on the model you are using for your Lotus Domino Server, 
different areas of hardware availability are covered. Redundant components, 
such as fans and power supplies, hot pluggable disks, and the ability for 
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remote maintenance by using a service processor (see 12.1.2, “Service 
Processor” on page 352), or the service director are features that make 
administration tasks a lot easier. For a closer look on these features, you 
might want to have a look at the system documentation books at: 
http://www.rs6000.ibm.com/resource/pubs.html; other valuable sources are the 
following redbooks:

  • RS/6000 SP Monitoring: Keeping It Alive, SG24-4873

  • RS/6000 Models E30, F40, F50 and H50 Handbook, SG24-5143

Within AIX, there are a couple of features that support the availability of the 
server and the application service. The most important regarding the Lotus 
Domino Server are:

  • Dynamic kernel reconfiguration
  • Logical Volume Manager (LVM)
  • Journaled filesystems
  • Automatic reboot after crash

The URL http://www.rs6000.ibm.com/library is a good starting point to get 
familiar with AIX and the RS/6000. You can also access the complete 
software documentation for AIX Version 4.3 at: 
http://www.rs6000.ibm.com/resource/aix_resource/pubs.

11.1.2  Service Processor
The service processor allows you to access your system remotely even 
without an active AIX. The service processor monitors the status of the 
system and sends a message to a remote site if a hardware or operating 
system problem is detected. The service processor enables remote power 
control, reset, and boot features. It also enables remote maintenance and 
diagnostic activities including console mirroring. Using a RS/6000 with a 
service processor is ideal for customers with geographically distributed 
computing environments that need to be serviced and monitored remotely.

The service processor enables or contributes to the following RAS functions 
among others:                                        

  • Integrated system environmental monitoring/alerting included as standard 
including AC/DC voltage, fan speed, and temperature sensing.

  • Early Power Off Warnings (EPOW), error log analysis, and alert.

  • Auto-dial out, call IBM Service Center capability. The system objective is 
to predict a potential component failure and automatically dispatch an IBM 
service representative to take preventive maintenance measures to avoid 
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an outage. The system may also call the IBM Service Center in the event 
of a critical failure.

  • Integrated system monitoring enhances failure error logging, analysis and 
alert. It can be programmed by the system administrator to re-boot after 
experiencing the following conditions:

  • AC power restored (after a power loss)

  • Hardware checkstop failures

  • Machine check interrupt

  • Operating system hang or failure

For a detailed description of a service processor, go to: 
http://www.rs6000.ibm.com/resource/hardware_docs. There you will find various 
manuals and guides.

11.1.3  RS/6000 HA50 Cluster Server
The RS/6000 High Availability Cluster Server - HA50 is a special 
package-priced solution with options for applications, services, and financing; 
it is not a new server model. The HA50 consists of currently marketed 
products:

  • H50 Enterprise Servers

  • 7133 Serial Disk System

  • HACMP cluster software

  • AIX operating system

Designated applications are featured solutions with the HA50. The 
applications (and the providers) are selected as focus segments. The 
featured application solutions include HA50 specific implementation guides 
and scripts, available from IBM, to simplify the planning and installation of an 
HA50 cluster. One of the applications currently featured is Lotus Domino 
Release 4.6.

The application scripts are executable start/stop failover scripts and are 
tested for compatibility with the specific application and the HA50. 
Implementation guides describe the scripts and provide assistance for 
planning and installation. The scripts and implementation guides are 
available from a central IBM repository and can be downloaded through the 
Internet by IBM Global Services (IGS), Business Partner, or customer service 
personnel from the IBM Web site at: http://www.rs6000.ibm.com/HA50scripts.
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11.2  Middleware Issues

On top of RS/6000 and AIX, you may apply some high availability solutions.

11.2.1  HACMP
HACMP works in conjunction with Lotus Domino and provides failover of 
service to another system. A common scenario is to run the nodes at lower 
than full capacity so that spare resources are available to cope with services 
failed over from a crashed node. Using this method provides hot failover, and 
under normal circumstances, all nodes are doing useful work; whereas, other 
hardware clustering mechanisms may require a redundant spare node, on 
which to failover services, that is not usually active. This wastes resources 
that could be usefully employed.

For a detailed discussion, please refer to:

  • High Availability and Scalability with Domino Clustering and Partitioning on AIX, 
SG24-5163

Background information about HACMP for both RS/6000 single server and 
SP systems is provided by:

  • RS/6000 SP HA Infrastructure, SG24-4838
  • Implementing High Availability on RISC/6000 SP, SG24-4742
  • High Availability on the RISC System/6000 Family, SG24-4551

11.2.2  Lotus Domino Clustering
As discussed in 7.5, “Domino Server Clustering” on page 173, Domino 
Enterprise Servers provide for high availability of your Lotus Domino service. 
This section provides rough guidelines on how to decide on which of the two 
clustering methods to use. For a detailed discussion, please refer to the 
redbook High Availability and Scalability with Domino Clustering and Partitioning on AIX, 
SG24-5163.

The decision to use Domino clustering or HACMP or a combination of both 
has to be made individually based on your specific needs.

The decision may be based on the technical restrictions or on your 
preference for one environment. Available skills may also be taken into 
account during the decision making process. There are no technical reasons 
why both cannot be used to complement each other to support specific 
scenarios.
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Table 20 shows some scenarios and constraints that may be used to guide 
the decision.

Table 20.  Selecting a Clustering Technology

From the implementation point of view, you should be aware of the main 
differences regarding the data handling.

  • HACMP would restart the defined services on another physical system 
(node) using the same data of the original system used (by acquiring the 
volumegroup from a shared disk array). For a Lotus Domino Server, that 
means restarting the server and running fixup on all databases that were 
open at the time of the takeover.

  • Domino Enterprise Server clustering provides real-time replication during 
normal operation to maintain replicas of the data available on another 
system. In the event of a crash on a heavily loaded system, outstanding 
synchronization events may not be actioned before the crash. If that 
should happen, slight differences between the databases on the original 
system and the replica databases would result until the crashed server is 
brought on-line again and standard scheduled replication re-synchronizes 
the changes.

  • With HACMP, even if the end user is working in an already opened 
database at the time of the service outage, the end user will be able to 
save their work afterwards, transparently, as HACMP has taken over the 
original IP address. Domino Enterprise Server clustering failover occurs 
only when opening a database.

Lotus Domino 
Server 
Functionality

Preferred 
Solution

Rationale

Mail HACMP or 
Domino

Domino Enterprise Servers support mail user 
failover, free-time lookup, and shared mail. 
Either can be used.

Mail Router HACMP or 
Domino

Mail delivery failover is supported at last hop or 
all hops in the routing path. Either can be used.

Application Domino For load balancing and failover of applications.

External Domain 
Replication

HACMP Domino clustering can support only servers in a 
single domain.

Internet HACMP or 
Domino running 
Internet Cluster 

Manager

Domino clustering now supports failover of 
HTTP/HTTPS requests when used with the 
Internet Cluster Manager.
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11.3  Scalability and RS/6000 SP

The most important point about scaling in a Lotus Domino environment is, as 
always, the proper design of your implementation. As soon as you have 
identified your Lotus Domino topology in terms of server instances, you have 
different possibilities to scale your installation. Again, the detailed scalability 
issues for your environment have to be identified individually, and you have to 
pick the approach that is right for you.

Scaling in terms of faster hardware on the same server is possible by adding 
additional memory and additional CPUs or additional network cards 
depending on your scaling needs. Therefore, if you expect growth during the 
lifetime of your server, you should start with an SMP system or with an SMP 
node in an RS/6000 SP. Remember that more than two CPUs are exploited 
best when running more than one Lotus Domino Server instance on the 
system (see 7.4, “Domino Server Partitioning” on page 162).

If you reach the limits of your single server, you must add an additional 
system. You could either use Domino Enterprise Server and/or HACMP to 
provide for high availability, as discussed in 11.2.2, “Lotus Domino Clustering” 
on page 320 and 7.5, “Domino Server Clustering” on page 173.

If you need more systems, you should plan in time for a RS/6000 SP since 
management of multiple servers would be much easier. If you know your 
scaling needs from the start, it would be wise to start with a one or two-node 
SP instead of starting with single boxes. If you want to use clustering right 
from the start, consider the SP High Performance Switch as the proper 
connection solution for the servers. You would follow the same procedure as 
described in 7.5.4, “Private LAN Configuration” on page 177, but instead of a 
second LAN adapter, use the IP address of the switch in setting up your port 
definitions.

Providing a scalable Web server solution could use the combination of 
Domino Enterprise Server clustering plus the Internet Cluster Manager task 
for directing Web clients to an appropriate server. The ICM provides 
loadbalancing between servers for HTTP and HTTPS requests. See 7.5.9, 
“The Internet Cluster Manager (ICM)” on page 191. 

11.3.1  RS/6000 SP: Planning
If you are going to install a Lotus Domino Server in a SP system, you should 
know some specifics of the software and the hardware of the RS/6000 SP. 
For a good starting point to get familiar with software and hardware of 
RS/6000 SP systems, refer to the new redbook Inside the RS/6000 SP, 
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SG24-5145. As the Scalable Parallel (SP) system is one of the most 
successful products within the RS/6000 family, this redbook provides a 
comprehensive and detailed look at the different components that make up 
this system. It also includes the history and evolution of the SP.

In general, running Lotus Domino on the SP is the same as on a cluster of 
distinct servers, from the point of view of the application, but you have to 
consider the system administration advantages of the RS/6000 SP as a 
foundation for your Lotus Domino Servers. You can also use all the 
information provided so far in this redbook about Lotus Domino on the 
RS/6000 SP. Major points to consider, especially for the combination of Lotus 
Domino and RS/6000 SP, are:

  • Use of the High Performance Switch as a separate network for Domino 
cluster communications.

  • Use of the High Performance Switch as a network for backup/restore 
purposes. If you have a large number of registered mail users, or high 
volumes of application data, you must carefully plan your backup/restore 
to fit into the timeframe available.

  • Use of the High Performance Switch in conjunction with a network routing 
node to gain network bandwidth advantages on connecting many clients 
instead of multiple network adapters per node.

The central source of information about how to implement Lotus Domino 
Servers using the RS/6000 SP is currently available at the IBM Web site: 
http://www.rs6000.ibm.com/resource/technology/notesSPcfg.

This location provides information about:

  • Planning the hardware
  • Planning SP Lotus Domino Servers
  • Planning SP AIX users
  • Planning disk space and configuration
  • Planning networks for Lotus Domino Servers
  • Planning Lotus Domino High Availability on the RS/6000 SP

Even if you are starting a small Lotus Domino implementation on your SP 
system, follow these recommendations. It will simplify the growth of your 
Lotus Domino environment in your SP system.

11.3.2  RS/6000 SP: Installation
After planning your installation, install Lotus Domino on the SP as usual (see 
Chapter 2, “Installing a Lotus Domino R5 Server” on page 15).
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1. Make sure the hardware is installed correctly and that each node meets 
the requirements for a Lotus Domino Server as described in 2.1, 
“Hardware, Software, and System Requirements” on page 15.

2. Make sure AIX and Parallel System Support Program (PSSP) are installed 
on all nodes; see 2.1, “Hardware, Software, and System Requirements” on 
page 15 and check with the current release notes of Lotus Domino for the 
needed PTFs. Lotus Domino on a RS/6000 SP needs the same PTFs as a 
standalone server.

3. Make sure your network connectivity is configured correctly (multiple IP 
addresses for the switch interfaces if you use partitioning or network 
routes). The server names you are going to use must be resolvable both 
by the servers and the clients. For details about multiple IP addresses and 
partitioning, see 7.4.4, “Configuring TCP/IP for Partitioned Servers” on 
page 168. Basic network setup is described in 2.2.4, “Step 4 - Configure 
TCP/IP” on page 18.

4. Make sure paging space is large enough for your environment as 
described in 2.2.15, “Step 15 - Paging Space” on page 36. There are no 
special requirements over those for a standalone server.

5. Make sure a user notes with group notes exists on every node where 
Lotus Domino is going to be installed. It does not have to be a login user, 
but it is used for file ownership of the server code. Details about creating a 
user can be found in 2.2.7, “Step 7 - Create AIX Users” on page 26.

6. For each server instance, create a user ID and make it a member of group 
notes.

7. Create the filesystem /usr/domino on each node where the Lotus Domino 
Server code is to be installed owned by user notes; see 2.2.10, “Step 10 - 
Create a Logical Volume for the Domino Binaries” on page 30 and 2.2.12, 
“Step 12 - Create a File System for the Domino Binaries” on page 33.

8. Create Volume Groups and filesystems, as planned, for each server 
instance owned by the appropriate user from step 5. A good naming 
convention is to create the filesystem with the server instance name. So, 
each filesystem for each server instance will have a different name. See 
2.2.9, “Step 9 - Create a Logical Volume for the Domino Data Directory” on 
page 28 and 2.2.11, “Step 11 - Create a File System for the Domino Data 
Directory” on page 32.

9. Modify each user’s profile as usual for a notes server user and specify the 
Domino binaries and data directory on the path.

10.Install the Lotus Domino Server executable code on all nodes through the 
Lotus Domino installation process. If you have the installation CD on the 
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SPs control workstation, you can install to multiple hosts at the same time 
if required. You do not have to modify the file .rhosts since the control 
workstation has access to the nodes anyway.

11.Configure each server instance by starting the http httpsetup setup task; see 
the details starting with 2.3.14, “Step 14 - Login” on page 52 and finishing 
with 2.3.22, “Step 22 - Server Setup is Complete” on page 58.

12.Perform further setup and administration of Lotus Domino as usual.

11.4  Further Information on High Availability and Scalability

As already pointed out several times, the redbook High Availability and Scalability 
with Domino Clustering and Partitioning on AIX, SG24-5163, provides valuable 
additional information on these topics. It gives a comprehensive explanation 
about the different ways of making a Lotus Domino Server highly available. It 
describes the Lotus Domino Clustering technology as well as the standard 
HACMP implementation for AIX and RS/6000 SP.

The redbook will help you to plan, install, and configure a highly available 
Lotus Domino Server using Lotus Domino Clustering and Partitioning as well 
as HACMP technology including the special version developed for the 
RS/6000 SP.

Within the six chapters of the book, you will find a good deal of information 
about what environment will better fit your needs for high availability and 
scalability as well as detailed examples for implementing those different 
environments.
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Chapter 12.  Troubleshooting

Some potential problems and solutions are presented in this chapter. Please 
also take a careful look at "Things you need to know->Platforms and 
requirements" in Release Notes: Domino Server R5 supplied on the Lotus Domino 
Server CD.

A good source for known problems regarding Lotus Domino is the Lotus 
Notes Knowledge Base. It is used by Lotus Support to collect known 
problems. If you work for IBM, you can access it on the intranet at: 
http://w3.ncs.ibm.com/lkb.nsf. If you are a Lotus Business Partner, please 
check with Lotus on how to access it. In general, you might want to go to: 
http://www.support.lotus.com and perform a search.

For RS/6000 related topics, it is worth visiting: 
http://www.rs6000.ibm.com/support and 
http://service.software.ibm.com/support/rs6000.

12.1  Cleaning Lotus Domino Processes

If a Domino Server should crash, you may have trouble restarting it. This is 
caused by corrupted shared memory and semaphores that the program does 
not clean. Even if you do not have trouble after a crash, it is a good practice 
to clean up before restarting any process. In order to clean up after a crash, 
you basically have three steps to perform:

1. Kill all processes of the server that failed.

2. Remove the associated Inter-Process Communication (IPC) resources, 
which are:

  • Shared memory segments
  • Semaphores

3. Remove the file ~notes.lck (located in the Domino data directory).

How do you do it manually?

Assume the Lotus Domino Server has been running with the userid notes:

1. Identify the processes to kill by issuing:

ps -ef | grep notes

(Assuming notes is the AIX account be used to run server).

2. Do a kill -9 on all suspicious processes either as user root or user notes.
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The following screen shot shows an example of a list of processes you might 
see after issuing the ps command. The screen below shows how to end the 
first Lotus Domino process. Preferably, you should use scripts to do the 
cleanup (see Figure 293 on page 330). 

Figure 290.  Sample Process Screen

After killing the processes, you have to remove the corrupted shared memory 
and semaphores. With the command ipcs, you can list them. With ipcrm, you 
can remove them. You have to identify the items to remove by looking at 
those belonging to the appropriate user (OWNER=notes in our example) and 
having the KEY started with 0xf80. Sometimes, there are also KEYs starting 
with 0x01, 0x02 or 0x03. See Figure 291 on page 329 for a sample of output 
and Figure 292 on page 329 on how to remove the IPC resources with their 
ID.

# ps -ef|grep notes
   notes 12886 25566   2 13:58:29  pts/2 24:24 /opt/lotus/notes/latest/ibmpow/pop3 
   notes 22190 18848   0   Feb 04  pts/2  0:00 -ksh 
   notes 22570 22190   0 13:57:15  pts/2  0:00 sh /opt/lotus/bin/server 
   notes 23272 25566   1 13:57:34  pts/2 11:25 /opt/lotus/notes/latest/ibmpow/replica 
   notes 23870 26372   2 13:57:48  pts/2 12:34 /opt/lotus/notes/latest/ibmpow/amgr -e 1 
   notes 24584 25566   2 13:58:04  pts/2 30:23 /opt/lotus/notes/latest/ibmpow/event 
   notes 24936 25566   0 13:58:09  pts/2 11:41 /opt/lotus/notes/latest/ibmpow/stats 
   notes 25332 25566   1 13:57:39  pts/2 13:07 /opt/lotus/notes/latest/ibmpow/update 
   notes 25566 22570   1 13:57:16  pts/2 129:09 /opt/lotus/notes/latest/ibmpow/server 
   notes 26188 25566   0 13:57:59  pts/2 13:05 /opt/lotus/notes/latest/ibmpow/sched 
   notes 26372 25566   0 13:57:44  pts/2 12:49 /opt/lotus/notes/latest/ibmpow/amgr 
   notes 27728 25566   0 13:58:44  pts/2 13:44 /opt/lotus/notes/latest/ibmpow/decs 
   notes 28032 25566   1 13:58:14  pts/2 14:51 /opt/lotus/notes/latest/ibmpow/http 
   notes 28566 25566   0 13:58:39  pts/2 36:22 /opt/lotus/notes/latest/ibmpow/nntp 
   notes 29532 25566   0 13:57:54  pts/2 11:24 /opt/lotus/notes/latest/ibmpow/calconn 
   notes 29996 25566   0 13:58:54  pts/2 12:51 /opt/lotus/notes/latest/ibmpow/maps 
   notes 30238 25566   1 13:58:24  pts/2 24:29 /opt/lotus/notes/latest/ibmpow/imap 
   notes 30686 25566   0 13:58:34  pts/2 15:55 /opt/lotus/notes/latest/ibmpow/ldap 
   notes 30826 25566   2 13:57:49  pts/2 19:37 /opt/lotus/notes/latest/ibmpow/adminp 
    root 31346  3522   0 10:59:51  pts/1  0:00 grep notes 
   notes 33114 25566   0 13:57:29  pts/2 12:54 /opt/lotus/notes/latest/ibmpow/router 
   notes 34396 25566   1 13:59:00  pts/2 26:02 /opt/lotus/notes/latest/ibmpow/smtp 
   notes 34826 22354   0   Feb 16  pts/5  0:00 -ksh 
   notes 36238 25566   1 13:58:19  pts/2 25:28 /opt/lotus/notes/latest/ibmpow/diiop
# kill -9 12886

Be careful when you are using the kill command. In general, the Notes 
processes have the path /opt/lotus/notes/latest/ibmpow. If you are absolutely 
sure that only the Lotus Domino processes have been run under the userid 
notes, you could do the following:

su - notes
kill -9 -1

Never run this command as root user.

Note
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Figure 291.  Output of ipcs Command

Figure 292.  Removing of IPC Resources

Figure 293 on page 330 shows a sample script that tries to kill all Notes 
processes and remove the semaphores and shared memory. It is only 
provided to show the principles; use at your own risk. 

Be sure to adjust the environment variables at the beginning to suit your 
environment.

$ ipcs
IPC status from /dev/mem as of Thu Feb 18 11:09:12 CST 1999
T        ID     KEY        MODE       OWNER    GROUP
Message Queues:
q         0 0x4107001c -Rrw-rw----     root   printq
Shared Memory:
m         0 0x580518df --rw-rw-rw-     root   system
m         1 0x00001a4c --rw-------     root   system
m         2 0x00000001 --rw-r--r--     root   system
m         3 0x47040813 --rw-r--r--   imnadm   imnadm
m        12 0x4404081a --rw-rw-rw-   imnadm   imnadm
m   2621453 0xf800d000 --rw-rw----    notes    notes
m        15 0x0d052168 --rw-rw-rw-     root   system
Semaphores:
s         0 0x580518df --ra-ra-ra-     root   system
s         1 0x440518df --ra-ra-ra-     root   system
s    131074 0x00001a4c --ra-------     root   system
s         3 0x620520df --ra-r--r--     root   system
s   2621459 0xf800d000 --ra-ra----    notes    notes
s   2621460 0xf800d001 --ra-ra----    notes    notes
s   2621461 0xf800d002 --ra-ra----    notes    notes
s   2621462 0xf800d003 --ra-ra----    notes    notes
s   2621463 0xf800d004 --ra-ra----    notes    notes
s   2621464 0xf800d005 --ra-ra----    notes    notes
s   2621465 0xf800d006 --ra-ra----    notes    notes
s   2097178 0xf800d007 --ra-ra----    notes    notes
s    786459 0xf800d008 --ra-ra----    notes    notes
$

$ ipcrm -s 2621459
$ ipcrm -s 2621460
$ ipcrm -s 2621461
$ ipcrm -s 2621462
$ ipcrm -s 2621463
$ ipcrm -s 2621464
$ ipcrm -s 2621465
$ ipcrm -s 2097178
$ ipcrm -s 786459
$ ipcrm -m 2621453
$ 
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Figure 293.  Clean Lotus Notes Processes Script - Killnotes

12.2  Monitoring File System Space

Assume your Lotus Domino Server data directory is installed in the filesystem 
/server1. You can monitor the filesystem use with the command df. Other file 
systems that must be verified are /, /var,/tmp, and /usr.

When you receive a file system full message, or when you want to increase 
the file system size before this error occurs, do the following as root:

1. Verify if you have space in the volume group that contains the file system 
you want to increase. Checkout the volume group by issuing lsvg 
dominodatalv.

#!/bin/ksh
NOTES_USER=notes # AIX userid for this server
NOTES_PATH=/server1 # Path for server data directory
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH # Ensure PATH is set for scripts

count=0
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
while [[ -n $NOTES_RUNNING ]] ; do
sleep 10
count=‘expr $count + 1‘
echo " ... waiting "$count"0 seconds"
#
# Terminate Domino Server if still running
#
if [ $count -eq 13 ] ; then
   echo "Domino Server is still running after 2 minutes"
   echo " ... now for the ungraceful method"
   for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print $2 }’‘; do
     kill -9 $i
   done
   mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’|\

awk ’{ print $1 }’‘
   sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ |\

awk ’{ print $1 }’‘
   for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
   for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
   echo "Lotus Domino R5 TERMINATED"
   exit
fi
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
done
#
echo "Domino for AIX ($NOTES_SERVER) shutdown completed

$ df -k /server1
Filesystem    1024-blocks      Free %Used    Iused %Iused Mounted on
/dev/dominodatalv      204800     13700   94%      840     2% /server1
$ 
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In this case, we have 632 MB available in the dominovg volume group.

2. Run the command smitty chjfs.

3. Select the file system you want to increase in size. In our example, 
/server1.

4. Type the new size (you can only increase the size) in the SIZE of file 
system (in 512-byte blocks) field. For example, the /server1 file system 
would be changed to 300 MB by entering 600000 in that field.

5. Instead of step 2 to 4, you could just type

crfs -a size=300000 /server1

or

crfs -a size=+190400

[190400 = (600000 - (204800*2); 204800 from df -k above]

If you need more space than is left in the volume group, you can acquire a 
new hard disk for the server and add it to the volume group. All of this 
filesystem handling is standard practice with AIX but may be new to 
someone used to PC-based operating systems.

In 4.3, “Monitoring Disk Space on File Systems on the Domino Server” on 
page 119, a script that monitors the disk space is described.

12.3  Increasing Paging Space

Paging space may affect the performance of your Lotus Domino Server. If 
paging space runs low, you may loose processes or cause a system panic. If 
you did not increase your paging space during the installation of the Domino 
Server as described in 2.2.15, “Step 15 - Paging Space” on page 36, we will 
show you how to do it in this chapter. 

# lslv dominodatalv
LOGICAL VOLUME:     dominodatalv           VOLUME GROUP:   dominovg
...
# lsvg dominovg
VOLUME GROUP:   dominovg                 VG IDENTIFIER:  00615151cb0638ff
VG STATE:       active                   PP SIZE:        4 megabyte(s)
VG PERMISSION:  read/write               TOTAL PPs: 258 (1032 megabytes)
MAX LVs:        256                      FREE PPs: 158 (632 megabytes)
LVs:            2                        USED PPs:       100 (400 megabytes)
OPEN LVs:       2                        QUORUM:         2
TOTAL PVs:      1                        VG DESCRIPTORS: 2
STALE PVs:      0                        STALE PPs:      0
ACTIVE PVs:     1                        AUTO ON:        yes
MAX PPs per PV: 1016                     MAX PVs:        32
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The size of the paging space is by default set to the size of the physical 
memory. If you want to increase the size of the default paging space (you 
can’t decrease), do the following as root:

1. Run the command smitty chps, and select hd6.

Figure 294.  Change/Show Characteristics of a Paging Space

2. Enter the number of additional logical partitions you want (Figure 294). Be 
sure to enter the right number of partitions based on your volume group’s 
Physical Partition (PP) size. With the lsvg command, you can see the 
logical partition size:

In the above example, the hd6 paging space size will be increased by 16 
MB.

Alternatively, you can add another paging space to the system either in a 
different volume group or just on a different disk for performance reasons, or 
on the same disk if you think of decreasing paging space again later on. A 
paging space can be added by doing the following steps:

1. Run the command smitty mkps and make appropriate selections or just 
enter mkps -s’4’ -n -a dominovg.

This would add an additional paging space size of 4 partitions in dominovg 
for immediate use.

2. To list the total paging space, you can use the command lsps -a.

 Change / Show Characteristics of a Paging Space

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Paging space name                                   hd6
  Volume group name                                   rootvg
  Physical volume name                                hdisk0
  NUMBER of additional logical partitions            [4] #
  Use this paging space each time the system is       yes +
          RESTARTED?

F1=Help                F2=Refresh              F3=Cancel              F4=List
F5=Reset               F6=Command              F7=Edit                F8=Image
F9=Shell               F10=Exit                Enter=Do                              

# lsvg rootvg |grep SIZE
VG STATE:       active                   PP SIZE:        4 megabyte(s)
# 
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Figure 295.  List Paging Space

To remove an active paging space, change its characteristics so that it is not 
configured at the subsequent system restarts (smitty chps or chps command). 
On the next system restart, the paging space is not active, and it can be 
removed.

12.4  Accessing a Server in a Different TCP/IP Domain

If you want to access a Domino Server in a different TCP/IP domain, your 
Domino Server (for example server1/ibm) has to be able to translate the 
Lotus Domino Server name of the second server (for example Jupiter/Mainz) 
into a valid TCP/IP address (for example jupiter.mainz.ibm.com). Table 21 
shows the TCP/IP and the Lotus Domino Names. The two servers or 
organization certifiers have to be cross-certified if they do not share the same 
certification hierarchy.

Table 21.  Client and Server Names

The following sections explain two different methods of achieving this either 
from within Lotus Notes or from within the network layer.

12.4.1  Setup within Lotus Notes
To setup a connection between two servers in different Domains, you have to 
add a Server Connection Document.

1. Start the Domino Administrator.

2. Choose the desired server.

3. Choose Configuration -> Connections.

4. Select your server.

5. Click on Add Connection.

Server Location TCP/IP Name Lotus Domino Name

Local server1.itsc.austin.ibm.com server1/ibm

Remote jupiter.ncs.mainz.ibm.com jupiter/Mainz

# lsps -a
Page Space  Physical Volume   Volume Group    Size   %Used  Active  Auto  Type
paging00    hdisk1            dominovg       16MB      26     yes   yes    lv
hd6         hdisk0            rootvg         128MB      51     yes   yes    lv
# 
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6. In the Basics tab: 

  • Choose the Connection type Local Area Network.

  • Check the Source Server name.

  • Enter the Source domain.

  • Select the LAN port TCPIP.

  • Enter the Destination Server name.

  • Enter the Destination domain.

  • Enter the Optional network address.

7. If needed, customize the settings in the Replication/Routing and the Schedule 
tab.

8. Save and Close the Server connection document.

Figure 296.  New Server Connection - Basic Tab

Now server1/ibm can connect to jupiter/Mainz.

12.4.2  Setup on the Network Layer
If you are not using a server connection document, you must have an alias for 
the server name in question (jupiter), which can be resolved by TCP/IP name 
resolution. If you are using the /etc/hosts file, you have to add to it a line, 
such as the one in Figure 297:

Figure 297.  Host Names Line

9.3.240.214 jupiter.ncs.mainz.ibm.com jupiter
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If you are using NIS, ask your NIS administrator to add a line (such as the 
one in Figure 297 on page 334) to the host’s file. He/she should add the 
address line to his/her host’s file and propagate it to the NIS hosts map.

If you are using Domain Name Server (DNS), you can ask your DNS 
administrator to add to the local Name server an alias for your Lotus Domino 
Server name pointing to your TCP/IP complete server name. If you don’t have 
a machine with the same name as your server name in your domain (in our 
example, if the machine jupiter.ncs.mainz.ibm.com does not exist), you can 
add a search tag to the /etc/resolv.conf file of your Domino Server machine. 
Note that if you have a search tag, you have to remove the domain tag.

In our example, the original /etc/resolv.conf would look like this:

The new resolv.conf would look like this:

You can have up to eight domains added to the search list.

12.5  Errors at Startup of HTTP Task

If you are running partitioned servers and more than one has the HTTP task 
active, you have to change the http task settings. 

1. Open the Domino Administrator.

2. Select the desired server.

3. Choose Configuration -> Web -> Web Server Configuration.

4. Select the Domino Server you want to change.

5. Choose Internet Protocols -> HTTP.

6. Enter the host name.

7. Enable bind to host name.

8. Save and Close the Document.

nameserver      9.3.240.2
domain  itsc.austin.ibm.com

nameserver      9.3.240.2
search itsc.austin.ibm.com ncs.mainz.ibm.com
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Figure 298.  HTTP Server Basic Settings

Afterwards, stop the HTTP task from the server console (tell http quit) and 
restart it (load http). You may want to have a look at the file domino.cnf in the 
servers data directory afterwards; it now contains two lines like this:

bindspecific yes
hostname itsosmp.itsc.austin.ibm.com

This combination allows each servers HTTP task to listen on the specific port 
built by hostname:port without the need to have different port numbers per 
server.

The error you get on start-up of Lotus Domino’s http task, if another http 
daemon is already running, normally looks like:

19/02/99 11:38:27 HTTP Socket bind error, hostname/ip ausres26.itsc.austin.ibm.com
19/02/99 11:38:27 HTTP server: Could not bind port 80. Port may be in use
19/02/99 11:38:27 HTTP Web Server shutdown

Note
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Appendix A.  Hints and Tips

We have collected some useful pieces of information that made our lives 
easier during our residency here at the International Technical Support 
Organization at IBM in Austin, Texas. The information provided here pertains 
to Lotus Domino Server R5 and AIX version 4.3.1 or higher.

A.1  Installation and Upgrade

These hints and tips pertain to the installation and upgrade process of Lotus 
Domino Server.

A.1.1  Backup, Backup, Backup

Ensure that a complete backup is taken of any server prior to any upgrade. To 
reverse a software upgrade by restoring from a backup will be significantly 
easier and less time consuming than having to re-install and re-configure the 
original software.

A.1.2  Upgrade Order Not Chaos

The recommended order in which to tackle upgrading from Domino 4.6 to 
Domino R5 is:

1. Public Name and Address Book (NAB)
2. Hub servers
3. Mail and application servers
4. Other servers 
5. Client software
6. Application design

A.1.3  HTTP Web Setup

It is a good idea to make a backup copy of the file called websetup.nsf that is 
located in your server’s data directory after you have finished installing the 
software from the CD. If there isn’t a backup copy of this file, and the http 
setup fails for whatever reason, the only course of action is to delete the 
installation and reinstall from the CD. If there is a backup copy of this file, 
then simply copy the backup over the original file and run the http setup 
again.

A.1.4  The Domino Directory

In our testing environment, we found it necessary to manually compact the 
Domino Directory (names.nsf) twice in order to make use of the ODS 
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database format. This was true for upgrades as well as new installations. To 
compact the Domino Directory, make sure the server has been stopped, 
change to the Domino data directory (/server1), and use the command 
compact names.nsf. Do this twice and restart the server. Remember, you must 
run this command as the notes user. Do not run the compact command as the 
root user.

A.1.5  Database Design 

Make sure that the design elements of a database that are not to be changed 
by a design refresh or design replace have the property Do not allow design 
refresh/replace to modify enabled.

A.2  AIX Operating System

These hints and tips pertain to the AIX operating system.

A.2.1  PATH Environment Variable

In 2.2.2, “Step 2 - Check Your Default Path Environment Variable” on page 
16, we discussed the requirements for the PATH environment variable in AIX. 
Something that should be considered is adding /opt/lotus/bin to the PATH 
environment variable as well. Although this is not a requirement, it simplifies 
having to type long commands with their directory. For example with 
/opt/lotus/bin added to the PATH environment variable, the administrator 
could just type server from the Domino data directory instead of having to 
type /opt/lotus/bin/server.

A.3  Disks

These hints and tips pertain to installing and configuring disks on a RS/6000 
system.

A.3.1  Directory Names and Mount Points

When installing a new Domino server, it is recommended that the Domino 
data directory names be the same as the server names. This is very 
important in a partitioned environment. For example, if a company had a 
RS/6000 system with three partitioned servers, and the server names were 
Grape, Tomato, and Orange, the data directories should be called /grape, 
/tomato, and /orange. This makes for easier administration both in Domino 
and AIX.
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A.3.2  Recommendations for Large Files

In 2.2.11, “Step 11 - Create a File System for the Domino Data Directory” on 
page 32 and 2.2.12, “Step 12 - Create a File System for the Domino Binaries” 
on page 33, we discussed how to create a Journaled File System (JFS) for 
the Domino binaries and data files. The physical file size limitation of a 
standard JFS is 2 GB, but Lotus Domino Server R5 allows file sizes up to 64 
GB. To allow Domino to fully utilize its storage capacity, the data directory 
must be stored on a Large File Enabled Journaled File System instead of a 
Standard Journaled File System.

A.3.3  Volume Groups, Logical Volumes, and File Systems

In Chapter 2, “Installing a Lotus Domino R5 Server” on page 15, we explained 
how to set up volume groups, logical volumes, and file systems for the 
Domino server. In our example, we placed the entire data directory in a single 
file system within a single volume group. For best performance, multiple file 
systems and multiple volume groups that span no more than one to two disk 
drives should be used. Creating separate file systems for the data directories, 
mail directories, and application directories on separate disk drives greatly 
improves I/O performance. For Domino mail servers, use multiple mail 
directories, such as /data/mail1, /data/mail2, /data/mail3. Each directory 
should be a separate file system and on a different disk drive to maximize 
performance.

A.3.4  Striping Versus Spreading

Striping is a technique for spreading a logical volume across several disk 
drives so that I/O capacity can be used in parallel when accessing data. The 
primary objective of striping is very high performance reading and writing of 
large sequential files. For randomly accessed files, striping may not be 
effective. Domino performs frequent small random disk accesses; therefore, 
striping provides no benefit. The best solution is to simply spread the file 
systems associated with the Domino data directories across as many drives 
as possible. This will help balance the I/O requests over multiple drives; 
however, this does not ensure that I/O will be completely balanced across all 
drives. Spreading will give you the capability to relocate heavily used files to 
other less utilized file systems, thus, balancing the I/O.

A.3.5  Mirroring Versus RAID 5

Mirroring outperforms RAID 5 for reads and writes but costs more for the disk. 
This does not consider cache or interconnection technology that can also 
make a difference. Nor does it consider full stripe writes that avoid the RAID 5 
write penalty. It only considers the bandwidth of the actual disks. The 
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recommendation is to use mirroring for more flexibility and control of file 
locations and to use RAID 5 for more capacity with fewer drives.

A.3.6  Transaction Logs

Since the transaction logs are critical to data integrity and maximum 
performance, it is strongly recommended that the disk used to contain the 
Transaction Log Extent be mirrored and, if possible, connected to a separate 
disk controller than that used to service the Domino data directory.

A.4  Server Partitioning and Clustering

These hints and tips pertain to Lotus Domino Server partitioning and 
clustering.

A.4.1  Partitioned Servers

When installing partitioned servers, we recommend manually specifying the 
data directories since the file system mount points will already have been 
created and may not match the default names generated by the install 
program. Consider associating the name of the server with the mount point of 
the file system for clarity and ease of administration.

A.4.2  Partition Number

The file used to identify the partition number for the server, 
.sgf.notespartition, is no longer used in R5. Instead, the partition name is 
based upon the data directory name. For example, a data directory name of 
/server1 generates a partition identifier of .server1.

A.4.3  AIX Owner - Partitioned Servers

For ease of administration, each partitioned server should be run using a 
different AIX user account name. The ownership of each set of data files must 
be changed except for those in the first data directory. The ownership of the 
files in the first data directory should be set correctly using the user name 
specified during the install. To change the ownership of subsequent data 
directories, use the command chown -R <user>.<group> /directory. For 
example:

# chown -R notes2.notes /server2

This will change all files in the directory /server2 and any subdirectories 
located under that file structure.
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A.5  Domino Configuration

These hints and tips pertain to configuring Lotus Domino Server.

A.5.1  Domino Server Security

To ensure that all security mechanisms are covered, disable all access and 
then re-enable only the specific areas of access that are required. Having to 
remember to enable a feature is much less of a risk than having to remember 
to disable one as security may already have been breached.

A.5.2  Flat Versus Hierarchical

If your server environment still uses flat ID files, consider moving to a 
hierarchical certification model for increased security, flexibility of access 
control, and simpler administration through the use of the administration 
process.

A.5.3  Router/SMTP Configuration

Remember, when adding a configuration document for the Router/SMTP 
configuration settings through the Domino Administrator, to enclose any 
TCP/IP addresses in square brackets. For example [5.34.67.100] or 
[5.34.67.*]. If the square brackets are omitted, the TCP/IP address will be 
ignored.

A.6  Client Configuration

These hints and tips pertain to configuring the Lotus Notes client software.

A.6.1  Client Software

In a WIN32 server environment, where the administration client can be 
installed on the server, a Domino Administrator Only installation is relevant. In 
an AIX server environment, the administration client must be run from an 
administrator’s workstation, and since the administrator is also a user, it is 
easier to install all clients on the workstation using the Install All Clients 
option.

A.6.2  Change the Default Home Page

The default home page is set to the Welcome database (bookmark.nsf) when 
the R5 client is installed. This default can be changed by right clicking on any 
bookmark listed in the Favorite Bookmarks or Databases folders and 
selecting Set Bookmark as Home Page. 
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A.7  Notes.ini Settings

These hints and tips pertain to various parameters in the notes.ini file.

A.7.1  Notes_SHARED_DPOOLSIZE

In Domino R5 the Notes_SHARED_DPOOLSIZE parameter is now specified 
in the notes.ini file and not as an AIX environment variable. When upgrading 
from Domino 4.6, remove this variable from the user .profile or environment 
definition files. Only manually specify this in the notes.ini file when the 
number of shared memory segments exceeds seven. See 3.2.6, “Modifying 
AIX Environment Settings” on page 78 for more information.

A.7.2  NSF_Buffer_Pool_Size

The parameter NSF_Buffer_Pool_Size may or may not have been specified 
for a machine running a single partitioned server. In Domino R5, it is 
recommended that it not be specified for a single server. However, it should 
always be specified for partitioned servers as the physical memory in the 
machine has to be shared between multiple servers. Use the formula 
((physical memory / number of partitions) / 4) to figure out a good starting 
value to be specified in each server’s notes.ini file.

A.7.3  View_Rebuild_Dir

For optimal performance of the indexing process, it is better to store the 
temporary files that are used on a different physical disk not on the same disk 
as the Domino data directory. To change the location in which temporary files 
are stored during indexing, specify View_Rebuild_Dir=/directoryname in the 
server’s notes.ini file.

A.8  Server Console

These hints and tips pertain to Lotus Domino Server console commands.

A.8.1  CConsole Administration

Consider registering a user ID specifically for this purpose that does not have 
access to databases. Should the ID file be copied from the file system and 
the password compromised, it will be of limited use. If a specific user ID is not 
created, then consider creating a separate administration group to contain 
users allowed to use the AIX remote console, and add this group name to the 
field on the server document in addition to the existing entries. Relevant 
users can then be specified as being able to use remote console but do not 
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obtain the same access privileges to databases that existing administrators 
may have.

A.8.2  Running a Batch File of Console Commands

Several console commands can be executed using a single command that 
calls a batch file. To do this, simply create a text file in AIX that has a list of 
server console commands you want to execute and save that file in the 
Domino data directory. Each command should be on a separate line, and the 
name of the batch file can be anything. Once the file has been created, the 
batch file is ready to be executed from the server console window. The syntax 
for the command is < batchfilename. This is very useful for administrators who 
may perform a series of console commands over and over again. This 
batchfile can also be executed from a scheduled server program document in 
the Domino Directory.

A.9  Miscellaneous Items

These hints and tips pertain to miscellaneous items that just didn’t fit 
anywhere else.

A.9.1  Easter Eggs

Although this isn’t really anything useful, we thought it was kind of nice to 
include it anyway. We ran across two easter eggs in the Lotus Notes R5 
client. Please don’t try these using the beta version of the client because it 
wasn’t functioning correctly. To view the easter eggs, start the R5 client and 
then click on the Help pull down menu and select About. When the R5 logo 
appears, type one of the these two phrases, and the easter egg will begin.

  • super.human.software

  • start
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Appendix B.  Lotus Domino R5 - New Features and Enhancements

Lotus has continually enhanced the Notes and Domino products over the past 
year. Notes/Domino R5 provides updated and broader adherence to industry 
Internet and messaging standards. Listed below are details of what is new in 
Release R5.

B.1  Networks Features

Features related to Networks are as listed below.

Administration

  • Ability to track connections for IMAP, LDAP, SMTP and NNTP servers, 
added statistics, and connection status information

  • Ability to start and stop Notes network and dialup ports through the 
console command (START/STOP PORT <portname>)

  • Added more trace information to help diagnose connectivity problems, 
including TRACE server console command

  • Ability to log and monitor passthru connections

Connectivity 

  • Connection configuration wizard in Location document
  • Able to connect to Notes servers using TCP host names or abbreviated 

name
  • Automatic importing of network addresses from other domains (such as 

external, remote, or foreign) by expanding the Notes
  • Name Service - Enhanced server search process by leveraging the 

improved Notes Name Service
  • NDS lookup modified to locate Domino servers within the users’ login NDS 

context
  • Ability to dial international calls without having to wait for the dial tone

Mobile

  • Integrated remote LAN support for IMAP, LDAP, POP3, NNTP, and 
outbound SMTP connections for Notes clients/workstations.

  • Notes workstation can now be setup using dial-up networking.
  • Added new command async scripting language to allow interactive dialogs 

during script execution.

Performance
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  • Server networking model was re-architected for high performance and 
scalability.

Security

  • IMAP, LDAP, SMTP, and NNTP servers now support 128-bit session 
encryption (with SSL) for use with export limited Internet clients (requires 
Verisign Global Server IDs).

B.2  Language Features

Features related to language are as listed below.

  • Users can now automatically recompile their LotusScript through a C API 
without manually using the IDE.

  • JavaScript is now available on client platforms (Win32 and Macintosh) so 
that it can be used for applications that need to support both browsers and 
Notes clients.

  • Allows any page embedded with JavaScript to trigger and manipulate 
plug-ins and Java applets loaded on the page and allows applets and 
plug-ins to communicate back to JavaScript code.

  • The Notes client and the Designer IDE now support Java for edit/compile 
as well as other languages. The InfoPane can now be used to browse 
Java and NOI classes.

  • LotusScript enhancements including additional built-in functions to 
manipulate Notes text lists; a 2 pass compiler allows forward references.

  • LotusScript code can now be up to 64 K possibly removing some of the 
need for libraries and allowing long strings.

  • LotusScript International Thai Support.

B.3  Messaging Features

Features related to messaging are as listed below.

  • Send MIME without conversion - The R5 Notes Client can compose, edit, 
and send messages in either MIME or CD formats. The R5 mail router now 
routes MIME without conversions, which improves fidelity and 
performance. 

  • Notes RPC, POP3, and IMAP Native MIME integration - No need for 
format conversions when messages are sent/received over Notes RPC, 
POP3, or IMAP protocols. MIME is now a first class native Notes format.

  • Directory Catalog support on server - This allows you to store a compact 
collection of all the directory information in your company. With this 
feature, most name lookups can be resolved on your home server without 
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the presence of all the directories for your enterprise. The Directory 
Catalog is very compact. You can store a million entries in less than 120 
megabytes.

  • Mobile Directory Catalog - You can store an entire enterprise-worth of 
compressed directory information on your desktop/laptop.

  • Native SMTP - You no longer need the Lotus SMTP MTA. Notes is now 
fully SMTP compliant and can intelligently choose whether to route mail 
using SMTP or Notes RPC.

  • Native Internet addressing - You can now use Internet addresses to 
address mail to your Notes clients.

  • LDAP V3. 
  • LDAP add, delete, modify.
  • Router MIME conversion - The R5 router can assume the role of the Lotus 

SMTP MTA for servicing R4.x systems that need to connect to the 
Internet.

  • Router controls and message quotas - This allows you to control spam 
mail from entering your enterprise. It also allows you to control what size 
messages can be sent. For example, you can ensure that very large 
messages get a low priority and are only transmitted during certain times 
of the day, such as late at night.

  • Namelist creation for external authorization - This allows you to plug in 
foreign LDAP directories to your Directory Assistance database, and then 
use those foreign databases to authenticate HTTP clients. This also 
means that you don’t have to put your HTTP users in the Domino 
Directory.

  • Calendar gateway - Allow a calendar gateway to be specified in a 
non-adjacent domain record.

  • NAMELookup to LDAP mapping - This is useful for existing SDK users of 
NAMELookup that don’t want to rewrite their code to work with LDAP 
client APIs.

  • Pull Router - This allows your mail router to pull mail on a schedule from 
other routers.

  • Schema publishing for LDAP - This is useful for customers who want to 
use LDAP to access a Notes directory.

  • LDAP Language Tags - This allows multiple language versions of your 
directory entries.

  • Domino Directory Extensible Schema and Binary attribute support - These 
APIs support adding and removing schema extensions to directory forms.

  • LDAP Schema publishing - Publishing Domino Directory objects over 
LDAP.

  • LDAP Schema checking - Checking LDAP writes against the associated 
directory objects schema (through the associated form) to verify attributes.
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B.4  Security Features

Features related to security are as listed below.

  • Password Quality Testing - Administrators can now specify one of five 
password quality levels. The higher the level, the more complex the 
passphrase needs to be, and the more difficult it is for an unauthorized 
user to guess the IDs passphrase. 

  • Lost Password Recovery - Allows administrators to recover an ID file if a 
user loses, damages, or forgets the password for the ID.

  • Alternate name support - The alternate name feature allows 
administrators to assign a primary name and an alternate name to users 
and certifiers.

  • S/MIME (secure MIME) signed mail - signing and verification of 
signatures, using x.509 certificates.

B.5  Administration Features

Features related to administration are as listed below.

  • New Domino Administrator - Task-based, graphical server administration 
client.

  • New install - Separate installation of the Domino Administrator client using 
industry-standard InstallShield.

  • Move User - Drag and drop users in the People & Groups tab of the 
Domino Administrator to move them from one home server to another.

  • NT User migration application enhancements.
  • Server Monitoring - Real time server monitoring and troubleshooting tool 

displays the status and availability of Notes servers and services.
  • Single copy object store admin - New view in LOG.NSF that shows who is 

using space in your shared mail files.
  • Improved user registration and migration - including the ability to migrate 

users from other messaging systems (including cc:Mail, MS Mail, and 
Exchange) during user registration.

  • NT service for partitioned servers - You can run partitioned servers as NT 
services.

  • Decommission server analysis - The Decommission Sever Analysis tool 
enables administrators to consolidate existing servers and take existing 
servers out of service permanently.

  • Administration process enhancements - Extensibility - third-parties can 
enhance and extend the admin process, cross-domain features, moving a 
user’s mail file.
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  • Exchange to Notes migration tool - The Administration portion of the tool is 
complete. The end user tool for migrating local and personal data will be 
available in a later Beta build.

  • MS Mail to Notes migration tool.
  • cc:mail to Notes migration tool.
  • Organizer 2.x to Notes migration tool.
  • Graphical view of server statistics.
  • HTTP clusters/ICM.
  • OS clusters (support for Wolfpack).
  • Global database routing.
  • Internet addressing tool.
  • NT single log-on.
  • Third-party integration - Third-party vendors of migration tools can plug 

into our new Domino Upgrade Services SPI and have their tools tightly 
integrated with Domino Administrator.

  • Domino Upgrade Services - A Service Provider Interface (SPI).
  • Integrate Mail and TCP service monitoring - You can monitor the health of 

all of your Internet protocol servers, such as HTTP, IMAP, LDAP, NNTP.
  • Message Tracking - The ability to see where a message is during routing
  • Topology Maps - Graphically display your messaging and replication 

topologies.

B.6  Programmability Features

Features related to programmability are as listed below.

  • Domino Enterprise Connection Services (DECS) - A new forms-based 
technology in Domino that provides the capability to integrate live data 
from enterprise systems natively into Domino applications.

  • CORBA - Access Notes/Domino services from a browser. CORBA and 
CORBA remote interfaces allow you to place a custom applet on a form 
and have that applet access the Notes Object Model in both the Notes 
client and a browser.

  • View enhancements for backend classes. 
  • LSXBE enhancements (various backend classes).
  • Rich text enhancements for backend classes.
  • Synchronous new mail agents.
  • Reduce latency in agent manager.
  • New API to limit agent runtime.
  • Remote API to limit agent runtime.
  • Expose Profile documents.
  • Super catalog - Now the catalog has more information.
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  • Two-port listener - Allows SSL & non-SSL version of IIOP at the same 
time.

  • Java libraries.
  •  IIOP libraries.
  • Date/Time zone - Synchronized between Domino/Notes and OS 

(Win95/NT).

B.7  Database Features

Features related to databases are as listed below.

  • Transactional logging and recovery - When enabled, this provides atomic 
transactions for all Domino API functions. It provides full database 
integrity and a replacement of Database Fixup on system restart with 
high-speed transaction roll forward/rollback from transaction logs along 
with support for backup and recovery APIs.

  • New database options - A set of options you can specify on database 
creation to provide higher performance and functionality for specific uses. 
For example, unread marks can be disabled for individual databases to 
avoid the sometimes substantial overhead of maintaining unread marks 
for all users of the database.

  • Anti-delete - Deleted item recovery. This provides the ability to restore 
deleted notes for a designer-specified amount of time by accessing them 
in a special view type. By setting the soft delete database option, and by 
creating this view, mistakenly deleted documents can be retrieved simply 
and quickly.

  • 32GB database support on NT and Unix.
  • Full backup API - This is an API for backup vendors.

B.8  UNIX Features

Features related to UNIX are as listed below.

  • Telnet into Server Console - This allows the administrator to remotely 
attach to their server consoles in a secure way and administer their 
Domino servers.

  • Ultra-Sparc Inst Set Utility - This takes advantage of some Ultra-Sparc 
instructions (if available) to enhance performance on these boxes.

  • AIX Atomic Changes - Allows performance improvements by changing 
some of the low-level atomics on the AIX platform. 

  • Solaris MMAP Memory - Uses memory mapping for some resources to 
speed access and improve performance.
350 Lotus Domino R5 on IBM RS/6000



  • Posix Async I/O - Increases the performance/scalability by using Async 
I/O to make our handling of thread resources more efficient on the UNIX 
platforms.

  • Auto Restart Enhancements - This provides various improvements to the 
auto-recovery feature.

  • Batch Console Commands - This allows console commands to be batched 
and executed on one or many Domino servers.

  • Consolidated Config Data - This simplifies the multiple sources of 
configuration data by allowing it to be stored in a single place.

  • Script Driven Install - This allows the users to provide an install script that 
can then completely automate the install process.

B.9  Client Navigation and General Features

Features related to client navigation and general features are as listed below.

  • Microsoft Office Mail integration - Uses Notes with your Microsoft Office 
Mail.

  • Internet Explorer V4 integration - IE4 support built right into Notes.
  • Desktop mail integration Table enhancements - more formatting options 

including HTML formatting.
  • Table programmability. 
  • Highlighter Text - Highlights text as if you were using a highlighter pen.
  • Stylesheet support in editor.
  • New KeyView Viewers for Win32 platforms - More file types supported.
  • Print Preview (W32) - You can now click the Preview button from the Print 

dialog to view your document before printing.
  • Alarms - Visual notifications that you can display even when Notes isn’t 

running. Plus, audible notifications allow you to choose your own alarm 
sound.

  • Removal of mail license type. 
  • Tabs for windows - New tabs allow you to switch windows in Notes with 

just one click.
  • Top level window support. 
  • Universal navigation buttons and navigation history - Back, Forward, Stop, 

Refresh, Search, and Go. These buttons, similar to those in popular Web 
browsers, appear at the top-right corner of the main window.

  • Find/Replace dialog box - More ease of use features including the new 
Wrap around option. When the search has reached the bottom of the 
document, Wrap around sends it back to the top to continue searching.

  • File Open dialog box - Enhanced File Open and Database Open that 
allows you to read about and bookmark a database without opening it.
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  • Import/Export (INSO) - Import lets you convert files from another 
application into a form that Notes can use; export lets you convert a Notes 
document or view into a form that another application can use.

  • Drag/Drop into Bookmarks - Uses drag and drop to create a bookmark of a 
database, document, Web page, newsgroup, or folder.

  • Bookmarks view replace desktop - Enhanced navigation lets you view and 
manage your databases.

  • Just-In-Time encrypting of Mobile Directory Catalog.
  • Undelete of documents - Allows you to easily retrieve deleted documents.
  • Embedded calendar control - Easy-to-use, graphical aid to calendar 

navigation.
  • Internet Certificates - Can obtain Internet certificates as well as Notes 

certificates.
  • ID File recovery - If you misplace your password, you can get a recovery 

password by contacting your Administrator.
  • Notes Minder - Runs in your operating system task bar allowing you to 

receive new mail notification and calendar and scheduling reminders 
without running Notes. 

  • Online Help Enhancements - New format, layout, and ease-of-use in a 
separate window.

  • Text flow in editor - Text flows from one-column to the next, also in tables.

B.10  Client Template Features

Features related to client templates are as listed below.

  • Bookmark template - Notes version
  • Headlines template - Notes version
  • Personal journal - Notes version
  • Personal Address Book - Notes version
  • Calendaring and Scheduling - Repeating meeting fixes
  • Calendaring and Scheduling - Tasks behave as Calendar entries
  • Mail template - Notes version
  • Reservation template - Notes version only
  • Discussion - Notes and Web version
  • Document library - Notes and Web version
  • Team Room - Notes and Web version

B.11  Server Template Features

Features related to the sever template are as listed below.

  • Search template - search form - Notes and Web version
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  • Search site template - Notes and Web version

B.12  Client Protocols Features

Features related to client protocols are as listed below.

  • LDAP search for Personal Address Book 
  • LDAP configuration
  • HTML rendering
  • Authentication of Internet protocols
  • LDAP Picklist support 
  • Applet/Bean persistence 
  • Type-down addressing
  • Convert HTML to CD
  • IMAIL Asyncronous folder/viewer operators LDAP (FC except for UTF8, 

2nd pass lookup, fix references)
  • Type-ahead re-implemented
  • IMAIL setup
  • Deployment (setup) improvements
  • HTML parsing
  • Universal Inbox
  • IMAIL folders
  • MIME import/rendering
  • MIME export
  • IMAIL POP3 support
  • NNTP driver
  • IMAIL API
  • IMAP
  • IMAP replication

B.13  Designer Features

Features related to the designer are as listed below.

  • New Designer client.
  • Imagemaps - Web-standard clickable images that you can edit directly on 

forms and pages.
  • Outlines - Hierarchical navigation and organizational tools.
  • Framesets - Frameset editor for building framesets for use in your client 

and browser apps; many types of links can have frame targets set on 
them. Design elements can be auto-launched into a frameset to maintain 
the look of your application.
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  • HTML Support - Rich text content and can be stored as HTML and edited 
WYSIWYG. Many more HTML attributes can be manipulated WYSIWYG.

  • Context-sensitive Help events - Application designers can provide 
formulas to execute when a user hits F1, and new commands make 
finding help easy.

  • Design Synopsis - The Design Synopsis has been overhauled to provide 
much more information in a more useful way.

  • Native images - Images can now be stored in their native form (JPEG, 
GIF) and can be displayed or served directly in that form. Animated GIFs 
work as well.

  • New design lists - Application developers get a more useful list of design 
elements with more information about each design element displayed.

  • Preview in multiple browsers - You can now preview your application in 
any of your browsers with handy buttons available for the browsers you 
have installed.

  • Non-scrollable editor regions - The top of a form can be marked as a 
non-scrolling region that stays visible at the top of the user’s window.

  • Tabbed tables - Tables can now be used to build multipanel user interfaces 
with a variety of mechanisms for changing the panel on display.

  • Recursive tables - Tables can be nested within tables to build more 
sophisticated layouts.

  • Field improvements.
  • Fields can now be sized directly.
  • Fields can be blended into the form better.
  • The tab order of fields can be set.
  • Native controls (combo boxes, for example) can be used as fields.
  • Password-style fields.
  • Much more sophisticated date and currency fields

  • Pages - Simple pages can be created as design elements without working 
with forms.

  • Shared actions - Actions can be shared across design elements much like 
subforms or shared fields.

  • Embedded Views - Embedded views are now supported by the Notes 
client and have more power. You can compute a single category to display, 
and you can control the number of lines to display on the Web.

  • Improved IDE - It’s easier to see your programmable objects, the functions 
available to you, and how to use them.

  • Java libraries.
  • IIOP libraries.
  • Hidden field generation.
  • JavaScript - The Designer understands JavaScript. All the JavaScript 

events are scriptable in the IDE in the Designer.
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  • New Links - Links can now be created to named design elements to 
provide more powerful and flexible navigation through your app.

  • LotusScript front end classes enhancements.
  • Image and Java Applet Resources.
  • Embedded calendar control - Easy-to-use.
  • Graphical aid to calendar navigation.
  • User interface applets - New applets provide views, outlines, action bars 

and styled-text editing in web browsers.

B.14  Applet Features

Features related to applets are as listed below.

  • View Applet 
  • Outline Applet
  • Rich Text Editor Applet
  • Action Bar Applet

B.15  Web Server Features

Features related to the Web server are as listed below.

  • Domino Web Server API (DSAPI) - A C API for writing Web server 
extensions for custom authentication, logging, and so on.

  • HTTP server clusters - Supports Web access among a cluster of Web 
servers.

  • Domino for IIS - Domino’s Web application engine can be used as an 
extension to Microsoft’s Internet Information Server (IIS) on Windows NT.

  • Java Servlet upgrade - Support for the Java Servlet API Specification 
version 2.0 published by Sun Microsystems, Inc. Version 2.0 adds new 
interfaces for cookies and HTTP sessions.

  • HTTP-based server setup - Domino server setup for OS/2 and UNIX 
platforms is now done through a Web browser connected to the Web 
server.

B.16  Support for Domino Designer Features

Features related to the support for the Domino Designer are as listed below.

  • Nested and tabbed tables.
  • Pages.
  • Outlines.
  • Framesets.
  • Imagemaps.
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  • JavaScript events.
  • Shared actions.
  • View, outline, and rich text applets.
  • Native images.
  • Image and applet resources.
  • CORBA applet support.
  • MIME content support.
  • File system ACLs can set access controls for files and directories that are 

accessed through the Web server.
  • Management and logging enhancements - Can reload HTTP configuration 

without restarting the server. Can specify time intervals for log files: 
monthly, weekly, daily, and so on.

  • Byte range serving - Support for byte range requests. Allows restart of file 
downloads and byte range serving for Adobe Acrobat (PDF) files.

  • Last-modified headers - Domino now sends Last-Modified headers with 
almost all HTTP responses greatly improving a browser’s ability to cache 
responses locally.

  • Multilingual databases - The Web server now supports the language 
properties of design elements in multilingual databases. The server 
chooses the most appropriate version of a design element based on the 
HTTP Accept-Language header sent by a browser.

B.17  Domino Directory Design Changes

The following table lists the main changes made to the design of the Domino 
Directory database.

Table 22.  Design Changes to the R5 Domino Directory

New Server Views

External Domain Network Information
Holiday
Web Configurations

New People Views
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Alternate Language Information
$ExternalDomainNetworkAddress
$ExternalDomainConfigurations
$ExternalDomainServerConfigurations
$Holidays
$LDAPCN
$LDAPG
$LDAPS
$PeopleGroupsByLang
$PeopleGroupsByCorpHier
$PeopleGroupsByPhonetic
$RegisterGroups

Deleted Views

$ACLMonitor
$RepMonitors
$Thresholds
$NamesFieldLookup (if all clients are R4.5x or higher)

New Forms

External Domain Network Configuration
Configuration Settings (was Domain Configuration)
Holiday
(AlternateLanguageInformation)
(ExternalDomainNetworkAddress)
(FileProtection)
(FileProtectionDialog)
(Mapping)
(VirtualServer)
($MessageSettings)
(InternetMail)

New Server Views
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Appendix C.  Licensing

The Domino Server Family is based on a singular architecture; so, you can 
choose the server that best meets your current needs and upgrade later. 
There are three servers available:

  • The Domino Mail Server

  • The Domino Application Server

  • The Domino Enterprise Server

There are also four Notes Client Licenses available:

  • Notes for Messaging

  • Notes for Collaboration

  • Domino Designer

  • Domino Application Studio

The Domino Servers and Notes Clients are supported on the following 
platforms.

Table 23.  Available Platforms for Release 5.0

For more details, please refer to: http://www.lotus.com, any Local Lotus 
Office, or Lotus Business Partner.

Platform Domino Server Release 5 Notes Client Release 5

UNIX (AIX V 4.3.1 or higher, 
HP-UX 11.0, Solaris/SPARC 2.6, 
Solaris/Intel 2.6)

Yes No

OS/2 Warp Server V4.0 Yes No

Windows 95/98 No Yes

Windows NT Server 4.0 and 
Windows NT Workstation 4.0

Yes Yes

Novell NetWare No No

Macintosh Power PC 7.6, 8.1 No Yes

AS/400 V4R2 Yes No

S/390 V2R6 Yes No
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Appendix D.  Using UNIX’s vi Editor

For those new to UNIX’s vi editor, below is a list of useful commands to help 
when using vi.

Table 24.  Useful vi Commands 

Command What Does It Do?

0 (zero) Move to the beginning of line.

$ Move to end of line.

/search_string Search forward for next line containing search_string.

?search_string Search backward for next line containing search_string.

A Append text, in insert mode, at end of line.

a Append text, in insert mode, after current cursor position.

^b Move up one screen.

B Move to previous space-delimited word.

b Move to previous word.

Backspace Move left one character.

C Change to end of current line.

cw Change word.

^d Move down half a screen.

D Delete until end of line.

dw Delete word.

dd Delete line.

ESC Leave insert mode and return to command mode.

^f Move forward on screen.

G Move to the last line of the file.

nG Move the nth line of the file.

h Move left one character.

I Insert text at beginning of line.

i Insert text before the current character.
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j Move down one line.

k Move up one character.

l Move right one character.

n Repeat last search.

O Open new line for insertion above current line.

o Open new line for insertion below current line.

Return Move to start of next line.

^u Move up half a page.

U Undo any changes to current line.

u Undo last changes made to file.

W Move forward one space delimited word.

w Move forward one word.

x Delete the current character.

:q Quit vi and return to the shell.

:q! Quit vi and return to the shell without saving any changes 
made to the file.

:w Write the changed file to disk.

Command What Does It Do?
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Appendix E.  Special Notices

This publication is intended to help the Lotus Notes systems administrator to 
install, set up, and administer Lotus Domino R5 in an IBM RS/6000 AIX 
operating system environment. The information in this publication is not 
intended as the specification of any programming interfaces that are provided 
by Lotus Domino. See the PUBLICATIONS section of the IBM or Lotus 
Programming Announcement for Lotus Domino R5 for more information 
about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not 
imply that IBM intends to make these available in all countries in which IBM 
operates. Any reference to an IBM product, program, or service is not 
intended to state or imply that only IBM’s product, program, or service may be 
used. Any functionally equivalent program that does not infringe any of IBM’s 
intellectual property rights may be used instead of the IBM product, program 
or service.

Information in this book was developed in conjunction with use of the 
equipment specified, and is limited in application to those specific hardware 
and software products and levels.

IBM may have patents or pending patent applications covering subject matter 
in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to the IBM 
Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, 
NY 10594 USA.

Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual 
use of the information which has been exchanged, should contact IBM 
Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any 
formal IBM test and is distributed AS IS. The information about non-IBM 
("vendor") products in this manual has been supplied by the vendor and IBM 
assumes no responsibility for its accuracy or completeness. The use of this 
information or the implementation of any of these techniques is a customer 
responsibility and depends on the customer’s ability to evaluate and integrate 
them into the customer’s operational environment. While each item may have 
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been reviewed by IBM for accuracy in a specific situation, there is no 
guarantee that the same or similar results will be obtained elsewhere. 
Customers attempting to adapt these techniques to their own environments 
do so at their own risk.

Any pointers in this publication to external Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of 
these Web sites.

The following document contains examples of data and reports used in daily 
business operations. To illustrate them as completely as possible, the 
examples contain the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and 
addresses used by an actual business enterprise is entirely coincidental.

Reference to PTF numbers that have not been released through the normal 
distribution process does not imply general availability. The purpose of 
including these reference numbers is to alert IBM customers to specific 
information relative to the implementation of the PTF when it becomes 
available to each customer according to the normal IBM PTF distribution 
process.

The following terms are trademarks of the International Business Machines 
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc. in the United States and/or other 
countries.

Java and all Java-based trademarks and logos are trademarks or registered 
trademarks of Sun Microsystems, Inc. in the United States and/or other 
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States and/or other countries.

ADSTAR AIX
AS/4000 AT
BookManager CT
IBM  IMS
Micro Channel OS/2
RISC System/6000 S/390
SP System/390
XT 400
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PC Direct is a trademark of Ziff Communications Company in the United 
States and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel 
Corporation in the United States and/or other countries. (For a complete list 
of Intel trademarks see www.intel.com/dradmarx.htm)

UNIX is a registered trademark in the United States and/or other countries 
licensed exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or service 
marks of others.
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Appendix F.  Related Publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this redbook.

F.1  International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO 
Redbooks” on page 369.

  • Lotus Domino Release 4.6 on IBM RS/6000: Installation, Customization, and 
Administration, SG24-4694

  • High Availability and Scalability with Domino Clustering and Partitioning on AIX, 
SG24-5163

  • Implementing High Availability on RISC/6000 SP, SG24-4742

  • High Availability on the RISC System/6000 Family, SG24-4551

  • RS/6000 SP High Availability Infrastructure, SG24-4838

  • RS/6000 SP Monitoring: Keeping It Alive, SG24-4873

  • Understanding LDAP, SG24-4986

  • Using ADSM to Back Up Lotus Notes, SG24-4534

  • RS/6000 Models E30, F40, F50, and H50 Handbook, SG24-5143

F.2  Redbooks on CD-ROMs

Redbooks are also available on the following CD-ROMs:

CD-ROM Title Collection Kit 
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbook SK2T-8038

Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849

RS/6000 Redbooks Collection (HTML, BkMgr) SK2T-8040
RS/6000 Redbooks Collection (PostScript) SK2T-8041
RS/6000 Redbooks Collection (PDF Format) SK2T-8043

Application Development Redbooks Collection SK2T-8037
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F.3  Other Publications

These publications are also relevant as further information sources:

  • Lotus Domino R5 Administration Help, (help/help5_admin.nsf)

  • Lotus Notes R5 Client Help, (help/help5_client.nsf)

  • Notes Installation Guide for Servers, (doc/srvinst.nsf)

  • Workstation Install Guide, (doc/wrkinst.nsf)

  • Notes Migration Guide, (doc/migrate.nsf))

  • Release Notes: Domino Server R5, (help/readme.nsf)

  • SMTP MTA Administration Guide, (smtpag.nsf)

  • AIX V4.3 Installation Guide, SC23-4112

  • IBM Internet Connection Server for AIX, Users Guide, SC31-8194

  • AIX Performance Tuning Guide, SC23-2365

  • AIX Version 4 System Management Guide: Communications and Networks, SC23-2526

F.4  World Wide Web Publications

The following World Wide Web online information can be used for further 
reference:

  • The Domino Cluster Zone, http://www.lotus.com/cluster

  • Lotus Notes Internet Cookbook for Release 4, 
http://NS.notes.net/cookbook/cbook.htm

  • Iris Today Articles, http://www.notes.net

  • Workload Balancing with Domino Clusters

  • Fine Points of Configuring a Domino Cluster

  • The Domino Internet Cluster Manager
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How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, 
redpieces, and CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

  • Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download or order hardcopy/CD-ROM redbooks from the redbooks web site. Also 
read redpieces and download additional materials (code samples or diskette/CD-ROM images) from 
this redbooks site. 

Redpieces are redbooks in progress; not all redbooks become redpieces and sometimes just a few 
chapters will be published this way. The intent is to get the information out much quicker than the 
formal publishing process allows.

  • E-mail Orders

Send orders via e-mail including information from the redbooks fax order form to:

  • Telephone Orders

  • Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest 
information for customer may be found at http://www.redbooks.ibm.com/ and for IBM employees at 
http://w3.itso.ibm.com/.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order” 
section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

IBM employees may register for information on workshops, residencies, and redbooks by accessing 
the IBM Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. 
Look in the Materials repository for workshops, presentations, papers, and Web pages developed 
and written by the ITSO technical professionals; click the Additional Materials button. Employees 
may also view redbook. residency, and workshop announcements at http://inews.ibm.com/.

IBM Intranet for Employees
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IBM Redbook Fax Order Form

Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries.  Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
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List of Abbreviations

ACL Access Control List

ADSM ADSTAR Distributed 
Storage Manager

AFS Andrew File System

AIX Advanced Interactive 
eXecutive

APAR Authorized Program 
Analysis Report

API Application 
Programming Interface

ASCII American Standard 
Code for Information 
Interchange

ATM Asynchronous Transfer 
Mode

CAPI Common ISDN 
Application 
Programming Interface

CD Compact Disk

CDE Common Desktop 
Environment

CGI Common Gateway 
Interface

CORBA Common Object 
Request Broker 
Architecture

CPU Central Processing Unit

CRC Cyclic Redundancy 
Check

DAS Domino Advanced 
Services

DAT Digital Audio Tape

DCE Distributed Computing 
Environment

DECS Domino Enterprise 
Connection Services
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DES Domino Enterprise 
Server

DLT Digital Linear Tape

DNS Domain Name System

DOS Disk Operating System

DRT Delivery Report Task

DSAPI Domino Web Server 
API

ECL Execution Control List

E Pow Early Power Off 
Warning

FDDI Fiber Distributed Data 
Interface

FTP File Transfer Protocol

GID Group ID

GIF Graphical Interchange 
Format

GTR Global Text Retrieval

HACMP High Availability 
Clustered 
Multi-Processing

HPS High Performance 
Switch

HTML Hypertext Markup 
Language

HTTP Hypertext Transfer 
Protocol

IBM International Business 
Machines Corporation

ICM Internet Cluster 
Manager

IGS Information Gateway 
Service

IMAP Internet Message 
Access Protocol

IMAP4 IMAP, Version 4
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IIOP Internet Inter-Orb 
Protocol

IIS Internet Information 
Server

IND Interactive Network 
Dispatcher

I/O Input/Output

IP Internet Protocol

IPC Inter-Process 
Communication

IPX Internetwork Packet 
eXchange

ISA Industry Standard 
Architecture

ISDN Intergrated-Services 
Digital Network

ISP Internet Service 
Provider

ITSO International Technical 
Support Organization

JPEG Joint Photographic 
Experts Group

LAN Local Area Network

LDAP Lightweight Directory 
Access Protocol

LIPS Lightweight Internet 
Person Schema

LVM Logical Volume 
Manager

MB Megabytes

MIME Multipurpose Internet 
Mail Extensions

MTA Message Transfer 
Agent

MX Mail Exchanger

NAB Name and Address 
Book

NFS Network File System

NIC Network Interface Card

NIF Not in File

NIM Network Install 
Manager

NIS Network Information 
System

NLM NetWare Loadable 
Module

NNTP Network News Transfer 
Protocol

NRK Notes Recovery Kit

NRPC Notes Remote 
Procedure Call

ODBC Open Database 
Connectivity

ODM Object Data Manager

ODS On-Disk Structure

OLE Object Linking and 
Embedding

OU Organizational Unit

PAB Public (Name and) 
Address Book

PCL Printer Control 
Language

POP3 Post Office Protocol 
Version 3

PP Physical Partition

PPP Point-to-Point Protocol

PRPQ Programming Request 
for Price Quotation

PSSP Parallel System 
Support Programs

PTF Program Temporary Fix

PTPE Performance Toolbox 
Parallel Extensions

PTX Performance Toolbox

QMR Quarterly Maintenance 
Release
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RAID Redundant Array of 
Inexpensive Disks

RAM Random Access 
Memory

RAS Reliability, Availability, 
Serviceability

RDBM Relational Database 
Manager

RFC Request For Comments

RISC Reduced Instruction 
Set Computing

RPC Remote Procedure Call

SACL Server Access Control 
Lists

SCSI Small Computer system 
Interface

SLIP Serial Line Internet 
Protocol

S/MIME Secure MIME

SMIT System Management 
Interface Tool

SMP Symmetric 
Multi-Processing

SMTP Simple Mail Transfer 
Protocol

SNMP Simple Network 
Management Protocol

SP Scalable Parallel

SPI Service Provider 
Interface

SPX Sequenced Packet 
eXchange

SSA Serial Storage 
Architecture

SSL Secure Sockets Layer
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